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Part I: Setting Up and Configuring BSM
Connector

This section includes:

l "BSM Connector Overview" on page 14

l "Setup and Configuration" on page 24

l "Security" on page 56

l "Event Synchronization" on page 76

l "UI Drilldown" on page 81

l "Remote Servers Overview" on page 85



Chapter 1: BSM Connector Overview
HP BSMConnector (BSM Connector) is a component of HP Business ServiceManagement (BSM)
that enables you to integrate data from third-party systems (typically enterprisemanagement
systems) in BSM. You can integrate events, metrics, and topology data in BSM. Third-party
systems are those not provided by HP. BSM Connector also works with someHP applications.

BSM Connector uses policies to access the data sources. If the datamatches the conditions
defined in the policies, the data is forwarded in the form of events or metrics to BSM. Policies can
also report topology data to BSM in order to create CIs and CI relationships in BSM's Run-time
ServiceModel (RTSM).

Integration Types
Depending on the third-party data source and what type of data you need to collect, you choose one
of the following integration types:

l Remote integration. In remote integrations, installation of HP software on the third-party
system is not required. BSM Connector can be installed on any system in your environment,
provided the systemmeets the installation prerequisites.

l Local integration. You install BSM Connector directly on the third-party system.

Integration Data
BSMConnector can access the following data sources:

Data Source
Integration
Type

Integration
Data Description

Log files Local or
remote

Events

Metrics

Topology

Log file policies watch for specific entries
added to a log file provided by a third-party
system by trying tomatch against a regular
expression.

For details, see "Log File Policies" on page
237.

Database tables Local or
remote

Events

Metrics

Topology

Database policies enable you to collect
event and time series of data from
database tables used by third-party
systems by performing a query through a
JDBC connection.

For details, see "Database Policies" on
page 199.
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Data Source
Integration
Type

Integration
Data Description

Web service
requests

Local or
remote

Events

Metrics

Topology

Web service listener policies process
messages received by the BSMConnector
Web service listener.

For details, see "Web Service Listener
Policies" on page 382.

SNMP traps Local or
remote

Events SNMP trap policies process SNMP traps
received by BSMConnector from third-
party systems.

For details, see "SNMP Trap Policies" on
page 316.

XML files Local or
remote

Events XML file policies watch for specific entries
added to an XML file provided by a third-
party system by trying tomatch against a
regular expression. The log file can be a
local file or a remote file that is available
through a network share.

For example, you can install the BSM
Connector for SCOM and BSMConnector
on a separate computer, or you can install
the software on the same computer that
runs the SCOM server.

For details, see "XML File Policies" on
page 427.

Openmessage
interfacemessages

Local only Events Openmessage interface policies process
messages sent by the BSMConnector
opcmsg command-line tool.

For details, see "OpenMessage Interface
Policies" on page 287.

Scheduled tasks Local only Events Scheduled task policies enable you to
schedule commands to run on the BSM
Connector system. Scheduled task
policies send an event to BSM to indicate
the start, success, or failure of the
command.

For details, see "Scheduled Task Policies"
on page 299.
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Data Source
Integration
Type

Integration
Data Description

Custom topology Local only Topology Custom topology policies (based on DFM
technology) enable you to run discovery
scripts on the BSMConnector system. The
discovery scripts collect topology data and
send the data to BSM to create CIs and CI
relationships in BSM's RTSM.

For details, see "Custom Topology
Policies" on page 325.

Topology-XML
policies

Local or
remote

Topology Local topology synchronization relies on
the discovered data being available in an
XML file that conforms to the BSM
Connector topology discovery syntax. To
create the XML file, write a discovery script
(using your preferred scripting or
programming language). You then integrate
the discovery script into the topology-XML
policy that applies themapping rules and
transfers the CIs and CI relationships to
BSM.

For details, see "Topology-XML Policies
and Local Topology Synchronization" on
page 329.
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Data Source
Integration
Type

Integration
Data Description

Discovery
(deprecated)

Local only Topology Discovery policies (based on HP
Operations Agent discovery technology)
execute discovery scripts on the BSM
Connector server. The discovery agent
stores the data that it discovers in the agent
repository (agtrep), which is a local data
store of configuration items and their
relationships.The agent then sends and
synchronizes the local repository with the
RTSM.

BSMConnector supports agent-based
discovery only for discovery policies that
have beenmigrated from BSM Integration
Adapter or imported from HP Operations
Manager (HPOM). You can edit migrated
discovery policies. HPOM service auto-
discovery policies cannot be edited
because they are incompatible with the
BSM Connector legacy discovery policy
editor.

For details, see "Legacy Discovery" on
page 371.

BSM Applications That Use BSM Connector Data
The following BSM applications consume BSMConnector data:

l Events

n Operations Management

n Service Health

n Service Level Management

l Metrics

n Operations Management PerformanceGraphing

Note: If you have a CI monitoring fiveminutes of data and there aremultiple data points
within the duration, the graph shows only the last data received within the duration.

n Service Health
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n Service Health Analyzer

n Service Level Management

n System Availability Management reports

l Topology

n Operations Management

n Run-time ServiceModel

n Service Health

n Service Health Analyzer

n Service Level Management

Available Out of the Box Integrations
You can use one of the out-of-the box integrations that are available for BSM Connector.
Alternatively, if you do not find the integration that you are looking for, you can develop your own
custom integration.

BSM Connector integrates with the following HP products:

l HP ArcSight ESM

l HP ArcSight Logger

l HP Network NodeManager i

In addition, HP provides the following out-of-the box integrations with third-party products:

l HP BSMConnector for IBM Tivoli

l HP BSMConnector for Microsoft System Center Operations Manager (SCOM)

l HP BSMConnector for Nagios

l HP BSMConnector for Oracle EnterpriseManager

l HP BSMConnector for Zenoss

HP is continually updating the list out-of-the box integrations with third-party products. For details
and for download information, see the HP Live Network site https://hpln.hp.com/group/bsm-
integrations.
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Key Features and Benefits
Key Features

l Topology. Discover and report topology from the product BSM Connector connects to (based
on log files, database tables, Web services, or custom data sources using topology scripts). The
discovered topology populates the RTSM. You can thenmanage and work with these
discovered configuration items (CIs) in views.

l Events. Get events (from log files, database tables, Web services, XML files, SNMP traps,
OpenMessage Interfacemessages, or scheduled tasks).

l Metrics. Get metrics (from log files, database tables, orWeb services); metrics are stored in the
BSM Profile Database.

l Web-based UI. Define policies usingWeb-based UI.

l Event synchronization. After BSM receives an event, you can keep it up to date on the event
source by configuring BSM and BSMConnector to synchronize event changes back to the third-
party system that generated the original event.

l BSM integration.Manage BSMConnector from BSM.

l Backward compatibility. Backward compatibility with previous integrations based on BSM
Integration Adapter or SiteScope Technology IntegrationMonitors, which can bemigrated to
BSM Connector. For new integrations, BSM Connector should be used.

l Out-of-the-box connectors. Supports BSM's open integration strategy, providing out-of-the-
box connectors to HP and third-party products. This enables expanding connectivity of BSM and
related products (Operations Manager i, Service Health Analyzer).

Customers can access connectors via HP Live Network (HPLN); NNMi Connector, BSM
Connector for IBM Tivoli, BSM Connector for Microsoft SCOM, BSMConnector for Nagios,
BSM Connector for Oracle EnterpriseManager, and BSMConnector for Zenoss and are already
available.

HP certified partners will also be able to build their own connectors and post them onHPLN. See
the HP Live Network site https://hpln.hp.com/group/bsm-integrations.

Benefits

l Run-time Service Model (RTSM). BSMConnector can discover and report topology from the
product BSM Connector connects to. You can thenmanage and work with these discovered
configuration items (CIs) in views.

l Service Health and Service Level Management. Health indicators assigned to BSM
Connector event andmetrics data provide amore detailed view of the health of a configuration
item (CI).
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l Reports. Ability to create and view reports of BSM Connector metrics in System Availability
Management andOperations Management PerformanceGraphing.

l Service Health Analyzer (SHA):SHA analyzes metrics, calculates the dynamic baseline to
detect if eachmetric behaves normally or not, and automatically correlates relatedmetrics to a
single meaningful event.

BSM Connector Deployment Scenarios
The following figure shows a BSMConnector deployment.

You typically install BSM Connector on
the third-party system that acts as data
source. For example, to integrate NNMi
data into BSM, you install BSM
Connector on the NNMi management
server. However, BSM Connector can
also access data sources on remote
systems without the need to install data
collectors on these systems.

Where you install BSM Connector
depends on the type of data you want to
integrate in BSM. BSMConnector must
be installed and run locally on the data
host when integrating data originating
from the openmessage interface or
scheduled tasks. You can install
BSM Connector on any system that
meets the requirements if you want to
integrate data originating from
databases, log, or XML files, or receive
data through SNMP traps or theWeb
service listener. For details, see
"Integration Types" on page 14 and
"Integration Data" on page 14.

User Interface
The BSMConnector user interface is Web based; you can therefore access it from anywhere using
a supportedWeb browser.
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When you connect to BSM Connector, the policy management list opens as shown below.

For more information about the toolbar buttons and columns, as well as policy management in
general, see "Policy Management" on page 125.

User Authentication
BSMConnector supports the following user authentication strategies:

l Single Sign-On (SSO) for BSM applications (recommended)

The default single sign-on authentication strategy for BSM is Lightweight Single Sign-On (LW-
SSO). LW-SSO is embedded in BSM and does not require an external computer for
authentication.

LW-SSO enables a user to log into BSM once and gain access to all BSM applications without
being prompted to log in again. The applications inside BSM trust the authentication, and you do
not need further authentication whenmoving from one application to another. For example, if you
configure BSM Connector to use LW-SSO, BSM users can launch the BSMConnector user
interface without having to provide additional credentials.

Tip: BSM enables you to group users tomakemanaging user permissions more efficient.
For example, you could add all BSM Connector users to a dedicated group (IA_ADMINS, for
example) and assign permissions to access BSMConnector to the group.

For more information about LW-SSO, see the BSM Platform Administration guide.

l Smart card authentication

BSM Connector supports user authentication using smart cards. BSM Connector can be
configured to use the certificates stored on the smart card in place of the standardmodel of each
user manually entering a user name and password.

l Local user authentication

Each BSMConnector instancemaintains a local user store. These users can access the local
BSM Connector instance only and cannot gain access to other BSM applications. When BSM
users launch the BSMConnector user interface, they have to provide the credentials of a local
BSM Connector user.
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Formore information about accessing BSMConnector, see "How to Log on to BSM Connector" on
page 26.
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Licensing
BSMConnector does not require a license. However, BSM and the BSM applications that consume
BSMConnector datamay require licenses. For example, youmay want to purchase the following
BSM licenses to be able to take full advantage of the data that BSM Connector sends to BSM:

l HP Operations Manager i Event Management Foundation License. TheOMi Event
Management Foundation License is required for BSMOperations Management functionality,
such as the Operations Management Event Browser.

If no OMi Event Management Foundation License is installed, only the event channel features
are enabled:

n CI Resolution

n Event Forwarding

n Event Notifications

n Event Type Indicators (ETI)

n Resolution by ETI Hint

n Health Indicator Updates

n Topology Discovery

The event channel features, for example, enable BSM events to set HIs and KPIs for BSM's
Service Health and Service Level Management.

Note: A Target Connector license is required for each nodemanaged by a third-party (non-
HP)management solution, where events are consolidated in BSMOperations Management.
For example, if a Microsoft SCOM system is connected to BSM, andmanages 20 nodes,
you require 20 target connector licenses.

l HP System Availability Management License. You use the System Availability Management
(SAM) application to view and analyze reports based on themetrics collected by BSM
Connector and stored in the BSM database. For example, if a System Availability Management
license is installed in your BSM environment, you can view metrics sent from BSMConnector,
filtered by monitored servers, monitor types, andmeasurements in SiteScope Cross-
Performance reports.

If no System Availability Management license is installed, you can generate user-defined reports
for BSM Connector metrics in BSM. For details, see "How to View Metrics in BSM User-
Defined Reports" on page 172. Alternatively, you can use PerformanceGraphing to draw
performance graphs to show metrics for the configuration items you aremonitoring.

To obtain licenses from HP, visit HP Software Support Online
(http://www.hp.com/go/hpsoftwaresupport).
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Chapter 2: Setup and Configuration
This chapter contains information about setting up and configuring BSM Connector.

Getting Started
1. Plan your integration strategy.

Consider the type of information you want to view in BSM from your third-party system:
events, metrics, or topology.

Consider the data source: log files, databases, Web services messages, SNMP traps, XML
files, openmessage interfacemessages, or scheduled tasks.

2. Install BSM Connector.

You install BSM Connector locally on the third-party system that provides the integration data.
Alternatively, install BSM Connector on any system that meets the installation requirements if
you want to access remote data sources such as databases or log files, or receive SNMP
traps orWeb servicemessages. For details on installing BSM Connector, see the interactive
HP BSM Connector Installation andMigration Guide.

Alternatively, upgrade from BSM Integration Adapter to BSM Connector as described in the
BSMConnector Installation andMigration Guide.

3. Configure the BSMConnector instance as a BSMConnector integration server in BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see "How to Configure
BSM Connector to Communicate with BSM" on page 30.

4. Log on to BSM Connector.

To access BSM Connector from aWeb browser or from within BSM, see "How to Log on to
BSM Connector" on page 26.

5. Create or import policies that collect the integration data from the third-party system.

For details on obtaining out-of-the box integrations, see "Available Out of the Box Integrations"
on page 18.

For more information about importing policies developed on other servers (for example, HP
Operations Manager, HP Network NodeManager i, HP SiteScope, or other BSM Connector
servers), see "How to Import Policies" on page 133
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Formore information about importingmigrated SiteScope Technology IntegrationMonitors,
see "How toMigrate SiteScope Technology IntegrationMonitors" on page 40.

You can also develop your own policies to collect data from different sources. Table: Policy
Development Tasks provides links to the tasks you need to complete for the different data and
policy types.

Table: Policy Development Tasks

Data
Source To Integrate Events To Integrate Metrics

To Integrate Topology
Only

Log files "How to Collect Event
Data from Log Files" on
page 237

"How to Collect Metrics
Data from Log Files" on
page 238

"How to Collect Topology
Data from Log Files" on
page 239

Database
tables

"How to Collect Event
Data from Databases"
on page 199

"How to Collect Metrics
Data from Databases"
on page 200

"How to Collect Topology
Data Only from
Databases" on page 201

Web
service
requests

"How to Collect Event
Data Through theWeb
Service Listener" on
page 382

"How to Collect Metrics
Data Through theWeb
Service Listener" on
page 383

"How to Collect Topology
Data Through theWeb
Service Listener" on page
385

SNMP
traps

"How to Collect Event
Data from SNMP
Traps" on page 317

Not available. "How to Report Topology
Data" on page 325

"How to Configure Local
Topology
Synchronization" on page
339

XML files "How to Collect Event
Data from XML Files"
on page 427

Not available. "How to Report Topology
Data" on page 325

"How to Configure Local
Topology
Synchronization" on page
339

Open
message
interface
messages

"How to Collect Event
Data from theOpen
Message Interface" on
page 287

Not available. "How to Report Topology
Data" on page 325

"How to Configure Local
Topology
Synchronization" on page
339
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Data
Source To Integrate Events To Integrate Metrics

To Integrate Topology
Only

Scheduled
tasks

"How to Schedule
Tasks" on page 299

Not available. "How to Report Topology
Data" on page 325

"How to Configure Local
Topology
Synchronization" on page
339

6. Activate the policies.

When you create a new policy or import a policy, the policy exists in the BSMConnector policy
repository but does not function yet. Youmust first activate the policy for it to start accessing
the corresponding data source.

For details on activating policies, see "How to Activate and Deactivate Policies" on page 130.

7. View the data in BSM.

In BSM, open the applications that consume the integrated data andmake sure BSM receives
the expected data. For details on the applications that consume BSM Conncector integration
data, see "BSM Applications That Use BSMConnector Data" on page 17.

For example, to view events in BSM, access Operations Management and open the Event
Browser.

How to Log on to BSM Connector
You access BSMConnector using a supportedWeb browser, from any computer with a network
connection to a BSMConnector server.

The BSMConnector user interface opens without prompting for user authentication if single sign-on
(SSO) is configured and the user is already logged on to BSM. In this case an LW-SSO session
cookie stored in theWeb browser contains the BSM authentication information. BSM users can
access BSMConnector only if they have the necessary permissions (for example, if they have the
SUPERUSER role assigned or aremembers of the BSMC_ADMINS group).

If BSM Connector is configured for smart card authentication, you are prompted to insert your smart
card and enter the PIN.

This section includes:

l "LogOn to BSM Connector" on the next page

l "LogOut of BSM Connector" on page 28

l "Troubleshooting" on page 28
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Log On to BSM Connector
You can start the BSM Connector user interface in the following ways:

l Start the BSM Connector user interface from aWeb browser

a. To start the BSM Connector user interface, open aWeb browser at the following URL:

https://<BSM Connector system>:30000/bsmconnector/

<BSM Connector system> is localhost or the hostname of the BSMConnector server. If
Apache Tomcat is configured to use a different port, use this port instead.

b. Depending on the security settings in your environment, youmay have to log on or provide
your smart card PIN. If asked for log-on credentials, type the user name and password of a
local user account. The user name and password of the default local user account is:

User name: admin
Password: admin

Note: BSMConnector locks the user account for 60 seconds after five failed logon
attempts. Each subsequent failed logon attempt restarts the lockout period.

l Start the BSM Connector user interface in BSM

BSM enables you to start the user interface of BSM Connector or of the third-party system
directly from within BSM. The following integrations are available:

BSM Connector UI integrations
n BSM Connector integrations page. Navigate toAdmin > Integrations > BSM

Connector Integrations. In the Summary view, locate the BSMConnector you want to
launch. Click the name in the Name column.

n Connected Servers manager. Navigate toAdmin > Operations Management > Setup >
Connected Servers. In the Connected Servers details pane, locate the BSMConnector you

want to launch and click the Launch Policy Management icon.

Alternatively, edit the BSM Connector you want to launch, navigate to the Policy

Management tab, and click the Launch Policy Management icon.

The following illustration shows the Launch Policy Management link in the Connected
Servers manager.
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n Event context. In the Operations Management Event Browser, right-click an event that has
been forwarded from a BSMConnector server, and then select Configure > Integration
Policies.

Depending on the security settings in your environment, youmay have to log on or provide a
smart card PIN. If you are prompted for login information, type the user name and password of a
local user account. BSM Connector does not require you to log on if single sign-on is configured.

For details, see "How to Configure Launch of the BSM Connector User Interface" on page 82.

Third-party system UI integration
In the Operations Management Event Browser, right-click an event that has been forwarded
from a BSMConnector server, and then select Show > Event in Source Manager.

UI integrations with third-party systems are not available out of the box. For information how to
configure a UI integration, see "How to Configure Drilldown into Third-Party Systems" on page
83.

Log Out of BSM Connector
To log out of BSM Connector, click Logout at the top of the page.

If a user ends a BSMConnector user interface session by closing theWeb browser window or tab
(for example by clicking the Close button in the window's title bar or using amenu option), BSM
Connector automatically logs the user off after 60 seconds.

Troubleshooting

l Problem:Accessing the BSMConnector user interface produces a "Web page not found" error
in the browser, and the Tomcat log file <BSM Connector root directory>/logs/tomcat.log
contains the following lines:

LifecycleException: service.getName(): "Catalina";
Protocol handler start failed: java.io.IOException:
Keystore was tampered with, or password was incorrect

Solution: The self-signed certificate that is provided out-of-the-box with BSM Connector must
be replaced with a server certificate from aCA in PKCS12 format. Alternatively, manually
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generate a server certificate using a Java Keystore (JKS) and have it signed by your CA. For
details, see "How to Configure BSM Connector to Use SSL" on page 64.

l Problem: The login page appears although a valid smart card exists.

Solution: The user is not set up as a local user in BSM Connector. Look for the value of the
User Principal Name (UPN) in the Subject Alternative Name (SAN) field in the certificate and
add a user with that name to BSM Connector. For details, see "Setting Up Smart Card
Authentication" on page 57.

How to Manage BSM Connector Processes
BSMConnector has multiple processes that are required to be running to allow users to access
BSMConnector. The processes run continuously as background processes without affecting other
applications.

BSM Connector on Windows service
UseWindows Services tomanage the BSMConnector service:

1. Start theWindows Task Manager.

2. Click theServices tab.

The default BSM Connector service name is HP BSM Connector.

BSM Connector on Linux processes

l To start themain BSM Connector process, use one of the following commands:

/opt/HP/BSMConnector/start

service bsmc start

l To stop themain process, use one of the following commands:

/opt/HP/BSMConnector/stop

service bsmc stop

l To restart themain BSM Connector process, use the following command:

service bsmc restart

l To print the status of themain BSM Connector process, use the following command:

service bsmc status

Note: The bsmc service is not by default registered on Linux. To register the service, complete
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the following steps:

1. Copy the init script bsmc to /etc/init.d:

cp /opt/HP/BSMConnector/bin/bsmc /etc/init.d

2. Add execution rights to the script:

chmod +x /etc/init.d/bsmc

3. Register the script:

chkconfig --add bsmc

HP Operations Agent processes
The HP Operations Agent processes start automatically. However you canmanually start and stop
HP Operations Agent using the ovc command: 

Windows: %ovinstalldir%\bin\ovc

Linux: /opt/OV/bin/ovc

Formore information about ovc, type ovc -help.

How to Configure BSM Connector to Communicate with
BSM

To enable the connection between BSMConnector and BSM, the BSMConnector instancemust
be configured as a BSMConnector integration server in BSM. This involves adding the BSM
Connector server to the BSM Integrations page in BSM (Admin > Integrations > BSM
Connector Integrations).

When you add a BSM Connector integration to BSM, the BSM Connector instancemust be
accessible to BSM. If this is not the case, for example, when working in HP Software-as-a-Service,
youmay add the BSMConnector with an inaccessible profile to BSM, and then configure the
connection and integration in the BSM Integration Preferences dialog box in BSM Connector. For
more information, see "Configuring Integration Preferences for Inaccessible Profiles" on page 48.

1. Prerequisite. Install and configure BSM Connector.

For details, see the interactive BSM Connector Installation and UpgradeGuide.

Note: On the BSMConnector server, close any running instances of the command
ovconfchg -edit.

2. Prerequisite. In BSM, check that a profile database exists, access:
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Admin > Platform > Setup and Maintenance > Manage Profile Databases

The profile database stores metrics data and is required, even if nometrics data will be sent
from the BSMConnector.

If a profile database does not yet exist, create one as described in "Database Administration"
in the BSM Platform Administration Guide.

3. Prerequisite. In a distributed BSM environment with a load balancer or reverse proxy, configure
HP Operations Agent manually.

In a distributed BSM environment with a reverse proxy or a load balancer, the BSM Data
Processing server and the BSM Connector server may not be able to communicate with each
other in order to request and install a certificate. To provide the agent with a certificate, you
must issue the certificate manually on the BSM certificate server and then import it manually
on the BSMConnector system. In addition, youmust manually set theMANAGER_ID
configuration variable. TheMANAGER_ID defines who is allowed to access the agent from
outside. For details, see "How to Configure BSM Connector to Communicate with a
Distributed BSM" on page 33.

4. In BSM, open the New BSMConnector page, select:

Admin > Integrations > BSM Connector Integrations

In the left pane, click New BSM Connector. The New BSMConnector page displays.

The information you need to enter depends on the type of integration data you want to collect
with this BSM Connector:

n Main Settings. Complete themandatory Display name andHost name fields. Accept or
change the default HTTP and HTTPS port numbers.

Note: If you are working with a BSMConnector that is not accessible to BSM (for
example in HP Software-as-a-Service), the procedure for the connection includes
creating an empty profile in BSM and creating an Integration Preference for BSM in
BSMConnector. For task details, see "Configuring Integration Preferences for
Inaccessible Profiles" on page 48.

n Event Drilldown Settings. These settings apply to event data only and are optional.

Event drilldown enables BSM users to launch the user interface of the third-party system in
the context of an event collected through BSMConnector. Event synchronization sends
event lifecycle changes back to the event source. For example, if a BSM operator closes an
event originating from NNMi, a notification can be automatically sent to NNMi.

n BSM Gateway Server Settings. These settings aremandatory and are completed
automatically. Accept or change the defaults as required.
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The required information includes the name of the BSMGateway Server to which the BSM
Connector sends the collected data. The name of the user to log into the BSMGateway
Server from the BSMConnector is also required because BSM Connector subsequently
uses this user name to authenticate internal calls to BSM.

If the BSM environment includes a load balancer or reverse proxy, make sure to change the
values of theGateway server name/IP address field to the fully qualified domain name
(FQDN) of the load balancer or reverse proxy.

n Policy Management Settings.

TheConfigure policy management settings establish secure communication between
BSMConnector and the BSMGateway Server based on certificates. The Configure policy
management check box sends a certificate request to BSM, whichmust then be granted in
BSM. Secure communication is required for policy activation in BSM Connector and for
event forwarding from BSMConnector to BSM.

n Profile Settings. These settings aremandatory and are completed automatically. Accept or
change the defaults as required.

The settings define a profile database for a BSM Connector in BSM. The profile database
stores metrics data and is required, even if nometrics data will be sent from the BSM
Connector. If a profile does not yet exist in BSM, create one as described in "Database
Administration" in the BSM Platform Administration Guide.

If BSM is configured to require SSL, selectWeb Server Use SSL. If the BSM Connector
server requires SSL, also select Use SSL. For details, see "Configuring BSM Connector to
Use SSL" on page 62.

n Topology Settings. These settings aremandatory for topology data only. Accept or change
the defaults as required.

The settings define how often the topology data is synchronized between BSM and BSM
Connector, from which routing domain the topology data is collected, and to which port on
the BSMGateway Server BSM Connector sends the collected data.

5. Click Submit to save the new BSMConnector integration.

Setting up a BSMConnector integration on this page automatically creates a BSMConnector
connected server in Operations Management.

6. Results. You can view the collected data in different BSM applications, depending on the type
of integration data that you collect. For example, you can view data in Operations
Management, RTSM, Service Health, or BSM Reports.

Note: Youmust first configure and activate policies in BSM Connector to start the data
collection. To stop data collection, deactivate the policies.
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For full details about how to configure a BSMConnector integration server, see the BSM online help
or the BSM Application Administration Guide.

How to Configure BSM Connector to Communicate with
a Distributed BSM

In a distributed BSM environment with a reverse proxy or a load balancer, the BSM data processing
server and the BSM Connector server may not be able to communicate with each other in order to
request and install a certificate. To provide the agent with a certificate, youmust issue the
certificate manually on the BSM certificate server and then import it manually on the BSM
Connector system. In addition, youmust manually set theMANAGER_ID configuration variable.
TheMANAGER_ID defines who is allowed to access the agent from outside.

1. On the BSMConnector system, use ovcoreid to show the core ID of the system:

ovcoreid

2. On the BSM certificate server (usually the data processing server), use ovcert to export the
trusted certificate, type:

ovcert -exporttrusted -file omi.cer

3. On the BSM certificate server (usually the data processing server), use ovcm to generate a
certificate, type:

ovcm -issue -file cert.cer -name <FQDN of BSM Connector> -coreid <OvCoreId of
BSM Connector> -pass <password>

4. Securely transfer the generated files to the BSMConnector system.

5. Use ovcert to import the certificates from the generated files, type:

ovcert -importtrusted -file omi.cer

ovcert -importcert -file cert.cer

The command prompts you for the password that you specified when you generated the
certificates. Type the password and press Enter.

6. On any of the gateway server systems, use ovcoreid to show the core ID of the system:

ovcoreid -ovrg server

7. On the BSMConnector system, set themanager and certificate server manually, type:

ovconfchg -ns sec.cm.client -set CERTIFICATE_SERVER <FQDN of reverse proxy or
load balancer>
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ovconfchg -ns sec.core.auth -set MANAGER <FQDN of reverse proxy or load
balancer>

ovconfchg -ns sec.core.auth -set MANAGER_ID <OvCoreId of any gateway server>

8. Run oainstall to complete the HP Operations Agent setup, type:

Windows 32-bit: cscript "%OvInstallDir%\bin\OpC\install\oainstall.vbs" -a -c

Windows 64-bit: cscript "%OvInstallDir%\bin\win64\OpC\install\oainstall.vbs" -a
-c

Linux: /opt/OV/bin/OpC/install/oainstall.sh -a -c

9. Review the agent installation log file:

Windows: %OvDataDir%log\oainstall.log

Linux: /var/opt/OV/log/oainstall.log

If the log file contains errors relating to the OvControl service failing to start or restart, complete
the following steps:

a. Manually reinstall ovcd as aWindows service, type:

ovcd -install

b. Rerun oainstall.

10. Securely delete any copies of the files that contain the certificates. Depending on how you
generate and transfer the files, youmay, for example, have copies in the following locations:

n on the BSM data processing server

n on the BSMConnector system

n on a USB flash drive, CD, or other portable media

11. Add the BSMConnector system to the BSMConnector Integrations page in BSM. For details,
see "How to Configure BSM Connector to Communicate with BSM" on page 30.

How to Configure BSM Connector to Connect to a BSM
Server That Uses SSL

In environments where only BSM is configured for secure communication (BSM Connector does
not have a server or client certificate), import the CA root certificate to the BSM Connector
keystore:
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1. Configure the BSM server to require SSL. For details, see the BSMHardening Guide.

2. Obtain the root CA certificate of the authority that issued the BSM server certificates for the
external access points (load balancer, reverse proxy, BSMWeb server).

Copy the certificate to the BSMConnector server.

3. On the BSMConnector server, import the root CA certificate:

cd <BSM Connector root directory>/java/bin

keytool -import -trustcacerts -alias <your alias> -keystore
../lib/security/cacerts -file <root CA certificate file>

4. In BSM, add the BSM Connector to the BSM Connector Integrations page. Open the New
BSMConnector page, select:

Admin > Integrations > BSM Connector Integrations

In the left pane, click New BSM Connector. The New BSMConnector page displays:

n Main Settings. Complete themandatory Display name andHost name fields. Accept or
change the default HTTP and HTTPS port numbers.

Note: If you are working with a BSMConnector that is not accessible to BSM (for
example in HP Software-as-a-Service), the procedure for the connection includes
creating an empty profile in BSM and creating an Integration Preference for BSM in
BSMConnector. For task details, see "Configuring Integration Preferences for
Inaccessible Profiles" on page 48.

n Event Drilldown Settings. These settings apply to event data only and are optional.

Event drilldown enables BSM users to launch the user interface of the third-party system in
the context of an event collected through BSMConnector. Event synchronization sends
event lifecycle changes back to the event source. For example, if a BSM operator closes an
event originating from NNMi, a notification can be automatically sent to NNMi.

n BSM Gateway Server Settings. These settings aremandatory and are completed
automatically. Accept or change the defaults as required.

The required information includes the name of the BSMGateway Server to which the BSM
Connector sends the collected data. The name of the user to log into the BSMGateway
Server from the BSMConnector is also required because BSM Connector subsequently
uses this user name to authenticate internal calls to BSM.
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If the BSM environment includes a load balancer or reverse proxy, make sure to change the
values of theGateway server name/IP address field to the fully qualified domain name
(FQDN) of the load balancer or reverse proxy.

n Policy Management Settings.

TheConfigure policy management settings establish secure communication between
BSMConnector and the BSMGateway Server based on certificates. The Configure policy
management check box sends a certificate request to BSM, whichmust then be granted in
BSM. Secure communication is required for policy activation in BSM Connector and for
event forwarding from BSMConnector to BSM.

n Profile Settings. These settings aremandatory and are completed automatically. Accept or
change the defaults as required.

Make sure to selectWeb Server Use SSL because the BSM server is configured to require
SSL.

The settings define a profile database for a BSM Connector in BSM. The profile database
stores metrics data and is required, even if nometrics data will be sent from the BSM
Connector. If a profile does not yet exist in BSM, create one as described in "Database
Administration" in the BSM Platform Administration Guide.

n Topology Settings. These settings aremandatory for topology data only. Accept or change
the defaults as required.

The settings define how often the topology data is synchronized between BSM and BSM
Connector, from which routing domain the topology data is collected, and to which port on
the BSMGateway Server BSM Connector sends the collected data.

5. Click Submit to save the new BSMConnector integration.

Setting up a BSMConnector integration on this page automatically creates a BSMConnector
connected server in Operations Management.

5. In BSM, grant the certificate request: 

a. Navigate toAdmin > Operations Management > Setup > Certificate Requests and
locate the request.

It may take a few minutes for the certificate request to appear.

b. Grant the corresponding certificate request.

How to Manage BSM Connector with HPOM
Tomanage a BSMConnector system with HPOM, you need to configure an agent-based flexible
management policy. The policy configures the BSM server as the primary manager of BSM
Connector, and the HPOM management server as a secondary and action-allowedmanagement
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server. This enables the HPOMmanagement server to start actions, and deploy policies and
packages.

The policy also configures HP Operations Agent to send the collected data as follows:

l The BSM server receives all events generated by BSMConnector policies that have the Type
attribute set toBSMC_Message.

The HPOM management server receives all events that do not have the Type attribute set to
BSMC_Message.

BSM Connector sets the event type attribute automatically to BSMC_Message. You can delete
the value in a policy but BSM Connector inserts it again when you save the policy. The type
attribute is available in the Advanced attributes tab of the policy editors.

l The BSM server receives all metrics data.

l The BSM server receives all topology data (both HP Operations Agent and DFM-discovered
data).

Note:

l The flexible management policy cannot be edited in the BSMConnector user interface.

l In the procedures below, use the ovcoreid command-line tool to find out the required core
ID of the system.

To manage BSM Connector with HPOM for Windows:

1. Exchange certificates between the BSM andHPOM systems. For information about
exchanging certificates, see "To configure trusted certificates:" on page 40.

2. On the HPOMmanagement server, use theConfigure Managed Nodes dialog box to add the
BSMConnector system as amanaged node. In the node's properties, manually add the core
ID and set the certificate state to Installed.

3. On the BSMConnector system, create and activate an agent-based flexible management
policy:

a. Make a copy of the flexible management policy template.

BSM Connector on Windows
Open a command prompt and type:

copy "%OvDataDir%\conf\HPOprIA\3F9A8F04-B5E3-43C3-999B-7A9492C35014_
data.template" "%OvDataDir%\conf\HPOprIA\3F9A8F04-B5E3-43C3-999B-
7A9492C35014_data"
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copy "%OvDataDir%\conf\HPOprIA\3F9A8F04-B5E3-43C3-999B-7A9492C35014_
header.xml.template" "%OvDataDir%\conf\HPOprIA\3F9A8F04-B5E3-43C3-999B-
7A9492C35014_header.xml"

BSM Connector on Linux
Open a shell and type:

cp /var/opt/OV/conf/HPOprIA/3F9A8F04-B5E3-43C3-999B-7A9492C35014_
data.template /var/opt/OV/conf/HPOprIA/3F9A8F04-B5E3-43C3-999B-
7A9492C35014_data

cp /var/opt/OV/conf/HPOprIA/3F9A8F04-B5E3-43C3-999B-7A9492C35014_
header.xml.template /var/opt/OV/conf/HPOprIA/3F9A8F04-B5E3-43C3-999B-
7A9492C35014_header.xml

b. Edit the policy data file 3F9A8F04-B5E3-43C3-999B-7A9492C35014_data.

c. Locate the string ${OM_MGR_SRV} and replace all occurrences with the FQDN of the HPOM
management server.

Locate the string ${OM_MGR_SRV_ID} and replace all occurrences with the core ID of the
HPOMmanagement server.

d. Locate the string ${OMi_MGR_SRV} and replace all occurrences with the FQDN of the BSM
gateway server.

Locate the string ${OMi_MGR_SRV_ID} and replace all occurrences with the core ID of the
BSM data processing server.

e. Save the policy data file. Import the policy in BSM Connector and activate it.

4. In the HPOM console, right-click the node that represents the BSMConnector system and
select All Tasks > Synchronize inventory > Packages.

5. On the HPOMmanagement server, check that you canmanage the BSMConnector system,
type:

opcragt -status <BSM Connector hostname>

The output should indicate that the agent is running.

For more information about HPOM forWindows, see the HPOM forWindows online help.

To manage BSM Connector with HPOM for UNIX or Linux:

1. Exchange certificates between the BSM andHPOM systems. For information about
exchanging certificates, see "To configure trusted certificates:" on page 40.

2. On the HPOMmanagement server, add the BSMConnector system as amanaged node, type:
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opcnode -add_node <BSM Connector hostname>

3. On the HPOMmanagement server, specify the core ID of the BSMConnector server, type:

opcnode -chg_id node_name=<BSM Connector hostname> id=<core ID of BSM
Connector system>

4. On the BSMConnector system, create and activate an agent-based flexible management
policy:

a. Make a copy of the flexible management policy template.

BSM Connector on Windows
Open a command prompt and type:

copy "%OvDataDir%\conf\HPOprIA\3F9A8F04-B5E3-43C3-999B-7A9492C35014_
data.template" "%OvDataDir%\conf\HPOprIA\3F9A8F04-B5E3-43C3-999B-
7A9492C35014_data"

copy "%OvDataDir%\conf\HPOprIA\3F9A8F04-B5E3-43C3-999B-7A9492C35014_
header.xml.template" "%OvDataDir%\conf\HPOprIA\3F9A8F04-B5E3-43C3-999B-
7A9492C35014_header.xml"

BSM Connector on Linux
Open a shell and type:

cp /var/opt/OV/conf/HPOprIA/3F9A8F04-B5E3-43C3-999B-7A9492C35014_
data.template /var/opt/OV/conf/HPOprIA/3F9A8F04-B5E3-43C3-999B-
7A9492C35014_data

cp /var/opt/OV/conf/HPOprIA/3F9A8F04-B5E3-43C3-999B-7A9492C35014_
header.xml.template /var/opt/OV/conf/HPOprIA/3F9A8F04-B5E3-43C3-999B-
7A9492C35014_header.xml

b. Edit the policy data file 3F9A8F04-B5E3-43C3-999B-7A9492C35014_data.

c. Locate the string ${OM_MGR_SRV} and replace all occurrences with the FQDN of the HPOM
management server.

Locate the string ${OM_MGR_SRV_ID} and replace all occurrences with the core ID of the
HPOMmanagement server.

d. Locate the string ${OMi_MGR_SRV} and replace all occurrences with the FQDN of the BSM
gateway server.

Locate the string ${OMi_MGR_SRV_ID} and replace all occurrences with the core ID of the
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BSM data processing server.

e. Save the policy data file. Import the policy in BSM Connector and activate it.

5. On the HPOMmanagement server, check that you canmanage the BSMConnector system,
type:

opcragt -status <BSM Connector hostname>

The output should indicate that the agent is running.

For more information about HPOM for UNIX or Linux, see the documentation that HPOM for UNIX
or Linux provides.

To configure trusted certificates:
In an environment with multiple servers, youmust configure each server to trust certificates that the
other servers issued. This task involves exporting every server's trusted certificate, and then
importing this trusted certificate to every other server. Youmust also update the agent's trusted
certificates, so that the agent also trusts the BSM servers.

Configure trusted certificates for every server (BSM gateway and data processing servers,
HPOM management server):

1. On everyBSM server, export the trusted certificate to a file using the following command:

ovcert -exporttrusted -file <file>

The command generates a file with the name that you specify.

2. Copy each file to every other server, and then import the trusted certificate using the following
commands:

ovcert -importtrusted -file <file>

ovcert -importtrusted -ovrg server -file <file>

3. On the BSMConnector system, update the trusted certificates using the following command:

ovcert –updatetrusted

How to Migrate SiteScope Technology Integration
Monitors

You canmigrate existing technology integrationmonitors from SiteScope to BSM Connector. The
export downloads a technology integrationmonitor from SiteScope and converts it to the BSM
Connector policy format for import to BSM Connector. Such imported policies can bemaintained
and further customized in BSM Connector.
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Supported SiteScope technology integration monitors
Only the following technology integrationmonitors with ametrics, common events, or legacy
events field mapping data type are supported for export in SiteScope:

l SiteScope Technology Database IntegrationMonitor

l SiteScope Technology Log File IntegrationMonitor

l SiteScope Technology Web Service IntegrationMonitor

Migrate SiteScope technology integration monitors to BSM Connector
policies

1. In SiteScope, export the integrationmonitor that you want to migrate to BSM Connector.

a. In SiteScope, open themonitor properties for the technology integrationmonitor that you
want to export, and expand theExport to BSM Connector panel.

b. In the Export to BSM Connector Policy panel, click theExport button, select a folder on
the client file system in which to save the policy files, and then click Open.

c. The export process is performed, and a popupmessage displays the results.

In case of an error, a detailed error message is written in the log file <SiteScope root
directory>/logs/error.log.

The SiteScopemonitor is converted to a policy data and header file. The files are saved to
the selected location in the format:

o <policy_id>_data for the policy data file

o <policy_id>_header.xml for the header file

For details on exporting technology integrationmonitors in SiteScope, see the SiteScope Help
or the the Using SiteScopeGuide.

2. Transfer the generated policy files to the BSMConnector system.

3. If a migrated technology log file integrationmonitor watches a log file on a remote server that is
not configured in BSM Connector, youmust add the remote server to BSM Connector before
importing themigratedmonitor policy. If the remote server does not exist in BSM Connector at
the time of the policy import, the name of the remote server is replaced with the BSM
Connector server.

For details, see "Remote Servers Overview" on page 85.

4. Import themigrated integrationmonitor to BSM Connector:

a. In the BSMConnector user interface, click in the toolbar. A file selection dialog box
opens.
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b. Navigate to the policy files and, for each former integrationmonitor, select both the header
(*_header.xml) and the data (*_data) files.

c. Click Open to start the import process.

The imported policy receives the name of themigrated integrationmonitor.

5. Edit the imported integrationmonitor policy:

a. In the BSMConnector user interface, select amigrated integrationmonitor policy and click
in the toolbar, or double-click an integrationmonitor policy. The integrationmonitor

policy editor opens. 

b. Check the information in the following pages:

o Properties. The properties page includes information that is related to the policy itself
(for example, the name and description of the policy).

o Source. The source page determines where the policy collects the data.

o Defaults (metrics only). The policy defaults assign default values to themetric
attributes.

o Rules (metrics only). The policy rules define what the policy should do in response to
a specific metric.

o Field Mapping (legacy and common events only.) The field mapping page is only
available in policies that have beenmigrated from SiteScope technology integration
monitors of the data type Legacy Events orCommon Events. The field mapping
defines the conversion rules from the third-party data to the BSM event format.

For more information on field mapping, see the SiteScope Help or the the Using
SiteScopeGuide.

Note: For new event integrations, create BSM Connector event integration policies
as described in "How to Collect Event Data from Databases" on page 199, "How to
Collect Event Data from Log Files" on page 237, and "How to Collect Event Data
Through theWeb Service Listener" on page 382.

o Topology. The topology page contains the topology script associated with themigrated
integrationmonitor.

Note:

o Imported integrationmonitors have one of the following topology script types:

No Topology is assigned tometric sample with no topology.
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Computer – Monitor is assigned tometric sample with computer-monitor
topology.

Custom is assigned to all other topology types.

BSM Connector may change the topology script type during the import; the
content of a topology script is not changed.

o Imported integrationmonitor policies that sendmetrics and custom topology
must use the following code in the custom topology script to set theMonitored
by attribute on the CIs reported by the script:

ems_lib.addMonitoredByForThirdPartySoftware(Framework, <ci>)

If necessary, modify the topology script after the import to include the above
statement for each reported CI.

c. Click OK to save the policy and close the editor.

6. Activate themigrated integration policy:

a. In the BSMConnector user interface, make sure themigrated integration policy is
selected.

b. Click in the toolbar. The activation state of the policy changes to activated.

Note: BSMConnector automatically deploys the policy “HP_SiteScope_to_Operations_
Manager_Integration_by_Log_File” the first time you activate an imported integration
monitor of the data typeCommon Events. This policy is required for the common events
flow from BSMConnector to BSM. The policy is not visible in the policy management UI in
BSM Connector.

Configuring LW-SSO Authentication
BSMConnector can use lightweight single sign-on (LW-SSO) for the user authentication strategy,
which allows the BSMConnector users to bemanaged in the sameway as the BSM users and
groups. LW-SSO is the recommended strategy for BSM. The BSMConnector installation program
enables LW-SSO authentication by default.

This section describes how to configure LW-SSO authentication for an existing BSM Connector
installation:

l "How to configure LW-SSO authentication for an existing BSM Connector installation" on the
next page

l "LW-SSO security warnings" on page 46
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How to configure LW-SSO authentication for an existing BSM Connector
installation

1. Prerequisite: Obtain the following information from BSM:

n BSM domain name. You need to know the domain name of the BSM gateway server to
which BSMConnector sends data (for example, example.com).

If the BSM gateway servers and the BSMConnector run in different subdomains, for
example, deu.example.com and ind.example.com, specify only the name of the parent
domain, which is example.com in this example.

BSM Connector and the BSM gateway server to which it is reportingmust run in the same
top-level domain.

n LW-SSO token key. Obtain the token key defined in BSM as follows:

i. In the BSM user interface, navigate to the Users and Permissions manager:

Admin > Platform > Users and Permissions > Authentication Management

ii. In the Single Sign-OnConfiguration group, view the value of the Token Creation Key
(initString) setting.

iii. Record the value so it will be available to you later in this procedure.

If the setting is not defined, work with a BSM administrator to define it :

i. Click Configure to open the AuthenticationWizard.

ii. Click Single Sign-On to view the Single Sign-On panel, and select Lightweight
for the Single Sign-On Authenticationmode.

iii. Generate the Token Creation Key (initString). Record the value so it will be
available to you later in this procedure.

iv. Define the domain or subdomains that are participating in the LW-SSO
configuration:

o If BSM and the BSMConnector instances are running in different subdomains
type the name of the parent domain in the HP Business Service
Management field.

o If BSM and the BSM Connector instances are running in the same domain,
select Parse automatically and add the domain to the Trusted
Hosts/Domains list.

v. Click Finish to save your changes and close the wizard.

n BSM Connector groups and roles. Define the groups and roles that are allowed to log into
the BSMConnector:
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i. In the BSM user interface, navigate to the Infrastructure Settings manager:

Admin > Platform > Setup and Maintenance > Infrastructure Settings

ii. Click Foundation and select Single Sign-On in the drop-down list.

iii. Set Add user groups information to LW-SSO token to true.

The default group for BSM Connector is BSMC_ADMINS.

iv. Set Add user roles information to LW-SSO token to true.

2. On the BSM Connector system, navigate to and open the LW-SSO configuration file: 

Windows: %OVDataDir%\conf\HPOprIA\lwsso-config.xml

Linux: /var/opt/OV/conf/HPOprIA/lwsso-config.xml

3. Enable LW-SSO authentication by changing the value of enableLWSSOFramework to true:

<enableLWSSO enableLWSSOFramework="true"
             enableCookieCreation="true"
             cookieCreationType="LWSSO"
             version="2.4"/>

4. Insert the LW-SSO token key by changing the initString value to the desired initString, for
example my_initString:

<in-ui-lwsso>
   <lwssoValidation id="ID000001">
      <domain/>
      <crypto cipherType="symmetricBlockCipher"
              engineName="AES"
              paddingModeName="CBC"
              keySize="256"
              encodingMode="Base64Url"

initString="my_initString"/>
   </lwssoValidation>
</in-ui-lwsso>

5. Change the <DNSDomain> value to the desired domain name, for example example.com: 

<multiDomain>
   <trustedHosts>

<DNSDomain>example.com</DNSDomain>
      <!--
      <DNSDomain>company.com</DNSDomain>
      <NetBiosName>host</NetBiosName>
      <IP>16.59.34.64</IP>
      <FQDN>host.company.com</FQDN>
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      -->
   </trustedHosts>
</multiDomain>

6. Save the file with your changes.

7. Change the groups and roles that are allowed to log into the BSMConnector. Use the
ovconfchg command-line interface tomodify the list of users and groups:

ovconfchg -ns BSMC.LWSSO -set BSMAccessGroups BSMC_ADMINS,SUPERUSER,
<myGroup>,<myRole>

Separate individual groups and roles with commas (,). Enter DISABLED to indicate that group-
based authentication is not used.

8. Restart BSM Connector:

Windows: Restart theHP BSM Connector service in theAdministrative Tools > Services.

Linux: Restart the BSM Connector main process, type /opt/HP/BSMConnector/stop followed
by /opt/HP/BSMConnector/start.

LW-SSO security warnings
This section describes security warnings relevant to LW-SSO configuration. For more information
about LW-SSO, see the Platform Administration Guide.

l Confidential initString parameter in LW-SSO security.

LW-SSO uses symmetric encryption to validate an LW-SSO token. The initString parameter
within the configuration is used for initialization of the secret key. An application creates a token,
and each application that uses the same initString parameter validates the token.

Caution:

n It is not possible to use LW-SSOwithout setting the initString parameter.

n The initString parameter is confidential information and should be treated as such in
terms of publishing, transporting, and persistency.

n The initString should be shared only between applications integrating with each other
using LW-SSO.

n Theminimum length of the initString is 12 characters.

l LW-SSO should be disabled unless it is specifically required.

l Symmetric encryption implication.
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LW-SSO uses symmetric cryptography for issuing and validating LW-SSO tokens. Therefore,
any application using LW-SSO can issue a token to be trusted by all other applications sharing
the same initString. This potential risk is relevant when an application sharing the initString
either resides or is accessible in an untrusted location.

Configuring BSM Connector to Send Compressed Data
to BSM

How to Configure BSM Connector to Send Bulk Topology Data to the Run-
time Service Model
BSMConnector topology data can be sent to BSM’s Run-time ServiceModel (RTSM) either zipped
or unzipped. The request includes a parameter that indicates to the RTSMwhether the results being
sent are in zipped or unzipped format.

1. Open the following file: <BSM Connector root directory>\discovery\discovery_
agent.properties.

2. Locate the line beginning appilog.agent.probe.send.results.zipped. If the line does not
exist, add it to the file.

3. Change the value to =true.

4. Restart BSM Connector:

Windows: Restart theHP BSM Connector service in theAdministrative Tools > Services.

Linux: Restart the BSM Connector main process, type /opt/HP/BSMConnector/stop followed
by /opt/HP/BSMConnector/start.

BSM Connector data is zipped before being sent to RTSM.

How to Configure BSM Connector to Send Compressed Metrics Data to
BSM
By default, whenmetrics data is sent from the BSMConnector server to BSM it is sent
uncompressed. You can configure BSM Connector to compress metric (ss_t) samples in gzip
before they are sent to BSM (where they are decompressed).

To enable data compression of BSM Connector metrics data, complete the following steps:

1. Open the following file:

<BSM Connector root directory>/groups/master.config

2. Set the value of _compressDataInGzipFormat to true.

3. Restart the BSM Connector server:

Windows: Restart theHP BSM Connector service in theAdministrative Tools > Services.
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Linux: Restart the BSM Connector main process, type /opt/HP/BSMConnector/stop followed
by /opt/HP/BSMConnector/start.

Configuring Integration Preferences for Inaccessible
Profiles

When you add a BSM Connector integration to BSM, the BSM Connector instancemust be
accessible to BSM. If this is not the case, for example, when working in HP Software-as-a-Service,
youmay add the BSMConnector with an inaccessible profile to BSM, and then configure the
connection and integration in the BSM Integration Preferences dialog box in BSM Connector.

To access
In the BSMConnector user interface, click BSM Integration Preferences. The BSM Integration
Preferences dialog box opens.

Tasks
This section includes:

l "How to configure integration preferences for inaccessible profiles" below

l "How to delete a BSM integration preference" on the next page

How to configure integration preferences for inaccessible profiles
This task describes the steps involved in integrating BSM Connector in BSM when the BSM
Connector is inaccessible to BSM, for example when working in HP Software-as-a-Service.

1. Prerequisite. Install BSM Connector.

For details, see the interactive BSM Connector Installation and UpgradeGuide.

2. Prerequisite. Create an empty profile for BSM Connector in BSM:

a. On the BSMConnector server, close any running instances of the command ovconfchg -
edit.

b. Make sure the BSM version is 9.21 or later.

c. In BSM, open the New BSMConnector page, click:

Admin > Integrations > BSM Connector Integrations

In the left pane, click New BSM Connector. The New BSMConnector page displays.

d. In the New BSMConnector page, complete the following information:
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o Display name. Name for the BSMConnector integration.

o Host name. Hostname of the BSMConnector server. Youmay enter a dummy
hostname for the purpose of creating an empty profile.

o BSM Connector is inaccessible from BSM. Creates an empty profile for the BSM
Connector.

o Profile name. In the Profile Settings pane, youmay optionally enter the name for this
profile. If you do not enter a profile name, the display name is used.

e. Click Submit to save the new BSMConnector integration.

3. In BSM Connector, complete the followingmandatory information in the BSM Integration
Preferences dialog box:

n Business Service Management FQDN. Enter the fully qualified domain name or IP
address of the BSM gateway server (load balancer or reverse proxy).

n Business Service Management user name. Enter the user name of a BSM user with
administrative privileges.

n Business Service Management user password. Enter the password of the BSM
administrator user.

n BSM Connector profile to use. Click Load available profiles from Business
Service Management and select the previously created profile.

4. Click Save to save the integration preferences.

If Configure policy management is selected in the Event Reporting Settings pane, BSM
Connector sends a certificate request to BSM, which youmust grant before the BSM
Connector can be used:

a. Navigate toAdmin > Operations Management > Setup > Certificate Requests and
locate the request.

It may take a few minutes for the certificate request to appear.

b. Grant the corresponding certificate request.

How to delete a BSM integration preference
When you delete a BSM integration preference youmust also delete the BSMConnector integration
with the inaccessible profile from the BSM deployment:

1. On the BSMConnector server, delete the BSM integration preference:

a. In the BSMConnector user interface, click BSM Integration Preferences. The BSM
Integration Preferences dialog box opens.
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b. Click Delete.

c. In the warning dialog box, click OK to confirm that you want to delete the BSMConnector
profile from BSM.

d. Results.

Deleting a BSM integration preference deletes all the BSM-related settings from the BSM
Connector server. This also sends amessage to the BSM server to release the BSM
Connector agent from the corresponding profile.

Resetting the configuration permanently removes the connection to BSM. BSMConnector
will stop transferring data to BSM and cannot be reconnected to the current profile. Thus,
new data collected from this BSM Connector will not appear in BSM.

2. Delete the BSMConnector integration with the inaccessible profile from your BSM
deployment:

a. Open the BSMConnector Integrations page, select:

Admin > Integrations > BSM Connector Integrations

b. Select the BSM Connector that you want to delete and click .

c. In the warning dialog box, click OK to confirm that you want to delete the BSMConnector
profile from BSM.

d. Results.

Deleting a BSMConnector integration deletes the BSMConnector registration from BSM
as well as the corresponding connected server in Operations Management.

UI Descriptions

BSM Integration Preferences

UI Element Description

Save Integration Preferences. Saves the integration settings.

Edit Integration Preferences. Enables you to edit the integration
preferences.
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UI Element Description

Delete All Integration Related Preferences. Deletes all the BSM-related
settings from the BSMConnector server. This also sends amessage to
the BSM server to release the BSMConnector agent from the
corresponding profile. To complete the deletion, youmust also delete the
BSMConnector integration with the inaccessible profile from BSM. For
details, see "How to delete a BSM integration preference" on page 49.

Resetting the configuration permanently removes the connection to BSM.
BSMConnector will stop transferring data to BSM and cannot be
reconnected to the current profile. Thus, new data collected from this BSM
Connector will not appear in BSM.

Note: If you delete the current integration preferences, you have to
create or use a different profile to reconnect BSM Connector with
BSM. BSM does not enable you to select a previously used profile.

Force BSM Connector to Synchronize Configuration with Business
Service Management. Forces BSMConnector to resend all its third-party
metrics definitions andmetadata to BSM.

Hard synchronization. Deletes the existingmetrics definitions and
metadata from BSM for this BSM Connector profile, and then forces BSM
Connector to resend all its third-party metrics definitions andmetadata to
BSM.

BSM Integration Main Settings

Business Service
Management
FQDN

Fully qualified domain name or IP address of the BSM gateway server,
load balancer, or reverse proxy (depending on your BSM deployment) to
which you want to connect this BSM Connector.

You can look up the hostname in theDefault Virtual Gateway Server for
Data Collectors URL infrastructure setting:

Admin > Platform > Setup and Maintenance > Infrastructure Settings
> Foundations > Platform Administration > Host Configuration

Note: This field is case-sensitive. If the HP Operations Agent is
already installed and configured, make sure to enter the BSM server
name in exactly the same case as used in the agent configuration.
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UI Element Description

BSM Certificate
Server FQDN

Select theBSM Certificate Server FQDN check box if you want to issue
certificates from a certificate server other than the BSM server specified in
theBusiness Service Management FQDN field (for example from anHP
Operations Manager server or a BSM server from another BSM
deployment). If selected, enter the fully qualified domain name or IP
address of the certificate server.

Clear the check box to issue the certificate from the BSM server.

Note:When accessing BSM through an IIS secure reverse proxy
(SRP), enter the FQDN of the BSM gateway server. For more
information on configuring an IIS reverse proxy for BSM, see the BSM
Hardening Guide.

Business Service
Management user
name

User name of a BSM administrator-level user.

Business Service
Management user
password

Password for the specified user.

Web Server Security Settings

Authentication
user name

User name for theWeb server authentication. Basic authentication and
IDM-SSO.

Note: This is the BSMWeb server, not the BSMConnectorWeb
server.

Authentication
password

Password for the authentication of theWeb server (basic authentication).

Use SSL (HTTPS) Specifies that theWeb server is configured for SSL.

Default value: not selected

Proxy Server Settings

Fully qualified
domain name

If BSM Connector connects to the BSMGateway Server through a proxy,
specify the proxy name or IP address.

User name User name for the proxy.

User password Password associated with the user name above.

BSM Connector Profile

BSMConnector User Guide
Chapter 2: Setup and Configuration

HP Business ServiceManagement (9.23) Page 52 of 521



UI Element Description

BSM Connector
profile to use

BSMConnector profile in which BSM stores the data collected by BSM
Connector.

Click Load available profiles from Business Service Management
to display a list of available empty profiles.

Note: The profile must previously have been configured in BSM's
BSM Connector Integrations page.

Topology Reporting Settings

Topology
resynchronization
time interval
(days)

Number of days for BSM Connector to synchronize topology data with
BSM.

Default value: 7 days

Minimum value: 1 day

Note: All topologies created by BSMConnector and stored in the
RTSM are subjected to the aging process. For more information on
aging, see "Aging of CIs in RTSM" on page 192.

Default routing
domain

Routing domain of the topology probe.

If you specify a new routing domain value, restart BSM Connector for the
change to take effect.

For more information on routing domains, see the Data Flow Management
Guide.

Default value:DefaultDomain

Topology receiver
port

The port at which the BSMGateway Server listens for topology data.

Default value: 80

Topology receiver
SSL port

The SSL port at which the BSMGateway Server listens for topology data.

Default value: 443

Topology anti-
aging offset
(minutes)

Offset frommidnight, in minutes, for running the topology synchronization
process. For more information on aging, see "Aging of CIs in RTSM" on
page 192.

Default value: 0

Example: To run topology synchronization at 1:30 am, enter an offset of
90.
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UI Element Description

Event Reporting Settings

Installed agent
version

Displays the version of the HP Operations Agent that is installed on the
BSMConnector system.

Configure policy
management

Enables the activation of policies and the collection of events through this
BSM Connector.

Policy activation and event collection require secure communication
between BSMConnector and the BSMGateway Server to which it is
sending the event data. BSM Gateway Servers and other HP BTO
Software applications use certificates to identify themselves and
communicate securely with each other.

If this check box is set when defining a new BSMConnector integration, a
certificate request is automatically generated when you save the
integration preferences. Youmust grant the certificate request before the
BSMConnector can be used.

To grant the certificate: 

1. On the BSMConnector page, click Save to save the integration
preferences.

2. Navigate toAdmin > Operations Management > Setup >
Certificate Requests and locate the request.

It may take a few minutes for the certificate request to appear.

3. Grant the corresponding certificate request.

If this check box is cleared when defining a new BSMConnector
integration, no certificate request is generated. The resulting BSM
Connector integration cannot activate policies and therefore cannot collect
any data.

Default value: selected

Troubleshooting and Limitations
This section provides help in troubleshooting problems relating to BSM Connector in general.

This section includes:

l "Tomcat Logging" on the next page

l "Verify That BSM Connector Can Send Events to BSM" on the next page

l "Debug Trace Logging for Events" on the next page
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Tomcat Logging
Tomcat log output is written to the <BSM Connector root dir>\logs\tomcat.log file.

Settings for the log file can be configured from the <BSM Connector root
directory>\Tomcat\common\classes\log4j.properties file.

Verify That BSM Connector Can Send Events to BSM
If Operations Management is enabled in BSM, you can use the following procedure to verify that
BSM Connector events actually arrive in the Operations Management Event Browser.

1. Create an openmessage interface policy. For details, see "OpenMessage Interface Policies"
on page 287.

2. In the Options page of the policy, underUnmatched Events, select are forwarded to BSM
Server. For details, see "Configuring Options in OpenMessage Interface Policies" on page
297.

3. Save the policy and activate it. The activation starts the opcmsgi process on the BSM
Connector server.

4. Use the opcmsg command-line tool to submit messages to the openmessage interface policy.
For details, see "opcmsg Command-Line Tool" on page 288.

5. In BSM, navigate to the Event Browser and verify that the events you submitted using opcmsg
have arrived.

Debug Trace Logging for Events
To enable debug trace logging for an event, add the custom attribute __TRACE__ and set it to any
value. The attribute creates flow trace logs at the INFO level for this event.

The attribute can be set in the Custom Attributes tab of the policy that sends the event. Whenever
this custom attribute is set on an event, trace output for this event appears in the trace logs:

l BSMData Processing Server: log/opr-backend/opr-flowtrace-backend.log

l BSMGateway Server: log/opr-gateway/opr-flowtrace-gateway.log

By default, only events with the custom attribute __TRACE__ set are logged to the flow trace log
files. To enable flow tracing for all events, set the flow trace log level to DEBUG.
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Chapter 3: Security
This section includes:

l "Hardening the BSMConnector Platform" below

l "Permissions and Credentials" on the next page

l "Setting Up Smart Card Authentication" on the next page

l "Configuring BSM Connector to Use SSL" on page 62

Hardening the BSM Connector Platform
This section describes several configuration and setup options that can be used to harden the BSM
Connector platform.

Network and system security has become increasingly important. As a third-party data integration
tool, BSM Connector might have access to some system information which could be used to
compromise system security if steps are not taken to secure it. You should use the configuration
and setup options in this section to protect the BSM Connector platform.

This section includes:

l "BSM Connector Users" below

l "Password Encryption" on the next page

l "Using Secure Socket Layer (SSL) to Access BSMConnector" on the next page

BSM Connector Users
Administrator user. By default, BSM Connector is installed with one administrator user account.
This account is required when adding a BSMConnector integration to BSM. The administrator user
name and password cannot be changed after the BSMConnector installation. The administrator
user can access the BSMConnector user interface only and does not have access to BSM or other
BSM applications.

Local users. You can add additional users to BSM Connector with the command-line tool user.
The tool creates local user accounts in the BSMConnector local user store. These users can
access BSMConnector only; they cannot access BSM or other BSM applications. For more
information about the user tool, see "Local User Configuration Tool" on page 455.

Single sign-on.BSMConnector also supports Single Sign-On (SSO) authentication. The default
single sign-on authentication strategy for BSM is Lightweight Single Sign-On (LW-SSO). LW-SSO
is embedded in BSM and does not require an external computer for authentication.

LW-SSO enables a user to log into BSM once and gain access to all BSM applications without
being prompted to log in again. The applications inside BSM trust the authentication, and you do not
need further authentication whenmoving from one application to another. For example, if you
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configure BSM Connector to use LW-SSO, BSM users can launch the BSMConnector user
interface without having to provide additional credentials.

For more information about LW-SSO, see the BSM Platform Administration Guide.

Password Encryption
BSMConnector passwords for servers accessed remotely are encrypted using amethod called
Triple Data Encryption Standard, or 3DES. 3DES applies the Data Encryption Algorithm on each
64-bit block of text three successive times, using either two or three different keys. As a result,
unauthorized users cannot reproduce the original password in a reasonable amount of time.

Using Secure Socket Layer (SSL) to Access BSM Connector
BSMConnector uses SSL to encrypt communication between the server and the user interface.
This requires installing a certificate from aCertificate Authority (CA). For more information, see
"How to Configure BSM Connector to Use SSL" on page 64.

Permissions and Credentials
The following table provides you with basic information about the permissions needed to secure
access to remote servers to collect data from databases or log files.

Data
Source

Protocol /
Technology

User Permissions and
Credentials Notes

Database JDBC User credentials are needed
to authenticate access to the
particular database. Each
database has a particular
method for providing access
control to the particular tables
that need to be accessed.

The user needs sufficient
permission to execute any specified
SQL statements.

Log File
(Windows)

NetBIOS Windows permissions for
read-only access to log file.

Log File
UNIX/
Linux)

Telnet,
SSH, rlogin

Need shell access to the
remote server. It is also
necessary for the logged-in
user to have permissions to
run specific executable
programs. Read-only file
permissions to the target file
system.

It is possible to restrict logged-in
users’ access by using UNIX group
permissions for the command that
BSM Connector would run. A list of
the relevant commands for a
particular operating system can be
found in the templates.os files.

Setting Up Smart Card Authentication
BSMConnector supports user authentication using smart cards. If smart card authentication is
configured, you cannot log in without a valid smart card.
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Learn More

Smart Card Authentication
Smart cards are physical devices used to identify users in secure systems. These cards can be
used to store certificates both verifying the user's identity and allowing access to secure
environments.

BSM Connector can be configured to use these certificates in place of the standardmodel of each
user manually entering a user name and password. When using smart cards with BSM Connector,
users can only log in using the smart card.

Tasks
This section includes:

l "Configure BSM Connector to Connect to a BSM Server That Requires Smart Card
Authentication" below

l "Enable Smart Card Authentication in BSM Connector" below

l "Disable Smart Card Authentication in BSM Connector" on page 61

Configure BSM Connector to Connect to a BSM Server That Requires
Smart Card Authentication
BSMConnector can be configured to communicate with BSM servers that have enabled smart card
authentication.

1. Configure BSM Connector to connect to a BSM server that requires a client certificate. By
completing this step, you ensure that metrics data is sent and indicator data is received
securely.

For details, see "How to Configure BSM Connector to Connect to a BSM Server That Requires
a Client Certificate" on page 67.

2. Configure BSM Connector to send topology to a BSM server that requires a client certificate.
By completing this step, you ensure that topology data is sent securely.

"How to Configure the Topology Discovery Agent in BSM ConnectorWhen the BSM Server
Requires a Client Certificate" on page 72.

Enable Smart Card Authentication in BSM Connector
To configure smart card authentication in BSM Connector, complete the following tasks:

1. Stop BSMConnector:

Windows: Stop theHP BSM Connector service in theAdministrative Tools > Services.

Linux: Stop the BSMConnector main process, type /opt/HP/BSMConnector/stop.
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2. Configure the BSMConnector Tomcat server to require a client certificate for mutual
authentication:

a. Configure the Tomcat server to request a client certificate by locating the following section
of the <BSM Connector root directory>/Tomcat/conf/server.xml configuration file:

<Connector port="30000" maxThreads="150"
           minSpareThreads="25" maxSpareThreads="75"
           enableLookups="true" disableUploadTimeout="true"
           acceptCount="100" debug="0"
           scheme="https" secure="true" clientAuth="false"
           sslProtocol="TLS"
           keystore="../groups/serverKeystore"
           keystoreType="JKS"
           keystorePass="changeit"/>

Note: The keystore passwordmust be the same as the one set for the BSM
Connector keystore in "How to Configure BSM Connector to Use SSL" on page 64.

Change clientAuth="true", and add the following attributes:

clientAuth="true"
           ...
           truststoreFile="../templates.certificates/truststore.jks"

truststorePass="changeit"
truststoreType="JKS"

 />

b. Import the certificate of your certificate authority to the BSMConnector Tomcat truststore
(<BSM Connector root directory>/templates.certificates/truststore.jks) by running the
command from the <BSM Connector root directory>/java/bin directory:

keytool -import -trustcacerts -alias <your alias> -keystore <BSM
Connector root directory>/templates.certificates/truststore.jks -file
<certificate file>

3. Import the HP Operations Agent certificate to the BSMConnector Tomcat truststore:

a. On the BSM Connector system, use the ovcoreid command-line tool to find out the core
ID:

ovcoreid

b. Export the HP Operations Agent certificate to a file, type:

ovcert -exportcert -file agent_client.p12 -alias <core ID>

c. Import the HP Operations Agent certificate to the Tomcat truststore:
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<BSM Connector root directory>/java/bin/keytool -importkeystore -
srckeystore agent_client.p12 -srcstoretype pkcs12 -srcalias <core ID> -
destkeystore <BSM Connector root
directory>/templates.certificates/truststore.jks -destalias agentcert

4. Modify the following parameters of the Java Virtual Machine:

Windows:

a. Edit the BSM Connector's service key in the registry. Use regedit to open the Registry
Editor.

b. In the Registry Editor, navigate to HKEY_LOCAL_
MACHINE/SYSTEM/CurrentControlSet/Services/<BSM Connector service
name>/serviceParam. The default service name is HP BSM Connector.

c. Modify the serviceParam default and add the following properties, for example at the
beginning of the data string:

-Djavax.net.ssl.keyStore="<full_path_to_keystore.jks>"
-Djavax.net.ssl.keyStorePassword=<keystore_pass>

Example:

-Djavax.net.ssl.keyStore="<BSM Connector root
directory>/templates.certificates/.ks"
-Djavax.net.ssl.keyStorePassword=<keystore_pass>

Linux:

a. Navigate to <BSM Connector root directory>/bin and edit the start-monitor script.

b. In the script, add the following properties to the JAVA_OPTS section:

-Djavax.net.ssl.keyStore=<full_path_to_keystore.jks>
-Djavax.net.ssl.keyStorePassword=<keystore_pass>

Example:

-Djavax.net.ssl.keyStore="<BSM Connector root
directory>/templates.certificates/.ks"
-Djavax.net.ssl.keyStorePassword=<keystore_pass>

5. Start BSM Connector:

Windows: Start theHP BSM Connector service in theAdministrative Tools > Services.

Linux: Start the BSM Connector main process, type /opt/HP/BSMConnector/start.
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6. Add users to BSM Connector using the BSMConnectoruser command line tool:

a. In the Subject Alternative Name (SAN) field of the certificate, look for the value of the User
Principal Name (UPN) in Other Name (OID: 1.3.6.1.4.1.311.20.2.3).

b. Use the user command-line tool to add a user to BSM Connector:

user -add <value of UPN> <password>

Note: The user tool requires a password for each user. However, the password is not
used when logging into BSM connector using a smart card. Users must enter their
smart card PIN instead.

For more information on the user command-line tool, see "Local User Configuration Tool"
on page 455.

Disable Smart Card Authentication in BSM Connector

1. Edit the following section in the <BSM Connector root directory>/Tomcat/conf/server.xml
configuration file:

<Connector port="30000" maxThreads="150"
           minSpareThreads="25" maxSpareThreads="75"
           enableLookups="true" disableUploadTimeout="true"
           acceptCount="100" debug="0"
           scheme="https" secure="true" clientAuth="true"
           sslProtocol="TLS"
           keystore="../groups/serverKeystore"
           keystoreType="JKS"
           keystorePass="changeit"
           truststoreFile="../templates.certificates/truststore.jks"

truststorePass="changeit"
truststoreType="JKS"

/>

2. Change clientAuth="false".

3. Restart BSM Connector:

Windows: Restart theHP BSM Connector service in theAdministrative Tools > Services.

Linux: Restart the BSM Connector main process, type /opt/HP/BSMConnector/stop followed
by /opt/HP/BSMConnector/start.
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Configuring BSM Connector to Use SSL
BSMConnector uses SSL to encrypt communication with the user interface. Because the self-
signed certificate that the BSMConnector uses by default is not from a trusted certificate authority,
you normally see certificate errors in theWeb browser when you connect to BSM Connector.

To secure the connection and prevent the certificate errors, you can obtain a server certificate from
a trusted certificate authority and then import the certificate.

BSM Connector can also be configured to connect to a BSM server that requires SSLwith or
without a client certificate. If the BSM server requires SSL, BSM Connector sends metrics and
topology data in securemode. Event data is always sent securely.

The diagram "Secure Communication Overview " on the next page illustrates the secure
communication channels between the browser-based BSMConnector user interface, the BSM
Connector server, and BSM. The numbers in the diagram correspond to the sections that explain
the configuration required to communicate securely:

(1)"How to Configure BSM Connector to Use SSL" on page 64

(2)"How to Configure BSM Connector to SendMetrics and Topology to a BSM Server Over a
Secure Channel" on page 65

(3)"How to Configure BSM Connector to Connect to a BSM Server That Requires a Client
Certificate" on page 67

(4)"How to Configure the Topology Discovery Agent in BSM ConnectorWhen the BSM Server
Requires a Client Certificate" on page 72
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Secure Communication Overview

Keytool
BSMConnector is shipped withKeytool. Keytool is a key and certificate management utility. It
enables users to administer their own public/private key pairs and associated certificates for
authentication using digital signatures. It also enables users to cache the public keys of other
persons and organizations they communicate with. This is installed in <BSM Connector root
directory>/java/bin.

You can find out more about keytool at the OracleWeb site:

http://docs.oracle.com/javase/7/docs/technotes/tools/windows/keytool.html
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How to Configure BSM Connector to Use SSL
BSMConnector is shipped with a self-signed certificate. Youmust replace the certificate with a
certificate issued by your Certificate Authority (CA) as described below.

1. Obtain a server certificate from your CA issued to the BSMConnector server. Typically this
certificate is issued in PKCS12 format with a password-protected private key.

Note: The following requirements apply:

n The BSM Connector server certificate must be created using a lower-case hostname.

n The private key passwordmust be at least six characters.

2. Change the Tomcat configuration to use the PKCS12 certificate instead of the default self-
signed Java certificate. Locate the following lines in the <BSM Connector root
directory>/Tomcat/conf/server.xml configuration file:

keystore="../groups/serverKeystore" keystoreType="JKS"
keystorePass="changeit"/>

Change them to:

keystore="path to server certificate in PKCS12 format"
   keystoreType="PKCS12"

keystorePass="password for the private key"

Note: The keystore password and the password for the private key must be the same.

3. Restart BSM Connector:

Windows: Restart theHP BSM Connector service in theAdministrative Tools > Services.

Linux: Restart the BSM Connector main process, type /opt/HP/BSMConnector/stop followed
by /opt/HP/BSMConnector/start.

If you cannot obtain a server certificate from aCA in PKCS12 format, manually generate a server
certificate using a Java Keystore (JKS) and have it signed by your CA. See the section "Creating a
Keystore" in the BSM Hardening Guide.
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How to Configure BSM Connector to Send Metrics and
Topology to a BSM Server Over a Secure Channel

This task describes the steps involved in enabling secure communication between BSMConnector
and BSMwhen the BSM server requires SSL. If the BSM server requires SSL, BSM Connector
sends metrics and topology data in securemode. Event data is always sent securely.

1. On the BSMConnector server, establish trust by importing the Certificate Authority (CA) root
certificate of the authority that issued the BSM server certificates for the external access
points (load balancer, reverse proxy, BSMWeb server). Run the following command from the
<BSM Connector root directory>/java/bin directory:

keytool -import -trustcacerts -alias <your alias> -keystore
../lib/security/cacerts -file <root CA certificate file>

2. In BSM, select Admin > Integrations > BSM Connector Integrations, and click theNew
BSM Connector button to add the BSMConnector instance. In the New BSMConnector
page, make sure all of the following settings are configured:

n Main Settings: InHTTP port number specify theHTTPS port number of the BSM
Connector. HTTP port number andHTTPS port numbermust both contain the same
value here. By default, BSM Connector uses the HTTPS port number 30000, but it can be
configured to use a different port number instead.

n BSM Gateway Server Settings:Check that theGateway server name/IP address
contains the correct server name and port (if not the default port 443). If the BSM
environment includes a load balancer, reverse proxy, or BSMWeb server, enter the name of
the external access point .

Note:When you configure BSM Connector in the New BSMConnector page inAdmin
> Integrations > BSM Connector Integrations, add the fully qualified domain name
of the BSM external access point in theGateway server name/IP address field. You
must use the same name as in the BSM server certificate.

n Policy Management Settings:Clear theConfigure policy management check box.

n Profile Settings:Select theWeb Server Use SSL check box. Youmust also select the
Use SSL check box if BSM Connector is configured to use SSL.

3. If the gateway servers are configured to use the Apache HTTP Server: In BSM, select Admin
> Platform > Setup and Maintenance > Infrastructure Settings, click Foundations and
then select Platform Administration.

Make sure all alphabetic characters in the following settings are lower-case:
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n Default Virtual Gateway Server for Application Users URL

n Default Virtual Gateway Server for Data Collectors URL

Note: The BSM server certificate must also have been created using a lower-case host
name.

4. On the computer that runs the BSMConnector, manually connect the HP Operations Agent to
BSM and generate a certificate request:

a. Stop BSM Connector:

Windows: Stop theHP BSM Connector service inAdministrative Tools > Services.

Linux: Stop the BSM Connector main process, type /opt/HP/BSM Connector/stop.

b. Activate the HP Operations Agent manually using one of the following commands:

Windows: Open a command prompt and type:

cd "%ovinstalldir%\bin\win64\OpC\install\"

cscript opcactivate.vbs -srv <BSM gateway server>

Linux:

/opt/OV/bin/OpC/install/opcactivate -srv <BSM gateway server>

c. Start BSM Connector:

Windows: Start theHP BSM Connector service inAdministrative Tools > Services.

Linux: Start the BSM Connector main process, type /opt/HP/BSM Connector/start.

5. Grant the certificate request in BSM: 

a. In BSM, navigate toAdmin > Operations Management > Setup > Certificate
Requests and locate the request.

It may take a few minutes for the certificate request to appear.

b. Grant the corresponding certificate request.
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How to Configure BSM Connector to Connect to a BSM
Server That Requires a Client Certificate

This task describes the steps involved in enabling secure communication between BSMConnector
and BSMwhen the BSM server requires a client certificate. By completing this procedure, you
ensure that metrics data is sent and indicator data is received securely.

1. If you obtained the client certificate in Java keystore (JKS) format, copy it to the <BSM
Connector root directory>/templates.certificates directory, and then continue with "Check
the keystore contents" on page 69.

If the client certificate already exists in PKCS#12 format, convert it to JKS format using the
following command from the <BSM Connector root directory>/java/bin directory, and then
continue with "Check the keystore contents" on page 69:

keytool -importkeystore -srckeystore <keystore with client certificate>.pfx
-destkeystore <BSM Connector root directory>/templates.certificates/.ks
-srcstoretype PKCS12

Example:

keytool -importkeystore -srckeystore c:\client.pfx -destkeystore
C:\BSMConnector\templates.certificates\.ks -srcstoretype PKCS12

Note:

n Make sure the client certificate is issued to an existing BSM user.

n Make sure that the private key password is at least six characters long, and that the
private key and keystore passwords are the same.

n Make sure that the above keystore contains the CA certificate that issued it.

Otherwise, perform the following steps (if you did not obtain the client certificate in JKS or
PKCS#12 format). See also the section "Creating a Keystore" in the BSM Hardening Guide.

a. Create a keystore under <BSM Connector root directory>/templates.certificates by
running the following command from the <BSM Connector root directory>/java/bin
directory:

keytool -genkeypair -keyalg RSA -alias bsmc -keystore <BSM Connector root
directory>/templates.certificates/.ks -storepass <your_keystore_password>

Example:
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keytool -genkeypair -keyalg RSA -alias bsmc -keystore
C:\BSMConnector\templates.certificates\.ks -storepass changeit
What is your first and last name?
[Unknown]: domain.name
What is the name of your organizational unit?
[Unknown]: dept
What is the name of your organization?
[Unknown]: XYZ Ltd
What is the name of your City or Locality?
[Unknown]: New York
What is the name of your State or Province?
[Unknown]: USA
What is the two-letter country code for this unit?
[Unknown]: US
Is CN=domain.name, OU=dept, O=XYZ Ltd, L=New York, ST=USA, C=US
correct?
[no]: yes
Enter key password for <BSM Connector>
Press Enter to use the same password as the keystore password.

b. Create a certificate request for this keystore by running the following command from the
<BSM Connector root directory>/java/bin directory:

keytool -certreq -alias bsmc -file c:\bsmc.csr -keystore <BSM Connector
root directory>\templates.certificates\.ks -storepass <your_keystore_
password>

Example:

keytool -certreq -alias bsmc -file c:\bsmc.csr -keystore
C:\BSMConnector\templates.certificates\.ks -storepass changeit

c. Have your certificate authority sign the certificate request. Copy and paste the contents of
the .csr file into your Certificate Authority Web form.

d. Download the signed client certificate in BASE-64 format to <BSM Connector root
directory>/templates.certificates/clientcert.cer.

e. Download the certificate authority certificate in BASE-64 format to c:\.

f. Import the certificate authority certificate into the JKS keystore by running the following
command:

keytool -import -alias ca -file c:\ca.cer -keystore <BSM Connector root
directory>/templates.certificates/.ks -storepass <your_keystore_password>
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Example:

keytool -import -alias ca -file c:\ca.cer -keystore
C:\BSMConnector\templates.certificates\.ks -storepass changeit
Owner: CN=dept-CA, DC=domain.name
Issuer: CN=dept-CA, DC=domain.name
Serial number: 2c2721eb293d60b4424fe82e37794d2c
Valid from: Tue Jun 17 11:49:31 IDT 2008 until: Mon Jun 17 11:57:06
IDT 2013
Certificate fingerprints:
MD5: 14:59:8F:47:00:E8:10:93:23:1C:C6:22:6F:A6:6C:5B
SHA1: 17:2F:4E:76:83:5F:03:BB:A4:B9:96:D4:80:E3:08:94:8C:D5:4A:D5
Trust this certificate? [no]: yes
Certificate was added to keystore

g. Import the client certificate into the keystore by running the following command:

keytool -import -alias bsmc -file <BSM Connector root
directory>/templates.certificates/certnew.cer -keystore <BSM Connector
root directory>/templates.certificates/.ks -storepass <your_keystore_
password>

Example:

keytool -import -alias bsmc -file
c:\BSMConnector\templates.certificates\certnew.cer -keystore
C:\BSMConnector\templates.certificates\.ks -storepass changeit

The certificate reply is installed in the keystore <BSM Connector root
directory>/java/bin directory.

2. Check the keystore contents

Run the following command from the <BSM Connector root directory>/java/bin directory,
and enter the keystore password:

keytool -list -keystore <BSM Connector root
directory>/templates.certificates/.ks

Example:

keytool -list -keystore C:\BSMConnector\templates.certificates\.ks
Enter keystore password: changeit

Keystore type: jks
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Keystore provider: SUN

Your keystore contains 2 entries

ca, Mar 8, 2012, trustedCertEntry,
Certificate fingerprint (MD5):
14:59:8F:47:00:E8:10:93:23:1C:C6:22:6F:A6:6C:5B
bsmc, Mar 8, 2012, keyEntry,
Certificate fingerprint (MD5):
C7:70:8B:3C:2D:A9:48:EB:24:8A:46:77:B0:A3:42:E1

3. To use this keystore for client certificate, add the following lines to the <BSM Connector root
directory>/groups/master.config file:

_urlClientCert=<keystoreName>
_urlClientCertPassword=<keystorePassword>

Example:

_urlClientCert=.ks
_urlClientCertPassword=changeit

4. Save the changes to the file.

5. Restart the BSM Connector server:

Windows: Restart theHP BSM Connector service in theAdministrative Tools > Services.

Linux: Restart the BSM Connector main process, type /opt/HP/BSMConnector/stop followed
by /opt/HP/BSMConnector/start.

6. In BSM, select Admin > Integrations > BSM Connector Integrations, and click theNew
BSM Connector button to add the BSMConnector instance.

Troubleshooting
If the connection between BSMConnector and BSM fails, check the following log files for errors:

l BSMConnector system:

<BSM Connector root directory>/log/bac_integration.log

l BSM Gateway Server:

<HPBSM root directory>/log/topaz_all.ejb.log

Check for the following error:
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javax.net.ssl.SSLHandshakeException:
sun.security.validator.ValidatorException: PKIX path building failed:
sun.security.provider.certpath.SunCertPathBuilderException: unable to find
valid certification path to requested target

Possible solutions: The error indicates one of the following:

n The CA root certificate was not imported into the BSM JVM.

n The BSM server was not restarted after the import. (A server restart is always required after a
certificate import.)
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How to Configure the Topology Discovery Agent in BSM
Connector When the BSM Server Requires a Client
Certificate

After configuring BSM Connector to connect to the BSMGateway Server using a client certificate
(see "How to Configure BSM Connector to Connect to a BSM Server That Requires a Client
Certificate" on page 67), you need to perform the following steps for discovery to report topology to
the BSM server.

1. Import the Certificate Authority (CA) certificate (or BSM server certificate) into the discovery
truststore (<BSM Connector root
directory>/WEBINF/classes/security/MAMTrustStoreExp.jks) with the password
logomania, which encrypted, is: [22,-8,116,-119,-107,64,49,93,-69,57,-13,-123,-32,-114,-88,-
61]):

keytool -import -alias <your_CA> -file <certificate file> -keystore <BSM
Connector root directory>/WEB-INF/classes/security/MAMTrustStoreExp.jks
-storepass logomania

Example:

keytool -import -alias AMQA_CA -file c:\ca.cer -keystore
C:\BSMConnector\WEB-INF\classes\security\MAMTrustStoreExp.jks -storepass
logomania

Note:

n The default discovery keystore password is logomania. We highly recommend that you
do not change the default password.

n The private key passwordmust be at least six characters, and the password for the
private key and password for the keystoremust be the same.

2. Check the contents of the truststore using the following command:

keytool -list -keystore <BSM Connector root directory>/WEB-
INF/classes/security/MAMTrustStoreExp.jks -storepass logomania

Keystore type: <Keystore_type>
Keystore provider: <Keystore_provider>

Your keystore contains 2 entries

mam, Nov 4, 2004, trustedCertEntry,Certificate fingerprint (MD5):
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<Certificate_fingerprint>
amqa_ca, Dec 30, 2010, trustedCertEntry,Certificate fingerprint (MD5):
<Certificate_fingerprint>

Example:

keytool -list -keystore C:\BSMConnector\WEB-INF\classes\security\
MAMTrustStoreExp.jks -storepass logomania

Keystore type: JKS
Keystore provider: SUN

Your keystore contains 2 entries

mam, Nov 4, 2004, trustedCertEntry,
Certificate fingerprint (MD5):
C6:78:0F:58:32:04:DF:87:5C:8C:60:BC:58:75:6E:F7
amqa_ca, Dec 30, 2010, trustedCertEntry,
Certificate fingerprint (MD5):
5D:47:4B:52:14:66:9A:6A:0A:90:8F:6D:7A:94:76:AB

3. Copy the BSMConnector client keystore (.ks) from <BSM Connector root
directory>/templates.certificates to <BSM Connector root directory>/WEB-
INF/classes/security/.

4. In the ssl.properties file, update the javax.net.ssl.keyStore property to the keystore name.
For example, javax.net.ssl.keyStore=.ks.

5. Change the BSMConnector client keystore password tomatch the discovery keystore
password (logomania).

keytool -storepasswd -new logomania -keystore <BSM Connector root
directory>/WEB-INF/classes/security/.ks -storepass <your_keystore_password>

Example:

keytool -storepasswd -new logomania -keystore C:\BSMConnector\WEB-
INF\classes\security\.ks -storepass changeit

6. Change the private key password tomatch the discovery keystore password:

keytool -keypasswd -alias bsmc -keypass <your_keystore_password> -new
logomania -keystore <BSM Connector root directory>/WEB-
INF/classes/security/.ks -storepass logomania
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Example:

keytool -keypasswd -alias bsmc -keypass changeit -new logomania -keystore
C:\BSMConnector\WEB-INF\classes\security\.ks -storepass logomania

7. Verify keystore using the new password:

keytool -list -v -keystore <BSM Connector root directory>/WEB-
INF/classes/security/.ks -storepass logomania

Example:

keytool -list -v -keystore C:\BSMConnector\WEB-INF\classes\security\.ks
-storepass logomania

8. Restart the BSM Connector server:

Windows: Restart theHP BSM Connector service in theAdministrative Tools > Services.

Linux: Restart the BSM Connector main process, type /opt/HP/BSMConnector/stop followed
by /opt/HP/BSMConnector/start.

9. In BSM, select Admin > Integrations > BSM Connector Integrations, and click theNew
BSM Connector button to add the BSMConnector instance. In theProfile Settings pane,
make sure to select theWeb Server Use SSL checkbox.

Troubleshooting

l Check the bac-integration.log located in <BSM Connector root directory>/logs/bac_
integration/ for the following errors:

2010-12-30 11:03:06,399 [TopologyReporterSender]
(TopologyReporterSender.java:364)
ERROR - failed to run main topology agent. topologyCommand=TopologyCommand
{commandType
=RUN_SCRIPT, …
java.lang.IllegalArgumentException: cannot find script with
name=create_monitor.py at com.mercury.sitescope.integrations
.bac.topology.dependencies.DependenciesCrawler
.findDependencies(DependenciesCrawler.java:60)
at com.mercury.sitescope.integrations.bac.topology.
dependencies.ScriptDependenciesFinder
.find(ScriptDependenciesFinder.java:80)
at com.mercury.sitescope.integrations.bac.topology.
TopologyReporterSender.getDependencies(TopologyReporterSender.java:552)
at com.mercury.sitescope.integrations.bac.topology.
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TopologyReporterSender.send(TopologyReporterSender.java:347)
at com.mercury.sitescope.integrations.bac.topology.
TopologyReporterSender.run(TopologyReporterSender.java:304)
at java.lang.Thread.run(Thread.java:619)

Verify that the certificate and keystore passwords are identical.
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Chapter 4: Event Synchronization
BSMConnector enables you to access event sources, and, if certain conditions apply, to forward
the detected events as HP Business ServiceManagement (BSM) events to BSM. After BSM
receives an event, you can keep it up to date on the event source by configuring BSM and BSM
Connector to synchronize event changes back to the third-party system that generated the original
event. For example, if a BSM Operations Management operator closes an event originating from
NNMi, a notification can be automatically sent to NNMi.

Note: Event changes that are synchronized back only include lifecycle changes to the state
closed (that is, the state is only updated when it changes to closed).

Synchronized events have additional runtime parameters that can be inserted in URL tools. For
more information about URL tools, see the Operations Management online help.

To configure event synchronization:

1. Configure the BSMConnector server as an integration server in BSM:

Admin > Integrations > BSM Connector Integrations

For full details about how to configure a BSMConnector integration server, see the BSM online
help.

Note: Setting up a BSMConnector integration server automatically creates a BSM
Connector connected server in Operations Management.

2. In the BSMConnectorEvent Drilldown Settings, select theEnable event drilldown and
synchronization checkbox.

This checkbox also enables event drilldown, if supported by the connected server. See also
"UI Drilldown" on page 81.

Note:

If you clear theEnable event drilldown and synchronization checkbox, BSM deletes
information about event changes and is therefore not able to update BSM Connector when
the checkbox is selected again. When the checkbox is selected but the BSMConnector
integration server is temporarily unavailable, BSM buffers information about event
changes, and tries to resend them when the server is available again.

3. Configure policies to include the source event ID in the generated event.

For more information, see "How to Configure Policies for Event Synchronization" on page 78.

4. Write a Perl script that receives the event changes from BSM and forwards them to the third-
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party system .

For more information, see "How toWrite Perl Scripts for Event Synchronization" on page 79.
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How to Configure Policies for Event Synchronization
The event that BSM Connector forwards to BSMmust include the original ID of the event in the
third-party system. Otherwise BSM and BSMConnector do not know which event to update in the
third-party system.

To configure policies for event synchronization:

1. Create or edit an event integration policy.

2. Set theSource Event ID attribute in theEvent Attributes tab.

The source event ID attributemay not be available in all event attributes tabs. For example, the
default event attributes of SNMP trap and openmessage interface policy editors do not include
this attribute.

3. Click OK to save the policy and close the editor.

4. Optional. Activate the policy for your changes to take effect.

The next step in configuring event synchronization is to create a Perl script that receives the event
changes and forwards them to the corresponding third-party system. See "How toWrite Perl
Scripts for Event Synchronization" on the next page.
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How to Write Perl Scripts for Event Synchronization
The ombacksync process on the BSMConnector server receives event updates from the BSM data
processing server. To forward these changes to the third-party system, youmust provide the
OMBackSync.pl Perl script that closes the event in the third-party system.

The Perl script must call the subroutine OMBackSync, which supports the following parameters:

l Operation (Init or Close)

l ID (Close only)

When the ombacksync process starts, it processes the Perl script and calls the subroutine
OMBackSyncwith the parameter Init. When the process receives an event with the status closed,
ombacksync calls the subroutine OMBackSyncwith the parameters Close and ID.

The script must be named OMBackSync.pl. Only one instance of the script can exist in BSM
Connector. If multiple integrations are hosted on BSMConnector, all integrations must merge their
event synchronization code into a single OMBackSync.pl file. When uninstalling an integration, the
integrationmust remove its event synchronization code from the file.

BSM Connector provides an example Perl script (OMBackSync.pl) that writes the time, date,
operation, and ID to the file OMBSOutput.txt.

The OMBackSync.pl file is located at:

Windows: "%OvDataDir%\conf\backsync\OMBackSync.pl"

Linux: /var/opt/OV/conf/backsync/OMBackSync.pl

The OMBSOutput.txt file is located at:

Windows: "%OvDataDir%\tmp\OMBSOutput.txt"

Linux: /var/opt/OV/tmp/OMBSOutput.txt

Caution: The OMBackSync.pl script does not encrypt user credentials. If you need to add user
credentials to the script, for example for connecting to an external management tool, use file
system permissions to restrict access to the script.

To forward event changes to the third-party system:

1. Write a Perl script that calls the subroutine OMBackSyncwith the parameters Operation and
ID.

2. Name your Perl script OMBackSync.pl and place it in the following folder on the BSM
Connector server:

Windows: "%OvDataDir%\conf\backsync\OMBackSync.pl"

Linux: /var/opt/OV/conf/backsync/OMBackSync.pl
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3. Restart the ombacksync process on the BSMConnector server:

ovc -restart ombacksync

Troubleshooting:

If the ombacksync process encounters syntax errors in the Perl script, it generates an event
describing the problem and stops. Correct the syntax and restart the ombacksync process.
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Chapter 5: UI Drilldown
BSM enables you to start the user interface of BSM Connector or of the third-party system directly
from within BSM. The following integrations are available:

BSM Connector UI integrations

l BSM Connector integrations page. Navigate toAdmin > Integrations > BSM Connector
Integrations. In the Summary view, locate the BSMConnector you want to launch. Click the
name in the Name column.

l Connected Servers manager. Navigate toAdmin > Operations Management > Setup >
Connected Servers. In the Connected Servers details pane, locate the BSMConnector you

want to launch and click the Launch Policy Management icon.

Alternatively, edit the BSM Connector you want to launch, navigate to the Policy Management

tab, and click the Launch Policy Management icon.

The following illustration shows the Launch Policy Management link in the Connected Servers
manager.

l Event context. In the Operations Management Event Browser, right-click an event that has
been forwarded from a BSMConnector server, and then select Configure > Integration
Policies.

Depending on the security settings in your environment, youmay have to log on or provide a smart
card PIN. If you are prompted for login information, type the user name and password of a local user
account. BSM Connector does not require you to log on if single sign-on is configured.

For details, see "How to Configure Launch of the BSM Connector User Interface" on the next page.

Third-party system UI integration
In the Operations Management Event Browser, right-click an event that has been forwarded from a
BSMConnector server, and then select Show > Event in Source Manager.

UI integrations with third-party systems are not available out of the box. For information how to
configure a UI integration, see "How to Configure Drilldown into Third-Party Systems" on page 83.
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How to Configure Launch of the BSM Connector User
Interface

This task shows you how to configure launch of the BSMConnector user interface from within
BSM.

To configure launch of a BSM Connector server from within BSM:

1. Configure the BSMConnector server as an integration server in BSM:

Admin > Integrations > BSM Connector Integrations

2. InEvent Drilldown Settings, select theEnable event drilldown and synchronization
checkbox.

This checkbox also enables event synchronization, if supported by the connected server. See
also "Event Synchronization" on page 76.

For full details about how to configure a BSMConnector integration server, see the BSM online
help.

Note: Setting up a BSMConnector integration server automatically creates a BSMConnector
connected server in Operations Management.
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How to Configure Drilldown into Third-Party Systems
BSM enables operators to start the user interface of third-party systems in the context of an event
in the Operations Management Event Browser. To launch the third-party system's user interface,
right-click the event in the Operations Management Event Browser and select Show > Event in
Source Manager.

You can configure drilldown in the following ways:

l Add the third-party system to the BSMConnector integration server configuration in BSM.

l Specify source information in the policies that forward the source events to BSM.

If a policy and a BSMConnector server configuration both contain information about the third-party
system, the information in the policy takes precedence.

Tip: Specify the third-party system in the BSMConnector integration server configuration if
you want to centrally configure drilldown to the third-party system, as opposed to adding this
information to individual policies.

This section includes:

l "To specify the third-party system in the BSMConnector Event Drilldown Settings:" below

l "To configure policies for event drilldown:" on the next page

To specify the third-party system in the BSM Connector Event Drilldown
Settings:

1. Configure the BSMConnector server as an integration server in BSM:

Admin > Integrations > BSM Connector Integrations

2. In theEvent Drilldown Settings, complete the following information:

External Event Processing Server. Enter the fully qualified DNS name of the computer that
hosts the third-party system (for example, SCOM.mgmt2.example.com).

Port. Specify the communication port on the third-party system.

URL Path. Specify the root URL of the event in the third-party system. This is the base path of
the URL, and does not include FQDN or port.

To drill down to a specific event in the third-party system, append the variable
${sourcedFrom.externalId} to the URL. BSM replaces the variable at runtime if the event
contains the source event ID.
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Formore information about adding the source event ID to a policy, see "How to Configure
Policies for Event Synchronization" on page 78.

Use SSL. Select to change the communication protocol used by the third-party system.

Enable event drilldown and synchronization. Select to enable drilldown and event
synchronization, if supported by the connected server.

For full details about how to configure a BSMConnector integration server, see the BSM online
help.

Note: Setting up a BSMConnector integration server automatically creates a BSMConnector
connected server in Operations Management.

To configure policies for event drilldown:

1. Create or edit an event integration policy.

2. Find theEvent Drilldown URL attribute in theAdvanced tab.

The event drilldown URL attributemay not be available in all advanced attributes tabs. For
example, the default advanced attributes of SNMP trap and openmessage interface policy
editors do not include this attribute.

3. In theEvent Drilldown URL field, type the URL of the event in the third-party system. This is
the complete path of the URL, and includes the FQDN (Fully Qualified Domain Name) of the
computer that hosts the third-party system, the communication port, and the root URL path.
Example:
http://nnmi.example.com:8004/nnm/launch?cmd=showForm
&objtype=Incident&objuuid=$OPC_CUSTOM[nnm.incident.uuid]
&menus=true

This event attribute can also be set by BSM based on connected server configuration. If a
policy and a connected server configuration both contain event drilldown information, the
information in the policy takes precedence.

4. Click OK to save the policy and close the editor.

5. Activate the policy for your changes to take effect.
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Chapter 6: Remote Servers
This section covers the following topics:

l "Remote Servers Overview" below

This section describes how to set up the connection between BSMConnector andWindows or
UNIX remote servers. BSM Connector accesses remote servers to read log files and to run
discovery scripts.

l "Secure Shell (SSH) Overview" on page 102

This section describes how to configure an SSH connection between BSMConnector and
Windows or UNIX remote servers. The SSH connectionmethod requires installing an SSH
server on each remote server to be connected.

l "UNIX Operating System Adapters" on page 117

This section describes how to use BSMConnector UNIX operating system adapters to extend
BSMConnector to access log files on remote servers that run other versions of UNIX, in
addition to those supported by default. This is done by configuring an adapter file to support the
particular version of UNIX you want to access.

l "Support for Internet Protocol Version 6 " on page 121

This section describes the level to which BSMConnector supports remote servers that have
IPv6 addresses.

Remote Servers Overview
BSMConnector must be able to establish a connection to the servers on which you want to read log
files or run discovery scripts. It must also be authenticated as a user having account permissions to
run command-line tools on the UNIX remotemachine as a remote user.

Microsoft Windows/UNIX Remote server options are used to set up the connection properties,
such as credentials and protocols, so that BSM Connector can access servers in remote
environments. Multiple policies can access the same remote server. You can also createmultiple
remote servers for the same host machine.

Note: If multipleWindows remote servers are configured for the same host machine using the
NetBIOS method, the connection fails. This is becauseWindows does not permit multiple
connections to a server or shared resource by the same user, usingmore than one user name
(System error 1219).

Note: You can use BSM Connector UNIX operating system adapters to extend
BSM Connector to connect to, and remotely access versions of UNIX that are not supported

HP Business ServiceManagement (9.23) Page 85 of 521



by default. For details, see "UNIX Operating System Adapters" on page 117.

How to Configure BSM Connector to Access Remote
Windows Servers

This task describes the steps involved in configuring BSM Connector to access remoteWindows
servers.

1. Windows Server 2008 remote servers only: Disable UAC remote restrictions.

BSM Connector supports accessingMicrosoft Windows Server 2008 remote servers with
User Account Control (UAC) enabled or disabled. Where UAC is enabled, youmust disable
the UAC remote restrictions.

a. Click Start, click Run, type regedit, and then press ENTER.

b. Locate and then click the following registry subkey: HKEY_LOCAL_
MACHINE\SOFTWARE\Microsoft\Windows\
CurrentVersion\Policies\System

c. If the LocalAccountTokenFilterPolicy registry entry does not exist, follow these steps:

o On theEditmenu, select New >DWORDValue.

o Type LocalAccountTokenFilterPolicy, and then press ENTER.

d. Right-click LocalAccountTokenFilterPolicy, and then click Modify.

e. In theValue data box, type 1, and then click OK.

f. Exit Registry Editor.

2. Enable BSM Connector to access remoteWindows servers by performing one of the following
steps:

n Define an individual remoteWindows server connection profile for each server.

Accessing remoteWindows server data requires authenticated access to the remote
server. A Windows server connection profile provides the necessary address and login
credentials for BSM Connector to log on to a remote server and to access theWindows
performance registry on that remotemachine.

To log on to a remote server using the Windows server connection profile, either:

o Log on to the remote server as a user with administrator privileges, or

o Create or modify a user account on the remote server that corresponds with the
connectionmethod and login permissions used in the BSMConnector connection profile
for that server.
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n Set domain access privileges to permit BSM Connector to access remote servers.

BSM Connector forWindows automatically generates a list of servers visible in the local
domain. BSM Connector running onWindows may be able to use this list to access remote
Windows servers without having to create individual connection profiles for each server.

To set domain privileges, use one of the following methods:

o Set the BSM Connector service to run as a user in the Domain Admin group.

By default, BSM Connector is installed to run as a Local System account. You can set
the BSMConnector service to log on as a user with domain administration privileges.
This gives BSM Connector access privileges to access server data within the domain.

To change the user account of the BSM Connector service:

o In Administrative Tools, openServices, and select BSM Connector from the list
of services. The BSMConnector Properties dialog box opens.

o Click the Log On tab, and in the Log on as area, enter an account that can access
the remote servers.

o Click OK to save your settings and close the BSMConnector Properties dialog
box.

o Right-click BSM Connector. Click Stop to stop the BSMConnector service.

o Click Start. The BSMConnector service now uses the new account.

o Add the server where BSM Connector is running to the Domain Admin group in
ActiveDirectory (for Windows 2000 or later).

With this option, the BSMConnector service is set to log on as a Local System
account, but themachine where BSMConnector is running is added to a group having
domain administration privileges.

o Edit the registry access permissions for all machines in the domain to enable
non-admin access.

This option requires changes to the registry on each remotemachine that you want to
access. This means that while the list of servers in the domain includes all machines in
the domain, only those remotemachines whose registry has beenmodified can be
accessed without use of a connection profile.

Note: If you configure the BSMConnector service to run as a domain user, BSM
Connector uses this account for all Windows-related authorization. Youmust ensure
that this account has the necessary privileges across the domain.
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3. Decide whichmethod to use to connect to theWindows remote server. The followingmethods
are available:

n NetBIOS. The default server-to-server communication protocol for Microsoft Windows
networks. While NetBIOS provides ease of connectivity, it does have the disadvantage of
being relatively vulnerable in terms of network security

Note: If multipleWindows remote servers are configured for the same host computer
using the NetBIOS method, the connection fails. This is becauseWindows does not
permit multiple connections to a server or shared resource by the same user, using
more than one user name (System error 1219).

n SSH. Secure Shell, a more secured communication protocol that can be installed on
Microsoft Windows networks. This connectionmethod requires installing an SSH server on
each remote server to be connected.

You can choose between a password-based and a key-based authorizationmethod.

See "Secure Shell (SSH) Overview" on page 102 for more information about the required
SSH setup.

4. Configure theWindows system as a remote server in BSM Connector. For details, see
"Configuring Remote Servers " on the next page.

How to Configure BSM Connector to Access Remote
UNIX Servers

This task describes the steps involved in configuring BSM Connector to access remote UNIX
servers.

To configure access to remote UNIX servers:

1. Define a remote UNIX Server Connection Profiles.

Accessing remote UNIX server data requires authenticated access to the remote server. A
UNIX server connection profile provides the necessary address and login credentials for BSM
Connector to log on to a remote server.

To log on to a remote server using the UNIX server connection profile, do one of the following:

n Log on to the remote server as a user with administrator privileges.

n Create or modify a user account on the remote server that corresponds with the connection
method and login permissions used in the BSMConnector connection profile for that server.

2. Decide whichmethod to use to connect to the UNIX remote server. The followingmethods are
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available:

n rlogin. Logs in to the remote server using the rlogin protocol. You can set up your remote
servers to require a password for rlogin, or to enable access without a password (like rsh).

n SSH. Logs in to the remote server using Secure Shell, a more secured communication
protocol. This may require additional software and setup depending on the version of UNIX.

Using SSH requires that digital certificates be installed on each of the servers to which you
are connecting.

You can choose between a password-based and a key-based authenticationmethod.

See "Secure Shell (SSH) Overview" on page 102 for more information about the required
SSH setup.

n telnet. Logs in to the remote server using Telnet. Telnet is a popular method for connecting
to remote UNIX servers. You can set up your remote servers to require a password for
telnet, or to enable access without a password (like rsh).

3. Configure the UNIX system as a remote server in BSM Connector. For details, see
"Configuring Remote Servers " below.

Configuring Remote Servers
You can use the Remote Servers page to add, edit, or delete remote servers.

Tip: You can createmultiple remote servers for the same host machine.

To access

l Click in the toolbar, then click Event > Log File. In theSource page, click Remote
Servers.

l Click in the toolbar, then click Metrics > Log File. In theSource page, click Remote
Servers.

l Click in the toolbar, then click Topology > Log File. In theSource page, click Remote
Servers.

l Click in the toolbar, then click Topology > Topology-XML. In the Topology page, click
Remote Servers.

Alternatively, click in the toolbar of the BSMConnector user interface.

Tasks

This section includes:
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l "How to set up remoteWindows servers in BSM Connector" below

l "How to set up remote UNIX servers in BSM Connector" on page 92

How to set up remote Windows servers in BSM Connector

1. Make sure BSM Connector is configured to access theWindows remote server. For details,
see "How to Configure BSM Connector to Access RemoteWindows Servers " on page 86.

2. In the Remote Servers dialog box, click in the toolbar, then click New Microsoft Windows
Remote Server.

3. Configure the following information:

Configure remote server details

n Type theName by which the remote server should be known in BSM Connector. Names
must be unique.

n Type aDescription for the remoteWindows server.

n Specify the remoteServer. Choose one of the following:

o IP address or UNC name, for example 192.168.1.2 or \\server1.

o IP host name, for example server1.

An IP host nameworks if the BSM Connector server can translate this common name
into an IP address by using a hosts file, DNS, orWINS/DNS integration. For more
information about IPv6 support, see "Support for Internet Protocol Version 6 " on page
121.

n Select the connectionMethod for accessing the remoteWindows server:

o NetBIOS. The default server-to-server communication protocol for Microsoft Windows
networks. While NetBIOS provides ease of connectivity, it does have the disadvantage
of being relatively vulnerable in terms of network security

Note: If multipleWindows remote servers are configured for the same host
computer using the NetBIOS method, the connection fails. This is because
Windows does not permit multiple connections to a server or shared resource by the
same user, usingmore than one user name (System error 1219).

o SSH. Secure Shell, a more secured communication protocol that can be installed on
Microsoft Windows networks. This connectionmethod requires installing an SSH server
on each remote server to be connected.

You can choose between a password-based and a key-based authorizationmethod.
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See "Secure Shell (SSH) Overview" on page 102 for more information about the required
SSH setup.

n Type theUsername for the remote server.

Note: If the server is within the same domain as the BSMConnector server, include the
domain name in front of the user login name (for example <DOMAIN>\<username>). If
using a local machine login account for machines within or outside the domain, include
themachine name in front of the user login name (for example
<machinename>\<username>).

n Type thePassword for the remote server or thePassphrase for the SSH key file.

n SSH authentication only: Path and name of theSSH Key File that contains the private key
for this connection. The default key file is <BSM Connector root
directory>/groups/identity. This setting applies only when the authenticationmethod
is Key file.

n Select theRemote Server Encoding if the remote server is running an operating system
version that uses a different character encoding than the server on which BSMConnector is
running. This enables BSM Connector to display encoded content correctly.

Default value: Cp1252.

Configure SSH details

n Type theSSH Port Number on which the remote SSH server is listening.

Default value: 22

n Specify theConnection Limit, that is the number of open connections that BSM Connector
permits for this remote server. If there aremany policies configured to use this connection,
set the number of open connections high enough to relieve a potential bottleneck.

Default value: 3

n Select Disable connection cache to turn off connection caching for this remote server. By
default, BSM Connector caches open connections.

Default value: Not selected

n Select SSH version 2 only to force BSMConnector to use SSH protocol version 2 only.

Default value: Not selected

n Select SSH keep alive mechanism to engages a keep alivemechanism for SSH version 2
sessions. This option applies only when using the integrated Java Client.

Default value: Not selected
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4. Click Save... to save the remote server configuration.

5. Optional: Test the connection to the remote server. Select the remote server that you want to
test and click .

How to set up remote UNIX servers in BSM Connector

1. In the Remote Servers dialog box, click in the toolbar, then click New UNIX Remote
Server.

2. Configure the following information:

Configure remote server details

n Type theName by which the remote server should be known in BSM Connector. Names
must be unique.

n Type aDescription for the remote UNIX server.

n Specify the remoteServer. Choose one of the following:

o IP address, for example 192.168.1.2.

o IP host name, for example server1.

An IP host nameworks if the BSM Connector server can translate this common name
into an IP address by using a hosts file or DNS.

n Select theOperating System that is running on a remote server. This is required so that the
correct information can be obtained from that server. Select an operating system from the
list.

The following operating systems are supported when defining Remote Unix servers: AIX,
CentOS Linux, FreeBSD, HP-UX, HP/UX, HP/UX64-bit, Linux, MacOSX, NonStopOS,
OPENSERVER, Red Hat Enterprise Linux, SCO, SGI Irix, Solaris Zones, Sun Solaris,
SunOS, Tru64 5.x, Tru64 Pre 4.x (Digital), and Ubuntu Linux.

For servers running versions of UNIX that are not included in the list, see "UNIX Operating
System Adapters" on page 117.

n Select the connectionMethod for accessing the remote UNIX server:

o rlogin. Logs in to the remote server using the rlogin protocol. You can set up your remote
servers to require a password for rlogin, or to enable access without a password (like
rsh).

o SSH. Logs in to the remote server using Secure Shell, a more secured communication
protocol. This may require additional software and setup depending on the version of
UNIX.
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Using SSH requires that digital certificates be installed on each of the servers to which
you are connecting.

You can choose between a password-based and a key-based authenticationmethod.

See "Secure Shell (SSH) Overview" on page 102 for more information about the required
SSH setup.

o telnet. Logs in to the remote server using Telnet. Telnet is a popular method for
connecting to remote UNIX servers. You can set up your remote servers to require a
password for telnet, or to enable access without a password (like rsh).

n Type theUsername for the remote server.

Note: If the server is within the same domain as the BSMConnector server, include the
domain name in front of the user login name (for example <DOMAIN>\<username>). If
using a local machine login account for machines within or outside the domain, include
themachine name in front of the user login name (for example
<machinename>\<username>).

n Type thePassword for the remote server or thePassphrase for the SSH key file.

n SSH authentication only: Path and name of theSSH Key file that contains the private key
for this connection. The default key file is <BSM Connector root
directory>\groups\identity. This setting applies only when the authenticationmethod
is Key file.

n Select theRemote Server Encoding if the remote server is running an operating system
version that uses a different character encoding than the server on which BSMConnector is
running. This enables BSM Connector to display encoded content correctly.

Configure UNIX shell details

n Specify thePrompt output that the remote system sends when it is ready to handle a
command (for example, >)

n Specify the Login Prompt output that the remote system sends when it is waiting for the
login to be entered (for example, User name:).

n Specify thePassword Prompt output that the system sends when it is waiting for the
password to be entered (for example, Password:).

n Specify theSecondary Prompt that the system sends if the telnet connection to the
remote server causes the remote server to prompt for more information about the
connection. Separatemultiple prompt string by commas (,).

Example: For Telnet connections to some remote servers, the remote server may ask what
terminal type should be emulated for the connection. In this case, enter Terminal type? as
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the secondary prompt. The response to the secondary prompt is entered in theSecondary
Response box below.

n Specify theSecondary Response to any secondary prompts required to establish
connections with this remote server. Separatemultiple responses with commas (,).

n In Initialize Shell Environment, type the Shell commands to be run at the beginning of the
session. Separatemultiple commands with a semicolon (;). This option specifies shell
commands to be run on the remote computer directly after a Telnet or SSH session has
been initiated. These commands can be used to customize the shell for each BSM
Connector remote server. Some examples include:

o The remote shell may not have the correct path set for BSM Connector scripts to run.
The following command adds the directory /usr/local/bin into the PATH of the current
shell on the remotemachine: export PATH=$PATH:/usr/local/sbin

o The remote shell may not be initializing the pseudo terminal correctly. Enter the following
command to increase the terminal width to 1024 characters: stty cols 1024;${SHELL}

Note: Commands after a shell invocation are not run.

o There have been cases where the remote Telnet Server does not echo back the
command properly. This may cause strange behavior for policies that rely on this
behavior. Enter the following command to force the remote terminal to echo: stty
echo

o Certain UNIX shells have been known to behave erratically with BSM Connector.
This includes bash, ksh, and csh. Enter the following command to change the shell
to sh for the BSMConnector connection: /bin/sh

n NonStopOS only: Specify Shell Choice Prompt output that the system sends when it is
waiting for the shell to be selected.

Default value: >

n NonStopOS only: Specify theShell Name to be executed.

Default value: OSS

Configure SSH details

n Type theSSH Port Number on which the remote SSH server is listening.

Default value: 22

n Specify theConnection Limit, that is the number of open connections that BSM Connector
permits for this remote server. If there aremany policies configured to use this connection,
set the number of open connections high enough to relieve a potential bottleneck.
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Default value: 3

n Select Disable connection cache to turn off connection caching for this remote server. By
default, BSM Connector caches open connections.

Default value: Not selected

n Select SSH version 2 only to force BSMConnector to use SSH protocol version 2 only.

Default value: Not selected

n Select SSH keep alive mechanism to engages a keep alivemechanism for SSH version 2
sessions. This option applies only when using the integrated Java Client.

Default value: Not selected

3. Click Save... to save the remote server configuration.

4. Optional: Test the connection to the remote server. Select the remote server that you want to
test and click .

Related tasks

l "How to Collect Event Data from Log Files" on page 237

l "How to Collect Metrics Data from Log Files" on page 238

l "How to Collect Topology Data from Log Files" on page 239

l "How to Configure Local Topology Synchronization" on page 339

l "How to Configure RemoteWindows Servers for SSH Access" on page 103

l "How to Configure Remote UNIX Servers for SSH Access" on page 112

l "How to Add an Adapter" on page 118

UI Descriptions

This section includes:

l "Remote Servers List" on the next page

l "Remote Server Configuration" on the next page

l "Unix Shell Details" on page 100

l "SSH Details" on page 102
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Remote Servers List

UI Element Description

Refresh Remote Server List. Updates the list of remote servers.

New Microsoft Windows/UNIX Remote Server. Opens the New Remote
Server Configuration dialog box enabling you to configure a remote server and add
it to the list.

Edit Remote Server. Enables you to edit the properties of the selected remote
server.

Delete Remote Server. Deletes the selected server from the list.

Test Remote Server Configuration. Tests the connection to the selected
remote server. The test results are displayed in a popup window.

Name Name by which the remote server is known in BSM Connector.

Server IP address or name of the remote server. You can create two remote servers with
the same host name.

Type Type of remote server: Windows or UNIX.

Description Description for the remote server.

Remote Server Configuration

UI Element Description

Name Name by which the remote server is known in BSM Connector.

Description Description for the remote server.
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UI Element Description

Server Windows remote servers:

l Real IP address or UNC name of theWindows server.

l An IP host name also works if the BSM Connector server can translate this
common name into an IP address by using a hosts file, DNS, orWINS/DNS
integration.

l When specifying a literal IPv6 address as the name for the remote server when
using the NetBIOS connectionmethod, youmust customize the IPv6 address.

a. Replace any colon (":") characters with a dash ("-") character.

b. Append the text .ipv6-literal.net to the IP address.

For example, the IPv6 address: 2004:DB8:2a:1005:230:48ff:fe73:982d
would be: 2004-DB8-2a-1005-230-48ff-fe73-982d.ipv6-literal.net

l You can createmultiple remote servers for the same host machine. For
example, you can create one remote server that uses the NetBIOS protocol
and another that uses SSH for the same host machine, provided the name is
unique.

l To use the same login credentials to configuremultiple servers at the same
time, enter the server names or addresses separated by a comma (","),
semicolon (";"), or a space. For example, \\server1,\\server2,\\.

UNIX remote servers:

l Real IP address or host name of the UNIX server.

l An IP host nameworks if the BSM Connector server can translate this
common name into an IP address by using a hosts file or DNS.

l You can createmultiple remote servers for the same host machine. For
example, you can create one remote server that uses the Telnet protocol and
another that uses SSH for the same host machine, provided the name is
unique.

l To use the same login credentials to configuremultiple servers at the same
time, enter the server names or addresses separated by a comma (","),
semicolon (";"), or a space. For example, server1, server2.

Note:

l Network address translation (NAT) is not supported for BSM Connector
policies that require a remote host definition.
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UI Element Description

BSMConnector is unable to determine if an external (real IP) or internal IP
(NAT) is used when you configure a log file policy with an IP address or
host. To access servers in a NAT environment, we recommend placing
BSMConnector inside the firewall.

l By default, BSM Connector connects to remote servers using IPv4
addresses. If you want your environment to resolve host names to IPv6,
configure BSM Connector to prefer IPv6 addresses, specify the hostname
in the Server field, andmake sure that the host name resolves to both an
IPv4 and an IPv6 address. For more information about IPv6 support, see
"Support for Internet Protocol Version 6 " on page 121.

Operating
System

UNIX remote servers only.

Operating system that is running on a remote server. This is required so that the
correct information can be obtained from that server. Select an operating system
from the list.

The following operating systems are supported when defining Remote Unix
servers: AIX, CentOS Linux, FreeBSD, HP-UX, HP/UX, HP/UX64-bit, Linux,
MacOSX, NonStopOS, OPENSERVER, Red Hat Enterprise Linux, SCO, SGI
Irix, Solaris Zones, Sun Solaris, SunOS, Tru64 5.x, Tru64 Pre 4.x (Digital), and
Ubuntu Linux.

For servers running versions of UNIX that are not included in the list, see "UNIX
Operating System Adapters" on page 117.

BSM Connector User Guide
Chapter 6: Remote Servers

HP Business ServiceManagement (9.23) Page 98 of 521



UI Element Description

Method Connection types for accessing Windows remote servers:

l NetBIOS. The default server-to-server communication protocol for Microsoft
Windows networks. While NetBIOS provides ease of connectivity, it does
have the disadvantage of being relatively vulnerable in terms of network
security

Note: If multipleWindows remote servers are configured for the same
host computer using the NetBIOS method, the connection fails. This is
becauseWindows does not permit multiple connections to a server or
shared resource by the same user, usingmore than one user name
(System error 1219).

l SSH. Secure Shell, a more secured communication protocol that can be
installed onMicrosoft Windows networks. This connectionmethod requires
installing an SSH server on each remote server to be connected.

You can choose between a password-based and a key-based authorization
method.

See "Secure Shell (SSH) Overview" on page 102 for more information about
the required SSH setup.

Connection types for accessing UNIX remote servers:

l rlogin. Logs in to the remote server using the rlogin protocol. You can set up
your remote servers to require a password for rlogin, or to enable access
without a password (like rsh).

l SSH. Logs in to the remote server using Secure Shell, a more secured
communication protocol. This may require additional software and setup
depending on the version of UNIX.

Using SSH requires that digital certificates be installed on each of the servers
to which you are connecting.

You can choose between a password-based and a key-based authentication
method.

See "Secure Shell (SSH) Overview" on page 102 for more information about
the required SSH setup.

l telnet. Logs in to the remote server using Telnet. Telnet is a popular method for
connecting to remote UNIX servers. You can set up your remote servers to
require a password for telnet, or to enable access without a password (like
rsh).
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UI Element Description

Username User name for the remote server.

Note: (ForWindows only) If the server is within the same domain as the BSM
Connector server, include the domain name in front of the user login name.
For example: <DOMAIN>\<username>. If using a local machine login account
for machines within or outside the domain, include themachine name in front
of the user login name. For example: <machinename>\<username>.

Password

Passphrase

Password for the remote server or the passphrase for the SSH key file.

SSH Key
File

Path and name of theSSH Key file that contains the private key for this
connection. The default key file is <BSM Connector root
directory>\groups\identity. This setting applies only when the authentication
method is Key file.

Remote
Server
Encoding

Encoding for the remote server, if the remote server is running an operating
system version that uses a different character encoding than the server on which
BSMConnector is running. This enables BSM Connector to display encoded
content correctly.

Default value:UTF-8

Unix Shell Details

UI Element Description

Prompt Prompt output when the remote system is ready to handle a command.

Login
Prompt

Prompt output when the system is waiting for the login to be entered.

Password
Prompt

Prompt output when the system is waiting for the password to be entered.

Secondary
Prompt

Secondary prompts if the telnet connection to the remote server causes the
remote server to prompt for more information about the connection. Separate
multiple prompt string by commas (,).

Example: For Telnet connections to some remote servers, the remote server
may ask what terminal type should be emulated for the connection. In this case,
enter Terminal type? as the secondary prompt. The response to the secondary
prompt is entered in theSecondary Response box below.

Secondary
Response

Responses to any secondary prompts required to establish connections with
this remote server. Separatemultiple responses with commas (,).
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UI Element Description

Mask
secondary
response
input field

Hides the secondary response behind asterisks. If you subsequently clear the
check box, the hidden data is deleted.

Default value:Not selected

Initialize
Shell
Environment

Shell commands to be run at the beginning of the session. Separatemultiple
commands with a semicolon (;). This option specifies shell commands to be run
on the remotemachine directly after a Telnet or SSH session has been initiated.
These commands can be used to customize the shell for each BSMConnector
remote. Some examples include:

l The remote shell may not have the correct path set for BSM Connector
scripts to run. The following command adds the directory /usr/local/bin into
the PATH of the current shell on the remotemachine: export
PATH=$PATH:/usr/local/sbin

l The remote shell may not be initializing the pseudo terminal correctly. Enter
the following command to increase the terminal width to 1024 characters:
stty cols 1024;${SHELL}

Note:Commands after a shell invocation are not run.

l There have been cases where the remote Telnet Server does not echo back
the command properly. This may cause strange behavior for policies that rely
on this behavior. Enter the following command to force the remote terminal to
echo: stty echo

l Certain UNIX shells have been known to behave erratically with BSM
Connector. This includes bash, ksh, and csh. Enter the following command
to change the shell to sh for the BSMConnector connection: /bin/sh

HP NonStop Shell Settings

Shell Choice
Prompt

(For NonStopOS only) Prompt output when the system is waiting for the shell to
be selected.

Default value: >

Shell Name (For NonStopOS only) Shell name to be executed.

Default value:OSS
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SSH Details

UI Element Description

SSH Port
Number

Port on which the remote SSH server is listening.

Default value: 22

Connection
Limit

Number of open connections that BSM Connector permits for this remote. If there
aremany policies configured to use this connection, set the number of open
connections high enough to relieve a potential bottleneck.

Default value: 3

Note: This setting does not effect running tests for a remote server. Tests always
create a new connection.

Disable
connection
cache

Turns off connection caching for this remote. By default, BSM Connector caches
open connections.

Default value:Not selected

SSH
version 2
only

Forces BSMConnector to use SSH protocol version 2 only.

Default value:Not selected

SSH keep
alive
mechanism

Engages a keep alivemechanism for SSH version 2 sessions. This option applies
only when using the integrated Java Client.

Default value:Not selected

Secure Shell (SSH) Overview
You can use Secure Shell (SSH) to connect to a server and automatically send a command, so that
the server runs that command and then disconnects. This is useful for creating automated
processing and scripting.

Secure Shell (SSH), sometimes known as Secure Socket Shell, is a UNIX-based command
interface and protocol for securely accessing a remote computer. It is widely used by network
administrators to remotely control Web and other kinds of servers. SSH commands are encrypted
and secure in several ways. Both ends of the client/server connection are authenticated using a
digital certificate, and passwords are protected by encryption. Secure Shell client machines make
requests of SSH daemons or servers on remotemachines.

Accessing remote servers over SSH has the following basic requirements:

l The servers that you want to access with BSM Connector using SSH must have an SSH
daemon (or server) installed and active. For details, see "How to Configure RemoteWindows
Servers for SSH Access" on the next page and "How to Configure Remote UNIX Servers for
SSH Access" on page 112.

l The BSMConnector integrated Java SSH client. BSM Connector includes a SSH client written
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in Java and native to the BSMConnector application code. For details, see:

"How to Configure the BSMConnector SSH Client" on page 113

It is recommended to use SSH version 2 (SSH2) for all SSH connections.

How to Configure Remote Windows Servers for SSH
Access

This task describes the steps involved in configuring remoteWindows servers for SSH access.

The servers that you want to access with BSM Connector using SSH must have an SSH daemon
(or server) installed and active. HP has tested and recommends Cygwin OpenSSH andOpenSSH
forWindows. HP has also tested SSH Server from F-Secure.

The following is a comparison overview of the OpenSSH packages:

OpenSSH
Package Advantages Disadvantages Comments

Cygwin
OpenSSH

Provides access to
eitherWindows or
UNIX-style scripting on
aWindows machine.

Provides access to
UNIX-style system
tools and utilities.

BSM Connector can
access the remote
server both as a
Windows Remote and
/or a UNIX Remote.

Complicated
setup procedure.

Available at
http://www.cygwin.com/.

OpenSSH
for
Windows

Simple setup procedure. Only provides
access to
Windows
commands,
scripts, and
utilities.

Formerly Network Simplicity
"OpenSSH onWindows".

Available at
http://sshwindows.sourceforge.net/
.

Note:

l OpenSSH forWindows and the Cygwin SSH implementations are incompatible with each
other. They should not be installed on the samemachine.

l If there is more than one version of the Cygwin utilities or more than one SSH server
installed on amachine, theremay be conflicts that prevent the SSH connections from
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working. An error message such as could not find entry point is one indication of this kind of
conflict. If you suspect this error, search themachine for multiple copies of cygwin1.dll. It
may be necessary to remove all versions of the utilities and then reinstall only a single
installation to resolve this problem.

To configure SSH for secure connections:

1. Install and configure an SSH server on each remote server to which you want BSM Connector
to connect. For details, see "Install Cygwin OpenSSH onWindows " below and "Install
OpenSSH forWindows" on page 109.

2. To run discovery scripts on a remoteWindows server: Install the BSM Connector remote
Windows SSH files.

If you want to run discovery scripts on a remoteWindows server, youmust install the BSM
Connector remoteWindows SSH files on theWindows server. For details, see "Install BSM
Connector RemoteWindows SSH Files" on page 111.

3. Configure the SSH client to connect to the remote servers

After you have set up SSH servers or daemons on remote servers, youmust configure the
integrated Java SSH client that BSM Connector uses to connect to the remote servers. For
task details, see "How to Configure the BSMConnector SSH Client" on page 113.

4. If not already done, configure theWindows remote server to use the SSH connectionmethod.

After confirming SSH connectivity between BSMConnector and the remote server, set up
Windows remote server settings in BSM Connector by selectingSSH as the connection
method.

For details, see "Configuring Remote Servers " on page 89.

Install Cygwin OpenSSH on Windows

This task describes the steps involved in installing and configuring a Cygwin OpenSSH server on
Windows servers.

Note:

l The following instructions assume that no other Cygwin or other SSH utilities are installed
on themachine and that themachine has Internet access.

l The user login account used to install and run the SSH daemon needs adequate
permissions to install the necessary programs, configure several file options, and control
Windows services. It does not need to be the account that BSM Connector uses to connect
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to the subject server, although that account must be configured within the Cygwin
installation before you can access that server with BSM Connector.

Supported versions

Cygwin 1.7.x (the latest certified Cygwin version is 1.7.7)

To install and configure a Cygwin OpenSSH server on Windows servers:

1. Create a new System Environment variable with the following definition: CYGWIN = ntsec
tty.

2. Add the string ;C:\cygwin\bin to your PATH variable. Save the changes to the variables.

3. Download the Cygwin setup program into a temporary folder. For example: C:\temp. The setup
program is used to select, download, and install different packages and components available
with Cygwin.

4. Run the downloaded setup program and choose the Install from Internet option when
prompted to Choose A Download Source. Click Next to continue.

5. If prompted, select a root install directory where the Cygwin package should be installed. This
is where the SSH daemon and related files are installed. For example, C:\cygwin. Click Next
to continue.

6. If prompted, select a temporary directory where the Cygwin installation files should be stored.
For example, C:\temp. Click Next to continue.

7. If prompted, select an Internet Connection option. Normally, you can useDirect Connection.
Click Next to continue.

8. Select a suitable mirror site from which to retrieve the files using the selection list when
prompted. Click Next to continue.

9. The Setup program queries themirror site for the packages available and displays a hierarchy
tree of package categories. To view and select the packages to download, click on the plus (+)
symbol to the left of the category name to expand any of the package trees. Packages that are
selected for download and installation display a version number in theNew column. If a version
number is not displayed for a particular package, it is not downloaded and installed. Click Skip
to the left of package name to select the package for download.

Note: Many of the development (Devel) and database (Database) tools that may be
selected by default for download are not necessary to run the SSH daemon and can be
deselected to reduce download time and installation space.

Select each of the following packages for download and installation:
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n cygrunsrv from the Admin branch

n cygwin-doc from the Doc branch

n pdksh from the Shells branch

n openssh and openssl from the Net branch

n your choice of UNIX-style text editor from the Editors branch (for example: vim or emacs)

Then click to download the files as prompted.

10. Depending on your installation options, the Cygwin setup downloads and installs the selected
packages. Youmay be prompted to choose to have a shortcut to the Cygwin terminal window
added to the Desktop or Program Start menu. Click to continue and complete the installation.

11. After the Cygwin setup is complete, open a Cygwin terminal window by clicking on the Cygwin
desktop shortcut or Program Start menu item.

Note: Depending on the user profile in theWindows system, the default directory that
opens in the terminal window may not be within the root Cygwin installation tree. Use the
pwd command to display the current directory. Typing in the command string cd /
normally changes the directory to the Cygwin root, which by default corresponds to the
Windows C:\cygwin directory.

Update the default Cygwin group file with the group names in use on themachine and on your
network. Use themkgroup utility to update the default Cygwin group file with the groups
defined on the server and in your domain. Examples of the commands to use are as follows:

mkgroup -l >> ../etc/group mkgroup -d >> ../etc/group

Note:

n To have Cygwin recognize both domain and local group accounts, run themkgroup
utility twice, once for local users (-l option) and once for domain users (-d option).
Remember to use >> syntax and not just >, to append entries to the file.

n If you use both the local and domain options, youmust manually edit the /etc/group
file (using the UNIX style text editor you downloaded) to remove any duplicate group
entries. Youmay also want to remove group entries that should not have access to this
machine.

Update the default Cygwin user (passwd) file with the users defined on the local machine plus
any individual domain users you want to grant access to Cygwin on this machine. Use the
mkpasswd utility to update the default Cygwin user file.

Examples of the commands to use are as follows:
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mkpasswd -l >> ..\etc\passwd mkpasswd -d -u username >> ..\etc\passwd (domain
users)

Note:

n By default, Cygwin is set to run the OpenSSH daemon as the local user called SYSTEM.
To have Cygwin recognize both domain and local machine user accounts, run the
mkpasswd using the -l option to add all local users, and run it with the -d and -u
options to add individual domain users. Remember to use >> syntax and not just >, to
append entries to the file.

n If you use both the local and domain options, youmust manually edit the /etc/passwd
file (using the UNIX style text editor you downloaded) to remove any duplicate user
entries. Youmay also change the default /home path and default shell for individual
users. This may be necessary to install the RemoteNTSSH package in the
/home/sitescopeaccount/ directory of the user account to be used by BSM
Connector.

12. Change the active directory to the /bin directory by typing cd /bin.

13. Create a symbolic link in the /bin directory that points to theWindows Command (CMD) shell
by entering the following command line (be sure to include the trailing space and period):

ln -s /cygdrive/c/winnt/system32/cmd.exe .

14. We recommend that you change permissions and ownership of several Cygwin files and
directories. Also create a log file for the SSH daemon. Enter the following command lines in the
Cygwin terminal command line and press ENTER after each command line entered:

cd /
chmod -R og-w .
chmod og+w /tmp
touch /var/log/sshd.log

Note:

n Exact syntax is required, including spaces.

n Inconsistent and incorrectly assigned file and directory permissions can be one reason
that the SSH daemon can not be started or that BSM Connector is unable to connect to
and run commands or scripts on the remote server.

15. Configure the SSH daemon to run as aWindows service by entering the following command:

ssh-host-config -y
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When presented with the CYGWIN= prompt, type ntsec tty to match the environment variable
you set at the beginning of this procedure. Normally, this configures the SSH daemon or
service to restart automatically if the server needs to be restarted.

16. Configure the encryption keys and files for the SSH daemon using the following command:

ssh-user-config -y.

Enter required passphrases for several keystore files when prompted. The program asks you to
re-enter the passphrase for confirmation.

17. Youmust change the ownership of several files and folders for use by the SSH daemon. The
program does not normally run if the permissions on these files enable them to be changed or
run by group or "world" level users. Enter the following command strings to restrict access to
these files:

chown SYSTEM:Users /var/log/sshd.log /var/empty /etc/ssh_h*
chmod 755 /var/empty

18. Check the installation by starting and then stopping the CYGWIN sshd service using the
Programs > Administrative Tools > Services panel.

Note: Cygwin includes a server utility to start the SSH daemon. However, there have
been a number of situations where this method failed to start the server, whereas using the
Windows Services panel was able to start the server.

19. Configure the default shell or command environment for the user account you use for
accessing the remotemachine with BSM Connector. The shell you select effects what types
of scripts or commands can be run remotely using the SSH connection. Use the UNIX-style
text editor and edit the /etc/passwd file. Find the entry for the BSMConnector login account
you intend to use and change the shell from /bin/bash to the shell you want to use as
described below. This is normally the last entry in the line for that account entry.

n If you chose to have BSMConnector interact with the remote server using theWindows
Command shell, change the default shell entry to /bin/cmd.Use this option when you plan
to useWindows-style batch files and scripts Youmust also include the symbolic link to the
Windows cmd.exe kernel in the /bin directory as described in a previous step of this
procedure.

n If you chose to have BSMConnector interact with the remoteWindows server using a
Cygwin UNIX shell, change the default shell entry to be /bin/pdksh. The BSMConnector
SSH client may not accurately parse Cygwin's default bash shell. Youmust also configure a
Remote UNIX server connection to this (Windows) server that connects to the Cygwin SSH
daemon.

Save the changes to the file.

20. Edit the PATH and the default prompt commands in the /etc/profile file to make sure that
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Cygwin can find certain files and that BSM Connector can parse the output from the remote
shell. Use the UNIX-style text editor and edit the /etc/profile file. Find the PATH definition
entry near the top of the file. For example:

PATH=/usr/local/bin:/usr/bin:/bin:$PATH

Change this to include the following:

PATH=.:/usr/local/bin:/usr/bin:/bin:$PATH

21. To change the default prompt commands, edit the /etc/profile file, and find the section
similar to the following:

;;
sh | -sh | */sh |\
sh.exe | -sh.exe | */sh.exe )
#Set a simple prompt
PS1='$ '
;;

Immediately under this entry, add the following:

;;
pdksh | -pdksh | */pdksh |\
pdksh.exe | -pdksh.exe | */pdksh.exe )
#Set a simple prompt
PS1='> '
;;

22. Save the changes to the file.

23. Change the active directory to the home directory of the user you have created for BSM
Connector.

After making these changes and starting the SSH daemon, you should be able to connect to
the server using an SSH client.

Note: Any time you run the mkpasswd -l /etc/passwd command (for example, when
adding a new user), edit the /etc/passwd file again tomake sure that the default shell for
that user is set to the required value for any account being used by BSMConnector.

Install OpenSSH for Windows

This task describes the steps involved in installing and configuring anOpenSSH server on
Windows servers.

TheOpenSSH forWindows package is an alternative to the Cygwin SSH package and can be
easier to install. Likemost products, the Cygwin product and the Open SSH forWindows are
subject to change. There are cases where some versions of the Cygwin SSH server have not
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returned the data needed by BSMConnector. If the OpenSSH forWindows package can solve this
problem, use this package in place of the Cygwin package.

To install and configure an OpenSSH for Windows server on Windows servers:

1. Download and install the OpenSSH forWindows package.

2. Open a command prompt and change to the installation directory (C:\Program
Files\OpenSSH is the default installation path).

3. Change the active directory to the OpenSSH\bin directory.

4. Youmust update the default group file with the group names in use on themachine and in your
network. Use the mkgroup utility to update the default OpenSSH group file with the groups
defined on the server and in your domain. Examples of the commands to use are as follows:

mkgroup -l >> ..\etc\group mkgroup -d >> ..\etc\group

Note:

n To haveOpenSSH recognize both domain and local group accounts, run themkgroup
utility twice, once for local users (-l option) and once for domain users (-d option).
Remember to use >> syntax and not just >, to append entries to the file.

n If you use both the local and domain options, youmust manually edit the /etc/group
file (using the UNIX style text editor you downloaded) to remove any duplicate group
entries. Youmay also want to remove group entries that are not needed or should not
have access to this machine.

5. Youmust update the default OpenSSH user (passwd) file with the users defined on the local
machine plus any domain user you want to grant access to the SSH server on this machine.
Use themkpasswd utility to update the default user file. Examples of the commands to use
are as follows:

mkpasswd -l >> ..\etc\passwd
mkpasswd -d -u username >> ..\etc\passwd

Note:

n To haveOpenSSH recognize both domain and local machine user accounts, run the
mkpasswd utility using the -l option to add all local users and run it with the -d and -u
options to add individual domain users. Remember to use >> syntax and not just >, to
append entries to the file.

n If you use both the local and domain options, youmust manually edit the /etc/passwd
file (using the UNIX style text editor you downloaded) to remove any duplicate user
entries. Youmay also change the default /home path and shell for individual users (see
instructions below).
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6. Check the installation by starting theOpenSSH Server service using thePrograms >
Administrative Tools > Services panel.

Install BSM Connector Remote Windows SSH Files

This task is only required if you want to run scripts on a remoteWindows server. For example,
topology-XML policies can run scripts on remote servers to discover configuration items (CIs) and
CI relations.

Choose one of the procedures below according to the SSH package you are working with.

To install the BSM Connector SSH Files on Cygwin installations:

1. Verify that the following directory exists on each computer that is accessed by BSMConnector
using SSH:

<install_drive>:\cygwin\home\bsmconnector_login_account_name\

Replace bsmconnector_login_account_namewith the user account name you use to
connect to the computer using the SSH server. For example:

C:\cygwin\home\Administrator\

2. On the computer where BSMConnector is installed, find the following file:

<BSM Connector root directory>\tools\RemoteNTSSH.zip

3. Copy RemoteNTSSH.zip to the user's directory on each of the remoteWindows servers
where you have installed the SSH server or daemon software, for example:

C:\cygwin\home\Administrator\RemoteNTSSH.zip

4. Unzip theRemoteNTSSH.zip file on the remote server. Place the contents of the zip file into
the user's home directory.

The zip file also extracts a scripts subdirectory, for example:

C:\cygwin\home\Administrator\scripts

Scripts you create for execution by topology-XML policies must be placed inside this directory.

5. Start the CYGWIN sshd service on the remote server.

To install the BSM Connector SSH Files on OpenSSH for Windows
installations:

1. On the computer where BSMConnector is installed, find the following file:

<BSM Connector root directory>\tools\RemoteNTSSH.zip
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2. Copy this file to the user home directory where the user is automatically directed after logging
on to themachine using the SSH server that was previously installed. This is the directory on
each of the remoteWindows servers where you have installed the SSH server or daemon
software.

3. Unzip theRemoteNTSSH.zip file on the remote server into the user home directory. This
should create a <user home directory>\scripts subdirectory. You use this subfolder to hold
scripts that can be run by the BSMConnector topology-XML policies.

4. Start the OpenSSH server service on the remote server.

How to Configure Remote UNIX Servers for SSH Access
This task describes the steps involved in configuring remote UNIX Servers for SSH access.

Note: Setting up the SSH hosts on the remote servers you want to access in the UNIX
environment can be very complex and is beyond the scope of this document. Some suggested
resources on installation of the OpenSSH daemon are:

l Solaris: http://www.sunfreeware.com/openssh.html

l RedHat Linux 5.3: http://docs.redhat.com/docs/en-US/Red_Hat_Network_
Satellite/5.3/html/Reference_Guide/s1-mon-rhnmd.html

l RedHat Linux 5.4: http://docs.redhat.com/docs/en-US/Red_Hat_Network_
Satellite/5.4/html/Reference_Guide/sect-Reference_Guide-Monitoring-RHN_Monitoring_
Daemon_rhnmd.html

To configure SSH for secure connections:

1. Secure Shell daemons or servers (sshd) must be installed on each remote server you want to
access with BSM Connector.

For details on the requirements for configuring remote UNIX servers for SSH access with BSM
Connector in a UNIX environment, see "SSH Configuration Requirements for UNIX Remote
Servers" on the next page.

2. Configure the SSH client to connect to the remote servers

After you have set up SSH servers or daemons on remote servers, youmust configure the
integrated Java SSH client that BSM Connector uses to connect to the remote servers. For
task details, see "How to Configure the BSMConnector SSH Client" on the next page.

3. If not already done, configure the UNIX remote server to use the SSH connectionmethod.

After confirming SSH connectivity between BSMConnector and the remote server, set up
UNIX remote server settings in BSM Connector by selecting SSH as the connectionmethod in
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the Remote Server configuration dialog box.

For details, see "Configuring Remote Servers " on page 89.

SSH Configuration Requirements for UNIX Remote Servers

The following are requirements for configuring remote UNIX servers for SSH access in a UNIX
environment:

l Secure Shell daemons or servers (sshd) must be installed on each remote server you want to
access with BSM Connector.

l The SSH daemons on the remote servers must be running and the applicable communication
ports must be open. For example, the default for SSH is port number 22.

l A SSH client must be installed on the server where BSMConnector is running. The BSM
Connector integrated Java SSH client fills this requirement.

Verify SSH client-to-server connectivity from themachine where BSMConnector is running to the
remotemachine you want to access. Check SSH connectivity outside of the BSMConnector
application before setting up remote server connections using SSH in BSMConnector. For
example, if BSM Connector is running on Linux, use the following command line to request an SSH
connection using SSH2 to the server <remotehost>:

ssh -2 <remotehost>

This normally returns text information that indicates the version of SSH protocol that is being used.
Also, this attempts to authenticate the current user. Use the -l username switch to request a login
as a different user.

Once you have confirmed SSH connectivity, create or configure UNIX Remote settings in BSM
Connector to use SSH as the connectionmethod.

How to Configure the BSM Connector SSH Client
BSMConnector provides a SSH client written in Java that is integrated into the BSMConnector
application. This client significantly reduces the required system resources used by BSM
Connector when connecting to servers by using SSH. The Java client supports both SSH version 1
(SSH1) and version 2 (SSH2) protocols as well as both password-based and key-based
authentication. The BSMConnector configuration for the client is identical for Linux andWindows
BSMConnector.

To configure the BSM Connector SSH client:

1. Configure SSH2 connections.

Some security vulnerabilities have been found in SSH1 that has resulted in SSH2 being
considered the current standard. HP therefore recommends that you configure SSH clients and
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SSH hosts to use the SSH2 protocol between them to communicate. For details, see
"Configure SSH2Connections" below.

2. Configure key-based authentication.

By default, the integrated SSH client for BSM Connector uses password authentication. You
can configure the integrated SSH client to use key-based authentication, which adds an
additional level of security through the use of a passphrase and a public-private key
authentication. For details, see "Configure Key-based Authentication" below.

Configure SSH2 Connections

While SSH1 and SSH2 are both Secure Shell protocols, they are considered to be two different
protocols and are not compatible with each other. Some security vulnerabilities have been found in
SSH1 that has resulted in SSH2 being considered the current standard. Most SSH software
supports both protocols. However, to be sure that a request for a SSH connection uses SSH2
instead of SSH1, it is necessary to configure SSH clients and SSH hosts to use the same protocol
version between them to communicate. In many cases, SSH1 is the default version used for
connections, as it is considered the lowest common denominator between a SSH client and a SSH
host.

There are two ways to force SSH2 connections:

l Configure all SSH daemons or servers to accept only SSH2 connection requests. This is the
most secure option but may be themost time-consuming unless each server was configured for
this option when it was installed and activated.

l Configure the SSH client on the BSMConnector server to only make SSH2 requests. Requires
changes only to the client on the BSMConnector server. For the integrated Java SSH client,
this can be controlled by theSSH version 2 only setting in theSSH Details section on the
remote server setup page. For details, see "How to Configure BSM Connector to Access
RemoteWindows Servers " on page 86 and "How to Configure BSM Connector to Access
Remote UNIX Servers " on page 88.

By default, the BSM Connector Java client uses the SSH1 protocol if the server it is trying to
connect using SSH1 connections. If this negotiation fails, BSM Connector attempts to connect
using version 2 protocol.

Configure Key-based Authentication

The integrated SSH client for BSM Connector can be configured to use one of two authentication
options:

l Password Authentication is the default method for SSH connections in BSM Connector.

l Key-Based Authentication adds an additional level of security through the use of a passphrase
and a public-private key authentication.
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To use Key-Based Authentication for SSH remote servers, youmust first create a pair of
public/private keys. The public key resides on the remote and the private key is kept on the BSM
Connector server. You can copy a BSMConnector SSH key to the remote server, or take the
remote server key from a remote server and copy it to BSM Connector.

Tip: It is recommended tomaintain one key file on the BSMConnector server and copy it to
the remote servers instead of generate a file for eachmachine and copy them to the BSM
Connector machine.

Both Cygwin OpenSSH andOpenSSH forWindows comewith a key generation tool called ssh-
keygen. The ssh-keygen tool enables you to create both protocol version 1 and version 2 keys.

When setting up a UNIX orWindows remote server using the Internal Java Libraries Client, use the
key generation tool calledMindTerm to create a public/private key pair for RSA (version 1 and
version 2) and DSA (version 2).

Creating a Key on the BSM Connector Server
To create a public or private key pair on the BSM Connector server:

1. Open a commandwindow on the BSMConnector server, and run the following command to
launchMindTerm:

<BSM Connectorroot directory>\java\bin\java -jar c:\<BSM Connector root
directory>\
WEB-INF\lib\mindterm.jar

2. In MindTerm, select File > Create Keypair > DSA (or RSA). Also select OpenSSH .pub
format.

3. The key pair is written to the <USER_HOME>\mindterm directory.

4. Copy the private key (file not ending in *.pub) to the <BSM Connector root
directory>\groups directory.

5. Copy the identity.pub file to the <USER_HOME>/.ssh directory on the remotemachine and
rename it authorized_keys (or authorized_keys2 for SSH2). You also can add content of
identity.pub to existing authorized_keys/authorized_keys2 file if you want to allow a
number of different users to connect to the server with different keys files.

6. On the remotemachine, run the command chmod 744 authorized_keys in the <USER_
HOME>/.ssh directory, andmake sure that User has read, write, and execute permissions,
and that Group and Other have read permissions on the authorized_keys file.

7. Create a remote connection in BSM Connector for the remote server using key file
authentication and Internal Java Libraries.

The public key goes in the <USER_HOME>/.ssh/authorized_keys file on the remote
machines.
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The private key file can be put into the <BSM Connector root directory>\groups directory,
and renamed identity, which enables BSM Connector to automatically take it without having to
specify the file path in the remote server configuration page. Alternatively, you can put the
private key in any other BSM Connector directory, or outside of BSM Connector.

The key generated fromMindTerm is inOpenssh format.

Note: Youmust verify that the server key and theMindTerm key are at the same level. For
example, if the server key is 768 bit and theMindTerm key is 1024 bit, the authentication
procedure fails.

To find out what your server is using:

1. Stop the sshd service on the remote server. On a RedHat Linux server, run the command:

/etc/rc.d/init.d/sshd stop

2. Start the sshd service in debugmode on the remote server. On a RedHat Linux server, run the
command:

/usr/sbin/sshd -d

You should see output similar to Generating 768 bit RSA key.

To convert the openSSH key to SEC SSH format:

1. Create a RSA key inMindTerm (which is an openSSH key pair).

2. Run the following command on the remote server to convert the openSSH key to SEC SSH
format:

ssh-kegen -e -f <public key>

3. Leave the private key on the BSMConnector server in the openSSH format.

Note:When using Key-Based authentication, the Key File suppliedmust be a version 2
private key.

Creating a Key on a UNIX Remote Server and Copying it to the BSM
Connector Server
To set up a connection by taking the remote machine key and put it into BSM Connector:

1. Log on to your UNIX remote server as the user that has root permissions.

2. To generate a public/private RSA key pair for protocol version 1, run the following command:

$> ssh-keygen -t rsa
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If you want to generate key pair for version 2, run the command:

$> ssh-keygen -t dsa

The possible output is:

Enter file in which to save the key (~/.ssh/id_rsa):
Enter passphrase* (empty for no passphrase):
Enter same passphrase again:

where the passphrase is the password used to decode your private key file; it can be left blank.

Your identification is saved in ~/.ssh/id_rsa and the public key in ~/.ssh/id_rsa.pub
(protocol version 1); or ~/.ssh/id_dsa and ~/.ssh/id_dsa.pub for protocol version 2.

3. The corresponding public key must be listed in the authorized file on the remote host. Add the
content of generated public key to this file (the default authorized_keys file location is the
~/.ssh directory).

To do this run the commands:

$> chmod 700 .ssh
$> cd .ssh
$> touch authorized_keys (for ver. 2: touch authorized_keys2)
$> chmod 600 authorized_keys (for ver. 2: chmod 600 authorized_keys2)
$> cat id_rsa.pub >> authorized_keys (for ver. 2: cat id_dsa.pub >>
authorized_keys2)
$> rm id_rsa.pub (for ver. 2: rm id_dsa.pub)

4. Copy the identification file, private key, to the BSMConnector machine.

5. In BSM Connector, create a new UNIX remote server with the following in the Remote Server
Configuration:

n Method. SSH.

n SSH authorization method. Keyfile.

n SSH Key file. Path and name of the file that contains the private key; for example,
C:\private.key.

6. Test the remote server connection.

UNIX Operating System Adapters
You can use BSMConnector UNIX operating system adapters to extend BSMConnector to
access log files on remote servers that run other UNIX platforms, in addition to those supported by
default. This is done by configuring an adapter file to support the particular UNIX platform you want
to access.
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BSMConnector uses adapter files to describe the commands that are needed to access and read
log files on servers running different platforms of the UNIX operating system. These adapter files
are written in plain text and are stored in the  <BSM Connector root directory>/templates.os
directory. For a list of the default UNIX adapters that are provided with BSM Connector, see "UNIX
Adapters Provided with BSM Connector" below.

You canmodify existing adapter files to adjust for specific system requirements in your
environment, or you can create your own adapter files.

How to Add an Adapter
This task describes the steps involved in adding an adapter to specific versions of UNIX.

1. If the UNIX platform to which you want to add support is similar to one of the default BSM
Connector-supported UNIX platforms, make a copy of the adapter file for that UNIX platform
and use that as a starting point for your adapter.

2. Modify the adapter file to match the command line requirements for the UNIX platform to which
you want BSM Connector to connect.

3. Save your adapter file to the <BSM Connector root directory>/templates.os directory. The
filenamemust use the .config extension.

4. Restart the BSM Connector service.

5. Start the BSM Connector user interface for the BSMConnector server to which you have
added the new adapter file, and log on.

6. Click theRemote Server Management toolbar button to open theRemote Servers dialog
box.

7. Create a new UNIX remote server.

8. In theOperating system box, select the name of the UNIX adapter that you have created.

9. Click OK. BSM Connector uses the new adapter file to try and retrieve that applicable data
from the remote server.

The amount of work required tomodify a particular template depends on how different the new
UNIX platform is from the supported UNIX platforms.

UNIX Adapters Provided with BSM Connector
The default UNIX adapters that are provided with BSM Connector, include:

Filename Description

AIX.config Adapter file for IBM AIX

CentOS.config Adapter file for CentOS Linux
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Filename Description

Digital.config Adapter file for Digital Tru64 UNIX (Pre 4.x)

FreeBSD.config Adapter file for FreeBSD 3.x

HP.config / HP-UX.config Adapter file for Hewlett-Packard HP/UX

HP64.config Adapter file for Hewlett-Packard HP/UX 64-bit

ILO.config Adapter file for Hewlett-Packard Integrated Lights-Out

Linux.config Adapter file for Linux (Red Hat and others)

MacOSX.config Adapter file for AppleMacIntosh OS X

NonStopOS.config Adapter file for Hewlett-Packard NonStopOperating System

OPENSERVER.config Adapter file for SCOOpenServer

RedHatEnterpriseLinux.config Adapter file for Red Hat ES Linux

SCO.config Adapter file for SCOUNIXWare

SGI.config Adapter file for Silicon Graphics Irix

Sun.config / SunOS.config Adapter file for SunMicrosystems Solaris

Tru64.config Adapter file for Compaq Tru64 UNIX 5.x

Ubuntu.config Adapter file for Ubuntu Linux

Adapter File Format
Each UNIX platform supported for remote access by BSMConnector has an adapter file in the
<BSM Connector root directory>/templates.os directory. These files use BSMConnector's
standard setting file format.

The first group of settings (those settings before the first # sign line) describe the platform:

id=yourPlatform
name=your Platform Name

The id is theBSM Connector internal ID for the OS. This ID must be unique, contain no spaces,
and can be alphanumeric.

Tip:We recommend that you use the name of the adapter file as the ID name. For example, if
the name of your adapter file is linux.config, your ID would be linux.

The name is the name you want displayed in theOperating system drop-down list when adding or
editing remote servers.
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The rest of the template file contains groups of settings representing a single command, separated
by a line of # characters. For example, the following settings represent the command to display the
last part of a log file:

id=tail
command=/usr/bin/tail -c +<bytes> <file>

where:

id=tail is the id that BSM Connector uses to look up a command. This must be one of the set of
BSM Connector commands (see "Adapter Command List" below). This entry is case sensitive.

For example:

command=/usr/bin/tail -c +<bytes> <file>means that the /usr/bin/tail -c +<bytes>
<file> command is run to display the last number of <bytes> of the file <file>.

Adapter Command List
BSMConnector requires settings for each the following commands to operate properly. Each
command description requires an ID and a command, one or more fields to specify where the data
is being read from, and optionally a set of modifiers that are used to filter the output of the command
to eliminate certain sets of lines (such as header lines).

Where the variable column is used below, it means the number of the column in which the data
appears, where columns are space delimited sets of data.

In addition, there are certain fields that can be optionally applied to any command description. For
details, see "Optional Adapter CommandDetails" below.

This section includes:

l "Log File Processing" below

l "Optional Adapter CommandDetails" below

Log File Processing

ID Description Fields

fileExists Checks that the log file exists. match. The text to match in the log entries.

filesize Returns the file size to ascertain if the
file changed.

size. The number in the size column in the
command output.

tail Reads the file content for local file
processing.

Optional Adapter Command Details
The following fields can optionally be applied to any command description:

Process List with Details
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ID Description

startLine The line number where the command starts looking for data.

endLine The line number where the command ends looking for data.

skipLine The pattern that if matched, skips the line.

matchLine The pattern that if matched, looks for data in that line.

startMatch The pattern that if matched, starts the command looking for data.

endMatch The pattern that if matched, ends the command looking for data.

reverseLines If true, the command output lines are reversed and read back to front. This is
useful if there is data at the end of the command and it is too difficult to work out
when to start reading.

If a field name has the format, fieldnameColumnName=COLUMN, the adapter searches the headers
(first line) for COLUMN and records the columns containing the data, and then use those settings to
read the fieldname field. This is useful where the width of the columns varies, and the data has
spaces in it.

For example, to read the my data information from the following command output:

MEM NAME DESC12K my data some of my data

you would specify the name field in the command description as:

nameColumnName=NAME

The adapter reads the header line, finds NAME, and records where the previous column ends (MEM in
this case) and where the specified column ends (NAME), and uses that to read, in this case, the text
in character columns 6 through 22.

Support for Internet Protocol Version 6
BSMConnector database, log file, andWeb service listener policies can communicate with remote
servers that have IPv6 addresses.

The level of support for IPv6 depends on the operating system onwhich BSMConnector is
installed:

l Windows Server 2008.Windows Server 2008 has full-featured support for IPv6, which is
installed and enabled by default. As a result, IPv6 is supported by BSMConnector database, log
file, andWeb service listener policies when BSMConnector is installed onWindows Server
2008 and later.

l Windows Server 2003. Support for IPv6 onWindows Server 2003 is limited, as many core
services and networking components do not support it.

l UNIX. IPv6 is also fully supported when BSMConnector is installed on Linux operating systems
that provide full support for IPv6.
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Supported Protocols
The following protocols are supported when IPv6 is used in BSM Connector installed onWindows
and UNIX platforms:

Target
BSM Connector Installed on
Windows Platform

BSM Connector Installed on UNIX
Platform

Windows NetBios SSH

UNIX Not supported SSH

Note:

l BSMConnector installed onWindows platforms can access Windows machines only.

l NetBIOS is supported when BSMConnector is installed onWindows platforms only .

l SSH is supported only when BSMConnector is installed on UNIX machines.

How to Configure BSM Connector to Prefer IPv6
Addresses

By default, BSM Connector connects to remote servers using IPv4 addresses. If you want your
environment to resolve host names to IPv6, you can configure BSM Connector to prefer IPv6
addresses:

1. Set the _preferIPV6Address property value to =true in the <BSM Connector root
directory>\BSMConnector\groups\master.config file.

Restart BSM Connector for your changes to this setting to take effect:

Windows: Restart theHP BSM Connector service in theAdministrative Tools > Services.

Linux: Restart the BSM Connector main process, type /opt/HP/BSMConnector/stop followed
by /opt/HP/BSMConnector/start.

2. Make sure the host name resolves to both an IPv4 and an IPv6 address. If the host name
resolves only to an IPv4 address, then the IPv4 address is used.

3. Specify a host name for the remote server. If an IP address is specified, the prefer IPv6 setting
has no effect on the host since the IP address determines the IP version that is used.

For details on specifying a hostname for remote servers for log file policies, see "Configuring
Remote Servers " on page 89.

Working in a Mixed IPv4 and IPv6 Environment
Whenworking in amixed environment where both IPv4 and IPv6 are used, the DNS server might
return both an IPv4 and an IPv6 address for a host name. To instruct BSM Connector which IP
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address to use for each resolved host name, you can:

l Configure BSM Connector to prefer IPv6 addresses, and perform one of the following (for the
hosts that you want to use the IPv4 protocol):

n Enter the IP address instead of the host name for the specified remote server.

n Configure the DNS server so that the host name resolves to the IP address that you want to
use for the remote server. You can do this by removing the IPv6 address from the DNS server
for the specified host.

l Configure BSM Connector to not prefer IPv6 addresses (this is the default), and perform the
following (for the hosts that you want to use the IPv6 protocol):

n Enter the IP address instead of the host name for the specified remote servers.

n Configure the DNS server so that the host name resolves to the IP address that you want to
use for the specified remote servers. You can do this by removing the IPv4 address from the
DNS server for the specified hosts.
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Chapter 7: Policy Management
Policies are collections of configuration information used to configure HP Operations Agent on the
BSMConnector server to process integration data. When you develop policies, you decide what
kinds of data to process, how often to process, what to look for in the data, and what to do if certain
conditions apply.

BSM Connector provides policy editors for different policy types (for example, for XML file policies).
You can import policies developed and exported on other servers, for example, HP Operations
Manager (HPOM)management servers, HP Network NodeManager i (NNMi) management
servers, or other BSM Connector servers. In addition, SiteScope 11.22 and later enables you to
export Technology IntegrationMonitors to BSM Connector policies.

When you create a new policy or import a policy, the policy exists in the BSMConnector policy
repository but does not function yet. Youmust first activate the policy for it to start accessing the
corresponding event source or discovering topology data.

Tip: You can sort the information that appears in the columns in the BSMConnector policy list
so that data appears in either ascending or descending order, indicated by either an up or down
arrow at the top of the column. In addition, you can change the order of columns by dragging
columns to other positions.

To access
To start the BSM Connector user interface, open aWeb browser at the following URL:

https://<BSM Connector system>:30000/bsmconnector/

<BSM Connector system> is localhost or the hostname of the BSMConnector server. If Apache
Tomcat is configured to use a different port, use this port instead.

Learn More
This section includes:

l "Drag and drop" below

l "Policies in cluster environments" on the next page

Drag and drop

Most BSM Connector policy editors offer drag-and-drop to quickly insert sample data, mappings,
policy variables, and so on in text boxes.

The following illustration shows the default event attributes page of log file policies. You can select
data in the Sample Data, Mappings, Indicators, and Policy Variables tabs on the right and drag it to
the Event Attributes, Event Correlation, Custom Attributes, and Advanced tabs on the left. BSM
Connector inserts the data at the current cursor position.
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Policies in cluster environments
Import and activate the same set of policies on all nodes in the cluster.

Make sure that you do not access data stored on the shared disk with the same policies activated
onmultiple cluster nodes. This may result in duplicate events in BSM after a failover. For example,
do not activate the same XML file policies onmore than one cluster node if the policies read an XML
file on a shared disk.

If the IP address of the resource group (also known as virtual IP address) sends SNMP events that
you plan to capture, make sure that the IP address is set up as a CI (configuration item) with the
attribute "host is virtual" in BSM. Otherwise the events display as unmapped events in BSM.

Tasks
Related tasks

l "How to Edit Policies" on page 128

l "How to Copy Policies" on page 129

l "How to Delete Policies" on page 130

l "How to Activate and Deactivate Policies" on page 130

l "How to Export Policies" on page 131

l "How to Import Policies" on page 133

l "How to Configure Policy Management Options" on page 134
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UI Descriptions
Policy Management

UI Element Description

Refresh. Reloads the policy list.

Create. Opens a policy editor to create a new policy.

Edit. Opens the selected policy in a policy editor for editing.

Copy. Opens the Copy Policy dialog box.

Delete. Deletes the currently selected policy.

Activate. Activates the currently selected policy so that it starts functioning.

Deactivate. Deactivates the currently selected policy. The policy stops on the
BSMConnector server.

Break Edit Lock. Removes the edit lock from the currently selected policy.

Import. Opens a file selection dialog box for you to select the policy files to
import.

Remote Server Management. Opens the Remote Servers dialog box. For more
information about remote servers, see "Remote Servers Overview" on page 85.

BSM Integration Preferences. Opens the BSM Integration Preferences dialog
box. For details, see "Configuring Integration Preferences for Inaccessible
Profiles" on page 48.

Options. Opens theOptions dialog box

Policy
Type

The policy type indicates the data source of the policy (for example, log file,
database, or openmessage interface).

Integration
Type

The integration type indicates the type of data that the policy integrates (for
example, event, metrics, or topology).

Policy ID Optional:GUID (globally unique identifier) of the policy.

Name Name of the policy.

Description Description of the policy.

Activation
State

The activation state indicates if a policy is activated, deactivated, or needs
reactivation after modification.

Edited by The lock icon and the name of the editing user indicate that a policy is being
edited and by whom.
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How to Edit Policies
BSMConnector enables multiple users to connect to the same server at the same time. However,
only one user at a time can edit a policy to prevent changes from other users overwriting each other.

When you edit a policy, BSM Connector locks the policy for you so that only you can save the
policy. Note that if you open a policy more than once, only the first editor instance receives the lock
and can save the policy.

Locked policies display with a lock icon and the name of the editing user in the list of policies in
the BSMConnector user interface. (The tooltip explains who locked the policy and when.)

BSM Connector releases the lock when the policy is closed or when a user forcefully breaks the
lock. It is recommended that you only break the edit lock when you have reason to believe that the
locked policy editor was abandoned or stopped working. Policy editors that have been forcefully
unlocked by another user change to read-only mode and you can no longer save any changes
made.

Tip:When you open a locked policy for viewing, reload the policy from time to time to ensure
that you are viewing themost recently saved version.

This section includes:

l "To edit unlocked policies:" below

l "To break the edit lock on locked policies:" below

To edit unlocked policies:

1. In the list of policies in the BSMConnector user interface, select the policy that you want to
edit.

2. Click in the toolbar. The policy editor opens. The policy is marked with the lock icon and
the name of the editing user in the list of policies in the BSMConnector user interface.

3. Modify the policy.

4. Click OK to save the policy and close the editor.

Alternatively, right-click the policy that you want to edit and click Edit in the context menu. Modify
the policy and click OK to save your changes.

To break the edit lock on locked policies:

1. In the list of policies in the BSMConnector user interface, select the locked policy that you
want to edit.

2. Click in the toolbar. A dialog box opens and lists the name of the editing user, the hostname
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of the BSMConnector server, and the date and time the policy was locked.

The date and time displays using the current time zone of the computer on which the BSM
Connector user interface runs. The language setting of theWeb browser determines the date
and time format (for example, 09/14/2010 8:16:38 AM for English (United States)). If the
Web browser and the computer on which the BSMConnector server run have different
language settings, the language setting of theWeb browser takes precedence. However,
English is the default language if theWeb browser is configured to use a language that is not
available on the server.

3. Click OK to break the edit lock. The lock icon and the name of the editing user disappear
from the list of policies in the BSMConnector user interface..

4. Open the policy for editing andmodify it.

5. Click OK to save the policy and close the editor.

Alternatively, right-click the locked policy that you want to edit and click Unlock in the context
menu. Modify the policy and click OK to save your changes.

Tip: You can unlock a policy at any time, even while editing.

How to Copy Policies
Instead of creating a new policy from scratch, you can copy an existing policy and change the copy
tomeet your needs. Copied policies are by default deactivated.

Note: You can copy only one policy at a time.

How to copy a policy

1. In the list of policies in the BSMConnector user interface, select a policy.

2. Click in the toolbar. TheCopy Policy dialog box opens.

3. Change the policy name and optionally the description.

4. Click OK. The copied policy appears in the list of policies in the BSMConnector user interface
and is by default deactivated.

UI description

UI
Element Description
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Name Name of the policy. You can use spaces in the name. The equal sign (=) is not
allowed.

Description Description of what the policy does. Youmight also add other notes (for example,
data sources that are used).

How to Delete Policies
You can only delete deactivated policies and policies that are not being edited by other users. When
you delete a policy the policy files are deleted from the file system. To temporarily stop a policy
from functioning, deactivate the policy instead.

To delete policies:

1. In the list of policies in the BSMConnector user interface, select the policies that you want to
delete.

2. Make sure that the policies are deactivated and not being edited.

3. Click in the toolbar. A message box opens.

4. Confirm that you want to delete the policies.

How to Activate and Deactivate Policies
When you create a new policy or import a policy, the policy exists in the BSMConnector policy
repository but does not function yet. Youmust first activate the policy for it to start accessing the
corresponding data source.

When you edit an existing, active policy, the previous version of the policy remains active on the
BSMConnector server and youmust reactivate the policy for your changes to take effect.

When you deactivate a policy, the policy remains in the BSMConnector policy repository but does
not function until it is activated again.

This section includes:

To activate policies:

1. In the list of policies in the BSMConnector user interface, select the policies that you want to
activate. The activation state of at least one of the selected policies must be deactivated or
activated (reactivate for new version). (If you include an already activated policy in
your selection, the policy is ignored and not activated again.)

2. Click in the toolbar. The activation state changes to activated.

Alternatively, right-click the policies that you want to activate and click Activate in the context
menu. The activation state changes to activated.
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To deactivate policies:

1. In the list of policies in the BSMConnector user interface, select the policies that you want to
deactivate. (If you include an already deactivated policy in your selection, the policy is ignored
and not deactivated again.)

2. Click in the toolbar. The activation state changes to deactivated.

Alternatively, right-click the policies that you want to deactivate and click Deactivate in the context
menu. The activation state changes to deactivated.

How to Export Policies
BSMConnector enables you to import policies developed on other servers, for example, HP
Operations Manager (HPOM)management servers, HP Network NodeManager i (NNMi)
management servers, or other BSM Connector servers. Most policies can simply be copied from
the source BSMConnector server and imported in the target server. However, some policies may
contain information that does not apply to the target BSM Connector server. Policies may also
contain sensitive information such as user names and passwords that must be secured before the
distribution.

Policy content that should be modified or removed before distribution
The following table describes policy content that should bemodified or removed before the
distribution. In addition to the items listed, youmay need to adapt other content to prepare your
policies for distribution, for example policy conditions.

Policy
Type Policy Field Recommended Action

Database
policies

Database
connection
URL

If necessary, enter placeholders for the database server name and
port, for example enter:
jdbc:mercury:sqlserver://<dbserver>:<dbport>;
DatabaseName=EVENT;AuthenticationMethod=type2

Database
user name

Enter a placeholder for the database user name, for example: <db
user name>.

Database
password

Remove the password from the policy.

Server name Enter a placeholder for the database server. for example: <db
server>.

Discovery
policies
(legacy)

User name Enter a placeholder for the account under which the command runs,
for example: <username>.

Password Remove the password from the policy.
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Policy
Type Policy Field Recommended Action

Log file
policies

Remote
server name

Change the server name to the BSMConnector server.

Log file name If necessary, change the path or file name.

Scheduled
task
policies

Command If necessary, change the path or file name.

User name in
commands,
Perl, or
VBScript

Remove the user name from the policy.

Password in
commands,
Perl, or
VBScript

Remove the password from the policy.

Alternatively, use the ExecuteCommandmethod passwordwith an
encrypted password. For details, see ExecuteCommand:
password.

Topology
policies

Scripts If necessary, remove sensitive information, or information that is
specific to the BSMConnector source server.

XML file
policies

Log file path /
name

If necessary, change the path or file name.

Tip: You can useWindows environment variables or call a
command or script that returns the log file name and path. For
details, see "Configuring the Data Source in XML File Policies"
on page 429

To export policies:

1. Prepare the policies for distribution:

a. Create copies of the policies. For details, see "How to Copy Policies" on page 129.

b. Edit the copied policies andmodify them as suggested in "Policy content that should be
modified or removed before distribution" on the previous page.

2. Identify the policy ID of each policy you want to export:

a. In the toolbar, click to open theOptions dialog box.

b. In the Options dialog box, select Policy ID and click OK.

The policy list now shows the ID of each policy in an additional column.

3. On the BSMConnector server, navigate to the policy store:
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n Windows: "%OvDataDir%\datafiles\policymanagement\store"

n Linux: /var/opt/OV/datafiles/policymanagement/store

4. Copy the header (<policyID>_header.xml) and the data (<policyID>_data) files to a
temporary location on the target BSM Connector server and import them. For more information
about importing policies, see "How to Import Policies" below.

How to Import Policies
BSMConnector provides policy editors for different policy types (for example, for XML file policies).
You can import policies developed and exported on other servers, for example, HP Operations
Manager (HPOM)management servers, HP Network NodeManager i (NNMi) management
servers, or other BSM Connector servers. In addition, SiteScope 11.22 and later enables you to
export Technology IntegrationMonitors to BSM Connector policies.

Policies Exported from HPOM
When you download policies on an HPOMmanagement server, make sure the resulting policy files
support the XML-based policy exchange format:

l HP Operations Manager forWindows: use the ovpmutil command-line tool.

l HP Operations Manager for UNIX or Linux: use the opccfgdwn command-line tool.

Policies Exported from NNMi
NNMi provides the nnmopcexport.ovpl command-line tool, which exports an SNMP trap policy for
use with BSM Connector. For more information about running this tool and the NNMi integration in
general, see theNNMi Deployment Reference.

Policies Exported from Other BSM Connector Servers
You can also import policies developed on other BSM Connector systems, for example, to ensure
that the same set of policies is available onmultiple BSM Connector systems. This is necessary,
for example, when running BSMConnector in a cluster environment.

BSM Connector stores policies in the following folders:

l Windows: %OvDataDir%\datafiles\policymanagement\store

l Linux: /var/opt/OV/datafiles/policymanagement/store

Technology Integration Monitors Exported from SiteScope
The export downloads a technology integrationmonitor in SiteScope and converts it to the BSM
Connector policy format for import to BSM Connector. Such imported policies can bemaintained
and further customized in BSM Connector.

For details on exporting technology integrationmonitors in SiteScope, see the SiteScope Help or
the the Using SiteScopeGuide.
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To import policies:

1. In the BSMConnector user interface, click in the toolbar. A file selection dialog box opens.

2. Navigate to the policy files and, for each policy, select both the header (*_header.xml) and the
data (*_data) files.

3. Click Open to start the import process.

If the same policies already exist in BSM Connector, you are asked whether you would like to
replace them with the newly imported policies.

The imported policies appear in the list of policies in the BSMConnector user interface. They
are by default deactivated.

4. If necessary, edit the imported policies and adapt their contents to the new BSMConnector
server. For example, configure a remote server in log file policies or replace placeholder
information with real data in database policies.

5. Optional: Activate the policies. See also "Activation error in the BSMConnector UI" on page
136.

How to Configure Policy Management Options
You can choose to show any combination of columns in the BSMConnector policy list

Tip: Click Default to restore the default selections.

How to change the column display

1. Click in the toolbar. TheOptions dialog box opens.

2. Select or clear the check box beside the column you want to show or hide.

3. Click OK to save your changes and close the dialog box.

UI description

UI Element Description

Policy
Type

The policy type indicates the data source of the policy (for example, log file,
database, or openmessage interface).

Integration
Type

The integration type indicates the type of data that the policy integrates (for
example, event, metrics, or topology).

Policy ID GUID (globally unique identifier) of the policy.

Name Name of the policy.
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Description Description of the policy.

Activation
State

The activation state indicates if a policy is activated, deactivated, or needs
reactivation after modification.

Edited by The lock icon and the name of the editing user indicate that a policy is being
edited and by whom.

Default Click to restore the default selection.

Troubleshooting and Limitations
This section provides help in troubleshooting problems relating to policies and policy management
in general.

This section includes:

l "Indicator definitions could not be loaded" below

l "Activation error in the BSMConnector UI" on the next page

l "Java Virtual Machine out of memory error" on the next page

l "Number of activated policies" on page 137

l "Number of events per second" on page 137

Indicator definitions could not be loaded
The following error message displays when BSMConnector cannot load indicator definitions from
the connected BSM server:

Indicator definitions could not be loaded, service returned:
com.hp.opr.policymanagement.exception.PolicyManagementException:
BSM integration is not initialized, possibly BSM Connector is not yet integrated
with BSM

The following problems can cause this error message:

l The BSMConnector system is not set up as a BSMConnector integration server in BSM. To
correct the problem, set up the BSMConnector system as a BSMConnector integration server
in BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see the BSM online help
or the BSM Application Administration Guide.

l The BSMConnector integration was deleted from one BSM server and added to another. To
correct the problem, restart BSM Connector:

Windows: Restart theHP BSM Connector service in theAdministrative Tools > Services.
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Linux: Restart the BSM Connector main process, type /opt/HP/BSMConnector/stop followed
by /opt/HP/BSMConnector/start.

Activation error in the BSM Connector UI
When you activate database policies with placeholder information in the USERNAME or URL
fields, the activation will fail and the activation state changes to activation error in the UI.
The following error message appears in the System.txt log file:BSM Connector

Windows: %ovdatadir%\log\System.txt

Linux: /var/opt/OV/log/System.txt

An error occurred during the initialization of an internal component for the
policy <policy ID> (of type <policy type>).
The component (MonitorDeployment) returned the following error:
Error Code: 55528. Error Description: Failed to deploy template. (OpC30-3913)

To resolve the problem, complete the following steps:

1. Edit the policies in the UI and replace the placeholder information with real data.

2. Reactivate the policies.

Java Virtual Machine out of memory error
If you receive the following error relating to the Java heap size (for example when opening a policy
with many rules), increase the JVM heap size:

An error of the type 'Server.Processing' occurred. If the problem persists,
contact your system administrator.
Error details: java.lang.OutOfMemoryError : Java heap space

Increase the JVM heap size on Windows:

1. Stop the BSMConnector service in theAdministrative Tools > Services.

2. Edit the BSM Connector's service key in the registry. Use regedit to open the Registry Editor.

3. In the Registry Editor, navigate to:

HKEY_LOCAL_MACHINE/SYSTEM/CurrentControlSet/Services/
<BSM Connector service name>/serviceParam.

The default service name is HP BSM Connector.

4. In serviceParam, modify (Default) and change -Xmx512m to one of the following:

2GB: -Xmx2048m

4GB: -Xmx4096m

5. Start the BSM Connector service in theAdministrative Tools > Services.
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Increase the JVM heap size on Linux:

1. Stop BSMConnector, type:

/opt/HP/BSMConnector/stop

2. Navigate to <BSM Connector root directory>/bin and edit the start-service script.

3. In the start-service script, change -Xmx512m to one of the following:

2GB: -Xmx2048m

4GB: -Xmx4096m

4. Start the BSM Connector service, type:

/opt/HP/BSMConnector/start

Number of activated policies
You can activate and run up to 60 policies on the BSMConnector server in parallel. If you activate
and runmore than 60 policies, the performance of BSM Connector may deteriorate.

Number of events per second
BSMConnector event integration policies can send up to 110 events per second to BSM, if BSM
Connector is installed on a system that meets the hardware requirements described in the BSM
Connector Installation and UpgradeGuide.

If BSM Connector database, log file, andWeb service listener policies send fewer than the
expected 110 events per second, try the following workarounds:

l Increase themaximum size of the event file. For details, see "Troubleshooting Database
Policies" on page 233, "Troubleshooting Log File Policies" on page 283, and "Troubleshooting
Web Service Listener Policies" on page 420.

l If the Java Virtual Machine (JVM) crashes, increase the JVM heap size:

Windows:

a. Stop the BSMConnector service in theAdministrative Tools > Services.

b. Edit the BSM Connector's service key in the registry. Use regedit to open the Registry
Editor.

c. In the Registry Editor, navigate to: HKEY_LOCAL_
MACHINE/SYSTEM/CurrentControlSet/Services/
<BSM Connector service name>/serviceParam. The default service name is HP BSM
Connector.

d. In serviceParam, modify (Default) and change -Xmx512m to one of the following:

2GB: -Xmx2048m
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4GB: -Xmx4096m

e. Start the BSM Connector service in theAdministrative Tools > Services.

Linux:

a. Stop BSMConnector, type:

/opt/HP/BSMConnector/stop

b. Navigate to <BSM Connector root directory>/bin and edit the start-monitor script.

c. In the start-monitor script, change -Xmx512m to one of the following:

2GB: -Xmx2048m

4GB: -Xmx4096m

d. Start the BSM Connector service, type:

/opt/HP/BSMConnector/start

BSMConnector User Guide
Chapter 7: Policy Management

HP Business ServiceManagement (9.23) Page 138 of 521



Chapter 8: Collecting and Viewing Metrics Data
You enable capturingmetrics data from third-party systems by configuringmetrics policies.

Metrics policies depend on the default monitor attributes and rules you define within the policies.
The rules define the processing of incoming data and in combination with the defaults define the
metrics forwarded to BSM.

Metrics can also bemapped to a topology to forward data to the correct CI hierarchy in BSM. You
can configure topology settings for the policy by selecting an out-of-the-box script, or configuring
your own custom topology script during policy creation.

This section includes:

l "Selecting a Topology" below

l "Related Tasks" on page 142

Selecting a Topology
The following topology scripts are available for integrating events, metrics, and topology:

Topology Script
Events
Integration

Metrics
Integration

Topology
Integration

No Topology

Select if you do not want to send any topology
(althoughmetrics and event data is still sent).

yes yes not
available
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Topology Script
Events
Integration

Metrics
Integration

Topology
Integration

Computer - Monitor (deprecated)

Creates a topology with a Computer CI connected to a
SiteScope CI with aMonitored By link.

Note:

The Computer - Monitor topology script has been
deprecated. For new metrics integrations, use the
Computer, Computer - Running Software, or a
custom topology script.

The Computer - Monitor topology integration
requires that the names or IP addresses of the
nodes that it adds to the RTSM are accessible
through DNS resolution. To successfully add a
Node CI specified in a policy's Target field to the
RTSM, BSMConnector must be able to resolve
the node's fully qualified domain name and IP
address through a DNS service.

not
available

yes not
available

Computer

Creates a topology with a Computer CI.

The Computer topology script is not available in
migrated SiteScope technology integrationmonitors.

yes yes yes
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Topology Script
Events
Integration

Metrics
Integration

Topology
Integration

Computer - Running Software

Creates a topology with a Computer CI and a Running
Software CI connected to it with aComposition
relationship. The following illustrates the topology
created for the Computer - Running Software
integration type which retrieves data from a third-party
system:

The Computer - Running Software topology script is
not available in migrated SiteScope technology
integrationmonitors.

yes yes yes

Custom

You create your own topology if you want the retrieved
data to be forwarded to specific CIs and not one of the
out-of-the-box topology scripts.

Note: You should only select Custom if you are
familiar with the Jython language, since youmust
create the topology script in Jython yourself.
Depending on the data type you want to collect,
we recommend that you select and edit one of the
out-of-the-box scripts.

yes yes yes

Note: BSMConnector automatically populates theMonitored by attribute of the reported CIs
with the following values when using one of the out-of-the-box topology scripts:

l BSM Connector

l <policy name>where <policy name> is the name of the policy as set in the policy's
Properties page
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Related Tasks

l "How to Collect Metrics with Computer - Monitor Topology" below

l "How to Collect Metrics with Custom, Computer, or Computer - Running Software Topology
Data" on page 147

l "How to Collect Metrics Without Reporting Topology" on page 160

l "How to View Metrics in BSM User-Defined Reports" on page 172

How to Collect Metrics with Computer - Monitor
Topology

The following task describes how to collect metrics data with Computer - Monitor topology.

This task includes the following steps:

l "Configure BSM integration" below

l "Plan the topology flow" below

l "Create a policy for metrics integration " on the next page

l "Assign group permissions if using System Availability Management reports" on the next page

l "View integration results" on the next page

1. Configure BSM integration
Integrate BSM Connector and BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see "BSM Connector
Integration Administration" in the BSM online help or the BSM Application Administration
Guide.

2. Plan the topology flow
Before you start, plan the following:

n Themetrics you will have.

n The health indicators (HIs) you want to be created on the Computer CI you will report in
topology.

n Formost of the default HIs, there are already HI and Key Performance Indicator (KPI)
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assignments, and there is no need to create new ones.

n Themetrics you want to map to the HIs.

3. Create a policy for metrics integration
Make sure to add an indicator in the Defaults or Rules pages, for example by dragging it from
the Indicators tab. This maps your metrics to HIs. Unmappedmetrics are automatically
mapped to the Legacy System HI.

Select Computer - Monitor from the topology script list in the Topology page. You do not need
to fill any topology script.

Note: The Computer - Monitor topology integration requires that the names or IP
addresses of the nodes that it adds to the RTSM are accessible through DNS resolution.
To successfully add a Node CI specified in a policy's Target field to the RTSM, BSM
Connector must be able to resolve the node's fully qualified domain name and IP address
through a DNS service.

4. Assign group permissions if using System Availability Management
reports

Note: You only need to perform to assign group permissions if you have a System
Availability Management license and plan to use System Availability Management reports,
or if you plan to use BSM custom reports.

If you configure a generic integrationmonitor with aMetrics field mapping, youmust assign for
each defined user, permissions to view SiteScope groups and their subgroups in System
Availability Management reports and custom reports. For more information, see the section on
Permissions in the BSM Platform Administration Guide in the BSMHelp.

5. View integration results
After activating the policy in BSM Connector, you can view the results in the following
applications:

In Service Health:

a. In BSM, select Applications > Service Health > Top View.

b. In the drop down list, select:

o System Hardware Monitoring to view the status of the Computer CI.

o System Monitors view to view themonitor and its status.

In System Availability Management Reports:
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If you have a System Availability Management license, you can also view the data of your
integration in System Availability Management reports. In the different reports, specify a filter
for the data that you want to be displayed in the graphs.

Configure the filter to include the following values that you defined in the policy:

n Target: Select a value that was defined in the Target field in the policy's Defaults or Rules
pages.

n Monitor type:Select a value that was defined in theMonitor Type field in the policy's
Defaults or Rules pages.

n Monitor title/name: Select a value that was defined in theMonitor Name field in the
policy's Defaults or Rules pages.

n Measurement: Select a value that was defined in theMetric(n) field (where n is an integer
identifying themetric) in the policy's Defaults or Rules pages.

Example – Collecting Metrics With Computer - Monitor
Topology

This example describes how to create ametrics integration policy to capture and forwardmetrics
from a third-party system that monitors different disks to BSM using the Computer - Monitor
topology script.

For a task related to this example, see "How to Collect Metrics with Computer - Monitor Topology"
on page 142.

This example includes the following steps:

l "Design stage" below

l "Create a log file policy for metrics integration" below

l "View the integration results" on page 146

1. Design stage
You have a third-party application that writes to a log file. It writes to the log the disk usage of
different computers.

Entries in the log file:

labamrnd42,disk,d,65,warning
labamrnd42,disk,d,70,warning
labamrnd42,disk,d,70,warning

2. Create a log file policy for metrics integration
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Since the application writes to log files, create a log file policy for metrics integration. Use the
Computer - Monitor topology script, and select theHostDiskUtilization indicator. There is
no need to create assignments for this health indicator (HI) or Key Performance Indicator (KPI)
since there are existing assignments for them.

For details about log file data, "Log File Policies" on page 237.

a. In theSource page, specify the name of the log file and the log file pattern.
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b. In theDefaults page, assign default values to themetric attributes, for example:

Drag theHostDiskUtilization indicator from the Indicators tab and drop it in the Indicator
Name field.

You can leaveCI Hint field empty because BSMConnector sets it automatically.

c. In the Topology page, select theComputer - Monitor topology script.

Note: The Computer - Monitor topology integration requires that the names or IP
addresses of the nodes that it adds to the RTSM are accessible through DNS
resolution. To successfully add a Node CI specified in a policy's Target field to the
RTSM, BSMConnector must be able to resolve the node's fully qualified domain
name and IP address through a DNS service.

d. Save and activate the policy.

3. View the integration results
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In BSM, select Applications > Service Health and view the target computer beingmonitored
(labamrnd42) in the System HardwareMonitoring view.

These are the results of the indicator status on themonitoredmachine:

How to Collect Metrics with Custom, Computer, or
Computer - Running Software Topology Data

The following task describes how to collect metrics with custom, Computer, or Computer - Running
Software topology data.

This task includes the following steps:
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l "Select an Indicator" below

l "Define an HI Assignment" below

l "Define a KPI Assignment for each CI type - optional" on the next page

l "Configure BSM integration" on page 150

l "Design the topology flow" on page 150

l "Create a policy for metrics integration " on page 151

l "Create or customize the topology script" on page 151

l "Assign group permissions if using System Availability Management reports" on page 151

l "View Integration Results" on page 151

1. Select an Indicator
To view the status of a CI, you need a health indicator (HI) which provides a fine-grained
measure of the health of the CI. In most cases, you want to view the HI state in BSM's Service
Health. The HI is also used in Service Level Management (SLM). For details on HIs in Service
Health and SLM, see the BSM Application Administration Guide.

Note: For alignment reasons, we recommend using an out-of-the-box HI; only create your
ownHI if you do not find an existing HI that fits your needs.

To select an existing HI or create a new HI:

a. In BSM, select Admin > Service Health / Service Level Management > Repositories
> Indicators.

b. From the CI type hierarchy in the left pane, select the CI type which you are going to report
from your topology script. The assigned indicators for the CI type are displayed in the
Indicators pane. When you select an indicator, its details are displayed in the right pane.
For more details on topology scripts, see "Create or customize the topology script" on page
151.

c. Check if you already have an existing HI that fits your requirements. If you do not, create a
new one. For details on how to create HIs, see the BSM Application Administration Guide.

2. Define an HI Assignment
After you select an HI, you need to define an HI assignment that will assign the HI to a CI. The
assignment also defines which data samples will be captured by this HI and which business
rule will be used to calculate the status of the HI according to the data samples.

For more information on HI assignments, see the BSM Application Administration Guide.
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To define an HI assignment:

a. In BSM, select Admin > Service Health / Service Level Management > Assignments
> Health Indicator Assignments.

b. From the CI type hierarchy in the left pane, select the CI type which you are going to report
from your topology script. The assigned indicators for the CI type are displayed in the
Indicators pane. When you select an indicator, its details are displayed in the right pane.
For more details on topology scripts, see "Create or customize the topology script" on page
151.

c. Create a new HI assignment. For details, see the BSM Application Administration Guide.

o In theCondition area, enter the policy name of your integration in theMonitored By
property. This enables you to distinguish between the CIs reported by your integration to
other CIs of this type.

o Select the HI you chose in the previous step ("Select an Indicator" on the previous
page).

o Choose the business rule to use for the HI calculation. We recommend using the
SiteScope Worst Status Rule. You can also use theSiteScope Consecutive Worst
Status Log orSiteScope Best Status Rule.

o In the selector, enter the following:

o eti_id = (Binary) <<Health Indicator Type ID>>

o ci_id = (Binary) <<CI ID>>

o sampleType = (String) ss_t

The policy sends metrics samples (ss_t) that contain the same eti_id as your ETI and
sameCI ID as the CI's.

The eti_id in the sample is sent by BSM Connector according to the Indicator Name in
the policy.

The ci_id is found by the CI resolver in BSM. For it to find the CI, it uses the CI hint
sent by BSM Connector in the sample, according to the CI Hint in the policy.

3. Define a KPI Assignment for each CI type - optional
Verify whether you have an appropriate Key Performance Indicator (KPI) assignment, or create
if one does not already exist.The assignment determines which KPI to put on the CI and for
which HIs.

If you use one of the default HIs then there should already be a default KPI assignment for your
HI and you do not need to create one.
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Formore information on KPI assignments, see the BSM Application Administration Guide.

To create a KPI assignment:

a. In BSM, select Admin > Service Health > Repositories > Indicators.

b. From the CI type hierarchy in the left pane, select the CI type which you are going to report
from your topology script. The assigned indicators for the CI type are displayed in the
Indicators pane. When you select an indicator, its details are displayed in the right pane.
For more details, see "Create or customize the topology script" on the next page.

c. Create a new KPI assignment.

d. In the KPI assignment, the related HI should be the one you chose in "Select an Indicator"
on page 148.

Note: If you also want to view the integration results in Service Level Management
(SLM), you need to define the Service Level Agreement (SLA).

4. Configure BSM integration
Integrate BSM Connector and BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see the BSM online
help or the BSM Application Administration Guide.

5. Design the topology flow
When planning the design strategy for the custom topology flow, you need to consider the
following:

n CIs to be reported to BSM

Consider the entities that you want to report to BSM. Youmight also want to report metrics
and to view the health status of these entities in BSM's Service Health.

For example, you have a third-party application named TPA that logs its metrics to a
database. The entries in this database contain performance data on CPU and network
usage of different computers. In this case, you will probably want to create a topology that
reports Computer CIs to BSM.

n Data that you want to be reported for these CIs

Consider what data you have for these CIs and how it can be attached to the CIs. What is
the relevant HI for the data being reported? If there is no such indicator, consider creating a
new HI. Which KPI or HI assignments create the desired HIs and KPIs? If no such
assignments exist, consider creating your own.
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6. Create a policy for metrics integration
Make sure to add the HI you chose previously in "Select an Indicator" on page 148 in the
Defaults or Rules pages, for example by dragging it from the Indicators tab.

Specify a hint for the CI in the CI Hint field in the Defaults or Rules pages. This hint is used by
the CI resolver in BSM to recognize the CI to which themetrics should be attached.

Depending on the topology you want to report, select Custom, Computer, orComputer -
Running Software from the topology script list in the Topology page.

7. Create or customize the topology script
For details on custom topology scripts, see "Configuring Scripts in Custom Topology Policies"
on page 328.

8. Assign group permissions if using System Availability Management
reports

Note: You only need to perform to assign group permissions if you have a System
Availability Management license and plan to use System Availability Management reports,
or if you plan to use BSM custom reports.

If you configure a generic integrationmonitor with aMetrics field mapping, youmust assign for
each defined user, permissions to view SiteScope groups and their subgroups in System
Availability Management reports and custom reports. For more information, see the section on
Permissions in the BSM Platform Administration Guide in the BSMHelp.

9. View Integration Results
After activating the policy in BSM Connector, you can view the results in the following
applications:

n Custom topologies. Create a view in RTSM to view the results of the integration in BSM's
Service Health or Service Level Management application. The view should describe the
topology you defined in "Create or customize the topology script" above.

For details on creating the view, see "Modeling Studio Page" in theModeling Guide in the
BSMDocumentation Library.

Computer topologies. You can view the results in the System HardwareMonitoring view.

Computer - Running Software topologies. You can view the results in the System
SoftwareMonitoring view.

If you defined the integration for SLM as well, you can view the integration results in SLM
reports. For more information on SLM and on the reports, see "SLM Reports - Overview" the
BSMUser Guide.

n If you have a System Availability Management license, you can also view the integration
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data in System Availability Management reports. In the different reports, specify a filter for
the data that you want to be displayed in the graphs.

Configure the filter to include the following values that you defined in the policy"How to
Collect Metrics with Custom, Computer, or Computer - Running Software Topology Data"
on page 147:

o Target: Select a value that was defined in the Target field in the policy's Defaults or
Rules pages.

o Monitor type:Select a value that was defined in theMonitor Type field in the policy's
Defaults or Rules pages.

o Monitor title/name: Select a value that was defined in theMonitor Name field in the
policy's Defaults or Rules pages.

o Measurement: Select a value that was defined in theMetric(n) field (where n is an
integer identifying themetric) in the policy's Defaults or Rules pages.

Example – Collecting Metrics With Custom Topology
This example describes how to create ametrics integration policy to capture and forwardmetrics
from a third-party system that monitors different Oracle databases to BSM using the custom
topology script. This script enables you to create your own topology.

For a task related to this example, see "How to Collect Metrics with Custom, Computer, or
Computer - Running Software Topology Data" on page 147.

This example includes the following steps:

l "Design stage" below

l "Select an indicator" on the next page

l "Define an HI assignment" on the next page

l "Define a KPI Assignment" on page 155

l "Create a log file policy for metrics integration" on page 157

l "View the integration results" on page 160

1. Design stage
You have an application named My Oracle Monitoring. This application writes metrics from
Oracle databases running on different computers to a log file.

Entries in the log file:
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amrnd153,27,1,good
amrnd153,82,1,warning
amrnd153,80,1,warning

2. Select an indicator
In BSM, select Admin > Service Health > Repositories > Indicators. For the My Oracle
Monitoring application, use theCPU Usage by SQL (Database) indicator.

This indicator is defined on theOracle CI type (the CI that will be reported), and is appropriate
for themetric being read from the log. This metric describes the amount of CPU that Oracle
uses.

3. Define an HI assignment
In BSM, select Admin > Service Health > Assignments > Health Indicator Assignments
and create the indicator assignment.

In theMonitored by property, enter the name of the BSMConnector policy, My Oracle
Monitoring integration in this example. This value is used to distinguish Oracle CIs
reported by this integration from other Oracle CIs that are being reported. This assigns the CPU
Usage by SQL indicator to Oracle CIs that are reported by this integration only.
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The following page opens when you edit the indicator in this assignment:

The CPU Usage by SQL indicator is calculated using the SiteScopeWorst Status Rule. The
selector defines that data of type ss_t (themetrics data type) with the same ci_id and eti_id
as the current CI and ETI that is reported by the integration.

4. Define a KPI Assignment
Since you used an out-of-the-box indicator, you do not need to create a KPI assignment as
there is an existing Service Health KPI assignment onOracle CIs.
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In BSM, select Admin > Service Health > Assignments > KPI Assignments, and in the CI
Type tree select Oracle and chooseOracle KPI Assignment.

Select theSoftware PerformanceKPI:
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You can see that one of the indicators related to this KPI is the CPU Usage by SQL indicator
which you used.

5. Create a log file policy for metrics integration
Since the application writes to log files, create a log file policy named My Oracle Monitoring
integration for metrics integration. The topology that you want to report includes Oracle CIs
for which HI status will be set.

For details about log file data, "Log File Policies" on page 237.
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a. In theProperties page, type My Oracle Monitoring integration in the Name field.

b. In theSource page, specify the name of the log file and the log file pattern.
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c. In theDefaults page, assign default values to themetric attributes:

o Themonitor name is My Oracle mon on $group0where $group0 is also the target
computer on which the Oracle database is running.

o You define a new monitor type: My Oracle.

o The quality that is sent is conditional and depends on what is written in the log file.

o Themetric name is oracle cpu usage and its value is taken from the log file.

o The CI hint is in the format <<oracle sid>>@@<<computer name>>. The CI hint is used
by the CI Resolver in BSM to find the CI to which this metric should be attached.

o The ETI to which themetric is mapped is CPUUsagebySQL.

d. In the Topology page, select Custom and create the topology script.

Note: The topology script to use is available in a Jython file attached to this PDF. To
view the attachment, select View > Navigation Panels > Attachments, and select
jython_metrics_custom_topo.py.

In the custom script, you can see that:

o system_lib.createNode(Framework) creates the node on which the database is
running.

o modeling.createDatabaseOSH creates the Oracle CI.
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o mainInstance is the SID of the Oracle you used.

o ems_lib.addMonitoredByForThirdPartySoftware sets theMonitored by attribute of
the Oracle CIs to the values BSM Connector and the name of the policy (My Oracle
Monitoring integration in this example), which is the condition you gave in the
indicator assignment (see "Define an HI assignment" on page 153).

e. Save and activate the policy.

6. View the integration results
In BSM, select Applications > Service Health andmanually create a view for the integration.
For example, here we created a view named My Oracle Monitoring (the integration result is
also displayed in System SoftwareMonitoring view):

These are the results of the indicator status on themonitoredmachine:

The state and value are the same as you assigned in the policy.

How to Collect Metrics Without Reporting Topology
The following tasks describe how to collect metrics with no topology data.

This task includes the following steps:
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l "Select an Indicator" below

l "Define an HI Assignment" below

l "Define a KPI Assignment for each CI type - optional" on the next page

l "Configure BSM integration" on page 163

l "Check the existing topology in BSM" on page 163

l "Create a policy for metrics integration " on page 163

l "Assign group permissions if using System Availability Management reports" on page 164

l "View Integration Results" on page 164

1. Select an Indicator
To view the status of a CI, you need a health indicator (HI) which provides a fine-grained
measure of the health of the CI. In most cases, you want to view the HI state in BSM's Service
Health. The HI is also used in Service Level Management (SLM). For details on HIs in Service
Health and SLM, see the BSM Application Administration Guide.

Note: For alignment reasons, we recommend using an out-of-the-box HI; only create your
ownHI if you do not find an existing HI that fits your needs.

To select an existing HI or create a new HI:

a. In BSM, select Admin > Service Health / Service Level Management > Repositories
> Indicators.

b. From the CI type hierarchy in the left pane, select the CI type which you are going to use.
The assigned indicators for the CI type are displayed in the Indicators pane. When you
select an indicator, its details are displayed in the right pane.

c. Check if you already have an existing HI that fits your requirements. If you do not, create a
new one. For details on how to create HIs, see the BSM Application Administration Guide.

2. Define an HI Assignment
After you select an HI, you need to define an HI assignment that will assign the HI to a CI. The
assignment also defines which data samples will be captured by this HI and which business
rule will be used to calculate the status of the HI according to the data samples.

For more information on HI assignments, see the BSM Application Administration Guide.

To define an HI assignment:
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a. In BSM, select Admin > Service Health / Service Level Management > Assignments
> Health Indicator Assignments.

b. From the CI type hierarchy in the left pane, select the CI type which you are going to use.
The assigned indicators for the CI type are displayed in the Indicators pane. When you
select an indicator, its details are displayed in the right pane.

c. Create a new HI assignment. For details, see the BSM Application Administration Guide.

o In theCondition area, enter the policy name of your integration in theMonitored By
property. This enables you to distinguish between the CIs reported by your integration to
other CIs of this type.

o Select the HI you chose in the previous step ("Select an Indicator" on the previous
page).

o Choose the business rule to use for the HI calculation. We recommend using the
SiteScope Worst Status Rule. You can also use theSiteScope Consecutive Worst
Status Log orSiteScope Best Status Rule.

o In the selector, enter the following:

o eti_id = (Binary) <<Health Indicator Type ID>>

o ci_id = (Binary) <<CI ID>>

o sampleType = (String) ss_t

For an example, see "Example – Create aMetrics Policy Not Reporting Topology" on
page 165.

The policy sends metrics samples (ss_t) that contain the same eti_id as your ETI and
sameCI ID as the CI's.

The eti_id in the sample is sent by BSM Connector according to the Indicator Name in
the policy.

The ci_id is found by the CI resolver in BSM. For it to find the CI, it uses the CI hint
sent by BSM Connector in the sample, according to the CI Hint in the policy.

3. Define a KPI Assignment for each CI type - optional
Verify whether you have an appropriate Key Performance Indicator (KPI) assignment, or create
if one does not already exist.The assignment determines which KPI to put on the CI and for
which HIs.

If you use one of the default HIs then there should already be a default KPI assignment for your
HI and you do not need to create one.

For more information on KPI assignments, see the BSM Application Administration Guide.
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To create a KPI assignment:

a. In BSM, select Admin > Service Health > Repositories > Indicators.

b. From the CI type hierarchy in the left pane, select the CI type which you are going to use.
The assigned indicators for the CI type are displayed in the Indicators pane. When you
select an indicator, its details are displayed in the right pane.

c. Create a new KPI assignment.

d. In the KPI assignment, the related HI should be the one you chose in "Select an Indicator"
on page 161.

Note: If you also want to view the integration results in Service Level Management
(SLM), you need to define the Service Level Agreement (SLA).

4. Configure BSM integration
Integrate BSM Connector and BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see the BSM online
help or the BSM Application Administration Guide.

5. Check the existing topology in BSM
When collectingmetrics without topology data, you need to consider the following:

n CIs available in BSM

Since you are using the No Topology option, you probably already have CIs in the RTSM to
which you want to report data using BSMConnector policies.

n Data that you want to be reported for these CIs

Consider what data you have for these CIs and how it can be attached to the CIs. What is
the relevant HI for the data being reported? If there is no such HI, consider creating a new
HI. Which KPI or HI assignments create the desired HIs and KPIs? If no such assignments
exist, consider creating your own.

For example, if you have data on CPU usage and network usage, you can use the CPU Load
and Interface UtilizationHIs that are defined for the Computer CI type, and you can
use the System Performance KPI. Check if there are HI and KPI assignments that meet
your needs, and if not, consider creating them.

6. Create a policy for metrics integration
Make sure to add the HI you chose previously in "Select an Indicator" on page 161 in the
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Defaults or Rules pages, for example by dragging it from the Indicators tab.

Specify a hint for the CI in the CI Hint field in the Defaults or Rules pages. This hint is used by
the CI resolver in BSM to recognize the CI to which themetrics should be attached.

Select No Topology from the topology script list in the Topology page.

7. Assign group permissions if using System Availability Management
reports

Note: You only need to perform to assign group permissions if you have a System
Availability Management license and plan to use System Availability Management reports,
or if you plan to use BSM custom reports.

If you configure a generic integrationmonitor with aMetrics field mapping, youmust assign for
each defined user, permissions to view SiteScope groups and their subgroups in System
Availability Management reports and custom reports. For more information, see the section on
Permissions in the BSM Platform Administration Guide in the BSMHelp.

8. View Integration Results
After activating the policy in BSM Connector, you can view the results in the following
applications:

n Create a view in RTSM to view the results of the integration in BSM's Service Health or
Service Level Management application. The view should describe the topology you defined
in "How to Collect Metrics Without Reporting Topology" on page 160.

For details on creating the view, see "Modeling Studio Page" in theModeling Guide in the
BSMDocumentation Library.

If you defined the integration for SLM as well, you can view the integration results in SLM
reports. For more information on SLM and on the reports, see the BSM Application
Administration Guide.

n If you have a System Availability Management license, you can also view the integration
data in System Availability Management reports. In the different reports, specify a filter for
the data that you want to be displayed in the graphs.

Configure the filter to include the following values that you defined in the policy "How to
Collect Metrics Without Reporting Topology" on page 160:

o Target: Select a value that was defined in the Target field in the policy's Defaults or
Rules pages.

o Monitor type:Select a value that was defined in theMonitor Type field in the policy's
Defaults or Rules pages.

o Monitor title/name: Select a value that was defined in theMonitor Name field in the
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policy's Defaults or Rules pages.

o Measurement: Select a value that was defined in theMetric(n) field (where n is an
integer identifying themetric) in the policy's Defaults or Rules pages.

Example – Create a Metrics Policy Not Reporting
Topology

This example describes how to create ametrics integration policy to capture and forwardmetrics
from a third-party system that monitors different Oracle databases to BSM using a custom topology
script. This script enables you to create your own topology.

This example describes how to create ametrics integration policy to capture and forwardmetrics
from a third-party system that monitors different Oracle databases to BSM using the No Topology
option. This option is used to sendmetrics when a topology already exists in BSM, and there is no
need to report the CIs.

For a task related to this example, see "How to Collect Metrics Without Reporting Topology" on
page 160.

This example includes the following steps:

l "Design stage" below

l "Select an indicator" below

l "Define an HI assignment" on the next page

l "Define a KPI Assignment" on page 167

l "Create a log file policy for metrics integration" on page 169

l "View the integration results" on page 171

1. Design stage
You have an application named My Oracle Monitoring. This application writes various
metrics from Oracle databases running on different computers to a log file.

Entries in the log file:

amrnd153,27,1,good
amrnd153,82,1,warning
amrnd153,80,1,warning

2. Select an indicator
In BSM, select Admin > Service Health > Repositories > Indicators. For the My Oracle
Monitoring application, use theCPU Usage by SQL (Database) indicator.

BSM Connector User Guide
Chapter 8: Collecting and ViewingMetrics Data

HP Business ServiceManagement (9.23) Page 165 of 521



This indicator is defined on theOracle CI type (the CI that will be reported), and is appropriate
for themetric being read from the log. This metric describes the amount of CPU that Oracle
uses.

3. Define an HI assignment
In BSM, select Admin > Service Health > Assignments > Health Indicator Assignments
and create the indicator assignment.

The assignment condition shouldmatch the Oracle CIs on which you want to define the
indicators (and not other Oracle CIs that do not belong to this integration). In the indicator
assignment, select theCPU Usage by SQL indicator.
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The following page opens when you edit the indicator in this assignment:

The CPU Usage by SQL indicator is calculated using the SiteScopeWorst Status Rule. The
selector defines that data of type ss_t (themetrics data type) with the same ci_id and eti_id
as the current CI and ETI are captured by this indicator on this Oracle CI.

4. Define a KPI Assignment
Since you used an out-of-the-box indicator, you do not need to create a KPI assignment as
there is an existing Service Health KPI assignment onOracle CIs.

In BSM, select Admin > Service Health > Assignments > KPI Assignments, and in the CI
Type tree select Oracle and chooseOracle KPI Assignment.

In theMonitored by property, enter the name of the BSMConnector policy, My Oracle
Monitoring integration in this example. This value is used to distinguish Oracle CIs
reported by this integration from other Oracle CIs that are being reported. This assigns the CPU
Usage by SQL indicator to Oracle CIs that are reported by this integration only.
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Select theSoftware PerformanceKPI:
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You can see that one of the indicators related to this KPI is the CPU Usage by SQL indicator
which you used.

5. Create a log file policy for metrics integration
Since the application writes to log files, you need to create ametrics integration. Themetrics
will be assigned to Oracle CIs that already exist in RTSM; therefore the CIs do not need to be
reported. The data is assigned to HIs on the CIs.

For details about log file data, "Log File Policies" on page 237.
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a. In theSource page, specify the name of the log file and the log file pattern.

b. In theDefaults page, assign default values to themetric attributes:

o Themonitor name is My Oracle mon on $group0where $group0 is also the target
computer on which the Oracle database is running.

o You define a new monitor type: My Oracle.

o The quality that is sent is conditional and depends on what is written in the log file.

o Themetric name is oracle cpu usage and its value is taken from the log file.

o The CI hint is in the format <<oracle sid>>@@<<computer name>>. The CI hint is used
by the CI Resolver in BSM to find the CI to which this metric should be attached.

o The ETI to which themetric is mapped is CPUUsagebySQL.

BSM Connector User Guide
Chapter 8: Collecting and ViewingMetrics Data

HP Business ServiceManagement (9.23) Page 170 of 521



c. In the Topology page, select No Topoloy.

d. Save and activate the policy.

6. View the integration results
In BSM, select Applications > Service Health andmanually create a view for the integration.
For example, here we created a view named My Oracle Monitoring (the integration result is
also displayed in System SoftwareMonitoring view):

These are the results of the indicator status on themonitoredmachine:
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The state and value are the same as you assigned in the policy.

How to View Metrics in BSM User-Defined Reports
If a System Availability Management license is installed in your BSM environment, you can view
metrics from BSMConnectors, filtered by monitored servers, monitor types, andmeasurements in
SiteScope Cross-Performance reports, which can be accessed throughApplications > System
Availability Management > SiteScope Over Time Reports > Cross-Performance.

However, you can also generate user-defined reports for BSM Connector metrics in BSM, even if a
System Availability Management license is not installed. (BSM Connector does not require a
System Availability Management license.)
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To configure a user-defined report:

1. In BSM, access Applications > User Reports > Custom Query Builder.

2. ForSample type, select SiteScope Measurement (ss_t).

3. Add the following fields and optionally change the field aliases tomore user-friendly names:

Field name Optionally change field alias to

Profile Name Profiles

Target Name Servers

Monitor Name Monitor Types/Monitor Titles

Measurement Name Measurements

Measurement Value Value

Sample Time Date

4. Click Edit Presentation and choose one of the following layouts in the wizard:

n Table
Make sure Table is selected and click Next.

Make sureRegular is selected and click Next.
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Change the Field Order by moving Sample Time up by one in the list, and then click Next.

Specify theSort Order. Move all fields except for Measurement Value from theAvailable
Fields list to theSorted Fields list with ascending order. The Sorted Fields list should list
the following fields in this order:

o Profile Name (Ascending)

o Target Name (Ascending)

o Monitor Name (Ascending)

o Measurement Name (Ascending)

o Sample Time (Ascending)

Click OK to close the Presentation Settings Wizard.
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n Graph
Select Graph and click Next.

Select Line and click Next.

In the Define Graph page, configure the following settings:

o Y-axis: Measurement Value

o X-axis: Sample Time

o Available Dimensions: none

o Selected Dimensions: Profile Name, Target Name, Monitor Name, Measurement Name

Click OK to close the Presentation Settings Wizard.

5. In the Custom Query Builder, click Save Favorite to save your report for later use.

6. Click Favorites, select the saved report, and run it.

7. Optional: Click Filter Builder to create a filter on specific fields for the report. For example,
apply a filter on the Target Name field to filter on selectedmonitored servers.
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Tip: You can select metrics frommore than one BSMConnector instance (profile) for the same
report.

Foremore information on BSM user-defined reports, see the chapter "Build a Custom Query Using
Custom Query Builder" in the the BSMUser Guide.

Tips and Tricks
This section includes tips and tricks that you can use when collectingmetrics with BSM Connector.

l "Avoid Hardcoded Values in Certain Metrics Fields" below

l "Timestamps inMetrics" on the next page

l "Use SiteScope Cross Performance Reports to Check Metrics Arrival in BSM" on the next page

l "Do Not Set CI Hints in Metrics Policies Using Computer - Monitor Topology Type" on the next
page

l "Use the Same Values for Target and CI Hint in Metrics Policies Using Computer Topology
Type" on the next page

l "Do Not Use Dummy Values in the Target Field of Computer - Monitor Topologies" on page 178

l "Comparing String Values" on page 178

Avoid Hardcoded Values in Certain Metrics Fields
Metrics database tables can only storemetrics successfully when eachmetric is unique. The
uniqueness is determined by the following two characteristics of ametric:

l the combination of monitor name, metric name, and target

l the second when themetric is collected

If a policy collects multiple metrics from a third-party system at the same second, themetrics
cannot be stored in the database, unless the combination of monitor name, metric name, and target
is unique.

To ensure uniqueness, include a variable in themetrics fields, for example:

l Example 1

Monitor Name: "Third Party CPU Monitor on " + $group1
Target: $group1
Metric Name: "CPU Utilization"

l Example 2
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Monitor Name: "Third Party CPU Monitor"
Target: $group1
Metric Name: "CPU Utilization on " + $group1

Timestamps in Metrics

l Use the time() function to assign the current time (at the time of processing) to metrics.

l If original timestamps are available for themetrics collected from a third-party system, youmay
reuse and process them with the str_to_seconds() function. Beware of the following limitation
though.

Caution: BSM discards metrics with timestamps of more than six hours ahead of the BSM
time (absolute GMT time). For example, if a metric has the timestamp 19:00 and the BSM
time is 12:00, the difference is seven hours and themetric is dropped. To troubleshoot time-
related problems, switch to the time() function and verify that all metrics arrive in BSM.

Use SiteScope Cross Performance Reports to Check Metrics Arrival in
BSM
If a System Availability Management license is installed in your BSM environment, you can check
and troubleshoot metrics arrival in BSM by generating SiteScope Cross-Performance reports:

Applications > System Availability Management > SiteScope Over Time Reports > Cross-
Performance

Cross-Performance reports enable you to filter metrics by a BSMConnector instance, monitor type
(Monitor Type field in the policy), monitor name (Monitor Name field), and server (Target field).

Tip: BSMConnector does not require a System Availability Management license. You can
also generate user-defined reports using the Custom Query Builder. For details, see "How to
View Metrics in BSM User-Defined Reports" on page 172.

Do Not Set CI Hints in Metrics Policies Using Computer - Monitor Topology
Type
Metrics policies that use the Computer - Monitor topology script do not require the CI Hint field to be
set. BSM Connector sets this field automatically to the value of the Target field. Entries in the CI
Hint field are ignored.

In the Indicator Name field, insert an indicator that is defined on a Computer CI type or its
derivatives. It is recommended that you use drag and drop indicators from the Indicators tab to
insert indicators.

Use the Same Values for Target and CI Hint in Metrics Policies Using
Computer Topology Type
Metrics policies that use the Computer topology script may have the same value in the Target and
the CI Hint fields. The CI hint is used by the CI resolver in BSM to identify the CI to which the
metrics should be attached.
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Tip: For example, use the variable $group2 in these fields to represent the Primary DNS Name
of a server (for example, “myserver.example.com”).

Do Not Use Dummy Values in the Target Field of Computer - Monitor
Topologies
The Computer - Monitor topology integration requires that the names or IP addresses of the nodes
that it adds to the RTSM are accessible through DNS resolution. To successfully add a Node CI
specified in a policy's Target field to the RTSM, BSMConnector must be able to resolve the node's
fully qualified domain name and IP address through a DNS service. Specifying dummy values in
the Target field may therefore cause data and topology to be dropped.

Comparing String Values
Use the equals() function to compare string values instead of "==".

Example:

“myserver”.equals($group1) (equivalent to $group1.equals("myserver"))

Metrics Troubleshooting
This section provides help in troubleshooting problems relating tometrics integration.

This section includes:

l "Metrics integration policy error logs" below

l "Metrics error logs" below

l "Additional troubleshooting information" on the next page

Metrics integration policy error logs
BSMConnector converts metrics integration policies to an internal file format during policy
activation. If the policy converts successfully, the policy can be activated and starts collecting
metrics data.

Any errors encountered during the conversion are logged in the file:

<BSM Connector root directory>/logs/error.log

To troubleshoot activation problems that are caused by conversion errors, open the log file and
search for lines starting with ERROR.

The error message indicates in which line the error was encountered. In the section immediately
above the error message, look for the line [$DEFAULT_PARAMETERS$] and start the line count from
there.

Metrics error logs
You can configure BSM Connector to write themetrics it sends to BSM to the following log file:

<BSM Connector root directory>/logs/bac_integration/samples.log
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1. Open the following file in a text editor:

<BSM Connector root directory>/conf/core/Tools/log4j/PlainJava/bac_
integration.properties

2. Add the following lines:

############################################################################-
#######
# Sample printer
############################################################################-
#######
log4j.category.SamplePrinter=DEBUG, samples.appender
log4j.additivity.SamplePrinter=false
log4j.appender.samples.appender=org.apache.log4j.RollingFileAppender
log4j.appender.samples.appender.File=../${log.file.path}/samples.log
log4j.appender.samples.appender.MaxFileSize=1000KB
log4j.appender.samples.appender.MaxBackupIndex=5
log4j.appender.samples.appender.layout=org.apache.log4j.PatternLayout
log4j.appender.samples.appender.layout.ConversionPattern=%d [%t] (%F:%L) %-5p
- %m%n
log4j.appender.samples.appender.encoding=${general.encoding}

3. Save the file. It may take a few seconds for the changes to take effect.

The results are logged to the samples.log file

Additional troubleshooting information

l For troubleshooting database policies, see "Troubleshooting Database Policies" on page 233.

l For troubleshooting log file policies, see "Troubleshooting Log File Policies" on page 283.

l For troubleshootingWeb service listener policies, see "TroubleshootingWeb Service Listener
Policies" on page 420.
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Chapter 9: Working with Jython-Based Topology
Scripts

BSMConnector supports different methods of collecting CI and CI relationship information from
third-party systems. Themethods used include:

l Jython-based discovery scripts using Data Flow Management technology.

l Custom discovery scripts that feed into local topology synchronization processes before the
data is sent to the RTSM.

l HP Operations Agent discovery technology (agtrep) (deprecated).

For more information on the supported discovery methods, see "Topology Policies" on page 324.

This section contains information on developing Jython-based discovery scripts.

The input for a Jython-based topology script is amap of properties taken from third-party data
retrieved by a policy and various policy configuration variables. The output of the script is a list of
configuration items (CIs) and relationships that populate the RTSM.

Out-of-the-Box Topology Scripts
BSMConnector provides some out-of-the-box topology scripts that you can use with database, log
file, andWeb service listener policies. You can also create your own custom topology script. The
out-of-the-box topology scripts include Computer, Computer - Running Software, and Computer
Monitor (deprecated).

For more information, see:

l "Configuring Topology Scripts in Database Policies" on page 226

l "Configuring Topology Scripts in Log File Policies" on page 262

l "Configuring Topology Scripts inWeb Service Listener Policies" on page 413

Custom Topology Scripts
Custom topology scripts are scripts that you develop yourself using the information in this section.
To help you create your own custom scripts, predefined topology scripts are available in BSM
Connector that you can use as templates for creating your own custom scripts. BSM Connector
also provides some library scripts that contain methods which are supported and can be used in
custom topology scripts.

For more information, see "Developing Custom Topology Scripts" on page 183.

Jython Language
You develop topology scripts using the Jython language. For details on Jython, refer to theseWeb
sites:
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l http://www.jython.org

l http://www.python.org

Note: The Jython language is sensitive to spaces and tabs. A missing or incorrectly placed tab
or a space character may cause a script to work incorrectly or fail with a syntax error. It is
recommended to use text editors or plugins that support the Python language for script editing.

For more information on Jython, see http://wiki.python.org/moin/HowToEditPythonCode.

Library Scripts
BSMConnector provides library scripts that contain methods which can be used in your custom
topology scripts. See "Supported Library Scripts" below for details.

The library scripts are downloaded from BSM and can be found in the following location on the BSM
Connector system:

<BSM Connector root directory>/discovery/scripts

This section includes:

l "Modifying Library Scripts" below

l "Supported Library Scripts" below

l "Custom Library Scripts" on the next page

Modifying Library Scripts
It is not recommended that you change the library scripts because an upgrade of BSM will overwrite
your changes. However, if a temporary change is needed, the scripts can be changed in one of the
following ways:

l In BSM, navigate toAdmin > RTSM Administration > Data Flow Management > Adapter
Management. In the Resources panel, expand sitescope > Scripts and select the script that
you want to edit.

l In BSM, navigate toAdmin > RTSM Administration > Administration > Package Manager.
Right-click the sitescope package and export the whole package to any location. Edit the
scripts in the discoveryScripts folder. Then click Deploy packages to server and choose the
local, modified package.

l In BSM Connector, navigate to <BSM Connector root directory>/discovery/scripts and
modify the scripts.

Supported Library Scripts
The following library scripts are supported and can be used in custom topology scripts in BSM
Connector. The scripts are deployed as part of the sitescope package in RTSM:

BSMConnector User Guide
Chapter 9: Working with Jython-Based Topology Scripts

HP Business ServiceManagement (9.23) Page 181 of 521

http://www.jython.org/
http://www.python.org/
http://wiki.python.org/moin/HowToEditPythonCode


l common_lib.py. This library script provides general topology creationmethods.

l system_lib.py.Methods related to CI types that inherit from Infrastructure Element.

l business_lib.py.Methods related to CI types that inherit from Business Element.

l ems_lib.py. Various helper methods.

Additionally, the following library scripts are deployed as part of theAutoDiscovery package and
are considered DFM's external library:

l modeling.py.Methods useful for creation of nodes, IPs, and other types of CIs. These
methods enable the creation of commonly used CI types andmake the codemore readable.

Example:

ipOSH = modeling.createIpOSH(ip)
host = modeling.createHostOSH(ip)

l netutils.py. Various helper methods used to retrieve network and TCP information, such as
retrieving operating system names, checking if a MAC address is valid, checking if an IP
address is valid, and so on.

Example:

dnsName = netutils.getHostName(ip, ip)
isValidIp = netutils.isValidIp(ip)
address = netutils.getHostAddress(hostName)

l logger.py. Logging utilities and helper functions useful for error reporting from topology scripts.

Custom Library Scripts
If multiple BSM Connector integrations use the sameCI creationmethods or if your custom
topology script requires functionality that is not available out-of-the-box, youmay create custom
library scripts and store the scripts in a custom RTSM package using the RTSM Administration
PackageManager. (In BSM, navigate toRTSM Administration > Administration > Package
Manager and click Create custom package.)

Creating and storing custom library scripts in custom RTSM packages has the following additional
advantages:

l Topology script functionality that is stored in custom library scripts is easier to adapt and
maintain if the RTSMmodel changes between BSM versions.

l Custom RTSM packages can also contain other RTSM-related resources, for example views or
TQL queries, that may be required by your integration.
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Formore information on custom RTSM packages, see the section "Package Manager" in the
RTSM Administration Guide.

Developing Custom Topology Scripts
When developing your own custom topology scripts, consider the following useful information.

This section includes:

l "Topology Script Structure" below

l "Predefined Scripts as Examples" on page 185

l "Syntax Check" on page 185

l "Java Classes andMethods" on page 185

l "Debugging Topology Scripts" on page 188

l "Additional Documentation" on page 189

Topology Script Structure
A topology script has the following structure:

1. Import. Import of additional topology scripts and Java classes.

2. Global variables.

3. DiscoveryMain(Framework). Entry point to a topology script. CIs represented as
ObjectStateHolderVector that are returned from themethod are reported to the RTSM.

4. Script body. Other methods in the Jython language that are called by DiscoveryMain.

The script body usually includes the following steps:

a. Creation of an ObjectStateHolder. AnObjectStateHolder (representation of a CI) can be
created in one of the following ways:

o By directly passing a CI type as an argument.

Example:

oracle = ObjectStateHolder("oracle")

o By using predefinedmethods defined in one of the library scripts.

Example:

computer = system_lib.createComputerFromMap(computerAttributes)
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TheObjectStateHolder for the Computer CI is created inside themethod defined in
the library script system_lib.py.

Using predefinedmethods (if they exist for a particular CI type) is recommended because
they handlemultiple internal aspects related to CI creation.

b. Setting CI attributes. Each CI type has a unique set of identification attributes that can be
found in BSM (Admin > RTSM Administration > Modeling > CI Type Manager). For
more information on CI identification and reconciliation, see "Reconciliation" in the RTSM
Developer ReferenceGuide.

The attributes can be set in one of the following ways:

o Directly using themethod ci.setAttribute(key, value).

o Using a predefinedmethod defined in one of the library scripts.

Example:

system_lib. createComputerFromMap(…)

c. Creation of relationships between CIs. To complete the creation of a topology structure,
the CIs should be connected with relationships.

Example:

link = common_lib.createAgingLink("dependency", ci1, ci2)

Note: To create a Composition relationship, call the setContainer()method instead
of directly creating a relationship.

Example: oracle.setContainer(computer)

d. Storing CIs and relationships. Store the CIs and CI relationships in an
ObjectStateHolderVector object and return it from DiscoveryMainmethod.

Example:

oshv.add(oracle)
oshv.add(link)
return oshv
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Note: Composition relationships should not be added to anObjectStateHolderVector
separately.

Predefined Scripts as Examples
BSMConnector downloads various predefined topology scripts from BSM to <BSM Connector
root directory>/discovery/scripts. You can use these scripts as examples for operations related
to CI creation and update.

Example: The database_topology.py script includes various methods related to the creation of
database CIs.

Note: Do not import to or reuse any of the predefined topology scripts in your custom scripts.
The scripts serve only as examples.

Syntax Check
The Jython language is sensitive to spaces and tabs. For more information, see "Jython Language"
on page 180.

Topology scripts report errors in the following log file:

<BSM Connector root directory>/logs/bac_integration/bac_integration.log

Java Classes and Methods
This section describes the Java classes andmethods that can be used in custom topology scripts.
Full documentation on the available classes andmethods is available at:

http://<BSM server>/topaz/amdocs/eng/doc_lib/API_docs/DDM_JavaDoc/index.html

This section includes:

l "ObjectStateHolder" below

l "ObjectStateHolderVector" on the next page

l "Framework" on page 187

l "HostIPCachingManager" on page 188

l ObjectStateHolder
Java class representing a CI or relationship.

Commonly usedmethods:

n Create a CI

ci = ObjectStateHolder("<CI type>")
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Example:

node = ObjectStateHolder("node")

Note: To create a CI of a certain type in the RTSM youmust familiarize yourself with the
CI type name and its attributes. CIs are created using a CI type name and not the display
name. The same rule applies to the CI properties. You can find this information by
looking for the appropriate CI type in BSM: Admin > RTSM Administration >
Modeling > CI Type Manager.

Example: To create a CI of the type Computer, its name (“host_node”) should be used.

n Set CI attributes

ci.setAttribute("<attribute name>", <attribute value>)

Example:

node.setAttribute("name", nodeName)

n Set Boolean attribute

ci.setBoolAttribute("<attribute name>", <attribute value: "true" or
"false">)

Example:

ci.setBoolAttribute("root_enableageing", "true")

n Create a “Composition” relationship between two CIs

containedCI.setContainer(containerCI)

Example:

runningSoftware.setContainer(computer)

l ObjectStateHolderVector
Java class representing a list of CIs or relationships.

Commonly usedmethods:
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n Create an instance of ObjectStateHolder

ciList = ObjectStateHolderVector()

n Add a CI or relationship to a list

ciList.add(<ObjectStateHolder>)

Example:

ciList.add(ci)

n Remove a CI or relationship from a list

ciList.remove(<ObjectStateHolder>)

Example:

ciList.remove(ci)

l Framework
Map of properties passed as an input to a topology script. Themapmay contain the following
entries:

n Collected data, such as group0, group1, and so on, retrieved by a log file policy, or names of
database columns in database policies, or properties submitted through aWeb service
listener interface.

Example:

hostName = Framework.getDestinationAttribute("group1")

n Values defined in the Defaults - Default Monitor Attributes page of metrics policies.

The property names to be used in the script:

Monitor properties: MonitorName, MonitorType, TargetName, TimeStamp, Quality, and
MonitorState.

Example:

hostName = Framework.getDestinationAttribute("TargetName")

Commonly usedmethods:
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n Access property by name:

property = Framework.getDestinationAttribute("<property name>")

Example:

property = Framework.getDestinationAttribute("group0")

Note: “Collected data” properties should be accessed without the $ sign.

l HostIPCachingManager
Java class used to perform node DNS resolution (convert an IP address to node name and vice
versa).

Commonly usedmethods:

n Get node name from an IP address

HostIPCachingManager.getShortHostName(ip)

n Get IP address from a node name

HostIPCachingManager.getIPByHostName(nodeName)

Debugging Topology Scripts
Use the built-in logger to debug your topology scripts:

1. Add the logger import statement, for example:

import logger

2. Change the log level settings in the <BSM Connector root
directory>/conf/core/Tools/log4j/PlainJava/bac_integration.properties file as follows:

Open the bac_integration.properties file in a text editor and locate the following lines in the
file:

# Jython logger
log4j.category.PATTERNS_DEBUG=${loglevel}, discovery.appender

Change the argument of log4j.category.PATTERNS_DEBUG from ${loglevel} toDEBUG,
as follows:
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log4j.category.PATTERNS_DEBUG=DEBUG, discovery.appender

3. Add debug logging to your custom topology script. For example, to print a map of computer
attributes, add the following lines:

if (logger.isDebugEnabled()):
logger.debug("mapAttributesForComputer() map = %s"%map)

4. Results.

The debug data is written to the <BSM Connector root directory>/logs/bac_
integration/discovery.log file.

Additional Documentation
For additional information on topology scripts, see "Developing Jython Adapters" and "Create
Jython Code" in the RTSMDeveloper ReferenceGuide.

For additional information on Java classes that can be used in topology scripts, see "HP Data Flow
Management API Reference" in the RTSMDeveloper ReferenceGuide.

Example: Oracle Database Topology
The topology script described in this section demonstrates how to populate a simple topology of an
Oracle Database CI, Computer CI and a Composition relationship between them to the RTSM.

Note: The topology script to use is available in a Jython file attached to this PDF. To view the
attachment, select View > Navigation Panels > Attachments, and select jython_topoex_
oracle.py.

1. Create a Computer CI
a. Access the “collected data” using the Framework object.

In the example, the “collected data” of “group0” contains a computer name collected by a
log file policy.

b. Map attributes.

Themethod mapAttributesForComputer()maps the third-party data to the required
computer CI attributes.

c. Use a library script method to construct a Computer CI.

Call createComputerFromMap()method from system_lib.py to construct a Computer CI
from amap of attributes.
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d. Set “Monitored by” attribute.

Call a library method from ems_lib.py to set the required value of the "Monitored by"
attribute.

2. Create an Oracle Database CI
a. Access the “collected data” using the Framework object.

In the example, the “collected data” of “group1” contains a name of anOracle instance
collected by a log file policy.

b. Set CI attributes.

Set the CI attributes with themethod setAttribute(AttributeStateHolder(key,
value)).

In the example, themandatory attributes "name" and "product_name” are set.

In a similar way it is possible to set all CI attributes.

For a complete list of attributes, look for the required CI type in BSM (Admin > RTSM
Administration > Modeling > CI Type Manager).

c. Create a Composition relationship between Computer andOracle CIs.

Call the setContainer()method to set a Composition relationship. Instances of CI types
that inherit from Running Softwaremust be created in the context of a "container CI”
(usually derivatives of Node).

d. Set “Monitored by” attribute.

Call a library method from ems_lib.py to set the required value of the "Monitored by"
attribute.

3. Return a Result
Store the Computer andOracle CIs in the result ObjectStateHolderVector and return it from
the DiscoveryMain()method. The Composition relationship is stored in the
ObjectStateHolderVector implicitly.

Example: Business Application Topology
The topology script described in this section demonstrates how to populate topology of a Business
Application CI, Organization CI, and anOwnership relationship between them to the RTSM.

Note: The topology script to use is available in a Jython file attached to this PDF. To view the
attachment, select View > Navigation Panels > Attachments, and select jython_topoex_
business_application.py.
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1. Create a Business Application CI
a. Access the “collected data” using the Framework object.

In the example, the “collected data” of “group0” contains a name of a Business Application
collected by the log file policy.

b. Create a Business Application CI and fill its attributes.

Set the CI attributes using themethod setAttribute(AttributeStateHolder(key,
value)).

In the example, themandatory attribute "name” is set.

In a similar way it is possible to set all the CI attributes.

For a complete list of attributes, look for the required CI type in BSM (Admin > RTSM
Administration > Modeling > CI Type Manager).

c. Set “Monitored by” attribute.

Call a library method from ems_lib.py to set the required value of the "Monitored by"
attribute.

2. Create an Organization CI
a. Access the “collected data” using the Framework object.

In the example, the “collected data” of “group1” contains an organization name collected by
the log file policy.

b. Attach the Organization CI to Business Application.

Call the attachOrganizationToCI()method from business_lib.py to do the following:

o Create anOrganization CI.

o Set its mandatory attributes.

o Create anOwnership relationship between the Business Application CI and the
Organization CI.

o Add both Organization CI andOwnership relationship to anObjectStateHolderVector.

3. Return a Result
Store the Business Application CI in the result ObjectStateHolderVector and return it from
the DiscoveryMain()method. TheOrganization CI andOwnership relationship are added to
the ObjectStateHolderVector inside the call to business_lib.attachOrganizationToCI().
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Configuration Items in BSM
BSMConnector forwards the topology data to create a CI when the CI is discovered by BSM
Connector for the first time as a result of the policy retrieving andmatching data (regardless of
whether the CI exists in the RTSM). In addition, every time BSMConnector discovers changes to
the CI's properties, it forwards them to the RTSM. This prevents overloading the RTSMwith CI
updates coming from the policy.

This section includes:

l "Aging of CIs in RTSM" below

l "Touching of CIs in BSM Connector" below

Aging of CIs in RTSM
BSM removes CIs from the RTSM if the CIs have not had any activity over a period of time; that is,
if their last access time has not changed. The CIs created from BSMConnector data are also
subject to this aging policy. To prevent the aging policy from acting on CIs that BSM Connector has
sent to BSM, BSMConnector sends a list of active CIs to BSM in addition to the topology data.
This process is known as topology synchronization.

For details on setting the time interval for topology synchronization, see "BSM Connector
Integration Administration" in the BSM Application Administration Guide. For details on the aging
mechanism, see "CI Lifecycle and the AgingMechanism" in the RTSM Administration Guide.

Note: BSMConnector topology synchronization is not to be confused with local topology
synchronization in BSM Connector. During local topology synchronization, BSM Connector
applies mapping rules to discovered topology to transform the discovered objects to CIs and CI
relations that can then be stored in the RTSM. For details on local topology synchronization,
see "Topology-XML Policies and Local Topology Synchronization" on page 329.

Touching of CIs in BSM Connector
BSMConnector stores information about the CIs that it synchronizes with the RTSM in a local
cache. The cache is updated each time topology for a new CI or updates to an existing CI are
reported.

The local cache does not contain all information about the CI, only the CI ID and a flag indicating
whether the CI has been touched or not since the last topology synchronization; that is, whether
topology data has been received for the CI or not. With the next synchronization, BSM Connector
sends only those CI IDs to the RTSM that have been touched. RTSM then updates the last access
time of the CIs, which prevents them from becoming deletion candidates in the RTSM.

BSMConnector by default distinguishes between CIs for which topology data has been received
and CIs that have had no such activity. Inactive CIs are not touched and are not sent to the RTSM
with the next synchronization. Their last access time is not updated so they become subject to the
BSM aging policy.

You can configure BSM Connector to always touch CIs regardless of whether topology data has
been received for them. This guarantees that CIs reported by BSMConnector are never deleted
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automatically from the RTSM because their last access time is updated every time BSMConnector
synchronizes topology data with BSM.

The always touchmode is recommended for BSM Connector topology-only policies that collect
data from incremental data sources such as log files or databases. The first time the policies run,
they collect all CIs from the data source. The next time the policies run, they collect new and
changed CIs only and then forward only the additions and changes to BSM. The always touch
mode ensures that the already existing, unchanged CIs are also reported and are thus not deleted.

To enable the always touchmode, set the parameter _alwaysPerformTouch to true in the <BSM
Connector root directory>/groups/master.config file.

Note: The always touchmode is a global setting that affects all policies of a BSM Connector
instance that forwards topology data to BSM. You cannot havemultiple policies requiring
different agingmodes in the same instance of BSM Connector.

Topology Troubleshooting and Limitations
This section describes troubleshooting and limitations when BSMConnector is enabled to report
CIs and CIs relationships topology to BSM.

This section includes:

l "Troubleshooting If No Topology Is Reported" below

l "BSM Connector Topology Log Files" on the next page

l "BSM Topology Log Files" on the next page

l "Opening Logs in BSM Connector to DebugMode" on page 195

l "Opening Logs in BSM to DebugMode" on page 196

l "Jython Scripts Troubleshooting" on page 196

l "RTSM Troubleshooting" on page 197

l "Limitations" on page 197

Troubleshooting If No Topology Is Reported

1. Open all BSM Connector and BSM logs to debugmode. For details, see "Opening Logs in BSM
Connector to DebugMode" on page 195 and "Opening Logs in BSM to DebugMode" on page
196.

2. Check if there are /bin files left in the <BSM Connector root
directory>/cache/topologyresultsData/merged directory.

3. Check for errors in the logs in the following order:
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a. bac_integration.log. Topology is not sent due to general errors or syntax problems in the
scripts.

b. discovery.log. Get the complete picture of the topology reported from BSMConnector to
BSM through the discovery agent.

c. probeGW-taskResults.log. Shows the topology that the discovery agent actually sends
to the BSM server after doing the necessary validation.

If information is written to this log but there is no topology in BSM/RTSM, it means the
problem cause is on the BSM server.

d. mam.autodiscovery.log. Discovery manager log on the BSM server. The discovery
manager is responsible for handling all tasks on the server.

e. cmdb.reconciliation.log. Reconciliationmechanism is processing each bulk sent to
BSM and runs an identification process to identify similar objects.

f. cmdb.reconciliation.datain.ignored.log. Topology that is ignored by the server and is
not created.

g. discoveryservlet.log. Contains servlet log, which is responsible for getting the data from
the discovery agent (client) and send the reply (success/failure).

It is recommended to open logs that are in XML format (for example, probeGW-
taskResults.log) using an XML editor.

BSM Connector Topology Log Files
The following log files in BSM Connector contain information relating to the BSM integration.

l <BSM Connector root directory>/logs/bac_integration/bac_integration.log

l <BSM Connector root directory>/logs/bac_integration/discovery.log

l <BSM Connector root directory>/logs/bac_integration/probeGW-taskResults.log

This log file does not exist by default. To create it, open it in debugmode as described in
"Opening Logs in BSM Connector to DebugMode" on the next page.

BSM Topology Log Files
The following log files in BSM contain information relating to the integration with BSM Connector.

l <BSM root directory>/log/odb/odb/mam.autodiscovery.log

l <BSM root directory>/log/odb/odb/cmdb.reconciliation.log

l <BSM root directory>/log/odb/odb/cmdb.reconciliation.datain.ignored.log

l <BSM root directory>/log/odb/odb/discoveryServlet.log
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This log file does not exist by default. To create it, open it in debugmode as described in
"Opening Logs in BSM to DebugMode" on the next page.

Opening Logs in BSM Connector to Debug Mode

1. Open the following file in a text editor:

<BSM Connector root directory>/conf/core/Tools/log4j/PlainJava/bac_
integration.properties

2. For each relevant log file, change or add the following appenders:

n To open the file bac_integration.properties to debugmode, change the log level to
DEBUG:

# Main integration category
log4j.category.com.mercury.sitescope.integrations.bac=DEBUG,
integration.appender
log4j.additivity.com.mercury.sitescope.integrations.bac=false

n To open the file discovery.log to debugmode, change the log level to DEBUG:

# discovery logger
log4j.category.com.hp.ucmdb.discovery=DEBUG, discovery.appender
log4j.additivity.com.hp.ucmdb.discovery=false

n To log Jython scripts debug to the file discovery.log, change the log level to DEBUG:

# Jython logger
log4j.category.PATTERNS_DEBUG=DEBUG, discovery.appender
log4j.additivity.PATTERNS_DEBUG=false

n To create the file probeGW-taskResults.log in debugmode, add the following appender:

########################################################################
# Topology task results
########################################################################
log4j.category.ProbeTaskResultsLog=DEBUG, PROBE_TASK_RESULT_FILE
log4j.additivity.ProbeTaskResultsLog=false
log4j.appender.PROBE_TASK_RESULT_FILE=org.apache.log4j.RollingFileAppender
log4j.appender.PROBE_TASK_RESULT_FILE.MaxFileSize=10MB
log4j.appender.PROBE_TASK_RESULT_FILE.MaxBackupIndex=5
log4j.appender.PROBE_TASK_RESULT_FILE.File=../${log.file.path}/probeGW-
taskResults.log
log4j.appender.PROBE_TASK_RESULT_FILE.Threshold=DEBUG
log4j.appender.PROBE_TASK_RESULT_FILE.Append=true
log4j.appender.PROBE_TASK_RESULT_
FILE.layout=org.apache.log4j.PatternLayout
log4j.appender.PROBE_TASK_RESULT_FILE.layout.ConversionPattern=<%d> %-4r
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[%-5p] (%F:%L) - %m%n
log4j.appender.PROBE_TASK_RESULT_FILE.encoding=UTF-8

3. Save and close the file bac_integration.properties.

Opening Logs in BSM to Debug Mode
To open logs in BSM (on the Data Processing Server system in a distributed environment) to debug
mode, change the RTSM debug level to DEBUG in the following BSM files:

l To open cmdb.reconciliation.log and cmdb.reconciliation.datain.ignored.log to debug, edit
the following file:

<BSM root directory>/odb/conf/log/reconciliation.properties

l To openmam.autodiscovery.log to debug, edit the following file:

<BSM root directory>/odb/conf/log/mam.properties

l To create the file discoveryServlet.log in debugmode, edit the following file:

<BSM root directory>/odb/conf/log/mam.web.properties

Jython Scripts Troubleshooting
The scripts that enable BSM Connector to act as a discovery probe are stored on the BSM server.
When BSMConnector is registered to BSM, BSMConnector downloads the appropriate script from
the BSM server. It then uses the script to perform the discovery while integrating the event and
metrics data collected from the third-party system.

Use the following procedure tomake sure that the required Jython scripts are downloaded and
updated correctly:

l Check that the <BSM Connector root directory>/discovery/scripts directory is not empty.

l Check that there are two Jython scripts for each type, for example, system_lib.py and system_
lib.py.old.

If you encounter a script with the suffix *.py.11, the scripts were not updated correctly.

To download all scripts again, do the following:

1. Stop BSMConnector:

Windows: Stop theHP BSM Connector service in theAdministrative Tools > Services.

Linux: Stop the BSMConnector main process, type /opt/HP/BSMConnector/stop.

2. Delete all files in the following directory:

<BSM Connector root directory>/discovery/hsqldb
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3. Start BSM Connector:

Windows: Start theHP BSM Connector service in theAdministrative Tools > Services.

Linux: Start the BSM Connector main process, type /opt/HP/BSMConnector/start.

RTSM Troubleshooting
To get the properties of a CI reported to a Data Flow database with JMX:

1. Open http://<BSM_machine>:21212/jmx-console/ in aWeb browser.

2. Click UCMDB:service= Model Services.

3. Invokemethod: retrieveObjectProperties.

Limitations
If an integration discovers a node with multiple IP addresses, BSM Connector may createmore
than one instance of the node with different IP addresses attached to different instances. For
example: for a node A with IP addresses A1 and A2, BSM Connector may create two nodes A:A1
and A:A2. This may happen in the following scenarios:

l Different IP addresses discovered in different topology runs of a policy.

l Discovery of a large bulk of topology data where different IP addresses appear in different
places of the bulk (not together).

Possible solutions: To avoid or overcome the limitation, the following approaches are possible:

l To avoid the limitation, wherever possible, make sure that node information appears together in
one place of the discovered topology bulk. After nodes with multiple IP addresses have been
fully populated, they can be referenced using partial information; for example, after a node with
several IP addresses has been created in the RTSM, only its name and a single IP address can
be used to populate a running software CI for the node.

For more information on the node identification and reconciliation rule, as well as theminimal set
of attributes required to identify a node CI correctly, access RTSM Administration > CI Type
Manager > Select Node CIT > Details tab > Identification.

l To overcome the limitation, apply manual reconciliation in RTSM.

For more information about reconciliation in the RTSM, see the section on "Reconciliation" in the
Data Flow Management Guide.
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Part III: Integrating Data With BSM Connector
This section includes:

l "Database Policies" on page 199

l "Log File Policies" on page 237

l "OpenMessage Interface Policies" on page 287

l "Scheduled Task Policies" on page 299

l "SNMP Trap Policies" on page 316

l "Topology Policies" on page 324

l "Web Service Listener Policies" on page 382

l "XML File Policies" on page 427



Chapter 10: Database Policies
Database policies enable you to collect data from database tables used by third-party systems by
performing a query through a JDBC connection.

The following are examples of data that can be integrated into BSM using database policies:

l Events frommonitoring applications event tables or views.

l Data frommonitoring applications metrics tables.

l Topology from a third-party topology database.

What Data Is Forwarded
Database policies use a user-defined query and enumerating field name, field type, and initial value.
While the query provided by the user is used to define a search criterion on the database, the
enumerating field is used so that data records are processed only once. Using an initial value
enables you to specify an initial threshold value for the data that should be processed.

For example, if Enumerating Field Type uses DATE and Initial enumerating value uses 2003-
20-03 12:00:00, only data records that happened after the specified date are processed in the
first run of the policy. In subsequent runs, the highest value for the DATE field found is used to
verify that only new data is processed. For a details on how data from the enumerating field is
processed, see "Understanding How Data in the Enumerating Field is Processed" on page 205.

You use defaults and rules to control the data that is sent from BSMConnector to BSM.

Data can also bemapped to a topology to forward data to the correct CI hierarchy in BSM. You can
configure topology settings for the policy by selecting one of the out-of-the-box scripts, or
configuring your own custom topology script during policy creation.

How to Collect Event Data from Databases
This task describes how to collect event data and optionally topology data from databases.

1. Prerequisite:Make sure your BSM Connector is set up as a BSMConnector integration server
in BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see the BSM online
help or the BSM Application Administration Guide.

2. In the BSMConnector user interface, click in the toolbar. Then click Event > Database.

Alternatively, double-click an existing policy to edit it.

3. In theProperties page, define information that is related to the policy itself (for example, the
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name and description of the policy).

For details, see "Configuring Database Policy Properties" on page 203.

4. In theSource page, define the connection to the database and the columns that the policy
accesses.

For details, see "Configuring the Data Source in Database Policies" on page 204.

5. In theMappings page, configure the default mappings of table columns to custom variables.

For details, see "ConfiguringMappings in Database Policies" on page 210.

6. Optional. In theDefaults page, configure the default settings for all events generated by the
policy (for example, default event correlation settings).

For details, see "Configuring Event Defaults in Database Policies" on page 213.

7. In theRules page, define what the policy should do in response to a specific type of event.

For details, see "Configuring Event Rules in Database Policies" on page 217.

8. In theOptions page, configure several policy behaviors (for example, patternmatching
options).

For details, see "Configuring Options in Database Policies" on page 224.

9. In the Topology page, select or create a script that creates a topology in BSM's RTSM that
represents your third-party system.

For details, see "Configuring Topology Scripts in Database Policies" on page 226.

Note: For detailed information on topology scripts, see "Working with Jython-Based
Topology Scripts " on page 180.

10. Click OK to save the policy and close the editor.

11. Optional. If the list of policies does not refresh automatically in the BSMConnector user
interface, click in the toolbar.

How to Collect Metrics Data from Databases
This task describes how to collect metrics and optionally topology data from databases.

Note: For examples and end-to-end workflow information on collectingmetrics data with or
without topology, see "Collecting and ViewingMetrics Data" on page 139. See "Tips and
Tricks" on page 176 for information on what to do and what to avoid when collectingmetrics.
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1. Prerequisite:Make sure your BSM Connector is set up as a BSMConnector integration server
in BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see the BSM online
help or the BSM Application Administration Guide.

2. In the BSMConnector user interface, click in the toolbar. Then click Metrics >
Database.

Alternatively, double-click an existing policy to edit it.

3. In theProperties page, define information that is related to the policy itself (for example, the
name and description of the policy).

For details, see "Configuring Database Policy Properties" on page 203.

4. In theSource page, define the connection to the database and the columns that the policy
accesses.

For details, see "Configuring the Data Source in Database Policies" on page 204.

5. Optional. In theDefaults page, assign default values to themetric attributes.

For details, see "ConfiguringMetrics Defaults in Database Policies" on page 215.

6. In theRules page, define what the policy should do in response to a specific metric.

For details, see "ConfiguringMetrics Rules in Database Policies" on page 221.

7. In the Topology page, select or create a script that creates a topology in BSM's RTSM that
represents your third-party system.

For details, see "Configuring Topology Scripts in Database Policies" on page 226.

Note: For detailed information on topology scripts, see "Working with Jython-Based
Topology Scripts " on page 180.

8. Click OK to save the policy and close the editor.

9. Optional. If the list of policies does not refresh automatically in the BSMConnector user
interface, click in the toolbar.

How to Collect Topology Data Only from Databases
You can have BSMConnector report only the topology discovered by the BSMConnector database
policies.

This task describes how to collect topology data from database tables.
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Note: For detailed information on topology scripts, see "Working with Jython-Based Topology
Scripts " on page 180.

1. Prerequisite:Make sure your BSM Connector is set up as a BSMConnector integration server
in BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see the BSM online
help or the BSM Application Administration Guide.

2. In the BSMConnector user interface, click in the toolbar. Then click Topology >
Database.

Alternatively, double-click an existing policy to edit it.

3. In theProperties page, define information that is related to the policy itself (for example, the
name and description of the policy).

For details, see "Configuring Database Policy Properties" on the next page.

4. In theSource page, define the connection to the database and the columns that the policy
accesses.

For details, see "Configuring the Data Source in Database Policies" on page 204.

5. In the Topology page, select or create a script that creates a topology in BSM's RTSM that
represents your third-party system.

For details, see "Configuring Topology Scripts in Database Policies" on page 226.

6. Click OK to save the policy and close the editor.

7. Optional. If the list of policies does not refresh automatically in the BSMConnector user
interface, click in the toolbar.

Database Policy User Interface
Database policies display different pages depending on the type of data they are integrating and on
the policy origin.

Choose the type of data you want to integrate and then complete the following tasks:

Event data (optionally with topology data)

l "Configuring Database Policy Properties" on the next page

l "Configuring the Data Source in Database Policies" on page 204
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l "ConfiguringMappings in Database Policies" on page 210

l "Configuring Event Defaults in Database Policies" on page 213

l "Configuring Event Rules in Database Policies" on page 217

l "Configuring Options in Database Policies" on page 224

l "Configuring Topology Scripts in Database Policies" on page 226

Metrics data (optionally with topology data)

l "Configuring Database Policy Properties" below

l "Configuring the Data Source in Database Policies" on the next page

l "ConfiguringMetrics Defaults in Database Policies" on page 215

l "ConfiguringMetrics Rules in Database Policies" on page 221

l "Configuring Topology Scripts in Database Policies" on page 226

Topology data only

l "Configuring Database Policy Properties" below

l "Configuring the Data Source in Database Policies" on the next page

l "Configuring Topology Scripts in Database Policies" on page 226

Migrated SiteScope technology integrationmonitors (common and legacy events)

l "Configuring Database Policy Properties" below

l "Configuring the Data Source in Database Policies" on the next page

l "Configuring Field Mapping in Database Policies" on page 225

l "Configuring Topology Scripts in Database Policies" on page 226

Configuring Database Policy Properties
Every policy has a set of properties that identify and describe the policy. Properties include, for
example, the policy name and a description of what the policy does.

To access

l In the BSMConnector user interface, click in the toolbar. Then click Event > Database.

l In the BSMConnector user interface, click in the toolbar. Then click Metrics >
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Database.

l In the BSMConnector user interface, click in the toolbar. Then click Topology >
Database.

Alternatively, double-click an existing policy to edit it.

Tasks

How to configure policy properties
In the Properties page, type a name for the policy. You can use spaces in the name. The equal sign
(=) is not allowed.

Related tasks

l "How to Collect Event Data from Databases" on page 199

l "How to Collect Metrics Data from Databases" on page 200

l "How to Collect Topology Data Only from Databases" on page 201

UI Descriptions

For a description of the Properties page, see "Properties Page" on page 494.

Configuring the Data Source in Database Policies
The source page of the database policy editor enables you to set up the connection to the database
and to specify which database tables the policy accesses.

To access

l In the BSMConnector user interface, click in the toolbar. Then click Event > Database.

l In the BSMConnector user interface, click in the toolbar. Then click Metrics >
Database.

l In the BSMConnector user interface, click in the toolbar. Then click Topology >
Database.

Alternatively, double-click an existing policy to edit it.

Click Source to open the policy Source page.

Learn More

This section includes:
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l "Database drivers packages supplied with BSM Connector" below

l "Understanding How Data in the Enumerating Field is Processed" below

Database drivers packages supplied with BSM Connector
BSMConnector provides the following database driver packages:

Database Driver Database Database Driver String

DB2Driver IBM DB2 com.mercury.jdbc.db2.DB2Driver

OracleDriver Oracle com.mercury.jdbc.oracle.OracleDriver

SQLServerDriver Microsoft SQL Server com.mercury.jdbc.sqlserver.SQLServerDriver

SybaseDriver Sybase com.mercury.jdbc.sybase.SybaseDriver

Note: The database drivers supplied with BSM Connector should only be used in test
environments. For production environments, it is recommended that you install a compatible
JDBC database driver to ensure best performance.

Understanding How Data in the Enumerating Field is Processed
Since the data in the enumerating field is not a unique key, the data in the column used for the
enumerating field must have constantly increasing values or values that changed since the policy
run. For example, if before the first policy run the table contains the following data:

Run 1:

ENUM_FIELD DATA_NAME

1 Alice

1 Alice

2 Bob

The policy reads all entries, stores "1" as the position where all data was sent, and skips the lines
with ENUM_FIELD=2, because there is a possibility that new lines with ENUM_FIELD=2will be
added later.

Run 2:

ENUM_FIELD DATA_NAME

1 Alice

1 Alice

2 Bob
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ENUM_FIELD DATA_NAME

2 Bob

2 Bob

At the end of the run, the policy runs a query with the filter "where ENUM_FIELD>1". However, it
does not send any data because it did not reach the end of the values listed as having ENUM_
FIELD=2. The policy cannot send this partial list until a new higher value appears in the table.

Run 3:

ENUM_FIELD DATA_NAME

1 Alice

1 Alice

2 Bob

2 Bob

2 Bob

3 Charlie

At this stage, the policy runs the same query with the filter "where ENUM_FIELD>1", and sends all
the data with ENUM_FIELD equals to 2. It also updates the internal variable for last read position to
2, and skips the last line with ENUM_FIELD equals to 3, until new lines with a value higher than 3
appears.

Tasks

This section includes:

l "How to configure the prerequisites" below

l "How to configure the database source" on page 209

How to configure the prerequisites

l There are several key database driver requirements for using this policy.

n You can use the database drivers supplied with BSM Connector by default, or you can install
or copy a compatible JDBC database driver or database access API into the required BSM
Connector directory location. Many database driver packages are available as compressed
(zipped) archive files or .jar files. Copy the downloaded driver file into the <BSM Connector
root directory>\WEB-INF\lib subdirectory. If the file is in zip format, unzip the contents to a
temporary directory. Stop and restart the BSM Connector service after copying the driver file
to the BSMConnector machine.
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n Youmust know the syntax for accessing the database driver. Examples of common
database driver strings are:

o com.mercury.jdbc.sqlserver.SQLServerDriver. DataDirect driver from DataDirect
Technologies. It is a driver for thoseMicrosoft SQL databases that useWindows
authentication. For details on installing the driver, see the note below.

Note: To install theMSSQL JDBC driver:

o Download theMSSQL JDBC driver fromMicrosoft:

Microsoft SQL Server JDBC Driver 3.0: http://www.microsoft.com/en-
us/download/details.aspx?displaylang=en&id=21599

Microsoft JDBC Driver 4.0 for SQL Server: http://www.microsoft.com/en-
us/download/details.aspx?displaylang=en&id=11774

Unzip the contents to a temporary directory:

o Copy the sqljdbc4.jar file to the <BSM Connector root directory>\WEB-
INF\lib\ subdirectory.

o Restart theBSM Connector service.

o com.mercury.jdbc.oracle.OracleDriver. A driver for Oracle databases. This driver is
deployed with BSM Connector. When using the driver, the database connection URL has
the form of: jdbc:mercury:oracle://<server name or IP address>:<database
server port>;sid=<sid>

o oracle.jdbc.driver.OracleDriver. BSMConnector supports the following categories of
JDBC driver that are supplied by Oracle:

o JDBC thin driver for Oracle 7 and 8 databases.

o JDBC OCI (thick) driver.

You can access anOracle database using anOCI driver. If the port or SID are
changed, you only need tomake the change in the tnsnames.ora file (the database
policy editors remain unchanged).

o On the BSMConnector server, install the version of Oracle client that you are
using.

o Connect to the Oracle database using the Oracle OCI driver.

o Set ORACLE_HOME environment variable (ORACLE_HOME is the folder
where the Oracle client or database has been installed).
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o AddORACLE_HOME\lib to System PATH (onWindows platforms), or LD_
LIBRARY_PATH env variable (on UNIX platforms).

o Set CLASSPATH environment variable to useOracle JDBC driver from
ORACLE_HOME\jdbc\lib.

o In the \oracle\oraX\network\admin\tnsnames.ora file, configure the service
name.

o Add a database policy to BSM Connector, and configure the following settings in
the Basic Settings panel in the Source page:

o Database connection URL: jdbc:oracle:oci8:@<server name>

o Database driver: oracle.jdbc.driver.OracleDriver

o Enter the database user credentials in theDatabase user name and Database
password boxes

o org.postgresql.Driver. The database driver for the Postgresql database.

l Youmust know the syntax for the Database Connection URL. The Database Connection URL
normally includes the class of driver you are using, some key name relating to the supplier of the
driver software, followed by a combination of server, host, and port identifiers. Database
Connection URLs for this policy are:

n jdbc:mercury:sqlserver://<hostname>:1433;DatabaseName=master;
AuthenticationMethod=type2
where <hostname> is the name of the host where the database is running.

n jdbc:mercury:Sybase://<hostname>:<port>;DatabaseName=<dbname>;
where <hostname> is the name of the host where the database is running, <port> is the port
on which the database interfaces with the driver, and <dbname> is the name of the Sybase
database instance. The default Sybase port is 5000.

n jdbc:mercury:DB2:// <hostname>:<port>;DatabaseName=<dbname>;
where <hostname> is the name of the host where the database is running, <port> is the port
on which the database interfaces with the driver, and <dbname> is the name of the DB2
database instance. The default DB2 port is 50000.

n jdbc:mercury:oracle://<hostname or IP address>:<port>;sid=<sid>
where <hostname> is the name of the host where the database is running, <port> is the port
on which the database interfaces with the driver, and <sid> is the Oracle system ID.

n jdbc:oracle:thin:@<hostname>:<port>:<dbname>
where <hostname> is the name of the host where the database is running, <port> is the port
on which the database interfaces with the driver, and <dbname> is the name of the Oracle
database instance.
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l The database you want to query must be running, have a database name defined, and have at
least one named table created in the database. In some cases, the databasemanagement
software needs to be configured to enable connections by using themiddleware or database
driver.

l You need a valid user name and password to access and perform a query on the database. In
some cases, themachine and user account that BSM Connector is running onmust be given
permissions to access the database.

l Youmust know a valid SQL query string for the database instance and database tables in the
database you want to query. Consult your database administrator to work out required queries to
use.

l Use a database client to connect to the relevant software database. Identify which tables
contain the required data (the software schema documentationmay help you with this).

l WhenWindows authentication is used to connect to the database, configure BSM Connector
using the following settings:

n JDBC Connection string: jdbc:mercury:sqlserver://<hosthost>:1433;
DatabaseName=master;AuthenticationMethod=type2

n JDBC driver: com.mercury.jdbc.sqlserver.SQLServerDriver.

n Leave theDatabase User name andDatabase Password fields empty, because the
Windows user credentials of the account from which the BSMConnector service is running
are used to establish a connection to the database.

How to configure the database source
This task describes how configure the database source and how the policy queries the database.

1. Configure the connection to the database:

a. In theDatabase Connection URL field, type the URL to the database connection
(sometimes referred to as an Authentication string).

Example: jdbc:mercury:sqlserver://dbserver.example.com:1433;
DatabaseName=BSMEVENTS;AuthenticationMethod=type2

b. In theDatabase Driver field, type the driver used to connect to the database. Use the Fully
Qualified Class Name of the JDBC driver you are using.

Example: com.mercury.jdbc.sqlserver.SQLServerDriver

c. Specify how often the policy queries the database. Use the drop-down list to specify
increments of seconds, minutes, hours, or days.

d. Specify how long the policy tries to connect to the database. Use the drop-down list to
specify increments of seconds. The timeout periodmust be shorter than the frequency.
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2. Specify the query:

a. In theSELECT field, type the SELECT clause to be used in the SQL query. Enter * for all
fields or a comma separated list of column names to be retrieved from the database.

Example: TITLE,DESCRIPTION,SEVERITY,NODEHINT,CIHINT,TIMERECEIVED,ID,
IPADDRESS

b. In the FROM field, type the FROM clause to be used in the SQL query. Enter a table name
or a comma separated list of tables from which the selected columns should be extracted.

Example: ALL_EVENTS

c. In theEnumerating field field, type the name for a database field that can be used to order
the events that are returned from the database query.

Example: ID

d. InEnumerating field type, select the type of field used to order the result set. This can be
a DATE field, an INTEGER field, a DOUBLE floating point numeral field, or a LONG field.

e. In the Initial Enumerating Value field, type the initial value to be used as a condition for
the initial run of this policy.

f. In theMax rows to fetch field, type themaximum number of rows the policy retrieves from
the database for each run.

3. Click to retrieve the specified table columns from the database. The results are displayed in
the Sample Data tabs of the policy.

Related tasks

l "How to Collect Event Data from Databases" on page 199

l "How to Collect Metrics Data from Databases" on page 200

l "How to Collect Topology Data Only from Databases" on page 201

UI Descriptions

For a description of the Source page, see the following sections:

l "Source Page - Database Policies - Basic andQuery Settings" on page 503

l "Source Page - Database Policies - Sample Data" on page 505

Configuring Mappings in Database Policies
TheMappings page enables you tomap columns of database tables to custom variables.
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To access
In the BSMConnector user interface, click in the toolbar. Then click Event > Database.

Alternatively, double-click an existing policy to edit it.

Click Mappings to open the policy Mappings page.

Learn More

Mappings overview
A custom variable consists of amap name, an optional database table column, and one or more
source and target value pairs. For example, you can assign the table column SEVERITY to themap
name mapSeverity, and add a source value of Serious. You can then assign the target value
critical to the variable so that BSM Connector inserts the value critical into the event in all
places where the variable is used and the source value is Serious in the log file.

Table columns use the following syntax: <$DATA:/BSMConnectorEvent/<table_column>>

<table_column> is the name of the table column in the third-party database.

For example, the custom variable mapSEVERITY has the table column SEVERITY assigned.

Assigning a table column to amap name is optional. If you do not assign a table column to a
variable, youmust add the source value directly to the variable when you insert the variable in an
event attribute.

The Sample Data tab is empty if no sample data has been loaded into the policy or if the database
query fails.

The Table Column tab shows the following information, if sample data is available:

l Table columns

If sample data is available, then the Table Column section shows the table columns specified in
the query.

You can sort the information that appears in the Table Column section so that data appears in
either ascending or descending order, indicated by either an up or down arrow at the top of the
list. The items in the Table Column section are by default sorted alphabetically in ascending
order. To change the sort order, click the arrow at the top of the list.

l Values

The Values section displays the values of a column selected in the Table Columns section. If a
value appears more than once, click to show or hide duplicate values. To find values that
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belong tomore than one row, select the value and click . The Database Sample Data window
opens and shows all rows that have the selected value.

When you drag a column from the table columns list and drop it on the Default ValueMapping list,
BSM Connector automatically adds the default prefix map to themap name and inserts the table
column. You can then drag one or more column source values from the values list and drop them on
the Source Value list. You then finally only have to type the target values.

Tasks

How to configure mappings for table columns
This task describes how tomap table columns to custom variables.

1. Create one or more custom variables.

If you are working with sample data, drag the table column from the table column list to theMap
Name column. BSM Connector automatically adds the default prefix map to themap name and
inserts the column name.

Alternatively, click above theMapName column and type the variable name in themap
name field. Columns are optional. If you do not assign a column to a variable, youmust add the
source value directly to the variable when you insert the variable in an event attribute.

2. Add one or more source and target value pairs to each custom variable.

n If you are working with sample data, drag the value from the Values list to the Source Value
column, and type the target value in the corresponding field.

Alternatively, click above the Source Value column and type the source and target values
in the corresponding fields.

n Optionally, use the Indicators tab to add indicators to the source or target value fields. After
loading the indicators from the connected BSM server, the Indicators tab shows a hierarchy
of configuration item types with the associated health indicators (HIs) and event type
indicators (ETIs).

To insert an indicator in a source or target value field, drag and drop the indicator name (for
example, Normal) or the indicator name and state (for example, HTTPServer:Normal) from
the Indicators tab to the policy. Use theSelect target drop format panel to toggle between
inserting indicator names only and inserting indicator names and states.

Related tasks

l "How to Collect Event Data from Databases" on page 199

UI Descriptions

For a description of theMappings page, see the following sections:
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l "Mappings Page (Events Only)" on page 482

l "Sample Data Tab- Database Policies" on page 497

l "Indicators Tab" on page 481

Configuring Event Defaults in Database Policies
The Events page enables you to indicate default settings for all events generated by the policy.

These defaults affect all new and existing rules. You can override the defaults in individual rules if
needed. If a rule contains empty event attributes, the agent will use the defaults for the new event.

To access
In the BSMConnector user interface, click in the toolbar. Then click Event > Database.

Alternatively, double-click an existing policy to edit it.

Click Defaults to open the policy Default Event Attributes page.

Tasks

How to configure event defaults for database policies
This task describes how to configure default settings for all events generated by the policy.

1. Click Event Attributes to define default event attributes, such as severity and category.

Tip: After loading the indicators from the connected BSM server, the Indicators tab shows
a hierarchy of configuration item types with the associated health indicators (HIs) and
event type indicators (ETIs).

To insert an indicator, drag and drop the indicator, indicator state, or both from the
Indicators tab to the policy. Use theSelect target drop format panel to toggle between
inserting indicator names only and inserting indicator names and states.

2. Click Event Correlation to set the type of duplicate event suppression and define themethod
used to suppress duplicate events.

3. Click Custom Attributesto add additional information to all events generated by this policy.
For example, youmight add a company name, contact information, or a city location to an
event.

4. Click Advanced to define default advanced attributes such as legacy HPOM attributes and
agent MSI (Message Stream Interface) settings.

5. Optionally, use theSample Data tab to drag table columns and values to the policy fields.
Alternatively, you can type the path to the table column directly into the attribute box.
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Table columns use the following syntax: <$DATA:/BSMConnectorEvent/<table_column>>

<table_column> is the name of the table column in the third-party database.

BSM Connector replaces the table column at runtime with the value of the specified column. If
you insert a column value, the value will be used.

Note: The Sample Data tab is empty if no sample data has been loaded into the policy or if
the database query did not succeed. See also "Configuring the Data Source in Database
Policies" on page 204.

6. Optionally, use theMappings tab to addmapping definitions to the attribute boxes.

Mappings are custom variables that you define in theMappings page (see also "Configuring
Mappings in Database Policies" on page 210). To insert a custom variable, you can drag it from
theMappings list and drop it on the event attribute.

Alternatively, type the custom variable into the attribute box using the following syntax:

<$MAP(<custom_variable>)> where <custom_variable> is themap name of the variable (for
example, <$MAP(mapSEVERITY)>).

If the custom variable does not have a table column assigned, use the following syntax:

<$MAP(<custom_variable>,<<source_value>>) where <source_value> can be one of the
following:

n Name of the table column, for example <$MAP(mapSEVERITY)>,
<$DATA:/BSMConnectorEvent/SEVERITY>

n The source value itself, for example <$MAP(SEVERITY)>,Critical)>

Related tasks

l "How to Collect Event Data from Databases" on page 199

UI Descriptions

For a description of the Defaults page, see the following sections:

l "Event Attributes Tab" on page 459

l "Event Correlation Tab" on page 465

l "Custom Attributes Tab" on page 469

l "Advanced Tab" on page 470
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l "Sample Data Tab- Database Policies" on page 497

l "Mappings Tab (Events Only)" on page 483

l "Indicators Tab" on page 481

l "Policy Variables Tab (Events Only)" on page 491

Configuring Metrics Defaults in Database Policies
The Default Monitor Attributes page enables you to assign default values to themetric attributes.
The values can be used when defining the policy rules on the Rules tab, and can also be overridden
there.

Note: For examples and end-to-end workflow information on collectingmetrics data with or
without topology, see "Collecting and ViewingMetrics Data" on page 139. See "Tips and
Tricks" on page 176 for information on what to do and what to avoid when collectingmetrics.

To access
In the BSMConnector user interface, click in the toolbar. Then click Metrics > Database.

Alternatively, double-click an existing policy to edit it.

Click Defaults to open the policy Default Monitor Attributes page.

Learn More

Metrics attributes
Each time ametrics policy runs, it extracts raw data from its defined data source and builds a
metric structure, which it then forwards to BSM.

A metric structure consists of these attributes:

l Attributes related to themetrics source, category, or status:

n Monitor name

n Monitor type

n Target

n Time stamp

n Quality

n Monitor state

l Attributes related to a specific metric in the source:

BSM Connector User Guide
Chapter 10: Database Policies

HP Business ServiceManagement (9.23) Page 215 of 521



n Name

n Value

n CI hint

n Indicator name

Tasks

How to configure metrics defaults for database policies
This task describes how to configuremetric attribute defaults for all metrics collected by this policy.

1. Define the default metric attributes common to all metrics collected by this policy, such as
monitor name, type, and state.

Tip: The Policy Constants tab lists the available constants representingmetrics quality
(status) that are available in BSM Connector. Use drag and drop to add them to the
Quality attribute.

2. InMetrics, click to add attributes specific to a single metric.

Alternatively, expand an existingmetric group to edit it.

Tip: After loading the indicators from the connected BSM server, the Indicators tab shows
a hierarchy of configuration item types with the associated health indicators (HIs) and
event type indicators (ETIs).

To insert an indicator, drag and drop the indicator from the Indicators tab to the policy.
BSM Connector inserts the indicator name.

3. Optionally, use theSample Data tab to drag table columns and values to the policy fields.
Alternatively, you can type the table column directly into the attribute boxes.

Table columns use the following syntax: $<table_column>

<table_column> is the name of the table column in the third-party database.

BSM Connector replaces the table column at runtime with the value of the specified column. If
you insert a column value, the value will be used.

Note: The Sample Data tab is empty if no sample data has been loaded into the policy or if
the database query did not succeed. See also "Configuring the Data Source in Database
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Policies" on page 204.

4. Optionally, use theOperations tab to apply operations to themetric attribute values.

Related tasks

l "How to Collect Metrics Data from Databases" on page 200

l "How to Collect Metrics with Computer - Monitor Topology" on page 142

l "How to Collect Metrics with Custom, Computer, or Computer - Running Software Topology
Data" on page 147

l "How to Collect Metrics Without Reporting Topology" on page 160

UI Descriptions

For a description of the Defaults page, see the following sections:

l "Default Monitor Attributes and Attributes Tabs" on page 478

l "Sample Data Tab- Database Policies" on page 497

l "Indicators Tab" on page 481

l "Operations Tab (Metrics Only)" on page 483

l "Policy Constants Tab (Metrics Only)" on page 491

Configuring Event Rules in Database Policies
Rules define what a policy should do in response to a specific type of event. Each rule consists of a
condition and of settings for the event generated by the policy. The condition is the part of a policy
that describes the source. The settings enable you to configure the event that BSM Connector
sends to BSM.

A policy must contain at least one rule. If the policy contains multiple rules, it is important to
remember that the rules are evaluated in a specific order, and that when one condition is matched,
no additional rules will be evaluated.

To access

l In the BSMConnector user interface, click in the toolbar. Then click Event > Database.

Alternatively, double-click an existing policy to edit it.

Click Rules to open the policy Rules page.
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Learn More

Rule types
The rule types are:

l Event on matched rule. If matched, BSM Connector sends an event to BSM. The event uses
the settings defined for the rule. If you do not configure these settings, the default settings are
used.

l Suppress on matched rule. If matched, BSM Connector stops processing and does not send
an event to BSM.

l Suppress on unmatched rule. If not matched, BSM Connector stops processing and does not
send an event to BSM.

Tasks

How to configure rules in database policies
This task describes how configure policy rules.

1. In thePolicy Rules section, click and select the type of rule to define what the policy
should do in response to a specific value in a table column. Each policy must have at least one
rule.

2. In theRule Content section, use theCondition tab to specify the table column and values
that the policy searches for in the database that the policy accesses. If the policy finds a
match, it may or may not generate an event, depending on the rule type.

a. Click to create a new condition. New conditions by default use the equals operator.

b. Click to expand the new condition.

c. In theProperty field, specify the table column that the policy searches for. Youmust prefix
the column namewith /BSMConnectorEvent/ (for example,
/BSMConnectorEvent/SEVERITY).

If you are working with sample data, you can drag and drop the table column from the Table
Column list to the Properties field.

d. Select the pattern operator.

If you select thematches operator, you can type a pattern in the Operand field. For a list of
available operators, see "Configuring Event Rules in Database Policies" on the previous
page.

e. In theOperand field, type the value or pattern that you want the policy to compare with the
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table column. If you are working with sample data, you can drag the value from the Values
list and drop it in the Operand field.

Tip: You can use standard BSM Connector pattern-matching rules whenmatching
values. Select thematches operator and click in the Operand field to open the
patternmatching expression toolbox. The toolbox displays the following:

o Pattern Matching Expressions. Click an expression to insert it in the Operand
field.

o Variable Bindings Options. Variable bindings options include case sensitivity
and field separators for the rule. If you do not specify patternmatching options for
the rule, either the defaults (case sensitive; a blank and the tab character as
separators) or the default options set for the policy will be used. See also
"Configuring Options in Database Policies" on page 224.

3. Use theEvent Attributes tab to define event attributes (for example, event title and
description) for all events generated by this rule.

Tip: After loading the indicators from the connected BSM server, the Indicators tab shows
a hierarchy of configuration item types with the associated health indicators (HIs) and
event type indicators (ETIs).

To insert an indicator, drag and drop the indicator, indicator state, or both from the
Indicators tab to the policy. Use theSelect target drop format panel to toggle between
inserting indicator names only and inserting indicator names and states.

4. Use theEvent Correlation tab to set the type of duplicate event suppression and define the
method used to suppress duplicate events.

5. Use theCustom Attributes tab to add additional information to all events generated by this
rule. For example, youmight add a company name, contact information, or a city location to an
event.

6. Use theAdvanced tab to define an event drill-downURL, legacy HPOM attributes, and agent
MSI (Message Stream Interface) settings.

7. Optionally, use theSample Data tab to drag table columns and values to the policy fields.
Alternatively, you can type the path to the table column directly into the attribute box.

Table columns use the following syntax: <$DATA:/BSMConnectorEvent/<table_column>>

<table_column> is the name of the table column in the third-party database.

BSM Connector replaces the table column at runtime with the value of the specified column. If
you insert a column value, the value will be used.
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Note: The Sample Data tab is empty if no sample data has been loaded into the policy or if
the database query did not succeed. See also "Configuring the Data Source in Database
Policies" on page 204.

8. Optionally, use theMappings tab to addmapping definitions to the attribute boxes.

Mappings are custom variables that you define in theMappings page (see also "Configuring
Mappings in Database Policies" on page 210). To insert a custom variable, you can drag it from
theMappings list and drop it on the event attribute.

Alternatively, type the custom variable into the attribute box using the following syntax:

<$MAP(<custom_variable>)> where <custom_variable> is themap name of the variable (for
example, <$MAP(mapSEVERITY)>).

If the custom variable does not have a table column assigned, use the following syntax:

<$MAP(<custom_variable>,<<source_value>>) where <source_value> can be one of the
following:

n Name of the table column, for example <$MAP(mapSEVERITY)>,
<$DATA:/BSMConnectorEvent/SEVERITY>

n The source value itself, for example <$MAP(SEVERITY)>,Critical)>

9. Optionally, use thePattern Matching Variables tab to add variables created through pattern
matching.

Patternmatching variables insert matched strings that have previously been assigned to
variables. To insert a patternmatching variable, type the variable name enclosed in angle
brackets (for example, <variablename>) or drag and drop it from the PatternMatching
Variables list to the event attribute.

10. Optionally, use thePolicy Variables tab to add policy variables to event attributes. BSM
Connector replaces the variables with the appropriate values in the generated event.

It is often useful to surround the variable with quotationmarks, especially if it may return a
value that contains spaces, for example "<$MSG_NODE>".

Related tasks

l "How to Collect Event Data from Databases" on page 199

l "How to Collect Metrics Data from Databases" on page 200

UI Descriptions

For a description of the Rules page, see the following sections:
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l "Rules Page - Policy Rules" on page 495

l "Condition Tab - Rules Only" on page 472

l "Event Attributes Tab" on page 459

l "Event Correlation Tab" on page 465

l "Custom Attributes Tab" on page 469

l "Advanced Tab" on page 470

l "Sample Data Tab- Database Policies" on page 497

l "Mappings Tab (Events Only)" on page 483

l "PatternMatching Variables Tab (Event Rules Only)" on page 491

l "Indicators Tab" on page 481

l "Policy Variables Tab (Events Only)" on page 491

Configuring Metrics Rules in Database Policies
Rules define what a policy should do in response to a specific type of metric. Each rule consists of
a condition and of settings for themetrics generated by the policy. The condition contains the string
or pattern that must bematched for the rule to apply. The settings enable you to configure the
metrics that BSM Connector sends to BSM.

If the policy contains multiple rules, it is important to remember that the rules are evaluated in a
specific order, and that when one condition is matched, no additional rules will be evaluated.

Note: For examples and end-to-end workflow information on collectingmetrics data with or
without topology, see "Collecting and ViewingMetrics Data" on page 139. See "Tips and
Tricks" on page 176 for information on what to do and what to avoid when collectingmetrics.

To access
In the BSMConnector user interface, click in the toolbar. Then click Metrics > Database.

Alternatively, double-click an existing policy to edit it.

Click Rules to open the policy Rules page.

Learn More

This section includes:
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l "Rule types" below

l "Metrics attributes" below

Rule types
The rule types are:

l Process on matched rule. If matched, BSM Connector sends metrics to BSM. Themetrics
use the settings defined for the rule. If you do not configure these settings, the default settings
are used.

l Suppress on matched rule. If matched, BSM Connector stops processing and does not send
metrics to BSM.

l Suppress on unmatched rule. If not matched, BSM Connector stops processing and does not
sendmetrics to BSM.

Metrics attributes
Each time ametrics policy runs, it extracts raw data from its defined data source and builds a
metric structure, which it then forwards to BSM.

A metric structure consists of these attributes:

l Attributes related to themetrics source, category, or status:

n Monitor name

n Monitor type

n Target

n Time stamp

n Quality

n Monitor state

l Attributes related to a specific metric in the source:

n Name

n Value

n CI hint

n Indicator name
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Tasks

How to configure rules for metrics in database policies

1. In thePolicy Rules section, click and select the type of rule to define what the policy
should do in response to a specific string in the table column.

2. In theRule Content section, use theCondition tab to define thematch condition.

Thematch conditionmust be a valid boolean expression. The expression can contain one or
more operations from theOperations tab. The expression can access the contents of the data
that is being processed using the dollar sign ($) notation.

3. Optional. If you are creating a rule of the type 'process onmatched rule', set Attributes for
metrics that you want the policy to send. If default attributes are specified in the Defaults tab,
you use the defaults or you can override them as described below.

The attributes are in two groups: common attributes at the top that apply to all metrics defined
this policy, and attributes specific to eachmetric.

a. Define themetric attributes common to all metrics collected by this policy, such as monitor
name, type, and state.

Tip: The Policy Constants tab lists the available constants representingmetrics
quality (status) that are available in BSM Connector. Use drag and drop to add them to
theQuality attribute.

b. InMetrics, click to add attributes specific to a single metric.

Alternatively, expand an existingmetric group to edit it.

Tip: After loading the indicators from the connected BSM server, the Indicators tab
shows a hierarchy of configuration item types with the associated health indicators
(HIs) and event type indicators (ETIs).

To insert an indicator, drag and drop the indicator from the Indicators tab to the policy.
BSM Connector inserts the indicator name.

You can createmultiple metrics.

Click to expand ametric attribute group

4. Optionally, use theSample Data tab to drag table columns and values to the policy fields.
Alternatively, you can type the table column directly into the attribute boxes.

Table columns use the following syntax: $<table_column>
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<table_column> is the name of the table column in the third-party database.

BSM Connector replaces the table column at runtime with the value of the specified column. If
you insert a column value, the value will be used.

Note: The Sample Data tab is empty if no sample data has been loaded into the policy or if
the database query did not succeed. See also "Configuring the Data Source in Database
Policies" on page 204.

5. Optionally, use theOperations tab to apply operations to themetric attribute values.

Related tasks

l "How to Collect Metrics Data from Databases" on page 200

l "How to Collect Metrics with Computer - Monitor Topology" on page 142

l "How to Collect Metrics with Custom, Computer, or Computer - Running Software Topology
Data" on page 147

l "How to Collect Metrics Without Reporting Topology" on page 160

UI Descriptions

For a description of the Rules page, see the following sections:

l "Rules Page - Policy Rules" on page 495

l "Condition Tab (Rules Only)" on page 481

l "Default Monitor Attributes and Attributes Tabs" on page 478

l "Sample Data Tab- Database Policies" on page 497

l "Indicators Tab" on page 481

l "Operations Tab (Metrics Only)" on page 483

l "Policy Constants Tab (Metrics Only)" on page 491

Configuring Options in Database Policies
The options tab enables you to configure several policy behaviors, for example which events are
logged locally, how the policy handles unmatched events, and defaults for patternmatching in
policy rules.
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To access
In the BSMConnector user interface, click in the toolbar. Then click Event > Database.

Alternatively, double-click an existing policy to edit it.

Click Options to open the policy Options page.

Tasks

How to configure options for log file policies
In the Options page, configure which events are logged locally, how the policy handles unmatched
events, and defaults for patternmatching in policy rules.

For more information about the other fields, see "Configuring Options in Database Policies" on the
previous page.

Related tasks

l "How to Collect Event Data from Databases" on page 199

UI Descriptions

For a description of the Options page, see "Options Page (Events Only)" on page 489.

Configuring Field Mapping in Database Policies
The field mapping page is only available in policies that have beenmigrated from SiteScope
technology integrationmonitors of the data typeCommon Events or Legacy Events. The field
mapping defines the conversion rules from third-party data to the BSM event format.

You can use the field mapping page tomodify andmaintain the event field mapping inmigrated
integrationmonitor policies.

For more information on field mapping, see the SiteScope Help or the the Using SiteScopeGuide.

To access
In the BSMConnector user interface, select amigrated integrationmonitor policy and click in
the toolbar, or double-click an integrationmonitor policy. The integrationmonitor policy editor
opens. 

Click Field Mapping to open the policy Field Mapping page.

Learn More
Legacy and Common Events Data Type
In SiteScope, you can choose the Common Events or Legacy Events data type to integrate events
collected from third-party systems to BSM:
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l Common Events Integration. The SiteScope Common Events integration typemakes events
available for use in the following BSM applications:

n Operations Management

n Service Health

n Service Level Management

l Legacy Events Integration (deprecated). The SiteScope Legacy Events integrationmakes
events available for use in:

n System Availability Management Event Log

n BSM's Service Health

n Trend reports

For more information on common and legacy event integrations, see the SiteScope Help or the the
Using SiteScopeGuide.

Tasks
Related tasks

l "How toMigrate SiteScope Technology IntegrationMonitors" on page 40

UI Descriptions
For a description of the Field Mapping page, see "Field Mapping Page" on page 481.

Configuring Topology Scripts in Database Policies
The topology page enables you to create a topology in BSM's RTSM by selecting an out-of-the-box
script or creating your own custom script.

Note: For detailed information on topology scripts, see "Working with Jython-Based Topology
Scripts " on page 180.

To access

l In the BSMConnector user interface, click in the toolbar. Then click Event > Database.

l In the BSMConnector user interface, click in the toolbar. Then click Metrics >
Database.
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l In the BSMConnector user interface, click in the toolbar. Then click Topology >
Database.

Alternatively, double-click an existing policy to edit it.

Click Topology to open the policy Topology page.

Learn More
This section includes:

l "Selecting a Topology" below

l "Custom Topology Scripts" on page 229

l "Mandatory Values WhenReporting Topology Only" on page 229

Selecting a Topology
The following topology scripts are available for integrating events, metrics, and topology:

Topology Script
Events
Integration

Metrics
Integration

Topology
Integration

No Topology

Select if you do not want to send any topology
(althoughmetrics and event data is still sent).

yes yes not
available

Computer - Monitor (deprecated)

Creates a topology with a Computer CI connected to a
SiteScope CI with aMonitored By link.

Note:

The Computer - Monitor topology script has been
deprecated. For new metrics integrations, use the
Computer, Computer - Running Software, or a
custom topology script.

The Computer - Monitor topology integration
requires that the names or IP addresses of the
nodes that it adds to the RTSM are accessible
through DNS resolution. To successfully add a
Node CI specified in a policy's Target field to the
RTSM, BSMConnector must be able to resolve
the node's fully qualified domain name and IP
address through a DNS service.

not
available

yes not
available
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Topology Script
Events
Integration

Metrics
Integration

Topology
Integration

Computer

Creates a topology with a Computer CI.

The Computer topology script is not available in
migrated SiteScope technology integrationmonitors.

yes yes yes

Computer - Running Software

Creates a topology with a Computer CI and a Running
Software CI connected to it with aComposition
relationship. The following illustrates the topology
created for the Computer - Running Software
integration type which retrieves data from a third-party
system:

The Computer - Running Software topology script is
not available in migrated SiteScope technology
integrationmonitors.

yes yes yes

Custom

You create your own topology if you want the retrieved
data to be forwarded to specific CIs and not one of the
out-of-the-box topology scripts.

Note: You should only select Custom if you are
familiar with the Jython language, since youmust
create the topology script in Jython yourself.
Depending on the data type you want to collect,
we recommend that you select and edit one of the
out-of-the-box scripts.

yes yes yes
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Note: BSMConnector automatically populates theMonitored by attribute of the reported CIs
with the following values when using one of the out-of-the-box topology scripts:

l BSM Connector

l <policy name>where <policy name> is the name of the policy as set in the policy's
Properties page

Custom Topology Scripts
You can choose one of the out-of-the-box topologies which are already configured with the
necessary information, or you can create your own custom topology script.

To create a custom script, use the script editor provided in the Topology page, or use any other
script editor. Following are the guidelines for creating your own topology script:

l For general information on topology scripts, see "Working with Jython-Based Topology Scripts "
on page 180.

l Youmay use the following code to set theMonitored by attribute on the CIs reported by a
custom script:

ems_lib.addMonitoredByForThirdPartySoftware(Framework, <computer>)

l Use the following code to get the routing domain for a Node CI:

domainName = system_lib.getDiscoveryDomainByIP(Framework, <IP or node DNS
name>)

Formore information on the routing domain attribute in RTSM, see the Data Flow Management
Guide.

l You can access the names of database columns in database policies. For example, you can
access the value of the column NAME variable in the following way:

name = Framework.getDestinationAttribute("NAME")

Mandatory Values When Reporting Topology Only
The following values aremandatory when reporting only the topology discovered by the BSM
Connector policies, without reporting events or metrics data:
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For
Topology
Script

Field
Name Description

l Computer

l Computer -
Running
Software

target_
name

Name of the host or machine that generated the event. This can be
addedmanually or taken from:
Framework.getDestinationAttribute("<someAttribute>")

Examples:

Log file policies: Framework.getDestinationAttribute("group0") where
group0 is the value of the first patternmatching group.

Database policies: Framework.getDestinationAttribute("NAME")
where NAME is the name of a database column.

Web service listener policies: Framework.getDestinationAttribute
(“Host") where HOST is the key in the SOAP request
<key>Host</key>.

l Computer

l Computer -
Running
Software

target_
ip

IP of the host or machine. This can be addedmanually, or calculated
using:
HostIPCachingManager.getIPByHostName(target_name)

where target_name represents a valid host or machine, or you can
use:
HostIPCachingManager.getIPByHostName("<someAttribute>")

Computer -
Running
Software

name Name of Running Software. This can be addedmanually, or taken
from:
Framework.getDestinationAttribute("<someAttribute>")

Tasks
This section includes:

l "How to report topology with event data" below

l "How to report topology with metrics data" on the next page

l "How to report topology without event or metrics data" on the next page

How to report topology with event data

1. In the BSMConnector user interface, click in the toolbar. Then click Event > Database.

Click Topology to open the policy Topology page.

2. Select a script template and if necessary, click Load Template.

The out-of-the-box topology scripts do not require any changes.
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To create a custom script, see "Working with Jython-Based Topology Scripts " on page 180 for
more information.

3. Optionally, use theSample Data tab to drag table columns and values to the topology script.
Alternatively, you can type the table column directly into the topology script, for example, ALL_
EVENTS.

BSM Connector replaces the table column at runtime with the value of the specified column. If
you insert a column value, the value will be used.

Note: The Sample Data tab is empty if no sample data has been loaded into the policy or if
the database query did not succeed. See also "Configuring the Data Source in Database
Policies" on page 204.

How to report topology with metrics data

1. In the BSMConnector user interface, click in the toolbar. Then click Metrics >
Database.

Click Topology to open the policy Topology page.

2. Select a script template and if necessary, click Load Template.

The out-of-the-box topology scripts do not require any changes.

To create a custom script, see "Working with Jython-Based Topology Scripts " on page 180 for
more information.

3. Optionally, use theSample Data tab to drag table columns and values to the topology script.
Alternatively, you can type the table column directly into the topology script, for example, ALL_
EVENTS.

BSM Connector replaces the table column at runtime with the value of the specified column. If
you insert a column value, the value will be used.

Note: The Sample Data tab is empty if no sample data has been loaded into the policy or if
the database query did not succeed. See also "Configuring the Data Source in Database
Policies" on page 204.

How to report topology without event or metrics data

1. In the BSMConnector user interface, click in the toolbar. Then click Topology >
Database.

Click Topology to open the policy Topology page.
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2. Select a script template and if necessary, click Load Template.

3. Select a script template and if necessary, click Load Template.

The out-of-the-box topology scripts do not require any changes.

To create a custom script, see "Working with Jython-Based Topology Scripts " on page 180 for
more information.

4. Map the data discovered by the policy to the relevant attributes in the topology script.

For a list of mandatory values, see "Mandatory Values WhenReporting Topology Only" on
page 229.

5. Optionally, use theSample Data tab to drag table columns and values to the topology script.
Alternatively, you can type the table column directly into the topology script, for example, ALL_
EVENTS.

BSM Connector replaces the table column at runtime with the value of the specified column. If
you insert a column value, the value will be used.

Note: The Sample Data tab is empty if no sample data has been loaded into the policy or if
the database query did not succeed. See also "Configuring the Data Source in Database
Policies" on page 204.

Note: BSM removes CIs from the RTSM if no topology data has been received for them over a
period of time. To prevent BSM from deleting the CIs that BSM Connector has sent to BSM,
BSMConnector regularly sends a list of active CIs to BSM in addition to the topology data.
Inactive CIs are not sent to the RTSM and aremarked for deletion in the RTSM.

You can configure BSM Connector to always send CIs regardless of whether topology data
has been received for them. This guarantees that CIs reported by BSMConnector are never
deleted automatically from the RTSM. This configuration option is known as always touch
mode and is recommended for BSM Connector topology-only policies that collect data from
incremental data sources such as log files or databases. The first time the policies run, they
collect all CIs from the data source. The next time the policies run, they collect new and
changed CIs only and then forward only the additions and changes to BSM. The always touch
mode ensures that the already existing, unchanged CIs are also reported and are thus not
deleted.

For more information, see "Touching of CIs in BSM Connector" on page 192.

Related tasks

l "How to Collect Event Data from Databases" on page 199

l "How to Collect Metrics Data from Databases" on page 200
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l "How to Collect Topology Data Only from Databases" on page 201

UI Descriptions

For a description of the Topology page, see the following sections:

l "Topology Page - Database, Log File, Web Service Listener, and Custom Topology Policies" on
page 514

l "Sample Data Tab- Database Policies" on page 497

Troubleshooting Database Policies
This section describes troubleshooting and limitations when working with database policies.

This section includes:

l "Debugging errors" below

l "Database policy file rolling" on page 235

l "Metrics troubleshooting" on page 236

l "Topology troubleshooting" on page 236

Debugging errors

l Check for errors in the following files:

<BSM Connector root directory>\logs\error.log

<BSM Connector root directory>\logs\RunMonitor.log

<BSM Connector root directory>\logs\bac_integration\bac_integration.log.

l You canmodify the level and type of information reported to the log files by changing the log file
settings in the <BSM Connector root
directory>\conf\core\Tools\log4j\PlainJava\log4j.properties file. You can instruct the
loggingmechanism to:

n Report logged information in less or greater detail than is reported by default.

n Log all metrics sent by metrics integration policies to BSM.

n Log all received data from third-party systems.

To modify log settings:
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a. Open the log4j.properties file in a text editor.

b. To specify that metrics sent by metrics integration policies to BSM be logged:

i. Locate the following lines in the file:

log4j.category.EmsSamplePrinter=${loglevel}, integration.appender
log4j.additivity.EmsSamplePrinter=false

ii. Change the argument of log4j.category.EmsSamplePrinterfrom ${loglevel} to
DEBUG, as follows:

log4j.category.EmsSamplePrinter=DEBUG, integration.appender

iii. Save the file. It may take a few seconds for the changes to take effect.

The results are logged to the bac_integration.log file.

c. To specify that all received data from third-party systems be logged:

i. Locate the following lines in the file:

log4j.category.EmsEventPrinter=${loglevel}, monitors.appender
log4j.additivity.EmsEventPrinter=false

ii. Change the argument of log4j.category.EmsEventPrinter from ${loglevel} to
DEBUG, as follows:

log4j.category.EmsEventPrinter=DEBUG, monitors.appender

iii. Save the file. It may take a few seconds for the changes to take effect.

The results are logged to theRunMonitor.log file.

Tip: After you have determined the cause of the problem, we recommend that you set log
levels to their default settings so as not to overload the system.

l If metrics are created and sent from BSMConnector, but the data is not seen in BSM Service
Health, Event Log, or SiteScope reports, look in
<BSM root directory>\log\wde\wdeIgnoredSamples.log to make sure themetrics were not
dropped due tomissing fields or values.

l Change the logging level for Service Health to verify that Service Health received the samples.
Open the following file on the Gateway Server machine:
<BSM root directory>\conf\core\tools\log4j\wde\wde.properties

Change the log level parameter to DEBUG in the following lines:
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n log4j.category.com.mercury.am.platform.wde.decode.IgnoredSamples
Logger=${loglevel}, IgnoredSamples.appender

n log4j.category.com.mercury.am.platform.wde.publish_SamplePublisher
Samples=${loglevel}, PublishedSamples.appender

Look at the corresponding log files:

n <BSM root directory>\log\wde\wdeIgnoredSamples.log

n <BSM root directory>\log\wde\wdePublishedSamples.log

Database policy file rolling
A database policy reads the following XML file:

Windows: %OvDataDir%\tmp\<policyID>.xml

Linux: /var/opt/OV/tmp/<policyID>.xml

The file contains the results of the BSM Connector database queries in an XML file format that
database policies can evaluate. The file exists only for policies that integrate events.

To prevent the file from becoming too large, a new version of the file is created when its size
reaches 100000 KB. The original file is renamed and stored as a backup file. By default, up to three
backup files can be created.

Caution:When the XML file rolls, that is, a new version is created, but the policy has not
completed reading all entries, the unread entries are lost and no events are created.

The following defaults are set:

l Maximum file size: 100000 KB

Tip: If not all expected events arrive in BSM, increase themaximum file size to 1000000
KB.

l Maximum number of backup files: 3

To change the defaults:

1. Open the following file:

<BSM Connector root directory>/groups/master.config

2. Change the following values as required:

_eventRollingMaxFileSizeInKB=100000

_eventRollingMaxBackup=3
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3. Restart the BSM Connector server:

Windows: Restart theHP BSM Connector service in theAdministrative Tools > Services.

Linux: Restart the BSM Connector main process, type /opt/HP/BSMConnector/stop followed
by /opt/HP/BSMConnector/start.

Metrics troubleshooting
See "Metrics Troubleshooting" on page 178 for more information on troubleshooting and limitations
when BSMConnector sends metrics to BSM.

Topology troubleshooting
See "Topology Troubleshooting and Limitations" on page 193 for more information on
troubleshooting and limitations when BSMConnector is enabled to report CIs and CIs relationships
topology to BSM.
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Chapter 11: Log File Policies
This policy type reads entries in a log file by trying tomatch text that you choose against a regular
expression. When the policy finds amatch and certain conditions apply, the policy responds by
sending event, metrics, or topology data to BSM. You can define the details of the BSM data sent to
BSM based on information in the log file.

Note: Youmust have the format and syntax of the log file that the policy reads. Youmust
construct a regular expression tomatch on the entries in the log file that contain the data you
want to read and forward to BSM. For examples of regular expressions, see "Examples for Log
File Policies" on page 278.

What Data Is Collected
The log file policy sends to BSM Connector data that is extracted from any log fle row that matched
against the Log File Pattern regular expression.

Before setting up the log file policy, you should be clear about the purpose and usage of the data in
BSM (for presentation in Operations Management, Service Health, Service Level Management, or
reports).

The specific data that is forwarded to BSM is controlled by the type of policy (event, metrics, or
topology integration policy) and by the defaults and rules that the policy applies to the data.

Data can also bemapped to a topology to forward data to the correct CI hierarchy in BSM
Connector. You can configure topology settings for the policy by selecting one of the out-of-the-box
scripts, or configuring your own custom topology script during policy creation.

How to Collect Event Data from Log Files
This task describes how to collect event and optionally topology data from log files.

1. Prerequisite:Make sure your BSM Connector is set up as a BSMConnector integration server
in BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see the BSM online
help or the BSM Application Administration Guide.

2. In the BSMConnector user interface, click in the toolbar. Then click Event > Log File.

Alternatively, double-click an existing policy to edit it.

3. In theProperties page, define information that is related to the policy itself (for example, the
name and description of the policy).

For details, see "Configuring Log File Policy Properties" on page 241.
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4. In theSource page, define the log file that the policy reads (for example, the path and name of
the log file).

For details, see "Configuring the Data Source in Log File Policies" on page 242.

5. In theMappings page, configure the default mappings of patternmatching groups to custom
variables.

For details, see "ConfiguringMappings in Log File Policies " on page 245.

6. Optional. In theDefaults page, configure the default settings for all events generated by the
policy (for example, default event correlation settings).

For details, see "Configuring Event Defaults in Log File Policies" on page 247.

7. In theRules page, define what the policy should do in response to a specific type of event.

For details, see "Configuring Event Rules in Log File Policies" on page 252.

8. In theOptions page, configure several policy behaviors (for example, patternmatching
options).

For details, see "Configuring Options in Log File Policies" on page 260.

9. In the Topology page, select or create a script that creates a topology in BSM's RTSM that
represents your third-party system.

For details, see "Configuring Topology Scripts in Log File Policies" on page 262.

Note: For detailed information on topology scripts, see "Working with Jython-Based
Topology Scripts " on page 180.

10. Click OK to save the policy and close the editor.

11. Optional. If the list of policies does not refresh automatically in the BSMConnector user
interface, click in the toolbar.

How to Collect Metrics Data from Log Files
This task describes how to collect metrics and optionally topology data from log files.

Note: For examples and end-to-end workflow information on collectingmetrics data with or
without topology, see "Collecting and ViewingMetrics Data" on page 139. See "Tips and
Tricks" on page 176 for information on what to do and what to avoid when collectingmetrics.
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1. Prerequisite:Make sure your BSM Connector is set up as a BSMConnector integration server
in BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see the BSM online
help or the BSM Application Administration Guide.

2. In the BSMConnector user interface, click in the toolbar. Then click Metrics > Log
File.

Alternatively, double-click an existing policy to edit it.

3. In theProperties page, define information that is related to the policy itself (for example, the
name and description of the policy).

For details, see "Configuring Log File Policy Properties" on page 241.

4. In theSource page, define the log file that the policy reads (for example, the path and name of
the log file).

For details, see "Configuring the Data Source in Log File Policies" on page 242.

5. Optional. In theDefaults page, assign default values to themetric attributes.

For details, see "ConfiguringMetrics Defaults in Log File Policies" on page 250.

6. In theRules page, define what the policy should do in response to a specific metric.

For details, see "ConfiguringMetrics Rules in Log File Policies" on page 256.

7. In the Topology page, select or create a script that creates a topology in BSM's RTSM that
represents your third-party system.

For details, see "Configuring Topology Scripts in Log File Policies" on page 262.

Note: For detailed information on topology scripts, see "Working with Jython-Based
Topology Scripts " on page 180.

8. Click OK to save the policy and close the editor.

9. Optional. If the list of policies does not refresh automatically in the BSMConnector user
interface, click in the toolbar.

How to Collect Topology Data from Log Files
You can have BSMConnector report only the topology discovered by the BSMConnector log file
policies.

This task describes how to collect topology data from log files.
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Note: For detailed information on topology scripts, see "Working with Jython-Based Topology
Scripts " on page 180.

1. Prerequisite:Make sure your BSM Connector is set up as a BSMConnector integration server
in BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see the BSM online
help or the BSM Application Administration Guide.

2. In the BSMConnector user interface, click in the toolbar. Then click Topology > Log
File.

Alternatively, double-click an existing policy to edit it.

3. In theProperties page, define information that is related to the policy itself (for example, the
name and description of the policy).

For details, see "Configuring Log File Policy Properties" on the next page.

4. In theSource page, define the log file that the policy reads (for example, the path and name of
the log file).

For details, see "Configuring the Data Source in Log File Policies" on page 242.

5. In the Topology page, select or create a script that creates a topology in BSM's RTSM that
represents your third-party system.

For details, see "Configuring Topology Scripts in Log File Policies" on page 262.

6. Click OK to save the policy and close the editor.

7. Optional. If the list of policies does not refresh automatically in the BSMConnector user
interface, click in the toolbar.

Log File Policy User Interface
Log file policies display different pages depending on the type of data they are integrating and on the
policy origin.

Choose the type of data you want to integrate and then complete the following tasks:

Event data (optionally with topology data)

l "Configuring Log File Policy Properties" on the next page

l "Configuring the Data Source in Log File Policies" on page 242
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l "ConfiguringMappings in Log File Policies " on page 245

l "Configuring Event Defaults in Log File Policies" on page 247

l "Configuring Event Rules in Log File Policies" on page 252

l "Configuring Options in Log File Policies" on page 260

l "Configuring Topology Scripts in Log File Policies" on page 262

Metrics data (optionally with topology data)

l "Configuring Log File Policy Properties" below

l "Configuring the Data Source in Log File Policies" on the next page

l "ConfiguringMetrics Defaults in Log File Policies" on page 250

l "ConfiguringMetrics Rules in Log File Policies" on page 256

l "Configuring Topology Scripts in Log File Policies" on page 262

Topology data only

l "Configuring Log File Policy Properties" below

l "Configuring the Data Source in Log File Policies" on the next page

l "Configuring Topology Scripts in Log File Policies" on page 262

Migrated SiteScope technology integrationmonitors (common and legacy events)

l "Configuring Log File Policy Properties" below

l "Configuring the Data Source in Log File Policies" on the next page

l "Configuring Field Mapping in Log File Policies " on page 260

l "Configuring Topology Scripts in Log File Policies" on page 262

Configuring Log File Policy Properties
Every policy has a set of properties that identify and describe the policy. Properties include, for
example, the policy name and a description of what the policy does.

To access

l In the BSMConnector user interface, click in the toolbar. Then click Event > Log File.

l In the BSMConnector user interface, click in the toolbar. Then click Metrics > Log File.
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l In the BSMConnector user interface, click in the toolbar. Then click Topology > Log
File.

Alternatively, double-click an existing policy to edit it.

Tasks

How to configure policy properties
In the Properties page, type a name for the policy. You can use spaces in the name. The equal sign
(=) is not allowed.

For more information about the other fields, see "Configuring Log File Policy Properties" on the
previous page.

Related tasks

l "How to Collect Event Data from Log Files" on page 237

l "How to Collect Metrics Data from Log Files" on page 238

l "How to Collect Topology Data from Log Files" on page 239

UI Descriptions

For a description of the Properties page, see "Properties Page" on page 494.

Configuring the Data Source in Log File Policies
The source page of the log file policy editor enables you to specify which log file the policy reads.
You can also configure the policy to extract data from the log file. The policy retains that data (as
so-called patternmatching groups) for later reuse in other pages of the policy editor.

To access

l In the BSMConnector user interface, click in the toolbar. Then click Event > Log File.

l In the BSMConnector user interface, click in the toolbar. Then click Metrics > Log File.

l In the BSMConnector user interface, click in the toolbar. Then click Topology > Log
File.

Alternatively, double-click an existing policy to edit it.

Click Source to open the policy Source page.
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Learn More

Patternmatching groups

A patternmatching group represents a unit of data that matches a specified pattern and that is then
retained for use in event attributes, mappings, and rules.

Example: The log file pattern (.*) (.*) (.*) (.*)matches the log file lines

Info: user1 logged on
Info: user1 logged off

In this example, the parentheses surround thematch pattern, and instruct the policy to retain
thematched values as patternmatching groups. The patttern .*matches all characters, and
the space is the delimiter in the log file.

The pattern assigns the string Info: to the patternmatching group "group0", user1 to
"group1", logged to "group2", and the strings on and off to "group3". You can then insert the
generated patternmatching groups "group0" to "groupn" in event attributes, mappings, and
rules.

Tasks

How to configure the log file source
This task describes how configure the log file source and how the policy reads it.

1. Select a server from the server list (only those remote servers that have been configured in
BSM Connector are displayed). The BSMConnector server is the default server.

Alternatively, click Remote Servers to add a new server.

2. Type the path to the log file from which you want to extract data:

n Remote UNIX. For reading log files on remote UNIX machines, the pathmust be relative to
the home directory of UNIX user account being used to log on to the remotemachine. Click
Remote Servers and select the UNIX remote server for information about which UNIX user
account is being used.

n Remote Windows through NetBIOS. You can also access log files by including the UNC
path to the remote log file. For example, \\remoteserver\sharedfolder\filename.log.

This requires that the user account under which BSMConnector is running has permission
to access the remote directory using the UNC path.

If a direct connection using the operating system is unsuccessful, BSM Connector tries to
match the \\remoteserverwith servers currently defined as remoteWindows connection
profiles (displayed in the remote server list).
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If an exact match is found for \\remoteserver in the remoteWindows connection profiles,
BSM Connector tries to use this connection profile to access the remote log file. If no
matching server name is found, the policy reports that the remote log file cannot be found.

It is not necessary to select a remoteWindows server if you are using NetBIOS to connect
to remoteWindows servers.

n Remote Windows through SSH. Select a remote server from the drop-down list. The path
of the log file depends on the type of SSH server installed on the remoteWindows server:

o SSH servers that provide a UNIX-like interface (for example, Cygwin OpenSSH):

/cygdrive/<drive_letter>/<directory>/filename.log

o SSH servers that provide aWindows command prompt (for example, OpenSSH for
Windows):

<drive_letter>:\<folder>\filename.log

Optionally, you can use a regular expression to insert date and time variables. For example,
you can use a syntax of s/ex$shortYear$$0month$$0day$.log/ to match date-coded IIS log
file names. For details, see "Special Substitution for File Path" on page 277.

3. Select the log file encoding that is used if you are reading a log file whose encoding is different
than the BSMConnector system's default encoding.

4. Specify how often the policy reads the log file. Use the drop-down list to specify increments of
seconds, minutes, hours, or days.

Each time that BSM Connector reads the log file, the policy starts from the point in the log file
where it stopped reading the last time the policy ran. This ensures that you are notified only of
new entries and speeds the rate at which the policy runs.

5. Specify how long the policy should wait before timing out when access to the log file is delayed
or not possible. The timeout periodmust be shorter than the frequency.

6. Specify the text to look for in the log entries, for example (.*) (.*) (.*) (.*).

Tip:

n Use parentheses (()) to create patternmatching groups.

n Escape special characters with a backslash (\).

Examples of special characters are the plus sign (+), the asterisk (*), the questionmark
(?), the at sign (@), the exclamation point (!), the caret (^), brackets ([]), and braces
({}).
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n Formore information about regular expressions, see "Regular Expressions" on page
269.

7. Click to load the log file and apply the log file pattern. Only the first 100 lines of the log file
are processed. Matching results are displayed in the Sample Data tabs of the policy.

Related tasks

l "How to Configure BSM Connector to Access RemoteWindows Servers " on page 86

l "How to Configure BSM Connector to Access Remote UNIX Servers " on page 88

l "How to Collect Event Data from Log Files" on page 237

l "How to Collect Metrics Data from Log Files" on page 238

l "How to Collect Topology Data from Log Files" on page 239

UI Descriptions

For a description of the Source page, see "Source Page - Log File Policies" on page 506.

Configuring Mappings in Log File Policies
TheMappings page enables you tomap patternmatching groups to custom variables.

To access
In the BSMConnector user interface, click in the toolbar. Then click Event > Log File.

Alternatively, double-click an existing policy to edit it.

Click Mappings to open the policy Mappings page.

Learn More

Mappings overview
A custom variable consists of amap name, an optional patternmatching group, and one or more
source and target value pairs. For example, you can assign the patternmatching group group1 to
themap name mapgroup0, and add a source value of critical. You can then assign the target
value serious to the variable so that BSM Connector inserts the value serious into the event in all
places where the variable is used and the source value is critical in the log file.
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Patternmatching groups use the following syntax: <$DATA:/BSMConnectorEvent/<pattern_
matching_group>

<pattern_matching_group> is the name of the group assigned to a particular content match.

For example, the custom variable mapgroup0 has the patternmatching group group0 assigned.

Assigning a patternmatching group to amap name is optional. If you do not assign a pattern
matching group to a variable, youmust add the source value directly to the variable when you insert
the variable in an event attribute.

The Sample Data tab is empty if no sample data has been loaded into the policy or if the sample
data does not match the log file pattern.

The PatternMatching Group tab shows the following information, if sample data is available:

l Patternmatching groups

If sample data is available, then the PatternMatching Group section shows all groups that
match the log file pattern.

You can sort the information that appears in the PatternMatching Group section so that data
appears in either ascending or descending order, indicated by either an up or down arrow at the
top of the list. The items in the PatternMatching Group section are by default sorted
alphabetically in ascending order. To change the sort order, click the arrow at the top of the list.

l Values

The Values section displays the values of a group selected in the PatternMatching Group
section. If a value appears more than once, click to show or hide duplicate values. To find
values that belong tomore than one group, select the value and click . The PatternMatching
Group window opens and shows all groups that have the selected value.

When you drag a group from the patternmatching groups list and drop it on the Default Value
Mapping List, BSM Connector automatically adds the default prefix map to themap name and
inserts the patternmatching group. You can then drag one or more log file source values from the
values list and drop them on the Source Value list. You then finally only have to type the target
values.

Tasks

How to configure log file mappings
This task describes how tomap patternmatching groups to custom variables.
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1. Create one or more custom variables.

If you are working with sample data, drag the group from the patternmatching groups list to the
MapName column. BSM Connector automatically adds the default prefix map to themap name
and inserts the group name.

Alternatively, click above theMapName column and type the variable name in themap
name field. Groups are optional. If you do not assign a group to a variable, youmust add the
source value directly to the variable when you insert the variable in an event attribute.

2. Add one or more source and target value pairs to each custom variable.

n If you are working with sample data, drag the value from the Values list to the Source Value
column, and type the target value in the corresponding field.

Alternatively, click above the Source Value column and type the source and target values
in the corresponding fields.

n Optionally, use the Indicators tab to add indicators to the source or target value fields. After
loading the indicators from the connected BSM server, the Indicators tab shows a hierarchy
of configuration item types with the associated health indicators (HIs) and event type
indicators (ETIs).

To insert an indicator in a source or target value field, drag and drop the indicator name (for
example, Normal) or the indicator name and state (for example, HTTPServer:Normal) from
the Indicators tab to the policy. Use theSelect target drop format panel to toggle between
inserting indicator names only and inserting indicator names and states.

Related tasks

l "How to Collect Event Data from Log Files" on page 237

UI Descriptions

For a description of theMappings page, see the following sections:

l "Mappings Page (Events Only)" on page 482

l "Sample Data Tab - Log File Policies" on page 498

l "Indicators Tab" on page 481

Configuring Event Defaults in Log File Policies
The Events page enables you to indicate default settings for all events generated by the policy.

These defaults affect all new and existing rules. You can override the defaults in individual rules if
needed. If a rule contains empty event attributes, the agent will use the defaults for the new event.
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To access
In the BSMConnector user interface, click in the toolbar. Then click Event > Log File.

Alternatively, double-click an existing policy to edit it.

Click Defaults to open the policy Default Event Attributes page.

Tasks

How to configure events for log file policies
This task describes how to configure default settings for all events generated by the policy.

1. Click Event Attributes to define default event attributes, such as severity and category.

Tip: After loading the indicators from the connected BSM server, the Indicators tab shows
a hierarchy of configuration item types with the associated health indicators (HIs) and
event type indicators (ETIs).

To insert an indicator, drag and drop the indicator, indicator state, or both from the
Indicators tab to the policy. Use theSelect target drop format panel to toggle between
inserting indicator names only and inserting indicator names and states.

2. Click Event Correlation to set the type of duplicate event suppression and define themethod
used to suppress duplicate events.

3. Click Custom Attributesto add additional information to all events generated by this policy.
For example, youmight add a company name, contact information, or a city location to an
event.

4. Click Advanced to define default advanced attributes such as legacy HPOM attributes and
agent MSI (Message Stream Interface) settings.

5. Optionally, use theSample Data tab to drag patternmatching groups and values to the
attribute boxes. Alternatively, you can type the path to the patternmatching group directly into
the attribute box.

Patternmatching groups use the following syntax: <$DATA:/BSMConnectorEvent/<pattern_
matching_group>

<pattern_matching_group> is the name of the group assigned to a particular content match.

BSM Connector replaces the patternmatching group at runtime with the value of the specified
group. If you insert a group value, the value will be used.

Note:
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n The default patternmatching group host_name contains the fully qualified domain name
of the BSM Connector server.

n The Sample Data tab is empty if no sample data has been loaded into the policy or if the
sample data does not match the log file pattern specified in the source page. See also
"Configuring the Data Source in Log File Policies" on page 242.

6. Optionally, use theMappings tab to addmapping definitions to the attribute boxes.

Mappings are custom variables that you define in theMappings page (see also "Configuring
Mappings in Log File Policies " on page 245). To insert a custom variable, you can drag it from
theMappings list and drop it on the event attribute.

Alternatively, type the custom variable into the attribute box using the following syntax:

<$MAP(<custom_variable>)> where <custom_variable> is themap name of the variable (for
example, <$MAP(mapgroup0)>).

If the custom variable does not have a patternmatching group assigned, use the following
syntax:

<$MAP(<custom_variable>,<<source_value>>) where <source_value> can be one of the
following:

n Name of the patternmatching group, for example <$MAP(mapgroup0)>,
<$DATA:/BSMConnectorEvent/group0>

n The source value itself, for example <$MAP(mapgroup0)>,Critical)>

7. Optionally, use thePolicy Variables tab to add policy variables to event attributes. BSM
Connector replaces the variables with the appropriate values in the generated event.

It is often useful to surround the variable with quotationmarks, especially if it may return a
value that contains spaces, for example "<$MSG_NODE>".

Related tasks

l "How to Collect Event Data from Log Files" on page 237

UI Descriptions

For a description of the Defaults page, see the following sections:

l "Event Attributes Tab" on page 459

l "Event Correlation Tab" on page 465
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l "Custom Attributes Tab" on page 469

l "Advanced Tab" on page 470

l "Sample Data Tab - Log File Policies" on page 498

l "Mappings Tab (Events Only)" on page 483

l "Indicators Tab" on page 481

l "Policy Variables Tab (Events Only)" on page 491

Configuring Metrics Defaults in Log File Policies
The Default Monitor Attributes page enables you to assign default values to themetric attributes.
The values can be used when defining the policy rules on the Rules tab, and can also be overridden
there.

Note: For examples and end-to-end workflow information on collectingmetrics data with or
without topology, see "Collecting and ViewingMetrics Data" on page 139. See "Tips and
Tricks" on page 176 for information on what to do and what to avoid when collectingmetrics.

To access
In the BSMConnector user interface, click in the toolbar. Then click Metrics > Log File.

Alternatively, double-click an existing policy to edit it.

Click Defaults to open the policy Default Monitor Attributes page.

Learn More

Metrics attributes
Each time ametrics policy runs, it extracts raw data from its defined data source and builds a
metric structure, which it then forwards to BSM.

A metric structure consists of these attributes:

l Attributes related to themetrics source, category, or status:

n Monitor name

n Monitor type

n Target

n Time stamp
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n Quality

n Monitor state

l Attributes related to a specific metric in the source:

n Name

n Value

n CI hint

n Indicator name

Tasks

How to configure metrics defaults for log file policies
This task describes how to configuremetric attribute defaults for all metrics collected by this policy.

1. Define the default metric attributes common to all metrics collected by this policy, such as
monitor name, type, and state.

Tip: The Policy Constants tab lists the available constants representingmetrics quality
(status) that are available in BSM Connector. Use drag and drop to add them to the
Quality attribute.

2. InMetrics, click to add attributes specific to a single metric.

Alternatively, expand an existingmetric group to edit it.

Tip: After loading the indicators from the connected BSM server, the Indicators tab shows
a hierarchy of configuration item types with the associated health indicators (HIs) and
event type indicators (ETIs).

To insert an indicator, drag and drop the indicator from the Indicators tab to the policy.
BSM Connector inserts the indicator name.

3. Optionally, use theSample Data tab to drag patternmatching groups and values to the
attribute boxes. Alternatively, you can type the patternmatching group directly into the attribute
box.

Patternmatching groups use the following syntax: $<pattern_matching_group>

<pattern_matching_group> is the name of the group assigned to a particular content match.
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BSMConnector replaces the patternmatching group at runtime with the value of the specified
group. If you insert a group value, the value will be used.

Note:

n The default patternmatching group host_name contains the fully qualified domain name
of the BSM Connector server.

n The Sample Data tab is empty if no sample data has been loaded into the policy or if the
sample data does not match the log file pattern specified in the source page. See also
"Configuring the Data Source in Log File Policies" on page 242.

4. Optionally, use theOperations tab to apply operations to themetric attribute values.

Related tasks

l "How to Collect Metrics Data from Log Files" on page 238

l "How to Collect Metrics with Computer - Monitor Topology" on page 142

l "How to Collect Metrics with Custom, Computer, or Computer - Running Software Topology
Data" on page 147

l "How to Collect Metrics Without Reporting Topology" on page 160

UI Descriptions

For a description of the Defaults page, see the following sections:

l "Default Monitor Attributes and Attributes Tabs" on page 478

l "Sample Data Tab - Log File Policies" on page 498

l "Indicators Tab" on page 481

l "Operations Tab (Metrics Only)" on page 483

l "Policy Constants Tab (Metrics Only)" on page 491

Configuring Event Rules in Log File Policies
Rules define what a policy should do in response to a specific type of event. Each rule consists of a
condition and of settings for the event generated by the policy. The condition is the part of a policy
that describes the source. The settings enable you to configure the event that BSM Connector
sends to BSM.
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A policy must contain at least one rule. If the policy contains multiple rules, it is important to
remember that the rules are evaluated in a specific order, and that when one condition is matched,
no additional rules will be evaluated.

To access
In the BSMConnector user interface, click in the toolbar. Then click Event > Log File.

Alternatively, double-click an existing policy to edit it.

Click Rules to open the policy Rules page.

Learn More

Rule types
The rule types are:

l Event on matched rule. If matched, BSM Connector sends an event to BSM. The event uses
the settings defined for the rule. If you do not configure these settings, the default settings are
used.

l Suppress on matched rule. If matched, BSM Connector stops processing and does not send
an event to BSM.

l Suppress on unmatched rule. If not matched, BSM Connector stops processing and does not
send an event to BSM.

Tasks

How to configure rules in log file policies

1. In thePolicy Rules section, click and select the type of rule to define what the policy
should do in response to a specific string in the patternmatching group. Each policy must have
at least one rule.

2. In theRule Content section, use theCondition tab to specify the patternmatching groups
and values that the policy searches for in the log file that the policy reads. If the policy finds a
match, it may or may not generate an event, depending on the rule type.

a. Click to create a new condition. New conditions by default use the equals operator.

b. Click to expand the new condition.

c. In theProperty field, specify the patternmatching group that the policy searches for. You
must prefix the group namewith /BSMConnectorEvent/ (for example,
/BSMConnectorEvent/group0).

If you are working with sample data, you can drag and drop the patternmatching group from
the PatternMatching Group list to the Properties field.
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d. Select the pattern operator.

If you select thematches operator, you can type a pattern in the Operand field. For a list of
available operators, see "Configuring Event Rules in Log File Policies" on page 252.

e. In theOperand field, type the value or pattern that you want the policy to compare with the
patternmatching group. If you are working with sample data, you can drag the value from
the Values list and drop it in the Operand field.

Tip: You can use standard BSM Connector pattern-matching rules whenmatching
values. Select thematches operator and click in the Operand field to open the
patternmatching expression toolbox. The toolbox displays the following:

o Pattern Matching Expressions. Click an expression to insert it in the Operand
field.

o Variable Bindings Options. Variable bindings options include case sensitivity
and field separators for the rule. If you do not specify patternmatching options for
the rule, either the defaults (case sensitive; a blank and the tab character as
separators) or the default options set for the policy will be used. See also
"Configuring Options in Log File Policies" on page 260.

3. Use theEvent Attributes tab to define event attributes (for example, event title and
description) for all events generated by this rule.

Tip: After loading the indicators from the connected BSM server, the Indicators tab shows
a hierarchy of configuration item types with the associated health indicators (HIs) and
event type indicators (ETIs).

To insert an indicator, drag and drop the indicator, indicator state, or both from the
Indicators tab to the policy. Use theSelect target drop format panel to toggle between
inserting indicator names only and inserting indicator names and states.

4. Use theEvent Correlation tab to set the type of duplicate event suppression and define the
method used to suppress duplicate events.

5. Use theCustom Attributes tab to add additional information to all events generated by this
rule. For example, youmight add a company name, contact information, or a city location to an
event.

6. Use theAdvanced tab to define an event drill-downURL, legacy HPOM attributes, and agent
MSI (Message Stream Interface) settings.

7. Optionally, use theSample Data tab to drag patternmatching groups and values to the
attribute boxes. Alternatively, you can type the path to the patternmatching group directly into
the attribute box.
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Patternmatching groups use the following syntax: <$DATA:/BSMConnectorEvent/<pattern_
matching_group>

<pattern_matching_group> is the name of the group assigned to a particular content match.

BSM Connector replaces the patternmatching group at runtime with the value of the specified
group. If you insert a group value, the value will be used.

Note:

n The default patternmatching group host_name contains the fully qualified domain name
of the BSM Connector server.

n The Sample Data tab is empty if no sample data has been loaded into the policy or if the
sample data does not match the log file pattern specified in the source page. See also
"Configuring the Data Source in Log File Policies" on page 242.

8. Optionally, use theMappings tab to addmapping definitions to the attribute boxes.

Mappings are custom variables that you define in theMappings page (see also "Configuring
Mappings in Log File Policies " on page 245). To insert a custom variable, you can drag it from
theMappings list and drop it on the event attribute.

Alternatively, type the custom variable into the attribute box using the following syntax:

<$MAP(<custom_variable>)> where <custom_variable> is themap name of the variable (for
example, <$MAP(mapgroup0)>).

If the custom variable does not have a patternmatching group assigned, use the following
syntax:

<$MAP(<custom_variable>,<<source_value>>) where <source_value> can be one of the
following:

n Name of the patternmatching group, for example <$MAP(mapgroup0)>,
<$DATA:/BSMConnectorEvent/group0>

n The source value itself, for example <$MAP(mapgroup0)>,Critical)>

9. Optionally, use thePattern Matching Variables tab to add variables created through pattern
matching.

Patternmatching variables insert matched strings that have previously been assigned to
variables. To insert a patternmatching variable, type the variable name enclosed in angle
brackets (for example, <variablename>) or drag and drop it from the PatternMatching
Variables list to the event attribute.

10. Optionally, use thePolicy Variables tab to add policy variables to event attributes. BSM
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Connector replaces the variables with the appropriate values in the generated event.

It is often useful to surround the variable with quotationmarks, especially if it may return a
value that contains spaces, for example "<$MSG_NODE>".

Related tasks

l "How to Collect Event Data from Log Files" on page 237

UI Descriptions

For a description of the Rules page, see the following sections:

l "Rules Page - Policy Rules" on page 495

l "Condition Tab - Rules Only" on page 472

l "Event Attributes Tab" on page 459

l "Event Correlation Tab" on page 465

l "Custom Attributes Tab" on page 469

l "Advanced Tab" on page 470

l "Sample Data Tab - Log File Policies" on page 498

l "Mappings Tab (Events Only)" on page 483

l "PatternMatching Variables Tab (Event Rules Only)" on page 491

l "Indicators Tab" on page 481

l "Policy Variables Tab (Events Only)" on page 491

Configuring Metrics Rules in Log File Policies
Rules define what a policy should do in response to a specific type of metric. Each rule consists of
a condition and of settings for themetrics generated by the policy. The condition contains the string
or pattern that must bematched for the rule to apply. The settings enable you to configure the
metrics that BSM Connector sends to BSM.

If the policy contains multiple rules, it is important to remember that the rules are evaluated in a
specific order, and that when one condition is matched, no additional rules will be evaluated.

Note: For examples and end-to-end workflow information on collectingmetrics data with or
without topology, see "Collecting and ViewingMetrics Data" on page 139. See "Tips and
Tricks" on page 176 for information on what to do and what to avoid when collectingmetrics.
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To access
In the BSMConnector user interface, click in the toolbar. Then click Metrics > Log File.

Alternatively, double-click an existing policy to edit it.

Click Rules to open the policy Rules page.

Learn More

This section includes:

l "Rule types" below

l "Metrics attributes" below

Rule types
The rule types are:

l Process on matched rule. If matched, BSM Connector sends metrics to BSM. Themetrics
use the settings defined for the rule. If you do not configure these settings, the default settings
are used.

l Suppress on matched rule. If matched, BSM Connector stops processing and does not send
metrics to BSM.

l Suppress on unmatched rule. If not matched, BSM Connector stops processing and does not
sendmetrics to BSM.

Metrics attributes
Each time ametrics policy runs, it extracts raw data from its defined data source and builds a
metric structure, which it then forwards to BSM.

A metric structure consists of these attributes:

l Attributes related to themetrics source, category, or status:

n Monitor name

n Monitor type

n Target

n Time stamp

n Quality

n Monitor state

l Attributes related to a specific metric in the source:
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n Name

n Value

n CI hint

n Indicator name

Tasks

How to configure rules for metrics in log file policies

1. In thePolicy Rules section, click and select the type of rule to define what the policy
should do in response to a specific string in the table column.

2. In theRule Content section, use theCondition tab to define thematch condition.

Thematch conditionmust be a valid boolean expression. The expression can contain one or
more operations from theOperations tab. The expression can access the contents of the data
that is being processed using the dollar sign ($) notation.

3. Optional. If you are creating a rule of the type 'process onmatched rule', set Attributes for
metrics that you want the policy to send. If default attributes are specified in the Defaults tab,
you use the defaults or you can override them as described below.

The attributes are in two groups: common attributes at the top that apply to all metrics defined
this policy, and attributes specific to eachmetric.

a. Define themetric attributes common to all metrics collected by this policy, such as monitor
name, type, and state.

Tip: The Policy Constants tab lists the available constants representingmetrics
quality (status) that are available in BSM Connector. Use drag and drop to add them to
theQuality attribute.

b. InMetrics, click to add attributes specific to a single metric.

Alternatively, expand an existingmetric group to edit it.

Tip: After loading the indicators from the connected BSM server, the Indicators tab
shows a hierarchy of configuration item types with the associated health indicators
(HIs) and event type indicators (ETIs).

To insert an indicator, drag and drop the indicator from the Indicators tab to the policy.
BSM Connector inserts the indicator name.
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You can createmultiple metrics.

Click to expand ametric attribute group

4. Optionally, use theSample Data tab to drag patternmatching groups and values to the
attribute boxes. Alternatively, you can type the patternmatching group directly into the attribute
box.

Patternmatching groups use the following syntax: $<pattern_matching_group>

<pattern_matching_group> is the name of the group assigned to a particular content match.

BSM Connector replaces the patternmatching group at runtime with the value of the specified
group. If you insert a group value, the value will be used.

Note:

n The default patternmatching group host_name contains the fully qualified domain name
of the BSM Connector server.

n The Sample Data tab is empty if no sample data has been loaded into the policy or if the
sample data does not match the log file pattern specified in the source page. See also
"Configuring the Data Source in Log File Policies" on page 242.

5. Optionally, use theOperations tab to apply operations to themetric attribute values.

Related tasks

l "How to Collect Metrics Data from Log Files" on page 238

l "How to Collect Metrics with Computer - Monitor Topology" on page 142

l "How to Collect Metrics with Custom, Computer, or Computer - Running Software Topology
Data" on page 147

l "How to Collect Metrics Without Reporting Topology" on page 160

UI Descriptions

For a description of the Rules page, see the following sections:

l "Rules Page - Policy Rules" on page 495

l "Condition Tab (Rules Only)" on page 481

l "Default Monitor Attributes and Attributes Tabs" on page 478
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l "Sample Data Tab - Log File Policies" on page 498

l "Indicators Tab" on page 481

l "Operations Tab (Metrics Only)" on page 483

l "Policy Constants Tab (Metrics Only)" on page 491

Configuring Options in Log File Policies
The options tab enables you to configure several policy behaviors, for example which events are
logged locally, how the policy handles unmatched events, and defaults for patternmatching in
policy rules.

To access
In the BSMConnector user interface, click in the toolbar. Then click Event > Log File.

Alternatively, double-click an existing policy to edit it.

Click Options to open the policy Options page.

Tasks

How to configure options for log file policies
In the Options page, configure which events are logged locally, how the policy handles unmatched
events, and defaults for patternmatching in policy rules.

For more information about the other fields, see "Configuring Options in Log File Policies" above.

Related tasks

l "How to Collect Event Data from Log Files" on page 237

UI Descriptions

For a description of the Options page, see "Options Page (Events Only)" on page 489.

Configuring Field Mapping in Log File Policies
The field mapping page is only available in policies that have beenmigrated from SiteScope
technology integrationmonitors of the data typeCommon Events or Legacy Events. The field
mapping defines the conversion rules from third-party data to the BSM event format.

You can use the field mapping page tomodify andmaintain the event field mapping inmigrated
integrationmonitor policies.

For more information on field mapping, see the SiteScope Help or the the Using SiteScopeGuide.

BSM Connector User Guide
Chapter 11: Log File Policies

HP Business ServiceManagement (9.23) Page 260 of 521



To access
In the BSMConnector user interface, select amigrated integrationmonitor policy and click in
the toolbar, or double-click an integrationmonitor policy. The integrationmonitor policy editor
opens. 

Click Field Mapping to open the policy Field Mapping page.

Learn More
Legacy and Common Events Data Type
In SiteScope, you can choose the Common Events or Legacy Events data type to integrate events
collected from third-party systems to BSM:

l Common Events Integration. The SiteScope Common Events integration typemakes events
available for use in the following BSM applications:

n Operations Management

n Service Health

n Service Level Management

l Legacy Events Integration (deprecated). The SiteScope Legacy Events integrationmakes
events available for use in:

n System Availability Management Event Log

n BSM's Service Health

n Trend reports

For more information on common and legacy event integrations, see the SiteScope Help or the the
Using SiteScopeGuide.

Tasks
Related tasks

l "How toMigrate SiteScope Technology IntegrationMonitors" on page 40

UI Descriptions
For a description of the Field Mapping page, see "Field Mapping Page" on page 481.
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Configuring Topology Scripts in Log File Policies
The topology page enables you to create a topology in BSM's RTSM by selecting an out-of-the-box
script or creating your own custom script.

Note: For detailed information on topology scripts, see "Working with Jython-Based Topology
Scripts " on page 180.

To access

l In the BSMConnector user interface, click in the toolbar. Then click Event > Log File.

l In the BSMConnector user interface, click in the toolbar. Then click Metrics > Log File.

l In the BSMConnector user interface, click in the toolbar. Then click Topology > Log
File.

Alternatively, double-click an existing policy to edit it.

Click Topology to open the policy Topology page.

Learn More
This section includes:

l "Selecting a Topology" below

l "Custom Topology Scripts" on page 265

l "Mandatory Values WhenReporting Topology Only" on page 265

Selecting a Topology
The following topology scripts are available for integrating events, metrics, and topology:

Topology Script
Events
Integration

Metrics
Integration

Topology
Integration

No Topology

Select if you do not want to send any topology
(althoughmetrics and event data is still sent).

yes yes not
available
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Topology Script
Events
Integration

Metrics
Integration

Topology
Integration

Computer - Monitor (deprecated)

Creates a topology with a Computer CI connected to a
SiteScope CI with aMonitored By link.

Note:

The Computer - Monitor topology script has been
deprecated. For new metrics integrations, use the
Computer, Computer - Running Software, or a
custom topology script.

The Computer - Monitor topology integration
requires that the names or IP addresses of the
nodes that it adds to the RTSM are accessible
through DNS resolution. To successfully add a
Node CI specified in a policy's Target field to the
RTSM, BSMConnector must be able to resolve
the node's fully qualified domain name and IP
address through a DNS service.

not
available

yes not
available

Computer

Creates a topology with a Computer CI.

The Computer topology script is not available in
migrated SiteScope technology integrationmonitors.

yes yes yes
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Topology Script
Events
Integration

Metrics
Integration

Topology
Integration

Computer - Running Software

Creates a topology with a Computer CI and a Running
Software CI connected to it with aComposition
relationship. The following illustrates the topology
created for the Computer - Running Software
integration type which retrieves data from a third-party
system:

The Computer - Running Software topology script is
not available in migrated SiteScope technology
integrationmonitors.

yes yes yes

Custom

You create your own topology if you want the retrieved
data to be forwarded to specific CIs and not one of the
out-of-the-box topology scripts.

Note: You should only select Custom if you are
familiar with the Jython language, since youmust
create the topology script in Jython yourself.
Depending on the data type you want to collect,
we recommend that you select and edit one of the
out-of-the-box scripts.

yes yes yes

Note: BSMConnector automatically populates theMonitored by attribute of the reported CIs
with the following values when using one of the out-of-the-box topology scripts:

l BSM Connector

l <policy name>where <policy name> is the name of the policy as set in the policy's
Properties page
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Custom Topology Scripts
You can choose one of the out-of-the-box topologies which are already configured with the
necessary information, or you can create your own custom topology script.

To create a custom script, use the script editor provided in the Topology page, or use any other
script editor. Following are the guidelines for creating your own topology script:

l For general information on topology scripts, see "Working with Jython-Based Topology Scripts "
on page 180.

l Youmay use the following code to set theMonitored by attribute on the CIs reported by a
custom script:

ems_lib.addMonitoredByForThirdPartySoftware(Framework, <computer>)

l Use the following code to get the routing domain for a Node CI:

domainName = system_lib.getDiscoveryDomainByIP(Framework, <IP or node DNS
name>)

Formore information on the routing domain attribute in RTSM, see the Data Flow Management
Guide.

l You can access values such as group0, group1, and so forth, from log file policies. For
example, you can access the value of the second variable in the log file line in the following way:

group1 = Framework.getDestinationAttribute("group1")

Mandatory Values When Reporting Topology Only
The following values aremandatory when reporting only the topology discovered by the BSM
Connector policies, without reporting events or metrics data:
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For
Topology
Script

Field
Name Description

l Computer

l Computer -
Running
Software

target_
name

Name of the host or machine that generated the event. This can be
addedmanually or taken from:
Framework.getDestinationAttribute("<someAttribute>")

Examples:

Log file policies: Framework.getDestinationAttribute("group0") where
group0 is the value of the first patternmatching group.

Database policies: Framework.getDestinationAttribute("NAME")
where NAME is the name of a database column.

Web service listener policies: Framework.getDestinationAttribute
(“Host") where HOST is the key in the SOAP request
<key>Host</key>.

l Computer

l Computer -
Running
Software

target_
ip

IP of the host or machine. This can be addedmanually, or calculated
using:
HostIPCachingManager.getIPByHostName(target_name)

where target_name represents a valid host or machine, or you can
use:
HostIPCachingManager.getIPByHostName("<someAttribute>")

Computer -
Running
Software

name Name of Running Software. This can be addedmanually, or taken
from:
Framework.getDestinationAttribute("<someAttribute>")

Tasks
This section includes:

l "How to report topology with event data" below

l "How to report topology with metrics data" on the next page

l "How to report topology without event or metrics data" on page 268

How to report topology with event data

1. In the BSMConnector user interface, click in the toolbar. Then click Event > Log File.

Click Topology to open the policy Topology page.

2. Select a script template and if necessary, click Load Template.

The out-of-the-box topology scripts do not require any changes.
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To create a custom script, see "Working with Jython-Based Topology Scripts " on page 180 for
more information.

3. Optionally, use theSample Data tab to drag patternmatching groups and values to the
topology script. Alternatively, type the patternmatching group directly into the topology script,
for example, group0.

BSM Connector replaces the patternmatching group at runtime with the value of the specified
group. If you insert a group value, the value will be used.

Note:

n The default patternmatching group host_name contains the fully qualified domain name
of the BSM Connector server.

n The Sample Data tab is empty if no sample data has been loaded into the policy or if the
sample data does not match the log file pattern specified in the source page. See also
"Configuring the Data Source in Log File Policies" on page 242.

How to report topology with metrics data

1. In the BSMConnector user interface, click in the toolbar. Then click Metrics > Log
File.

Click Topology to open the policy Topology page.

2. Select a script template and if necessary, click Load Template.

The out-of-the-box topology scripts do not require any changes.

To create a custom script, see "Working with Jython-Based Topology Scripts " on page 180 for
more information.

3. Optionally, use theSample Data tab to drag patternmatching groups and values to the
topology script. Alternatively, type the patternmatching group directly into the topology script,
for example, group0.

BSM Connector replaces the patternmatching group at runtime with the value of the specified
group. If you insert a group value, the value will be used.

Note:

n The default patternmatching group host_name contains the fully qualified domain name
of the BSM Connector server.

n The Sample Data tab is empty if no sample data has been loaded into the policy or if the
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sample data does not match the log file pattern specified in the source page. See also
"Configuring the Data Source in Log File Policies" on page 242.

How to report topology without event or metrics data

1. In the BSMConnector user interface, click in the toolbar. Then click Topology > Log
File.

Click Topology to open the policy Topology page.

2. Select a script template and if necessary, click Load Template.

3. Select a script template and if necessary, click Load Template.

The out-of-the-box topology scripts do not require any changes.

To create a custom script, see "Working with Jython-Based Topology Scripts " on page 180 for
more information.

4. Map the data discovered by the policy to the relevant attributes in the topology script.

For a list of mandatory values, see "Mandatory Values WhenReporting Topology Only" on
page 265.

5. Optionally, use theSample Data tab to drag patternmatching groups and values to the
topology script. Alternatively, type the patternmatching group directly into the topology script,
for example, group0.

BSM Connector replaces the patternmatching group at runtime with the value of the specified
group. If you insert a group value, the value will be used.

Note:

n The default patternmatching group host_name contains the fully qualified domain name
of the BSM Connector server.

n The Sample Data tab is empty if no sample data has been loaded into the policy or if the
sample data does not match the log file pattern specified in the source page. See also
"Configuring the Data Source in Log File Policies" on page 242.

Note: BSM removes CIs from the RTSM if no topology data has been received for them over a
period of time. To prevent BSM from deleting the CIs that BSM Connector has sent to BSM,
BSMConnector regularly sends a list of active CIs to BSM in addition to the topology data.
Inactive CIs are not sent to the RTSM and aremarked for deletion in the RTSM.
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You can configure BSM Connector to always send CIs regardless of whether topology data
has been received for them. This guarantees that CIs reported by BSMConnector are never
deleted automatically from the RTSM. This configuration option is known as always touch
mode and is recommended for BSM Connector topology-only policies that collect data from
incremental data sources such as log files or databases. The first time the policies run, they
collect all CIs from the data source. The next time the policies run, they collect new and
changed CIs only and then forward only the additions and changes to BSM. The always touch
mode ensures that the already existing, unchanged CIs are also reported and are thus not
deleted.

For more information, see "Touching of CIs in BSM Connector" on page 192.

Related tasks

l "How to Collect Event Data from Log Files" on page 237

l "How to Collect Metrics Data from Log Files" on page 238

l "How to Collect Topology Data from Log Files" on page 239

UI Descriptions

For a description of the Topology page, see the following sections:

l "Topology Page - Database, Log File, Web Service Listener, and Custom Topology Policies" on
page 514

l "Source Page - Log File Policies" on page 506

Regular Expressions
BSMConnector uses regular expressions tomatch log file content.

Regular expressions is a name given to a text parsing tool that was developed for use with scripting
languages such as Awk and Perl, as well as several programming environments, such as Emacs,
Visual C++, and Java. Regular expressions themselves are not a programming language. They do,
however, make use of many special combinations of characters and symbols that oftenmake them
more difficult to interpret than some programming languages. Themany different combinations of
these special characters, known as metacharacters, make regular expressions a very powerful and
flexible tool for parsing and isolating specific text within a larger body of text.

Including a regular expression in the Log File Pattern text box of a log file policy instructs BSM
Connector to parse the text returned to the policy when it is run and look for content that satisfies
the pattern defined by the regular expression. This document presents an overview of the syntax
andmetacharacters used in regular expressions for use inmatching content for BSM Connector log
file policies.
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Define a Regular Expression
Surrounding the regular expression with parentheses ( ) instructs BSM Connector to create pattern
matching groups. BSM Connector retains what was matched between the parentheses and
displays the text in the Sample Data tabs. You can then insert the patternmatching groups in event
attributes, mappings, and rules. For more information about patternmatching groups, see "Pattern
matching groups" on page 243. This is also very useful for troubleshooting your pattern.
Parentheses are also used to limit alternations, as discussed below.

Generally, it is best to use an iterative approach when building regular expressions for content
matching within BSM Connector. The following are some general steps and guidelines for
developing regular expressions for content matches:

l Create a regular expression using literal characters to match a single sample of the data you
want to check. For example, (value: 1022.5).

l Iteratively replace literal characters with character classes andmetacharacters to generalize the
literal into a pattern. For example, the literal in the example above could be changed to:
(value:\s\d\d\d\d\.\d) to match any four digits, a decimal point, and onemore digit.

l Consider that the pattern of the data you want to matchmay vary. Adjust your pattern tomatch
expected or possible variations in the target data. Continuing with the example used above, the
expression (value:\s\d\d\d\d\.\d)might become (value:\s[\d]{1, 8}\.[\d]{1,2}).
This pattern enables variation in the number of digits to the left of the decimal point and the
number of digits to the right of the decimal point. It expects that there is a decimal point. See the
following sections for more information about the character classes used here.

l Consider that the literal string or pattern you want to matchmay appear more than once in the
content. Identify unique content that precedes the content you want to match, and add regular
expression patterns tomake sure that the expressionmatches that unique content before it tries
to match the content you are trying to check. In the example used here, the patternmay match
the first of several entries that have a similar (value: numbers) pattern. Adding a literal to the
pattern, that matches some static content that delimits the particular data, can be used to be
sure thematch is made for the target data. For example, if the data you want to match is
preceded by the text Open Queries, this literal can be added to the pattern, along with a pattern
for any intervening content: (Open Queries[\s\W]{1,5} value:\s[\d]{1, 8}\.[\d]{1,2}).

Match String Literals
Finding andmatching an exact or literal string is the simplest form of patternmatching with regular
expressions. In matching literals, regular expressions behavemuch as they do in search/replace in
word processing applications. The example abovematched the text Web site. The regular
expression (Buy Now) succeeds if the text returned to the policy contains the characters Buy Now,
including the space, in that order.

Note that regular expressions are, by default, case sensitive and literal. This means that the
content must match the expression in case and order, including non-alphanumeric characters. For
example, a regular expression of (Website), without any modifiers, succeeds only if the content
contains the string Website exactly but fails even if the content on the page is website, WEBSITE,
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or Web site. (In the last case thematch fails because there is space between the two words but
not in the regular expression.)

There are cases where youmay want to literally match certain non-alphanumeric characters which
are special "reserved" metacharacters used in regular expressions. Some of thesemetacharacters
may conflict with important literals that you are trying tomatch with your regular expression. For
example, the period or dot symbol (.), the asterisk (*), the dollar sign ($), and back slash (\) have
special meanings within regular expressions. Because one of these characters may be a key part of
a particular text pattern you are looking for, youmust "escape" these characters in your regular
expression so that the regular expression processing treats them as literal characters rather than
interpreting them as special metacharacters. To force any character to be interpreted as a literal
rather than ametacharacter, add a back slash in front of that character.

Example - Matching a Literal String
For example, if you wanted to find the string 4.99 on aWeb page youmight create a regular
expression of (4.99). While this matches the string 4.99, it would alsomatch strings like 4599
and 4Q99 because of the special meaning of the period character. To have the regular expression
interpret the period as a literal, escape the period with a forward slash as follows: (4\.99). You can
add the back slash escape character in front of any character to force the regular expression
processing to interpret the character following the back slash as a literal. In general, use this syntax
whenever you want to match any punctuationmark or other non-alphanumeric character.

Using Alternation
Alternation enables you to construct either/or matches where you know that one of two or more
strings should appear in the content. The alternation character is the vertical pipe symbol ("|").

The vertical pipe is used to separate the alternate strings in the expression. For example, the
regular expression ((e-mail|e-mail|contact us)) succeeds if the content contains any one of
the three strings separated by the vertical pipes. The parentheses are used here to delimit
alternations. In this example, there are no patterns outside of the alternation that must bematched.
In contrast, a regular expressionmight be written as ((e-mail|e-mail|contact) us). In this
case, thematch succeeds only when any of the three alternates enclosed in the parentheses is
followed immediately by a single white space and the word us. This is more restrictive than the
previous example, but also shows how the parentheses limit the alternation to the three words
contained inside them. Thematch fails even if one or more of the alternates are found but the word
"us" is not the next word.

Match Patterns with Metacharacters
Often youmay not know the exact text you need tomatch, or the text patternmay vary from one
session or from one day to another. Regular expressions have a number of special metacharacters
used to define patterns andmatch whole categories of characters. While matching literal
alphanumeric characters seems trivial, part of the power of regular expressions is the ability to
match non-alphanumeric characters as well. Because of this, it is important to keep inmind that
your regular expressions need to account for the presence of non-alphanumeric characters in the
content you are searching. This means that characters such as periods, commas, hyphens,
quotationmarks, and even white spaces, must be considered when constructing regular
expressions.

This section contains the following topics:
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l "Metacharacters Used in Regular Expressions" below

l "Defining Character Classes" below

l "Using Quantifiers" on the next page

Metacharacters Used in Regular Expressions

Metacharacter Description

\s Matches generic white space (that is, the Spacebar key). This metacharacter is
particularly useful when combined with a quantifier to match varying numbers of
white space positions that may occur between words that you are looking to
match.

\S Matches characters that are not white space. Note that the \S is capitalized as
opposed to the small \swhich is used tomatch white space.

. This is the period or dot character. Generally, it matches all characters.
Because BSMConnector considers the dot as a form of character class on its
own, do not include it inside the square brackets of a character class.

\n Matches the linefeed or newline character.

\r Matches the carriage return character.

\w Matches non-white space word characters, the same as what is matched by
character class [A-Za-z0-9_]. It is important to note that the \w metacharacter
matches the underscore character but not other punctuationmarks such as
hyphens, commas, periods, and so forth.

\W Matches characters other than thosematched by \w (lowercase). This is
particularly useful for matching punctuationmarks and non-alphabetic
characters, such as ~!@#$%^&*()+={[}]:; and including the linefeed character,
carriage return, and white space. It does not match the underscore character,
which is considered a word constituent matched by \w.

\d Matches digits only. This is equivalent to the [0-9] character class.

\D Matches non-numeric characters (what \d does not match) plus other
characters. Similar to \W but alsomatches on alphabetic characters. In BSM
Connector, this generally matches everything, includingmultiple lines, until it
encounters a digit.

\b Requires that thematch have a word boundary (usually a white space) at the
position indicated by the \b.

\B Requires that thematch not have a word boundary at the position indicated.

Defining Character Classes
An important and very useful regular expression construct is the character class. Character classes
provide a set of characters that may be found in a particular position within a regular expression.

BSM Connector User Guide
Chapter 11: Log File Policies

HP Business ServiceManagement (9.23) Page 272 of 521



Character classes may be used to define a range of characters to match a single position or, with
the addition of a quantifier, may be used to universally matchmultiple characters and even
complete lines of text.

You form character classes by enclosing any combination of characters andmetacharacters in
square brackets: [ ]. Character classes create an "any-or-all-of-these" group of characters that may
bematched. Unlike literals andmetacharacters outside character classes, the physical sequence
of characters andmetacharacters within a character class has no effect on the search or match
sequence. For example, the class [ABC0123abc] matches the same content as [0123abcABC].

The hyphen is used to further streamline character classes to indicate a range of letters or numbers.
For example, the class [0-9] includes all digits from zero to nine inclusive. The class [a-z] includes
all lowercase letters from a to z. You can also createmore restrictive classes with the hyphen, such
as [e-tE-T], to match upper or lowercase letters from E to T, or [0-5] to match digits from zero to five
only.

You can use the caret character (^) within a character class as a negation or to exclude certain
characters from a content match.

Example Character Classes

Example Description

[a-zA-Z] This matches any alphabetic character, both upper case and lowercase, from the
letter a to the letter z. Tomatchmore than one character, append a quantifier after the
character class as described below.

[0-9] This matches any digit from 0 to 9. Tomatchmore than one digit, append a quantifier
after the character class as described below.

[0-9A-Za-
z]

This matches any alphanumeric character, excluding the underscore.

[\w\s] This matches any alphanumeric character, any white space, or both.

Using Quantifiers
Another set of metacharacters used in regular expressions provides character counting options.
This adds a great deal of power and flexibility in content matching. Quantifiers are appended after
themetacharacters and character classes described above to specify against which positions the
precedingmatch character or metacharacter should bematched. For example, in the regular
expression ((contact|about)\s+us), themetacharacter \smatches on a white space. The plus
sign quantifier following the \smeans that theremust be at least one white space between the
words contact (or about) and us.

The following table describes the quantifiers available for use in regular expressions. TheQuantifier
applies to the single character immediately preceding it. When used with character classes, the
quantifier is placed outside the closing square bracket of the character class. For example: [a-z]+
or [0-9]*.
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Quantifier Description

? The questionmark means the preceding character or character class may appear
once, but is optional and not required to appear in the position indicated.

* The asterisk requires that any number of the preceding character or character class
appear in the designated position. This includes zero or morematches.

Note: Caremust be used in combining this quantifier with the dot (.) metacharacter
or a character class including the \W metacharacter, as these are likely to "grab"
more content than anticipated and cause the regular expression engine to use up all
of the available CPU time on the BSMConnector server.

+ The plus sign requires that the preceding character or character class appear at
least once.

{min,
max}

Using curly braces creates a quantifier range. The range enumerator digits are
separated by commas. This construct requires that the preceding character or
character class appear at least as many times as specified by themin enumerator
up to but nomore than the value of themax enumerator. Thematch succeeds as
long as there are at least as many matches as specified by themin enumerator.
However, thematching continues up to the number of times specified by themax
enumerator or until nomorematches are found.

Search Mode Modifiers
Regular expressions used in BSM Connector may include optional modifiers outside of the slashes
used to delimit the expression. Modifiers after the ending slash affect the way thematching is
performed. For example, regular expression of (website)/iwith the i searchmodifier added
makes thematch content search insensitive to upper and lowercase letters. This wouldmatch
either website, Website, WEBSite, or even WEBSITE.

With the exception of the imodifier, somemetacharacters and character classes can override
searchmodemodifiers. In particular, the dot (.) and the \Wmetacharacters can override the m and s
modifiers, matching content across multiple lines despite themodifier.

More than onemodifier can be added by concatenating them together after the closing slash of the
regular expression. For example: (matchpattern)/ic combines both the i and c modifiers.

Regular Expression Match Mode Modifiers

Mode
Modifier Description

/i Ignore casemode. This makes the search insensitive to upper case and lowercase
letters. This is a useful option especially when searching for matches in the text
content of Web pages.
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Mode
Modifier Description

/c Thematched patternmay NOT appear anywhere in content that is being searched.
This is a "complement" match, returning an error if the pattern IS found, and
succeeding if the pattern is NOT found.

/m Match across multiple lines WITHOUT ignoring intervening carriage returns and
linefeeds. With this modifier youmay still need to account for possible linefeeds and
carriage returns with a character class such as [\w\W]* or [\s\S\n\r]*. The .* does not
match carriage returns or linefeed characters with this modifier.

/s Consider the content as being on a single line, ignoring intervening carriage returns
and linefeed characters. With this modifier, both the [\w\W]* character class and the
.* patternmatch across linefeeds and carriage returns.

BSM Connector Date Variables
BSMConnector uses specially defined variables to create expressions that match the current date
or time. These variables can be used in the log file pattern field to find date-coded content. The
General Date Variables are useful for matching portions of date formats. The Language/Country
Specific Date Variables enable you to automatically extend the language used for month names
and weekday names to specific countries, based on ISO codes.

This section contains the following topics:

l "General Date Variables" below

l "Language/Country Specific Date Variables" on the next page

l "Special Substitution for File Path" on page 277

General Date Variables
The following table lists the general variables:

Variable Range of Values

$hour$ 0 - 23

$minute$ 0 - 59

$month$ 1 - 12

$day$ 1 - 31

$year$ 1000 - 9999

$shortYear$ 00 - 99
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Variable Range of Values

$weekdayName$ Sun - Sat

$fullWeekdayName$ Sunday - Saturday

$0hour$ 00 - 23

$0minute$ 00 - 59

$0day$ 01 - 31 (two-digit day format)

$0month$ 01 - 12 (two-digit month format)

$monthName$ Jan - Dec (three-letter month format in English)

$fullMonthName$ January - December

$ticks$ milliseconds sincemidnight, January 1, 1970

For example, if the content match search expression was defined as:

Updated on $0month$\/$0day$\/$shortYear$

and the content returned by the request includes the string:

Updated on 06/01/98

then the expression wouldmatch when the policy is run on June 1, 1998. Thematch fails if the
content returned does not contain a stringmatching the current system date or if the date format is
different than the format specified.

If you want the time to be before or after the current time, you can add a $offsetMinutes=mmmm$
to the expression, and this offsets the current time bymmmmminutes (negative numbers are
permitted for going backwards in time) before doing the substitutions.

For example, if the current day is June 1, 2007, and the search expression is:

$offsetMinutes=1440$Updated on $0month$\/$0day$\/$shortYear$

the content string that wouldmatch would be:

Updated on 06/02/07

Note: The date is one day ahead of the system date.

Language/Country Specific Date Variables
The following table lists the BSMConnector special variables for use with international day and
month namematching. The characters LL and CC are placeholders for two-letter ISO 639 language
code characters and two-letter ISO 3166 country code characters (see the notes below the table for
more details).
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Variable Range of Values

$weekdayName_LL_
CC$

Abbreviated weekday names for the language (LL) and country (CC)
specified (see notes below).

$fullWeekdayName_
LL_CC$

Full weekday names for the language (LL) and country (CC) specified.

$monthName_LL_
CC$

Abbreviatedmonth names for the language (LL) and country (CC)
specified.

$fullMonthName_LL_
CC$

Full month names for the language (LL) and country (CC) specified.

CC - an uppercase 2-character ISO-3166 country code. Examples are: DE for Germany, FR for
France, CN for China, JP for Japan, BR for Brazil. You can find a full list of these codes at a
number of Internet sites, such as:
http://www.iso.org/iso/country_codes/iso_3166_code_lists/country_names_and_code_
elements.htm.

LL - a lowercase 2-character ISO-639 language code. Examples are: de for German, fr for French,
zh for Chinese, ja for Japanese, pt for Portuguese. You can find a full list of these codes at a
number of Internet sites, such as:
http://www.ics.uci.edu/pub/ietf/http/related/iso639.txt or
http://www.dsv.su.se/~jpalme/ietf/language-codes.html.

For example, if the content match expression was defined as:

$fullWeekdayName_fr_FR$

and the content returned by the request includes the string:

mercredi

then this expression wouldmatch when the policy was run onWednesday.

If you are not concerned with the country-specific language variations, it is possible to use any of
the above variables without including the country code. For example:

$fullWeekdayName_fr$

could be used tomatch the same content as /$fullWeekdayName_fr_FR$/.

Special Substitution for File Path
BSMConnector Date Variables are useful for matching content as part of a regular expression. The
date variables can also be used as a special substitution to dynamically create file paths for log file
policies. This is useful for accessing date-coded files and directories where the file path is updated
automatically based on system date information. BSM Connector is an example of an application
that creates date-coded log files. The log file names include some form of the year, month, and day
as part of the file name, such as File2001_05_01.log,where the year, month, and date are
included.

Based on this example, a new file is created each day. Checking the creation, size, or content of
the current days file would normally require the file path of the log file policy to bemanually changed
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each day. Using the BSMConnector date variables and special substitution, BSM Connector can
automatically update the file path to the current day's log file. By knowing the pattern used in
naming the files, you can construct a special substitution string similar to a regular expression that
substitutes portions of the system date properties into the file path.

For example if the absolute file path to the current day's log file in a log file policy is:

D:/Production/Webapps/Logs/File2001_05_01.log

the log file for the following day would be:

D:/Production/Webapps/Logs/File2001_05_02.log

You can construct a special substitution expression to automatically update the file path used by
the policy, with the following syntax:

s/D:\/Production\/Webapps\/Logs\/File$year$_$0month$_$0day$.log/

The substitution requires that the expression start with a lower-case s and that the expression is
enclosed by forward slashes /.../. Forward slashes that are part of the file pathmust be escaped
by adding the back slash (\) character as shown. The BSMConnector date variables are separated
by the underscore character literals. BSM Connector checks the system time properties each time
the policy runs and substitutes with applicable values into the file path before accessing the file.

While the special substitution syntax is similar in syntax to the substitution syntax used in regular
expressions, they are not the same. While all of the BSM Connector date variables can be used in
match content regular expressions, the special substitution discussed here can not be used as part
of amatch content expression.

Examples for Log File Policies
Log file policies check for entries in files created by other applications. These files may be data files
created by a third-party application or they may be logs created by a custom system specially
designed for your environment. Where the logs or files are written with a known, predictable format,
BSM Connector can be configured to regularly check the files for new entries andmatch on specific
content strings. The following are several examples of log file entries and simple regular expression
patterns that can be used to check the entries. You can use these examples or modify them to work
with a specific case.

Note: All regular expressions must be entered on a single line in BSM Connector. Some of the
examples below may break across more than one line to fit on this page.

This section contains the following topics:

l "Searching Paths for Log Files" on the next page

l "Matching Comma-Separated Values" on page 280

l "Matching Space Separated Values" on page 280

l "Matching and Retaining the Numbers in a Line of Text and Numbers" on page 280
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l "Matching Integers and Floating-point Numbers (Positive or Negative)" on page 281

l "Matching Date and Time-Coded Log Entries" on page 281

Searching Paths for Log Files
UNIX andWindows operating systems treat the case ("N" and "n") of file names in incompatible
ways. Windows operating systems are case insenstive whichmeans that when a file is being
searched, its case is ignored. UNIX operating systems are case sensitive whichmeans that the
case of a name is significant at all times. To avoid log file errors when using regular expressions to
search for path names on UNIX operating systems, usemarkers to change the character case in
the path expression.

Marker Description

$L Enables changing characters between the $Lmarker and the $E marker to lowercase.

$U Enables changing characters between the $U marker and the $E marker to upper case.

$E The endmarker used for changing character case.

Example:

If you define the following path expression:

s/\/tmp\/logs\/arcv.log.$weekdayName$/

for the /tmp/logs/arcv.log.tue log file on a Linux machine, you get a log file error because
BSMConnector tries to find tmp/logs/arcv.log.Tue, and Linux is case sensitive.

To resolve this problem, define the path expression as follows:

s/\/tmp\/logs\/arcv.log.$L$weekdayName$$E/

The policy converts the characters between $L and $E to lowercase,
/tmp/logs/arcv.log.tue.

Conversely, use $U and $E to enable BSM Connector to change the characters between the
markers to upper case. For example, if you define the path expression:

s/\/tmp\/logs\/arcv.log.$L$weekdayName$$E/

the policy converts the path to /tmp/logs/arcv.log.TUE.

You can use $L and $Umultiple times in a path expression, and you can use them both in the
same expression.

For example:

s/\/tmp\/logs-$L$weekdayName$$E\/arcv.log.$U$weekdayName$$E/

converts the path to /tmp/logs-tue/arcv.log.TUE

s/\/tmp.$L$monthName$$E\/logs-$L$weekdayName$$E\/arcv.log.$U$weekdayName$$E/
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converts the path to /tmp.mar/logs-tue/arcv.log.TUE

Matching Comma-Separated Values
The following is an example of log file entries that are comma-separated strings of digits and letters:

new,open,changed,12,alerts
new,open,changed,13,alerts
new,open,changed,13,alerts
new,open,changed,14,alerts

A regular expression tomatch on log file entries that are comma-separated strings of digits and
letters.

([\w\d]+,[\w\d]+,[\w\d]+,[\w\d]+,[\w\d]+)[\n\r]?

Note: If the file entries include punctuationmarks such as an underscore or a colon, add that
character explicitly to the [\w\d] class pattern. For example, to include a colon character,
change each of the [\w\d] patterns to [\w\d:].

Matching Space Separated Values
The following is an example of log file entries that are a sequence of strings and digits separated by
spaces:

requests 12 succeeded 12 failed
requests 12 succeeded 12 failed
requests 11 succeeded 11 failed
requests 12 succeeded 12 failed
requests 10 succeeded 10 failed

The following is a regular expression tomatch on log file entries that are a sequence of strings and
digits separated by spaces.

([\w\d]+\s+[\w\d]+\s+[\w\d]+\s+[\w\d]+\s+[\w\d]+)[\n\r]?

Note: The use of the + character forces thematch to include the number of sequences per line
included in thematch pattern: in this example, five word or number sequences per line of the
log file. If the sequences include punctuationmarks such as an underscore or colon, add that
character explicitly to the [\w\d] class pattern. For example, to include a colon character,
change each of the [\w\d] patterns to [\w\d:].

Matching and Retaining the Numbers in a Line of Text and Numbers
The following is an example of log file entries that are comma separated strings that combine digits
and letters:
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request handle number 12.56, series 17.5, sequence reported 97.45, 15.95 and
19.51
request handle number 15.96, series 27.5, sequence reported 107.45, 25.95 and
19.52
request handle number 11.06, series 36.5, system codes 9.45, 35.95 and 19.53
log reference number 12.30, series 17.5, channel reset values 100.45, 45.95
and 19.54

The following is a regular expression tomatch on log file entries that are comma-separated strings
that combine digits and letters and retain the decimal numeric data:

[,\D\s]+(\d+\.\d+)[,\D\s]+(\d+\.\d+)[,\D\s]+(\d+\.\d+)[,\D\s]+
(\d+\.\d+)[,\D\s]+(\d+\.\d+)[\n\r]?

Note: If the file entries include punctuationmarks such as an underscore or colon, add that
character explicitly to the [,\D\s] class pattern. For example, to include a colon character that
appears embedded in the text sequences, change each of the [,\D\s] patterns to [,:\D\s].

Matching Integers and Floating-point Numbers (Positive or Negative)
The following is an example of log file entries that are a sequence of integers and floating point
numbers that may be negative or positive:

12.1987 -71 -199.1 145 -1.00716
13.2987 -72 -199.2 245 -1.00726
14.3987 -73 -199.3 345 -1.00736
15.4987 -74 -199.4 445 -1.00746

The following is a regular expression tomatch on log file entries that are a sequence of 5 integers
and floating point numbers that may be negative or positive. The numbers in each entry must be
separated by one or more spaces.

(-?\d+\.?\d{0,})[\s]+(-?\d+\.?\d{0,})[\s]+(-?\d+\.?\d{0,})[\s]+
(-?\d+\.?\d{0,})[\s]+(-?\d+\.?\d{0,})[\n\r]?

Matching Date and Time-Coded Log Entries
Many log files include some form of date and time data with each entry. The following is an example
of log file entries that include date and time information together with string data separated by
commas:

20/04/2003 14:29:22,ERROR,request failed
20/04/2003 14:31:09,INFO,system check complete
20/04/2003 14:35:46,INFO,new record created
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The following is a regular expression tomatch on log file entries that are date- and time-coded
followed by comma-separated strings of letters and digits. This example uses the BSMConnector
date variables tomatch only on entries that were created on the same day, month, and year as
indicated by the system clock of the server where BSMConnector is running.

($0day$\/$0month$\/$year$\s+\d+:\d+:\d+,[\w\s]+,[\w\s]+)

The following example uses the BSMConnector date variables tomatch on amore restricted set of
entries that were created on the same day, month, year, and within the same hour as indicated by
the system clock of the server on which BSMConnector is running.

($0day$\/$0month$\/$year$\s+$0hour$:\d+:\d+,[\w\s]+,[\w\s]+)

Problems Working with Regular Expressions
This section contains problems encountered when working with regular expressions.

This section contains the following topics:

l "Using the .* construct presents a very large number of possible matches on any page of
content" below

l "Regular expressionmatch succeeds as soon as theminimummatch requested is satisfied"
below

l "Forgetting to account for non-alphanumeric content" below

l "Use of excessivemetacharacters can be problematic" on the next page

l "Example Regular Expression Syntax" on the next page

Using the .* construct presents a very large number of possible matches
on any page of content
The use of the .* construct is known to cause the regular expression-matching engine used by BSM
Connector to take over all available CPU cycles on the BSMConnector server. If this occurs, BSM
Connector is unable to function andmust be restarted each time the log file policy with the offending
regular expression is run, until the expression has been corrected.

Regular expression match succeeds as soon as the minimummatch
requested is satisfied
After amatch is made, no further matching is performed. Therefore, regular expressions are not well
suited to count the number of occurrences of a repeating text pattern.

Forgetting to account for non-alphanumeric content
Regular expressions need to be written to account for all of the characters that are andmay be
present. This includes white space, linefeed, and carriage returns. This is not normally a problem
whenmatching a single-word literal. It can be a challenge when you need to create amatch of
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several words separated by unknown amounts of white space and other non-alphanumeric
characters and possibly spanmore than one line. The [\s\n\r]+ character class can be useful
between words used in the expression. Always check the format of the content you are trying to
match to look for patterns and special characters, such as periods, commas, and hyphens, that
may cause a seemingly simplematch to fail.

Use of excessive metacharacters can be problematic
In some cases, overly generous quantifiers combined with the . or \Wmetacharacters can grab
content that you were intending tomatch with a literal string elsewhere in your regular expression
resulting in amatch failure. For example, the followingmight be used tomatch the log file line: User
"([\W\w\s]*)". When the policy performs the check for this regular expression, however, the
match grabs the first occurrence of the pattern User "... and continues matchingmultiple lines of
text up to the last quotationmark found in the file. Without some other unique ending delimiter, the
[\W\w\s]* class and quantifier combination is too excessive. A more successful syntax that
narrows the class of expected characters would be: User "?([:\/\w\s\d\.]*)"?

Example Regular Expression Syntax
The following are some examples of syntax for use in regular expressions:

Example
Expression Description

CUSTID\s?=\s?
([A-Z0-9]{20,
48})

This examplematches an ID string that is made of 20 or more digits and upper-
case letters with no spaces or other non-alphanumeric characters. The \s?
construct permits a white space on either side of the equals sign. Using the
parentheses around the character class instructs BSM Connector to retain this
value (up to themaximum of 48 characters) as a patternmatching group and
thematched value is displayed in the Sample Data tabs.

"[^"]*" This examplematches text sequences that are contained between quotation
marks. Note the use of the negation caret (^) to define a character class of all
characters other than the quotationmark.

As with programming and scripting languages, there is almost always more than one way to
construct a regular expression to accomplish a particular match. There is not one right way to build
regular expressions. You should plan to test andmodify regular expressions as necessary until you
get the results you need.

Troubleshooting Log File Policies
This section describes troubleshooting and limitations when working with log file policies.

This section includes:

l "Debugging errors" on the next page

l "Log file policy file rolling" on page 285
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l "Metrics troubleshooting" on page 286

l "Topology troubleshooting" on page 286

Debugging errors

l Check for errors in the following files:

<BSM Connector root directory>\logs\error.log

<BSM Connector root directory>\logs\RunMonitor.log

<BSM Connector root directory>\logs\bac_integration\bac_integration.log.

l You canmodify the level and type of information reported to the log files by changing the log file
settings in the <BSM Connector root
directory>\conf\core\Tools\log4j\PlainJava\log4j.properties file. You can instruct the
loggingmechanism to:

n Report logged information in less or greater detail than is reported by default.

n Log all metrics sent by metrics integration policies to BSM.

n Log all received data from third-party systems.

To modify log settings:

a. Open the log4j.properties file in a text editor.

b. To specify that metrics sent by metrics integration policies to BSM be logged:

i. Locate the following lines in the file:

log4j.category.EmsSamplePrinter=${loglevel}, integration.appender
log4j.additivity.EmsSamplePrinter=false

ii. Change the argument of log4j.category.EmsSamplePrinterfrom ${loglevel} to
DEBUG, as follows:

log4j.category.EmsSamplePrinter=DEBUG, integration.appender

iii. Save the file. It may take a few seconds for the changes to take effect.

The results are logged to the bac_integration.log file.

c. To specify that all received data from third-party systems be logged:
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i. Locate the following lines in the file:

log4j.category.EmsEventPrinter=${loglevel}, monitors.appender
log4j.additivity.EmsEventPrinter=false

ii. Change the argument of log4j.category.EmsEventPrinter from ${loglevel} to
DEBUG, as follows:

log4j.category.EmsEventPrinter=DEBUG, monitors.appender

iii. Save the file. It may take a few seconds for the changes to take effect.

The results are logged to theRunMonitor.log file.

Tip: After you have determined the cause of the problem, we recommend that you set log
levels to their default settings so as not to overload the system.

l If metrics are created and sent from BSMConnector, but the data is not seen in BSM Service
Health, Event Log, or SiteScope reports, look in
<BSM root directory>\log\wde\wdeIgnoredSamples.log to make sure themetrics were not
dropped due tomissing fields or values.

l Change the logging level for Service Health to verify that Service Health received the samples.
Open the following file on the Gateway Server machine:
<BSM root directory>\conf\core\tools\log4j\wde\wde.properties

Change the log level parameter to DEBUG in the following lines:

n log4j.category.com.mercury.am.platform.wde.decode.IgnoredSamples
Logger=${loglevel}, IgnoredSamples.appender

n log4j.category.com.mercury.am.platform.wde.publish_SamplePublisher
Samples=${loglevel}, PublishedSamples.appender

Look at the corresponding log files:

n <BSM root directory>\log\wde\wdeIgnoredSamples.log

n <BSM root directory>\log\wde\wdePublishedSamples.log

Log file policy file rolling
A log file policy reads the following XML file:

Windows: %OvDataDir%\tmp\<policyID>.xml

Linux: /var/opt/OV/tmp/<policyID>.xml

The file contains the results of the patternmatching (that is, the patternmatching groups) in an XML
file format that database policies can evaluate. The file exists only for policies that integrate events.
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To prevent the file from becoming too large, a new version of the file is created when its size
reaches 100000 KB. The original file is renamed and stored as a backup file. By default, up to three
backup files can be created.

Caution:When the XML file rolls, that is, a new version is created, but the policy has not
completed reading all entries, the unread entries are lost and no events are created.

The following defaults are set:

l Maximum file size: 100000 KB

Tip: If not all expected events arrive in BSM, increase themaximum file size to 1000000
KB.

l Maximum number of backup files: 3

To change the defaults:

1. Open the following file:

<BSM Connector root directory>/groups/master.config

2. Change the following values as required:

_eventRollingMaxFileSizeInKB=100000

_eventRollingMaxBackup=3

3. Restart the BSM Connector server:

Windows: Restart theHP BSM Connector service in theAdministrative Tools > Services.

Linux: Restart the BSM Connector main process, type /opt/HP/BSMConnector/stop followed
by /opt/HP/BSMConnector/start.

Metrics troubleshooting
See "Metrics Troubleshooting" on page 178 for more information on troubleshooting and limitations
when BSMConnector sends metrics to BSM.

Topology troubleshooting
See "Topology Troubleshooting and Limitations" on page 193 for more information on
troubleshooting and limitations when BSMConnector is enabled to report CIs and CIs relationships
topology to BSM.
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Chapter 12: Open Message Interface Policies
BSMConnector can integrate data generated by its own openmessage interface command,
opcmsg. Openmessage interface policies filter messages by defining rules for thesemessages.

For example, youmight have a suppress onmatched rule in the openmessage interface policy,
which for example suppresses all submittedmessages with application=Test. If you have such
a condition and submit the call opcmsg application=Test object=Object msg_text="Test
message", then no event will be sent to BSM (themessage has been suppressed).

BSM Connector also provides Java classes that you can use to implement a Java program that
submits messages to openmessage interface policies.

How to Collect Event Data from the Open Message
Interface

This task describes how to collect event data submitted by the opcmsg command-line tool to the
openmessage interface.

1. Prerequisite:Make sure your BSM Connector is set up as a BSMConnector integration server
in BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see the BSM online
help or the BSM Application Administration Guide.

2. In the BSMConnector user interface, click in the toolbar, then click Event > Open
Message Interface. The openmessage interface policy editor opens. 

Alternatively, double-click an existing openmessage interface policy to edit it.

3. In theProperties page, define information that is related to the policy itself (for example, the
name and description of the policy).

For details, see "Configuring OpenMessage Interface Policy Properties" on page 292.

4. In theDefault Event Attributes page, configure the default settings for all events generated by
the policy (for example, default event correlation settings).

For details, see "Configuring Event Defaults in OpenMessage Interface Policies" on page 293.

5. In theRules page, define what the policy should do in response to a specific type of message
submitted to the openmessage interface.

For details, see "Configuring Rules in OpenMessage Interface Policies" on page 294.
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6. In theOptions page, configure several policy behaviors (for example, patternmatching
options).

For details, see "Configuring Options in OpenMessage Interface Policies" on page 297.

7. Click OK to save the policy and close the editor.

8. Optional. If the list of policies does not refresh automatically in the BSMConnector user
interface, click in the toolbar.

9. Activate the openmessage interface policy to start the opcmsgi process on the BSM
Connector server.

10. Use the opcmsg command-line tool to submit messages to the openmessage interface policy.
For details, see "opcmsg Command-Line Tool" below.

Alternatively, use the available Java classes or C API to implement a program that generates
messages. For details, see "opcmsg Java API" on page 290 and "opcmsg C API" on page 292.

opcmsg Command-Line Tool
The command opcmsg generates amessage that BSM Connector openmessage interface policies
evaluate.

The opcmsg command-line tool is located in:

l Windows 32-bit: %OvInstallDir%/bin/opcmsg

l Windows 64-bit: %OvInstallDir%/bin/win64/opcmsg

l Linux: /opt/OV/bin/opcmsg

Note: To enable the opcmsg command-line tool, at least one openmessage interface policy
must be activated on the BSMConnector server. Otherwise the command displays the
followingmessage:

The OVO Message Command is not configured on this system. Contact your OVO
Administrator to configure it. (OpC30-913)

Command Synopsis and Options
opcmsg [-help]

[-id]
[severity=normal|warning|minor|major|critical]

       application=<application>
       object=<object>
       msg_text=<text>

[msg_grp=<message group>]
[node=<node>]
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[service_id=<svcid>]
[-option <var>=<value>]

Tip: You can specify any unique prefix for the available options. Note that the prefix for the
option severity is swhile the prefix for the option service_id is ser.

Option Description

[-help] Optional. Prints the usagemessage of opcmsg. All other options
are ignored and nomessage is submitted.

[-id] Optional. Returns themessage ID of the submittedmessage to
stdout. This option also sets the OPCDATA_REMARK_FOR_
ACK flag of themessage, so that themanager information of the
message is held by themessage agent.

[severity=normal|warning|
minor|major|critical]

Optional. Sets the severity of themessage. The following
severities are supported: normal, warning, minor, major, critical.
By default, the severity normal is applied.

application=<application> Sets the application of themessage.

Tip: Specify the name of the application (or script or program)
that is affected by or has detected the event or problem.

object=<object> Sets the object of themessage.

Tip: Specify the name of the object (or process or sub-
program) that is affected by or has detected the event or
problem.

msg_text=<text> Sets themessage text of themessage.

Tip: Specify a descriptive text that explains the event or
problem inmore detail.

[msg_grp=<message
group>]

Optional. Sets themessage group to which themessage belongs.
By default, nomessage group is assigned.

[node=<node>] Optional. Sets the node of themessage. By default the system
name of the BSMConnector system is applied.

Tip: Specify the fully qualified domain name, the system
name, or the IP address of the system onwhich the event or
problem is detected.
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Option Description

[service_id=<svcid>] Optional. Sets the service ID of themessage. This is the ID of the
service associated with the event. A service ID is a unique
identifier for a service and can be used in BSM to identify the node
and CI associated with the event.

[-option <var>=<value>] Optional. Sets the variable <$OPTION(variable)> to value. You
can use this variable within the policy conditions to access the
value passed the opcmsg call.

Special characters must be escaped.

Exit Values

Value Description

0 Message is successfully generated.

1 Internal error.

2 Syntax or usage error. An error message displays.

Example

To submit a normal message issued when a user logs onto the system, you could set up the
following scheduled task

opcmsg appl=ScheduledTask obj=login severity=normal msg_t="%USERNAME% logged
onto system %COMPUTERNAME%" -option CIHint=myApplication@@%COMPUTERNAME%

opcmsg Java API
HP Operations Agent provides a set of Java classes to generatemessages for openmessage
interface policies. The classes can be used to generatemessages from within a Java program.

Note: The Java classes can also be used to acknowledge previously generatedmessages,
and to sendmonitor values to the HP Operations Agent. BSM Connector does not support
these uses.

JAR files
The JAR files jopcagtbase.jar and jopcagtmsg.jar that are necessary to use the APIs are
installed as part of HP Operations Agent on the BSMConnector server at:

Windows: %OvInstallDir%\java

Linux: /opt/OV/java

Prerequisites
To use the Java classes:

BSM Connector User Guide
Chapter 12: OpenMessage Interface Policies

HP Business ServiceManagement (9.23) Page 290 of 521



l The -classpath parameter used for the javac and java commands must include the
jopcagtbase.jar and jopcagtmsg.jar files.

l The PATH system variable must include the directory where the shared library files reside. The
agent installation does this automatically.

Documentation
Javadoc style class documentation is available at the following location:

Windows: %OvInstallDir%\www\htdocs\jdoc_agent\index.html

Linux: /opt/OV/www/htdocs/jdoc_agent/index.html

Formore information, see the section "Java API" in theHP Operations Agent ReferenceGuide
PDF.

Examples
Examples of how the API classes can be used from Java are available in the following directory on
the BSMConnector server:

Windows: %OvInstallDir%\examples\jopcagtapi

Linux: /opt/OV/OpC/examples/jopcagtapi

To compile and run the example code on Windows

1. Change to the folder %OvInstallDir%/examples/jopcagtapi on the BSMConnector server.

2. Compile the example code, type:

javac -classpath
"%OvInstallDir%/java/jopcagtbase.jar:%OvInstallDir%/java/jopcagtmsg.jar"
JOpcAgtMsgTest.java

3. Run the example code, type:

java -classpath
".:%OvInstallDir%/java/jopcagtbase.jar:%OvInstallDir%/java/jopcagtmsg.jar"
JOpcAgtMsgTest

To compile and run the example code on Linux

1. Change to the directory /opt/OV/OpC/examples/jopcagtapi on the BSMConnector server.

2. Compile the example code, type:

javac -classpath "/opt/OV/java/jopcagtbase.jar:/opt/OV/java/jopcagtmsg.jar"
JOpcAgtMsgTest.java

3. Run the example code, type:
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java -classpath ".:/opt/OV/java/jopcagtbase.jar:/opt/OV/java/jopcagtmsg.jar"
JOpcAgtMsgTest

opcmsg C API
HP Operations Agent provides a C-based API (application programming interface) to generate
messages for openmessage interface policies. The API can be used to generatemessages from
within a C program.

Note: The API can also be used to acknowledge previously generatedmessages, and to send
monitor values to the HP Operations Agent. BSM Connector does not support these uses.

For more information about the C-basedmessage API, see the section "Agent Application
Programming Interface" in theHP Operations Agent ReferenceGuidePDF.

Open Message Interface Policy User Interface
This section includes:

l "Configuring OpenMessage Interface Policy Properties" below

l "Configuring Event Defaults in OpenMessage Interface Policies" on the next page

l "Configuring Rules in OpenMessage Interface Policies" on page 294

l "Configuring Options in OpenMessage Interface Policies" on page 297

Configuring Open Message Interface Policy Properties
Every policy has a set of properties that identify and describe the policy. Properties include, for
example, the policy name and a description of what the policy does.

To access
In the BSMConnector user interface, click in the toolbar, then click Event > Open Message
Interface. The openmessage interface policy editor opens. 

Alternatively, double-click an existing openmessage interface policy to edit it.

Tasks

How to configure policy properties
In the Properties page, type a name for the policy. You can use spaces in the name. The equal sign
(=) is not allowed.
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Related tasks

l "How to Collect Event Data from theOpenMessage Interface" on page 287

UI Descriptions

For a description of the Properties page, see "Properties Page" on page 494.

Configuring Event Defaults in Open Message Interface
Policies

The Events page enables you to indicate default settings for all events generated by the policy.

These defaults affect all new and existing rules. You can override the defaults in individual rules if
needed. If a rule contains empty event attributes, the agent will use the defaults for the new event.

To access
In the BSMConnector user interface, click in the toolbar, then click Event > Open Message
Interface. The openmessage interface policy editor opens. 

Alternatively, double-click an existing openmessage interface policy to edit it.

Click Defaults to open the Default Event Attributes page.

Tasks

How to configure events for open message interface policies
This task describes how to configure default settings for all events generated by the policy.

1. Click Event Attributes to define default event attributes, such as severity and category.

Tip: After loading the indicators from the connected BSM server, the Indicators tab shows
a hierarchy of configuration item types with the associated health indicators (HIs) and
event type indicators (ETIs).

To insert an indicator, drag and drop the indicator, indicator state, or both from the
Indicators tab to the policy. Use theSelect target drop format panel to toggle between
inserting indicator names only and inserting indicator names and states.

2. Click Event Correlation to set the type of duplicate event suppression and define themethod
used to suppress duplicate events.

3. Click Advanced to define default advanced attributes such as legacy HPOM attributes and
agent MSI (Message Stream Interface) settings.

4. Optionally, use thePolicy Variables tab to add policy variables to event attributes. BSM
Connector replaces the variables with the appropriate values in the generated event.
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It is often useful to surround the variable with quotationmarks, especially if it may return a
value that contains spaces, for example "<$MSG_NODE>".

Related tasks

l "How to Collect Event Data from theOpenMessage Interface" on page 287

UI Descriptions

For a description of the Defaults page, see the following sections:

l "Event Attributes Tab" on page 459

l "Event Correlation Tab" on page 465

l "Advanced Tab" on page 470

l "Indicators Tab" on page 481

l "Policy Variables Tab (Events Only)" on page 491

Configuring Rules in Open Message Interface Policies
Rules define what a policy should do in response to a specific type of event. Each rule consists of a
condition and of settings for the event generated by the policy. The condition is the part of a policy
that describes the source. The settings enable you to configure the event that BSM Connector
sends to BSM.

A policy must contain at least one rule. If the policy contains multiple rules, it is important to
remember that the rules are evaluated in a specific order, and that when one condition is matched,
no additional rules will be evaluated.

To access
In the BSMConnector user interface, click in the toolbar, then click Event > Open Message
Interface. The openmessage interface policy editor opens. 

Alternatively, double-click an existing openmessage interface policy to edit it.

Click Rules to open the policy Rules page.

Learn More

Rule types
The rule types are:

l Event on matched rule. If matched, BSM Connector sends an event to BSM. The event uses
the settings defined for the rule. If you do not configure these settings, the default settings are
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used.

l Suppress on matched rule. If matched, BSM Connector stops processing and does not send
an event to BSM.

l Suppress on unmatched rule. If not matched, BSM Connector stops processing and does not
send an event to BSM.

Tasks

How to configure rules in open message interface policies
This task describes how configure policy rules.

1. In thePolicy Rules section, click and select the type of rule to define what the policy
should do in response to a specific string in amessage. Each policy must have at least one
rule.

2. In theRule Content section, use theCondition tab to specify the attributes and values that
the policy searches for in themessage that the policy receives from opcmsg. If the policy finds
amatch, it may or may not generate an event, depending on the rule type.

a. In theNode field, type the fully qualified domain name, the node name, or the IP address if
you only want to matchmessages whose node attribute is set to a specific node. Give
multiple entries with the OR (|) operator (for example:
node1.example.com|node2.example.com), or leave blank for all nodes.

This field corresponds to the node option of the opcmsg command.

b. In theMessage Group field, type themessage group if you only want to matchmessages
whosemessage group attribute is set to a specific message group. Givemultiple entries
with the OR (|) operator (for example: msggrp1|msggrp2), or leave blank for all message
groups.

This field corresponds to the msg_grp option of the opcmsg command.

c. In theApplication field, type the name of the application if you only want to match
messages whose application attribute is set to a specific application. Givemultiple entries
with the OR (|) operator (for example: appl1|appl2), or leave blank for all applications.

This field corresponds to the application option of the opcmsg command.

d. In theObject field, type the name of the object if you only want to matchmessages whose
object attribute is set to a specific object. Givemultiple entries with the OR (|) operator (for
example: object1|object2), or leave blank for all objects.

This field corresponds to the object option of the opcmsg command.
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Note: Although the term application generally refers to a general program name and
object generally refers to a process or sub-program, you should use these values to
assist your own organizational scheme.

e. Clear theSeverity checkboxes if you only want to matchmessages whose severity
attribute is set to a specific severity. You can select multiple severities but must select at
least one.

This field corresponds to the severity option of the opcmsg command.

f. In theMessage Text field, type the pattern that you want the policy to compare with the
message text in the sourcemessage that it is evaluating.

This field corresponds to the msg_text option of the opcmsg command.

Tip: You can use standard BSM Connector pattern-matching rules whenmatching
values. Select thematches operator and click in the Operand field to open the
patternmatching expression toolbox. The toolbox displays the following:

o Pattern Matching Expressions. Click an expression to insert it in the Operand
field.

o Variable Bindings Options. Variable bindings options include case sensitivity
and field separators for the rule. If you do not specify patternmatching options for
the rule, either the defaults (case sensitive; a blank and the tab character as
separators) or the default options set for the policy will be used. See also
"Configuring Options in OpenMessage Interface Policies" on the next page.

3. Use theEvent Attributes tab to define event attributes (for example, event title and
description) for all events generated by this rule.

Tip: After loading the indicators from the connected BSM server, the Indicators tab shows
a hierarchy of configuration item types with the associated health indicators (HIs) and
event type indicators (ETIs).

To insert an indicator, drag and drop the indicator, indicator state, or both from the
Indicators tab to the policy. Use theSelect target drop format panel to toggle between
inserting indicator names only and inserting indicator names and states.

4. Use theEvent Correlation tab to set the type of duplicate event suppression and define the
method used to suppress duplicate events.

5. Use theCustom Attributes tab to add additional information to all events generated by this
rule. For example, youmight add a company name, contact information, or a city location to an
event.
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6. Use theAdvanced tab to define an event drill-downURL, legacy HPOM attributes, and agent
MSI (Message Stream Interface) settings.

7. Optionally, use thePolicy Variables tab to add policy variables to event attributes. BSM
Connector replaces the variables with the appropriate values in the generated event.

It is often useful to surround the variable with quotationmarks, especially if it may return a
value that contains spaces, for example "<$MSG_NODE>".

Related tasks

l "How to Collect Event Data from theOpenMessage Interface" on page 287

UI Descriptions

For a description of the Rules page, see the following sections:

l "Rules Page - Policy Rules" on page 495

l "Condition Tab - OpenMessage Interface Policy Rules Only" on page 474

l "Event Attributes Tab" on page 459

l "Event Correlation Tab" on page 465

l "Custom Attributes Tab" on page 469

l "Advanced Tab" on page 470

l "Indicators Tab" on page 481

l "Policy Variables Tab (Events Only)" on page 491

Configuring Options in Open Message Interface Policies
The options tab enables you to configure several policy behaviors, for example which events are
logged locally, how the policy handles unmatched events, and defaults for patternmatching in
policy rules.

To access
In the BSMConnector user interface, click in the toolbar, then click Event > Open Message
Interface. The openmessage interface policy editor opens. 

Alternatively, double-click an existing openmessage interface policy to edit it.

Click Options to open the policy Options page.
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Tasks

How to configure options for open message policies
In the Options page, configure which events are logged locally, how the policy handles unmatched
events, and defaults for patternmatching in policy rules.

For more information about the other fields, see "Configuring Options in OpenMessage Interface
Policies" on the previous page.

Related tasks

l "How to Collect Event Data from theOpenMessage Interface" on page 287

UI Descriptions

For a description of the Options page, see "Options Page (Events Only)" on page 489.
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Chapter 13: Scheduled Task Policies
Scheduled task policies enable you to schedule commands or scripts to run on the BSMConnector
system, and will send an event to BSM to indicate the success or failure of the command or script.
Use this policy if you want to run commands or scripts on the BSM Connector system once or
according to a specific schedule.

How to Schedule Tasks
This section describes how to schedule tasks.

1. Prerequisite:Make sure your BSM Connector is set up as a BSMConnector integration server
in BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see the BSM online
help or the BSM Application Administration Guide.

2. In the BSMConnector user interface, click in the toolbar, then click Event >
Scheduled Task. The scheduled task policy editor opens. 

Alternatively, double-click an existing scheduled task policy to edit it.

3. In theProperties page, define information that is related to the policy itself (for example, the
name and description of the policy).

For details, see "Configuring Scheduled Task Policy Properties" on the next page.

4. In the Task page, specify the command or script that you want to run.

For details, see "Configuring Tasks in Scheduled Task Policies" on the next page.

5. In theSchedule page, configure the schedule according to which the command or script
should run.

Note: If you do not configure a schedule, the command or script runs every minute.

For details, see "Configuring Schedules in Scheduled Task Policies" on page 302.

6. In theStart Event, Success Event, and Failure Event pages, design the start, success, or
failure events that you want to receive.

For details, see "Configuring Events in Scheduled Task Policies" on page 303.

7. Click OK to save the policy and close the editor.
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8. Optional. If the list of policies does not refresh automatically in the BSMConnector user
interface, click in the toolbar.

Scheduled Task Policy User Interface
This section includes:

l "Configuring Scheduled Task Policy Properties" below

l "Configuring Tasks in Scheduled Task Policies" below

l "Configuring Schedules in Scheduled Task Policies" on page 302

l "Configuring Events in Scheduled Task Policies" on page 303

Configuring Scheduled Task Policy Properties
Every policy has a set of properties that identify and describe the policy. Properties include, for
example, the policy name and a description of what the policy does.

To access

In the BSMConnector user interface, click in the toolbar, then click Event > Scheduled
Task. The scheduled task policy editor opens. 

Alternatively, double-click an existing scheduled task policy to edit it.

Tasks

How to configure policy properties
In the Properties page, type a name for the policy. You can use spaces in the name. The equal sign
(=) is not allowed.

Related tasks

l "How to Schedule Tasks" on the previous page

UI Descriptions

For a description of the Properties page, see "Properties Page" on page 494.

Configuring Tasks in Scheduled Task Policies
In the Task page, you specify a command or script that you want to run on the BSMConnector
system.
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To access

In the BSMConnector user interface, click in the toolbar, then click Event > Scheduled
Task. The scheduled task policy editor opens. 

Alternatively, double-click an existing scheduled task policy to edit it.

Click Task.

Tasks

How to configure tasks
In Task type, select one of the following options:

l Command

By default, the command runs under the same account as the agent is running, which is Local
System or root by default.

n Command: Type the complete path and extension of the command that you want to run on
the BSMConnector system (for example,
%OvDataDir%\bin\instrumentation\cleanup.exe). The file that you specify should exist
on the system.

n Username: Type the user name under which the command should be run. The user must
exist and have permission to run the command on the system. If you specify a non-existent
user, the command fails to run.

n Password: Specify a password for the user. If the password changes, the policy must be
updated and reactivated.

l VB Script

Type the VB script in the window. Alternatively, click Upload to load an existing script.

Tip: Use the policy method Rule.Status to specify whether the task is successful. For
example, to specify that the task has failed (and trigger a failuremessage), use
Rule.Status=False. (See "Rule Object" on page 307 .)

Note: HP Operations Agent uses a generic Microsoft scripting engine to run VBScript
scripts.You can therefore use standard VBScript objects (for example, the
FileSystemObject object) in your scripts. Objects that are specific to wscript or cscript (for
example, theWScript object) are not supported.

l Perl Script

Type the Perl script in the window. Alternatively, click Upload to load an existing script.
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Tip: Use the policy method $Rule->Status to specify whether the task is successful. For
example, to specify that the task has failed (and trigger a failuremessage), use
$Rule.Status(False). (See "Rule Object" on page 307 .)

Note: The agent runs as a service that has no standard input, standard output, or standard
error. Therefore, the predefined file handles STDIN, STDOUT, and STDERR are not
available for Perl scripts in scheduled task policies. It is also not possible to open file
handles that use command pipes or capture the standard output from commands within
backticks (`).

Related tasks

l "How to Schedule Tasks" on page 299

UI Descriptions

For a description of the Task page, see "Task Page (Scheduled Task Policies)" on page 513.

Configuring Schedules in Scheduled Task Policies
Scheduled task policies can start commands either once or according to a schedule..

To access

In the BSMConnector user interface, click in the toolbar, then click Event > Scheduled
Task. The scheduled task policy editor opens. 

Alternatively, double-click an existing scheduled task policy to edit it.

Click Schedule.

Tasks

How to configure schedules
In the Schedule page, select one of the following schedule options:

l Once.WhenOnce is selected, the commandwill be run on one specific day at the time you
indicate.

Note: If the selected date or time occurs in the past, the command is not executed, and the
Schedule tab shows a warning.

l Once per interval.WhenOnce per interval is selected, the commandwill be run once each
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time the interval that you indicate passes.

l Advanced.When Advanced is selected, you can indicate specific days and times when the
command should be run. You select specific days of the week, specific days of themonth, and
specific months. This allows you to specify odd schedules such as, "OnMonday when it falls on
the 2nd of themonth." You can also indicate that the command should only be run during a
specific year.

Note: If you select Advanced but then do not specify a schedule, the command by default
runs every minute.

Tip:

To select multiple times, click the time, press Ctrl orShift, and select additional times.

To select the entire time range, click . To delete a selected time, click .

Related tasks

l "How to Schedule Tasks" on page 299

UI Descriptions

For a description of the Schedule page, see "Schedule Page - Scheduled Task Policies" on page
501.

Configuring Events in Scheduled Task Policies
Scheduled task policies can send a notification event to BSM when a command or script starts,
finishes, or fails.You can design the start, success, or failure events that you want to receive by
completing the information in the Start Event, Success Event, and Failure Event tabs.

To access

In the BSMConnector user interface, click in the toolbar, then click Event > Scheduled
Task. The scheduled task policy editor opens. 

Alternatively, double-click an existing scheduled task policy to edit it.

Click Start Event, Success Event, or Failure Event.

Tasks

How to configure events for scheduled task policies
This section describes how configure events generated by scheduled task policies.
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1. Select Send Start Event, Send Success Event, orSend Failure Event.

2. Click Event Attributes to define default event attributes, such as severity and category.

Tip: After loading the indicators from the connected BSM server, the Indicators tab shows
a hierarchy of configuration item types with the associated health indicators (HIs) and
event type indicators (ETIs).

To insert an indicator, drag and drop the indicator, indicator state, or both from the
Indicators tab to the policy. Use theSelect target drop format panel to toggle between
inserting indicator names only and inserting indicator names and states.

3. Click Event Correlation to set the type of duplicate event suppression and define themethod
used to suppress duplicate events.

4. Click Custom Attributesto add additional information to all events generated by this policy.
For example, youmight add a company name, contact information, or a city location to an
event.

5. Click Advanced to define default advanced attributes such as legacy HPOM attributes and
agent MSI (Message Stream Interface) settings.

6. Optionally, use thePolicy Variables tab to add policy variables to event attributes. BSM
Connector replaces the variables with the appropriate values in the generated event.

It is often useful to surround the variable with quotationmarks, especially if it may return a
value that contains spaces, for example "<$MSG_NODE>".

Related tasks

l "How to Schedule Tasks" on page 299

UI Descriptions

For a description of the Start, Success, and Failure Event pages, see the following sections:

l "Start, Success, Failure Event Pages (Scheduled Task Policies)" on page 512

l "Event Attributes Tab" on page 459

l "Event Correlation Tab" on page 465

l "Custom Attributes Tab" on page 469

l "Advanced Tab" on page 470
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l "Indicators Tab" on page 481

l "Policy Variables Tab (Events Only)" on page 491

Policy Objects for Scripts
The objects listed here are available for scheduled task policies and can bemanipulated with Visual
Basic Scripting Edition or with Perl. These policy objects can only be used in scripts that run within
a policy. They cannot be used in standalone scripts that are executed at a command prompt.

Caution: Policy scripts provide administrators with a powerful tool to evaluate andmanipulate
data. If, however, a script is incorrectly written, it could cause the agent to fail. Hewlett-
Packard Company is not responsible for agent failures resulting from incorrectly written
scripts.

This section includes:

l "Policy Object" below

l "Rule Object" on page 307

l "ConsoleMessageObject" on page 307

l "ExecuteCommandObject" on page 312

Policy Object
This object is used to access the attributes of a policy.

Policy Method: CreateObject

Parameter: progID (string of format: [Vendor.]Component[.Version])

Return Type: VB Script: IDispatch   Perl: not applicable

VB Script Syntax: Policy.CreateObject("progID")

Perl Syntax: not applicable

Description: Creates a component instance of a COM object. Note that this method is
valid only onWindows nodes, and cannot be used in a Perl script.

Policy Method: Execute

Parameter: command (string)

Return Type: VB Script: void   Perl: void
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Policy Method: Execute

VB Script Syntax: Policy.Execute("command")

Perl Syntax: $Policy->Execute("command");

Description: Run the specified command asynchronously. The command is executed in
the context of agent security, so could be run as Local System or any other
user-selected user to run the agent. Themethod will return immediately. See
the ExecuteCommandmethod Command for more information about how to
indicate commands.

Policy Method: Output

Parameter: string

Return Type: VB Script: void   Perl: void

VB Script Syntax: Policy.Output("string")

Perl Syntax: $Policy->Output("string");

Description: Appends the string to the annotation field of the event sent to BSM in
response to the success or failure of a scheduled task.

Policy Method: ExecuteEx

Parameter: command (string)

Return Type: VB Script: BSTR   Perl: string

VB Script Syntax: Policy.ExecuteEx("command")

Perl Syntax: $Policy->ExecuteEx("command");
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Policy Method: ExecuteEx

Description: Run the specified command synchronously and wait for it to complete before
returning the output of the command.

l Security. The command is executed in the context of agent security, so
could be run as Local System or any other user-selected user to run the
agent.

l Return values. If the command is successful, STDOUT is returned. If
the command is not successful (return value non-zero), the string
"ERROR:\n" followed by STDERR will be returned.

To handle non-zero return values, run ExecuteEx in an eval function and
then check the result, for example for the string ERROR.

Perl script example:

eval '$ReturnText = $ExecuteCommand->ExecuteEx()';
$ReturnText =$@ if $@;

l Paths. Youmust use complete paths or ensure that any needed path is
included in the PATH variable.

Example: dir_con = Policy.ExecuteEx ("cmd /c dir c:\")

Rule Object
In scheduled task policies, the Rule object is used to indicate whether the command has
succeeded or failed. TRUE = command succeeded, FALSE = command failed.

Rule Method: Status

Parameter: void

Return Type: VB Script: Boolean   Perl: integer

VB Script Syntax: for put: Rule.Status = boolvalue
for get: boolvalue = Rule.Status

Perl Syntax: for put: $Rule.Status(boolvalue);
for get: boolvalue = $Rule.Status();

Description: For scheduled task policies, FALSE indicates that the scheduled task failed.

ConsoleMessage Object
The ConsoleMessage object provides amethod for sending events directly to BSM. Events sent in
this way are not intercepted by an openmessage interface policy, but instead are sent directly to
the server. Multiple uses of the Sendmethod are supported. The same script can then sendmultiple
events to BSM depending on which problem it detects.
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Note: You cannot use action variables with the ConsoleMessage object.

ConsoleMessage Method: Application

Parameter: application (string)

Return Type: VB Script: void   Perl: void

VB Script Syntax: ConsoleMessage.Application = "application"

Perl Syntax: $ConsoleMessage->Application("application");

Description: This optional method sets the content of Application in the event
properties.

ConsoleMessage Method: Object

Parameter: object (string)

Return Type: VB Script: void   Perl: void

VB Script Syntax: ConsoleMessage.Object = "object"

Perl Syntax: $ConsoleMessage->Object("object");

Description: This optional method sets the content of Object in the event
properties.

ConsoleMessage Method: MsgText

Parameter: msgtext (string)

Return Type: VB Script: void   Perl: void

VB Script Syntax: ConsoleMessage.MsgText = "msgtext"

Perl Syntax: $ConsoleMessage->MsgText("msgtext");

Description: This method sets themessage text for the event.

ConsoleMessage Method: Severity

Parameter: severity
(valid strings are: Unknown|Normal|Warning|Minor|Major|Critical)

Return Type: VB Script: void   Perl: void
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ConsoleMessage Method: Severity

VB Script Syntax: ConsoleMessage.Severity = "severity"

Perl Syntax: $ConsoleMessage->Severity("severity");

Description: Sets the severity of the event that is sent. If not specifically set
with this method, the default is Normal. If an invalid string is
supplied, severity Unknownwill be used.

ConsoleMessage Method: MsgGrp

Parameter: messagegroup (string)

Return Type: VB Script: void   Perl: void

VB Script Syntax: ConsoleMessage.MsgGrp = "messagegroup"

Perl Syntax: $ConsoleMessage->MsgGrp("messagegroup");

Description: Sets the value for theMessage Group in event properties. If this
method does not supply a value, Misc is used.

ConsoleMessage Method: Node

Parameter: nodename (IP address or fully qualified hostname)

Return Type: VB Script: void   Perl: void

VB Script Syntax: ConsoleMessage.Node = "nodename"

Perl Syntax: $ConsoleMessage->Node("nodename");

Description: Sets the value forPrimary Node Name that will be displayed in
the event properties. IP addresses and fully qualified hostnames
are valid. If this method does not supply a value, the hostname of
the system is used by default.

ConsoleMessage Method: ServiceId

Parameter: serviceid (string)

Return Type: VB Script: void   Perl: void

VB Script Syntax: ConsoleMessage.ServiceId = "serviceid"

Perl Syntax: $ConsoleMessage->ServiceId("serviceid");

Description: This optional method sets the Service ID for the event.
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ConsoleMessage Method: MessageType

Parameter: messagetype (string)

Return Type: VB Script: void   Perl: void

VB Script Syntax: ConsoleMessage.MessageType = "messagetype"

Perl Syntax: $ConsoleMessage->MessageType("messagetype");

Description: This optional method sets the value for themessage type field of
the event properties.

ConsoleMessage Method: MessageKey

Parameter: messagekey (string)

Return Type: VB Script: void   Perl: void

VB Script Syntax: ConsoleMessage.MessageKey = "messagekey"

Perl Syntax: $ConsoleMessage->MessageKey("messagekey");

Description: This optional methods sets a key for event correlation.

ConsoleMessage Method: AcknowledgeMessageKey

Parameter: messagekey (string)

Return Type: VB Script: void   Perl: void

VB Script Syntax: ConsoleMessage.AcknowledgeMessageKey = "messagekey"

Perl Syntax: $ConsoleMessage->AcknowledgeMessageKey("messagekey");

Description: This optional method sets themessage key to indicate which
events are automatically closed.

ConsoleMessage Method: TroubleTicket

Parameter: Booleanvalue

Return Type: VB Script: void   Perl: void

VB Script Syntax: ConsoleMessage.TroubleTicket = Booleanvalue

Perl Syntax: $ConsoleMessage->TroubleTicket(Booleanvalue);

Description: This optional method specifies if the event is to be sent to a trouble
ticket interface. Default is FALSE.
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ConsoleMessage Method: Notification

Parameter: Booleanvalue

Return Type: VB Script: void   Perl: void

VB Script Syntax: ConsoleMessage.Notification = Booleanvalue

Perl Syntax: $ConsoleMessage->Notification(Booleanvalue);

Description: This optional method specifies if the event is sent to the
notificationmechanism. Default is FALSE.

ConsoleMessage Method: AgentMSI

Parameter: type (valid strings are: copy|divert|none)

Return Type: VB Script: void   Perl: void

VB Script Syntax: ConsoleMessage.AgentMSI = "type"

Perl Syntax: $ConsoleMessage->AgentMSI("type");

Description: This optional method specifies if the event is to be sent through
themessage stream interface on the agent. Default (or if string
misspelled) is none.

ConsoleMessage Method: ServerMSI

Parameter: type (valid strings are: copy|divert|none)

Return Type: VB Script: void   Perl: void

VB Script Syntax: ConsoleMessage.ServerMSI = "type"

Perl Syntax: $ConsoleMessage->ServerMSI("type");

Description: This optional method specifies if event is sent through the event
stream interface on the server. Default (or if stringmisspelled) is
none.

ConsoleMessage Method: Send

Parameter: void

Return Type: VB Script: void   Perl: void

VB Script Syntax: ConsoleMessage.Send()
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ConsoleMessage Method: Send

Perl Syntax: $ConsoleMessage->Send();

Description: This method sends the event to the BSM server. TheMsgText
methodmust set themessage text before using this method.
Multiple uses of the Sendmethod are supported. Policy variables
will not be expanded.

ExecuteCommand Object
Object used for requesting a command to be run. It starts a command to be run by the HP
Operations Agent.

ExecuteCommand Method: Command

Parameter: command (string)

Return Type: VB Script: void   Perl: void

VB Script Syntax: ExecuteCommand.Command = "command"

Perl Syntax: $ExecuteCommand->Command("command");

Description: This mandatory method is the name of the command to run with
all necessary parameters.

Note: For scripts that will run onWindows systems, internal
commands such as Copy, Rename, and DIR use a
command interpreter that must be started before the
command can be run. For commands of this type, the
commandmust be preceded with cmd /k, followed by any
other parameters required.

ExecuteCommand Method: KillonTimeout

Parameter: seconds (integer)

Return Type: VB Script: void   Perl: void

VB Script Syntax: ExecuteCommand.KillonTimeout = seconds;

Perl Syntax: $ExecuteCommand->KillonTimeout(seconds);

Description: This method sets themaximum time, in seconds, that the
commandwill run. The default is unlimited. Valid only with the
StartEx method.
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ExecuteCommand Method: UserName

Parameter: username (string)

Return Type: VB Script: void   Perl: void

VB Script Syntax: ExecuteCommand.UserName = "username"

Perl Syntax: $ExecuteCommand->UserName("username");

Description: User name under which the command should be run. Optional,
default is $AGENT_USER.

ExecuteCommand Method: Password

Parameter: password (string)

Return Type: VB Script: void   Perl: void

VB Script Syntax: ExecuteCommand.Password = "password"

Perl Syntax: $ExecuteCommand->Password("password");
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ExecuteCommand Method: Password

Description: Password for accessing the specified user account. To prevent
the password from being visible in the script, use the following
instructions:

1. Open a command prompt.

2. Change directory to the agent install directory:
<install_dir>/bin/<arch>/OpC/install

3. Encrypt your password with the command: opcpwcrpt
<yourpassword>

4. Use the output string as the password in your script.

In some cases it is better not to supply a password.

Should I provide the password or not?

Executing the commandwithout the password is the easier of
the twomethods, but it has some restrictions that make it
unsuitable in some situations. The lists below show the
restrictions and advantages of bothmethods.

Without a password:

l ForWindows systems, resources accessed through the
network are not available.

l For all systems, changed passwords do not invalidate the
policy.

With a password:

l For all systems, resources accessed through the network are
available.

l For all systems, the encrypted password is sent over the
network.

l For all systems, if the password changes, the policy must be
updated and redeployed.

ExecuteCommand Method: Start

Parameter: void
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ExecuteCommand Method: Start

Return Type: VB Script: void   Perl: void

VB Script Syntax: ExecuteCommand.Start()

Perl Syntax: $ExecuteCommand->Start();

Description: Run the command specified by ExecuteCommand.Command
and return immediately the control to the script so the next lines
can be processed right away.

ExecuteCommand Method: StartEx

Parameter: void

Return Type: VB Script: BSTR   Perl: String

VB Script Syntax: ExecuteCommand.StartEx

Perl Syntax: $ExecuteCommand->StartEx();

Description: Run ExecuteCommand.Command and wait until it finishes.
Commands can be run synchronously or asynchronously, as
needed. Multiple uses of the Start method are supported. This
way, the same script can trigger multiple external commands.

If the command is successful, STDOUT is returned. If the
command is not successful (return value non-zero), the string
"ERROR:\n" followed by STDERR will be returned.

To handle non-zero return values, run StartEx in an eval function
and then check the result, for example for the string ERROR.

Perl script example:

eval '$ReturnText = $ExecuteCommand->StartEx()';
$ReturnText =$@ if $@;
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Chapter 14: SNMP Trap Policies
SNMP trap policies configure HP Operations Agent to watch for SNMP traps received by BSM
Connector from third-party systems. The third-party systemmust be configured to send traps to the
BSMConnector server. The SNMP trap policy reads SNMP traps, and responds when a character
pattern that you choose is found in an SNMP trap.

SNMP trap policies collect data from any SNMP trap (version 1 and 2) received by BSM Connector,
and send events to BSM containing preferred values from the original SNMP trap.

Before setting up an SNMP trap policy, you should be clear about the purpose and usage of the data
in BSM (for presentation in Operations Management, Service Health, Service Level Management,
reports, or all).

Event data that is forwarded to BSM is controlled by policy rules. Policy rules consist of a condition
and of settings for the event generated by the policy. The condition uses regular expressions to
match the source data. The settings enable you to configure the event that BSM Connector sends
to BSM.

Note: You can use this policy type to forward information from HP Network NodeManager i
(NNMi) to BSM. When you install BSM Connector on an NNMi management server, youmust
enable the HP Operations Agent integration with NNMi so that the HP Operations Agent can
receive SNMP traps from the NNMi northbound interface. To enable the NNMi integration,
follow the procedures in theNNMi Deployment Reference instead of the one below.

Configuring the Trap Interceptor (opctrapi) Process
By default, the trap interceptor process (opctrapi) of HP Operations Agent uses the Net-SNMP
APIs to receive SNMPv1 and SNMPv2 traps at port 162. If port 162 is already bound by another
process (for example theMicrosoft SNMP Trap service or the Linux snmptrapd process), the trap
interceptor process fails to start.

You can reconfigure the trap interceptor process to listen at another port by setting the SNMP_
TRAP_PORT variable. Alternatively, forWindows systems, you can configure the trap interceptor
process to subscribe to theMicrosoft SNMP Trap service. This configuration provides the trap
interceptor process with SNMPv1 traps only.

To configure HP Operations Agent for theMicrosoft SNMP Trap service, complete the following
steps:

1. Open a command prompt, and then type:

ovconfchg -ns eaagt -set SNMP_SESSION_MODE WIN_SNMP

2. Restart the trap interceptor process:

ovc -restart opctrapi

Formore information about the SNMP_SESSION_MODE and SNMP_TRAP_PORT variables, see the
HP Operations Agent ReferenceGuide.
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Troubleshooting

l If onWindows, the trap interceptor process does not receive SNMPv2 traps, make sure the
Microsoft SNMP Trap service is disabled, and the SNMP_SESSION_MODE variable is set to
NETSNMP.

l To check that BSM Connector receives SNMP traps, complete the following steps:

a. Edit the SNMP trap policy and open theOptions page.

b. In the Options page, select one or more of the Log Local Events options.

c. Reactivate the SNMP trap policy.

d. Open the following log file and check that SNMP trap events are logged:

Windows: %OvDataDir%\log\OpC\opcmsglg

Linux: /var/opt/OV/log/OpC/opcmsglg

For details on logging local events, see "Configuring Options in SNMP Policies" on page 322.

How to Collect Event Data from SNMP Traps
This task describes how to collect event data from SNMP traps.

1. Prerequisite:Make sure your BSM Connector is set up as a BSMConnector integration server
in BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see the BSM online
help or the BSM Application Administration Guide.

2. In the BSMConnector user interface, click in the toolbar, then click Event > SNMP.
The SNMP trap policy editor opens. 

Alternatively, double-click an existing SNMP trap policy to edit it.

3. In theProperties page, define information that is related to the policy itself (for example, the
name and description of the policy).

For details, see "Configuring SNMP Policy Properties" on the next page.

4. Optional. In theDefault Event Attributes page, configure the default settings for all events
generated by the policy (for example, default event correlation settings).

For details, see "Configuring Event Defaults in SNMP Policies" on page 319.

5. In theRules page, define what the policy should do in response to a specific type of event.
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For details, see "Configuring Rules in SNMP Policies" on page 320.

6. In theOptions page, configure several policy behaviors (for example, patternmatching
options).

For details, see "Configuring Options in SNMP Policies" on page 322.

7. Click OK to save the policy and close the editor.

8. Optional. If the list of policies does not refresh automatically in the BSMConnector user
interface, click in the toolbar.

9. Activate the SNMP trap policy to start the opctrapi process on the BSMConnector server.

SNMP Trap Policy User Interface
This section includes:

l "Configuring SNMP Policy Properties" below

l "Configuring Event Defaults in SNMP Policies" on the next page

l "Configuring Rules in SNMP Policies" on page 320

l "Configuring Options in SNMP Policies" on page 322

Configuring SNMP Policy Properties
Every policy has a set of properties that identify and describe the policy. Properties include, for
example, the policy name and a description of what the policy does.

To access
In the BSMConnector user interface, click in the toolbar, then click Event > SNMP. The
SNMP trap policy editor opens. 

Alternatively, double-click an existing SNMP trap policy to edit it.

Tasks

How to configure policy properties
In the Properties page, type a name for the policy. You can use spaces in the name. The equal sign
(=) is not allowed.

Related tasks

l "How to Collect Event Data from SNMP Traps" on the previous page
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UI Descriptions

For a description of the Properties page, see "Properties Page" on page 494.

Configuring Event Defaults in SNMP Policies
The Events page enables you to indicate default settings for all events generated by the policy.

These defaults affect all new and existing rules. You can override the defaults in individual rules if
needed. If a rule contains empty event attributes, the agent will use the defaults for the new event.

To access
In the BSMConnector user interface, click in the toolbar, then click Event > SNMP. The
SNMP trap policy editor opens. 

Alternatively, double-click an existing SNMP trap policy to edit it.

Click Defaults to open the Default Event Attributes page.

Tasks

Configure events for SNMP trap policies
This task describes how to configure default settings for all events generated by the policy.

1. Click Event Attributes to define default event attributes, such as severity and category.

Tip: After loading the indicators from the connected BSM server, the Indicators tab shows
a hierarchy of configuration item types with the associated health indicators (HIs) and
event type indicators (ETIs).

To insert an indicator, drag and drop the indicator, indicator state, or both from the
Indicators tab to the policy. Use theSelect target drop format panel to toggle between
inserting indicator names only and inserting indicator names and states.

2. Click Event Correlation to set the type of duplicate event suppression and define themethod
used to suppress duplicate events.

3. Click Advanced to define default advanced attributes such as legacy HPOM attributes and
agent MSI (Message Stream Interface) settings.

4. Optionally, use thePolicy Variables tab to add policy variables to event attributes. BSM
Connector replaces the variables with the appropriate values in the generated event.

It is often useful to surround the variable with quotationmarks, especially if it may return a
value that contains spaces, for example "<$MSG_NODE>".
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Related tasks

l "How to Collect Event Data from SNMP Traps" on page 317

UI Descriptions

For a description of the Defaults page, see the following sections:

l "Event Attributes Tab" on page 459

l "Event Correlation Tab" on page 465

l "Advanced Tab" on page 470

l "Indicators Tab" on page 481

l "Policy Variables Tab (Events Only)" on page 491

Configuring Rules in SNMP Policies
Rules define what a policy should do in response to a specific type of event. Each rule consists of a
condition and of settings for the event generated by the policy. The condition is the part of a policy
that describes the source. The settings enable you to configure the event that BSM Connector
sends to BSM.

A policy must contain at least one rule. If the policy contains multiple rules, it is important to
remember that the rules are evaluated in a specific order, and that when one condition is matched,
no additional rules will be evaluated.

To access
In the BSMConnector user interface, click in the toolbar, then click Event > SNMP. The
SNMP trap policy editor opens. 

Alternatively, double-click an existing SNMP trap policy to edit it.

Click Rules to open the policy Rules page.

Learn More

Rule types
The rule types are:

l Event on matched rule. If matched, BSM Connector sends an event to BSM. The event uses
the settings defined for the rule. If you do not configure these settings, the default settings are
used.

l Suppress on matched rule. If matched, BSM Connector stops processing and does not send
an event to BSM.
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l Suppress on unmatched rule. If not matched, BSM Connector stops processing and does not
send an event to BSM.

Tasks

How to configure rules in SNMP trap policies
This task describes how configure policy rules.

1. In thePolicy Rules section, click in the toolbar and select the rule type. Then type a
description for the rule. After a rule has been added, you can change the rule type by clicking
the current rule type in the list of rules and selecting another rule type from the drop-down list.

Alternatively, select an existing rule and click to copy the rule. You can then rewrite the
description of the copied rule and edit the rule.

2. In theRule Content section, use theCondition Definition tab to define thematch condition
for the SNMP traps. You canmatch SNMP traps generated from a specific node, or SNMP
traps with specific IDs.

3. In theCondition Variable Bindings tab, select the variable bindings you want the policy to
read, and write one or morematch patterns for each binding. You can use pattern-matching
rules whenmatching variable bindings.

For example, $2 contains in many SNMP events the hostname of the sender of the SNMP
event. To only match events from systems in the domain example.com, use the pattern
<*>.example.com:

4. Use theEvent Attributes tab to define event attributes (for example, event title and
description) for all events generated by this rule.

Tip: After loading the indicators from the connected BSM server, the Indicators tab shows
a hierarchy of configuration item types with the associated health indicators (HIs) and
event type indicators (ETIs).

To insert an indicator, drag and drop the indicator, indicator state, or both from the
Indicators tab to the policy. Use theSelect target drop format panel to toggle between
inserting indicator names only and inserting indicator names and states.

5. Use theEvent Correlation tab to set the type of duplicate event suppression and define the
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method used to suppress duplicate events.

6. Use theCustom Attributes tab to add additional information to all events generated by this
rule. For example, youmight add a company name, contact information, or a city location to an
event.

7. Use theAdvanced tab to define an event drill-downURL, legacy HPOM attributes, and agent
MSI (Message Stream Interface) settings.

8. Optionally, use thePolicy Variables tab to add policy variables to event attributes. BSM
Connector replaces the variables with the appropriate values in the generated event.

It is often useful to surround the variable with quotationmarks, especially if it may return a
value that contains spaces, for example "<$MSG_NODE>".

Related tasks

l "How to Collect Event Data from SNMP Traps" on page 317

UI Descriptions

For a description of the Rules page, see the following sections:

l "Rules Page - Policy Rules" on page 495

l "Condition Definition Tab - SNMP Trap Policy Rules Only" on page 476

l "Condition Variable Bindings Tab - SNMP Trap Policy Rules Only" on page 477

l "Event Attributes Tab" on page 459

l "Event Correlation Tab" on page 465

l "Custom Attributes Tab" on page 469

l "Advanced Tab" on page 470

l "Indicators Tab" on page 481

l "Policy Variables Tab (Events Only)" on page 491

Configuring Options in SNMP Policies
The options tab enables you to configure several policy behaviors, for example which events are
logged locally, how the policy handles unmatched events, and defaults for patternmatching in
policy rules.

To access
In the BSMConnector user interface, click in the toolbar, then click Event > SNMP. The
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SNMP trap policy editor opens. 

Alternatively, double-click an existing SNMP trap policy to edit it.

Click Options to open the policy Options page.

Tasks

How to configure options for SNMP trap policies
In the Options page, configure which events are logged locally, how the policy handles unmatched
events, and defaults for patternmatching in policy rules.

For more information about the other fields, see "Configuring Options in SNMP Policies" on the
previous page.

Related tasks

l "How to Collect Event Data from SNMP Traps" on page 317

UI Descriptions

For a description of the Options page, see "Options Page (Events Only)" on page 489.
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Chapter 15: Topology Policies
Discovery is the process of populating the Run-time ServiceModel database (RTSM) with CI and
CI relationship data. Accurate CI topology information provided by discovery of the system
infrastructure is essential for the following BSM applications:

l Operations Management (for example, for Topology-based Event Correlation (TBEC), context-
specific tools, service health monitoring (Health Perspective))

l Service Health

l Service Health Analyzer

l Service Level Management

BSM Connector uses the following technologies to discover topology:

l Data Flow Management (DFM). DFM is a component of BSM that collects discovery data for
BSM.

BSM Connector uses DFM technology to collect topology based on DFM discovery scripts in
policies. The policies report data based on the topology settings script you select or create for
the policy. The data they report is tightly integrated with BSM. You can create a custom topology
script or use an out-of-the-box script to forward the relevant data.

Note: BSMConnector uses DFM technology internally; it does not include a full version of
DFM and a DFM license is therefore not required.

Note: For detailed information on topology scripts, see "Working with Jython-Based
Topology Scripts " on page 180.

l Topology-XML Discovery and Synchronization. Topology-XML discovery and
synchronization enables you to write your own discovery scripts andmapping rules. The
discovery scripts discover topology data, themapping rules map the discovered data on the
BSMConnector system to the CI and CI relationmodel used in the RTSM. The processed and
transformed topology data is then forwarded to BSM and stored in the RTSM.

The advantage of using topology-XML discovery and synchronization is that you can separate
the discovery technology from the RTSM datamodel. If the RTMS datamodel changes, you
only need to update themapping files, not the discovery scripts.

For details, see "Topology-XML Policies and Local Topology Synchronization" on page 329.

l HP Operations Agent Discovery Agent and Agent Repository (Legacy). The discovery
agent is an extension to the HP Operations Agent.
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The discovery agent runs discovery policies that execute discovery scripts on the BSM
Connector server. The discovery agent stores the data that it discovers in the agent repository
(agtrep), which is a local data store of configuration items and their relationships. The agent then
publishes details of new, changed, and removed CIs to the BSM server, but does not resend
details of unchanged CIs.

Note: BSMConnector supports agent-based discovery only for discovery policies that
have beenmigrated from BSM Integration Adapter or imported from HP Operations
Manager (HPOM). You can edit migrated discovery policies. HPOM service auto-discovery
policies cannot be edited because they are incompatible with the BSM Connector legacy
discovery policy editor.

For details on HP Operations Agent discovery, see the HP Operations Agent ReferenceGuide.

Custom Topology Policies
BSM Connector log file, database, andWeb service listener policies enable you to create topology
data by mapping the data to events andmetrics collected from log files, databases, and through the
Web service listener. In addition, you can report topology data to BSM without reporting event or
metrics data. To collect the data, you can select an out-of-the-box topology script or create your
own custom script.

For data sources other than log files, databases, and theWeb service listener, you can create
topology policies that run custom topology scripts.

You develop topology scripts using the Jython language. For details on how to work in Jython, you
can refer to theseWeb sites:

l http://www.jython.org

l http://www.python.org

Note: For detailed information on topology scripts, see "Working with Jython-Based Topology
Scripts " on page 180.

How to Report Topology Data
BSMConnector provides several options for reporting topology data. The options that are available
to you depend on the type of data you want to integrate and on the data source:

l Topology mapped to event data from log files, databases, and the Web service listener.
Create a log file, database, orWeb service listener policy for event integration and complete all
pages, including the Topology page.

For details, see the following tasks:
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"How to Collect Event Data from Log Files" on page 237

"How to Collect Event Data from Databases" on page 199

"How to Collect Event Data Through theWeb Service Listener" on page 382

l Topology mapped to metrics data from log files, databases, and the Web service
listener. Create a log file, database, orWeb service listener policy for metrics integration and
complete all pages, including the Topology page.

For details, see the following tasks:

"How to Collect Metrics Data from Log Files" on page 238

"How to Collect Metrics Data from Databases" on page 200

"How to Collect Metrics Data Through theWeb Service Listener" on page 383

l Topology without event or metrics data from log files, databases, and the Web service
listener. Create a log file, database, orWeb service listener policy for topology integration.

For details, see the following tasks:

"How to Collect Topology Data from Log Files" on page 239

"How to Collect Topology Data Only from Databases" on page 201

"How to Collect Topology Data Through theWeb Service Listener" on page 385

l Topology without event or metrics data from other sources (for example, SNMP, open
message interface, and XML files). Create a custom topology policy:

a. Prerequisite:Make sure your BSM Connector is set up as a BSMConnector integration
server in BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see the BSM online
help or the BSM Application Administration Guide.

b. In the BSMConnector user interface, click in the toolbar. Then click Topology >
Custom.

Alternatively, double-click an existing policy to edit it.

c. In theProperties page, define information that is related to the policy itself (for example, the
name and description of the policy).

For details, see "Configuring Custom Topology Policy Properties" on the next page.

d. In the Topology page, create a script that creates a topology in BSM's RTSM that
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represents your third-party systems.

For details, see "Configuring Scripts in Custom Topology Policies" on the next page.

e. Click OK to save the policy and close the editor.

f. Optional. If the list of policies does not refresh automatically in the BSMConnector user
interface, click in the toolbar.

Note: BSM removes CIs from the RTSM if no topology data has been received for them
over a period of time. To prevent BSM from deleting the CIs that BSM Connector has sent
to BSM, BSMConnector regularly sends a list of active CIs to BSM in addition to the
topology data. Inactive CIs are not sent to the RTSM and aremarked for deletion in the
RTSM.

You can configure BSM Connector to always send CIs regardless of whether topology data
has been received for them. This guarantees that CIs reported by BSMConnector are never
deleted automatically from the RTSM. This configuration option is known as always touch
mode and is recommended for BSM Connector topology-only policies that collect data from
incremental data sources such as log files or databases. The first time the policies run, they
collect all CIs from the data source. The next time the policies run, they collect new and
changed CIs only and then forward only the additions and changes to BSM. The always
touchmode ensures that the already existing, unchanged CIs are also reported and are thus
not deleted.

For more information, see "Touching of CIs in BSM Connector" on page 192.

Note: For detailed information on topology scripts, see "Working with Jython-Based Topology
Scripts " on page 180.

Custom Topology Policy User Interface
This section includes:

l "Configuring Custom Topology Policy Properties" below

l "Configuring Scripts in Custom Topology Policies" on the next page

Configuring Custom Topology Policy Properties

Every policy has a set of properties that identify and describe the policy. Properties include, for
example, the policy name and a description of what the policy does.

To access
In the BSMConnector user interface, click in the toolbar. Then click Topology > Custom.
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Alternatively, double-click an existing policy to edit it.

Tasks

How to configure policy properties
In the Properties page, type a name for the policy. You can use spaces in the name. The equal sign
(=) is not allowed.

Related tasks

l "How to Report Topology Data" on page 325

UI Descriptions

For a description of the Properties page, see "Properties Page" on page 494.

Configuring Scripts in Custom Topology Policies

The topology page enables you to create a topology in BSM's RTSM by creating your own custom
script.

Note: For detailed information on topology scripts, see "Working with Jython-Based Topology
Scripts " on page 180.

To access
In the BSMConnector user interface, click in the toolbar. Then click Topology > Custom.

Alternatively, double-click an existing policy to edit it.

Click Topology to open the policy Topology page.

Learn More

Custom Topology Scripts
To create a custom script, use the script editor provided in the Topology page, or use any other
script editor. Following are the guidelines for creating your own topology script:

l For general information on topology scripts, see "Working with Jython-Based Topology Scripts "
on page 180.

l Youmay use the following code to set theMonitored by attribute on the CIs reported by a
custom script:

ems_lib.addMonitoredByForThirdPartySoftware(Framework, <computer>)
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l Use the following code to get the routing domain for a Node CI:

domainName = system_lib.getDiscoveryDomainByIP(Framework, <IP or node DNS
name>)

Formore information on the routing domain attribute in RTSM, see the Data Flow Management
Guide.

Tasks

How to report topology without event or metrics data

1. Configure the frequency of the script.

2. Configure the script.

Related tasks

l "How to Report Topology Data" on page 325

UI Descriptions

For a description of the Topology page, see "Topology Page - Database, Log File, Web Service
Listener, and Custom Topology Policies" on page 514.

Topology-XML Policies and Local Topology
Synchronization

Local topology synchronization enables you to filter and process the discovered data on the BSM
Connector system before sending it to BSM. By applyingmapping rules, you can transform the
discovered data to CIs and CI relations that can then be stored in BSM's RTSM.

You can alsomap and transform the discovered data by developing appropriate Jython scripts.
However, mapping rules use XML syntax and are therefore easier to create andmaintain. Keeping
themodel information separate from the discovery script alsomakes updating the files easier, if the
discovery methods or the datamodel changes.

You can apply local topology synchronization only to topology data discovered by discovery scripts
that are integrated in topology-XML policies. Database, log file, Web service listener, custom
topology, and legacy service discovery policies do not support local topology synchronization.

Topology Synchronization Data Flow
Local topology synchronization relies on the discovered data being available in an XML file that
conforms to the BSMConnector topology discovery syntax. To create the XML file, write a
discovery script (using your preferred scripting or programming language). You then integrate the
discovery script in a topology-XML policy that runs the script and creates the XML file.
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Themapping rules transform the generated discovery XML to CIs and CI relations that comply with
the RTSM datamodel. To configure the transformation, create a topology synchronization package
and include the necessary mapping rules. You then configure the topology-XML policy to apply the
synchronization package to the discovery XML file. Each time the topology-XML policy runs, the
mapping rules are applied to the whole discovery XML file, not only to appended entries.

Before sending themapped topology data to BSM, BSMConnector performs anti-aging and
touching processes on themapped CIs and CI relationships before synchronizing the topology data
with BSM. For details, see "Configuration Items in BSM" on page 192.

Topology Synchronization Rules
The filter andmapping rules that process the discovered data are gathered in a synchronization
package. You can apply multiple synchronization packages to the topology data discovered by a
custom topology policy.

Topology Synchronization Packages
A synchronization package consists of the following files:

l package.xml. The package descriptor file defines the name of the synchronization package and
contains a description and the priority level. The priority level determines the order in which
synchronization packages are applied.

l contextmapping.xml. The context mapping file defines the filter that is applied to the
discovered data. Filtering involves assigning a context to those CIs you want to process and
send to BSM. Configuring the context enables you to apply mapping rules selectively to CIs of
the same context.

l typemapping.xml. The typemapping file defines themapping from the type of a discovered CI
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to the type of a CI in BSM.

l attributemapping.xml. The attributemapping file defines themapping between the attributes of
a discovered CI and the attributes of a CI in BSM.

Attributemapping enables you to change CI attributes and add new attributes to better describe
a CI and create amore detailed view of the environment.

l relationmapping.xml. Using the relationmapping file, you can define the CI relationships
created in BSM between specified discovered CIs.

Make sure that the specified discovered CIs are created as CIs in the RTSM. Otherwise it is not
possible for topology synchronization to create a relationship in the RTSM.

Synchronization packages must be placed in the following directory on the BSM Connector
system:

<BSM Connector root directory>/conf/topology/xml/sync-packages/<synchronization
package directory>/

Package Descriptor File: package.xml
A topology synchronization packagemust include the package descriptor file (package.xml). The
package.xml file defines a topology synchronization package and includes:

l <Name> The name of the packagemust be the same as the name of the subdirectory in which
you place the synchronization package:

<BSM Connector root directory>/conf/topology/xml/sync-packages

l <Description>Description of the package.

l <Priority> Priority level of the package.

The highest priority is represented by 1. The default synchronization package is assigned the
lowest priority of 10. A higher priority rule result overwrites a result from a lower priority rule.

Note: Theremay bemore than one synchronization package with the same priority. The
order of execution of the rules between synchronization packages with the same priority is
not specified.

Example:

<?xml version="1.0" encoding="utf-8"?>
<Package xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
         xsi:noNamespaceSchemaLocation="Schemas/Package.xsd">
   <Name>mysyncpkg</Name>
   <Description>Integrate My Topology in HP BSM</Description>
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 <Priority>5</Priority>
</Package>

Context Mapping (Filtering): contextmapping.xml
The context mapping file assigns a context to CIs that match specified conditions. BSM Connector
synchronizes all the CIs that youmap to any context, and ignores all other CIs.

In the following example, the context myTopology is assigned to all discovered CIs that have the
attribute myAttributewith a value of myAttributeValue.

Example:

<?xml version="1.0" encoding="utf-8"?>
<Mapping xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
         xsi:noNamespaceSchemaLocation="Schemas/Mapping.xsd">

<Rules>
<Rule name="Filter my discovered CIs">

<Condition>
<Equals>

<OMAttribute>myAttribute</OMAttribute>
<Value>myAttributeValue</Value>

</Equals>
</Condition>

 <MapTo>
<Context>myTopology</Context>

</MapTo>
</Rule>

  </Rules>
</Mapping>

Type Mapping File: typemapping.xml
The typemapping file maps the type of a discovered CI to the type of a CI in BSM.

In the following example, the CIs with the context myTopology that have the attribute myTypewith a
value of myTypeValue aremapped to the CI type myCIType in BSM.

Example:

<?xml version="1.0" encoding="utf-8"?>
<Mapping xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
         xsi:noNamespaceSchemaLocation="Schemas/Mapping.xsd">
  <Rules Context="myTopology">
    <Rule name="Map myTypeValue to myCIType">

<Condition>
        <Equals>
          <OMAttribute>myType</OMAttribute>
          <Value>myTypeValue</Value>
        </Equals>
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</Condition>
      <MapTo>
        <CMDBType>
          <Value>myCIType</Value>
        </CMDBType>
      </MapTo>
    </Rule>
  </Rules>
</Mapping>

Attribute Mapping File: attributemapping.xml
The attributemapping file maps the attributes of a discovered CI to the attributes of a CI in BSM.

In the following example, for the CIs with the context myTopology that have the attribute
myAttributewith a value of myAttributeValue, the attribute title is mapped to the CI attribute
name in BSM.

Example:

<?xml version="1.0" encoding="utf-8"?>
<Mapping xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
         xsi:noNamespaceSchemaLocation="Schemas/Mapping.xsd">

<Rules Context="myTopology">
<Rule name="Map my attributes to RTSM CI attributes">

<Condition>
<Equals>

<OMAttribute>myAttribute</OMAttribute>
<Value>myAttributeValue</Value>

</Equals>
</Condition>

 <MapTo>
        <CMDBAttribute>
          <Name>name</Name>
          <SetValue>
            <OMAttribute>title</OMAttribute>
          </SetValue>
        </CMDBAttribute>
      </MapTo>
    </Rule>
  </Rules>
</Mapping>

Relation Mapping File: relationmapping.xml
Using the relationmapping file, you can create CI relationships in BSM between specified
discovered CIs.

BSM Connector User Guide
Chapter 15: Topology Policies

HP Business ServiceManagement (9.23) Page 333 of 521



In the following example, for CIs with the context myTopology, the CI myAttributeValue1 creates
a contains relationship to CIs that have the attribute myAttribute1with a value of
myAttributeValuew or myAttributeValuey.

Example:

<?xml version="1.0" encoding="utf-8"?>
<Mapping xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
         xsi:noNamespaceSchemaLocation="Schemas/Mapping.xsd">
  <Rules Context="myTopology">
    <Rule name="Create relation from myAttributeValuew to myAttributeValue
(root)">
      <Condition>
        <Equals>
          <OMAttribute>myAttribute1</OMAttribute>
          <Value>myAttributeValuew</Value>
        </Equals>
      </Condition>
      <MapTo>
        <RootContainer>
          <DependentCI relationType="contains">
            <Equals>
              <OMAttribute>myAttribute</OMAttribute>
              <Value>myAttributeValue</Value>
            </Equals>
          </DependentCI>
        </RootContainer>
      </MapTo>
    </Rule>
    <Rule name="Create relation from myAttributeValuey to myAttributeValue
(root)">
      <Condition>
        <Equals>
          <OMAttribute>myAttribute1</OMAttribute>
          <Value>myAttributeValuey</Value>
        </Equals>
      </Condition>
      <MapTo>
        <RootContainer>
          <DependentCI relationType="contains">
            <Equals>
              <OMAttribute>myAttribute1</OMAttribute>
              <Value>myAttributeValue1</Value>
            </Equals>
          </DependentCI>
        </RootContainer>
      </MapTo>
    </Rule>
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  </Rules>
</Mapping>

Topology Discovery Syntax
The XML file that the discovery script creates and to which themapping rules are appliedmust use
the BSMConnector topology discovery syntax described in this section.

This section includes:

l "Configuration Item XML SchemaDefinition (XSD)" below

l "Configuration Item XMLElement Description" on page 337

l "Example Discovery XML" on page 338

Configuration Item XML Schema Definition (XSD)
Your discovery script must output XML that conforms to the following schema:

<?xml version="1.0" encoding="utf-8"?>
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema">
   <xs:element name="Service">
      <xs:complexType>
         <xs:choice maxOccurs="unbounded">
            <xs:element ref="NewInstance" />
            <xs:element ref="NewRelationship" />
         </xs:choice>
      </xs:complexType>
      <xs:key name="InstanceKey">
         <xs:selector xpath="NewInstance">
         </xs:selector>
         <xs:field xpath="Key"></xs:field>
      </xs:key>
      <xs:keyref refer="InstanceKey" name="InstanceKeyRef">
         <xs:selector xpath="NewInstance">
         </xs:selector>
         <xs:field xpath="@ref"></xs:field>
      </xs:keyref>
      <xs:keyref refer="InstanceKey" name="InstanceRef">
         <xs:selector xpath="NewRelationship/*/Instance">
         </xs:selector>
         <xs:field xpath="@ref"></xs:field>
      </xs:keyref>
   </xs:element>
   <xs:element name="NewInstance" type="InstanceType" />
   <xs:complexType name="InstanceType">
      <xs:sequence>
         <xs:element ref="Std" />
         <xs:element ref="Virtual" minOccurs="0" />
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         <xs:element ref="Key" />
         <xs:element ref="Attributes" />
      </xs:sequence>
      <xs:attribute name="ref" type="xs:string" use="required" />
   </xs:complexType>
   <xs:element name="NewRelationship" type="RelationType" />
   <xs:complexType name="RelationType">
      <xs:sequence>
         <xs:element ref="Parent" />
         <xs:element ref="GenericRelations" minOccurs="0" />
      </xs:sequence>
   </xs:complexType>
   <xs:element name="Std">
      <xs:simpleType>
         <xs:restriction base="xs:string">
            <xs:enumeration value="DiscoveredElement" />
         </xs:restriction>
      </xs:simpleType>
   </xs:element>
   <xs:element name="Virtual">
      <xs:complexType />
   </xs:element>
   <xs:element name="Key" type="xs:string" />
   <xs:element name="Attributes">
      <xs:complexType>
         <xs:sequence>
            <xs:element ref="Attribute" maxOccurs="unbounded" />
         </xs:sequence>
      </xs:complexType>
   </xs:element>
   <xs:element name="Attribute">
      <xs:complexType>
         <xs:attribute name="value" type="xs:string" use="required" />
         <xs:attribute name="name" type="xs:string" use="required" />
      </xs:complexType>
   </xs:element>
   <xs:element name="Parent">
      <xs:complexType>
         <xs:sequence>
            <xs:element ref="Instance" />
         </xs:sequence>
      </xs:complexType>
   </xs:element>
   <xs:element name="GenericRelations" type="RelationsList" />
   <xs:complexType name="RelationsList">
      <xs:sequence>
         <xs:element name="Relations" maxOccurs="unbounded">
            <xs:complexType>
               <xs:attribute name="type" type="xs:string" use="required" />
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               <xs:sequence>
                  <xs:element ref="Instance" maxOccurs="unbounded" />
               </xs:sequence>
            </xs:complexType>
         </xs:element>
      </xs:sequence>
   </xs:complexType>
   <xs:element name="Instance">
      <xs:complexType>
         <xs:attribute name="ref" type="xs:string" use="required" />
      </xs:complexType>
   </xs:element>
</xs:schema>

Configuration Item XML Element Description
The following table describes the elements that the XML document can contain.

Element Description

NewInstance Represents a discovered CI. Youmust add a ref attribute, whichmust
match the unique CI ID that you specify in theKey element. You can then
use this reference in Instance elements in the current XML document if you
want to create or delete relationships.

NewRelationship Defines a new relationship between CIs. This element must contain exactly
oneParent element and can contain one or moreGenericRelations elements.

Std Must contain the string DiscoveredElement.

Virtual Include this element if the CI is virtual. A virtual CI is abstract and does not
exist on any node CI. Omit this element if the CI is hosted on a node CI.

Key Contains the full CI ID for this CI, whichmust be unique. Youmust include
this element in all NewInstanceelements. Youmust not specify a
NewInstancewith the same key in the same XML document.

Attributes Contains Attribute elements.

Attribute Has a name attribute and a value attribute.

Parent Contains an Instance element, which defines the CI that is the parent of this
relationship.

The parent instance that you specify must exist in the RTSM.

Instance Has a ref attribute that refers to aNewInstance element in the current XML
document.

GenericRelations Contains one or moreRelations elements.

Relations Has a type attribute that refers to the type of relation as stored in the RTSM
(for example, usage). Contains one or more Instance elements, which refer to
the CIs that are related to the specifiedParent element.
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Example Discovery XML
The following example XML creates three CI instances with the IDs myUniqueID1, myUniqueID2,
and myUniqueID3. myUniqueID1 is the parent CI, and has a contains relationshipt to myUniqueID2
and myUniqueID3.

Example:

<?xml version="1.0" encoding="utf-8" standalone="yes"?>
<Service>
  <NewInstance ref="myUniqueID1">
    <Key>myUniqueID1</Key>
    <Std>DiscoveredElement</Std>
    <Attributes>
      <Attribute name="myAttribute" value="myAttributeValue" />
      <Attribute name="myAttribute1" value="myAttributeValue1" />
      <Attribute name="myType" value="myTypeValue" />
      <Attribute name="title" value="myTitle1" />
    </Attributes>
  </NewInstance>
  <NewInstance ref="myUniqueID2">
    <Key>myUniqueID2</Key>
    <Std>DiscoveredElement</Std>
    <Attributes>
      <Attribute name="myAttribute" value="myAttributeValue" />
      <Attribute name="myAttribute1" value="myAttributeValuew" />
      <Attribute name="myType" value="myTypeValue1" />
      <Attribute name="title" value="myTitle2" />
    </Attributes>
  </NewInstance>
  <NewInstance ref="myUniqueID3">
    <Key>myUniqueID3</Key>
    <Std>DiscoveredElement</Std>
    <Attributes>
      <Attribute name="myAttribute" value="myAttributeValue" />
      <Attribute name="myAttribute1" value="myAttributeValuey" />
      <Attribute name="myType" value="myTypeValue2" />
      <Attribute name="title" value="myTitle3" />
    </Attributes>
  </NewInstance>
  <NewRelationship>
    <Parent>
      <Instance ref="myUniqueID1"/>
    </Parent>
    <GenericRelations>
      <Relations type="contains">
        <Instance ref="myUniqueID2"/>
      </Relations>
      <Relations type="contains">
        <Instance ref="myUniqueID3"/>
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      </Relations>
   </GenericRelations>
  </NewRelationship>
</Service>

How to Configure Local Topology Synchronization
1. Deploy the BSM Connector package to the RTSM.

Manually deploy the BSMConnectorRTSM package to enable local topology synchronization:

a. BSM 9.20, 9.21, and upgraded 9.22 only: Copy the BSMConnectorRTSM package from
the following location on the BSMConnector system to the BSM server:

<BSM Connector root directory>/conf/topology/packages/BSMConnector.zip

b. Upgraded BSM 9.23 only: Locate the BSMConnectorRTSM package in the following
location on the BSM server:

<BSM root directory>/odb/conf/factory_packages/BSMConnector.zip

c. In BSM, navigate to the RTSM PackageManager:

Admin > RTSM Administration > Administration > Package Manager

d. Click the button to open the Deploy Packages to Server dialog box.

e. Click the button to open the Deploy Packages to Server (from local disk) dialog box.

f. Select the BSM Connector package zip file and click Open.

The package appears in the upper pane of the dialog box. Select it to display its resources
in the lower pane.

g. Make sure the discovery script resource is selected and click Deploy.

h. A status report appears indicating whether the deployment was successful for the selected
resource.

2. Create the discovery script.
Create a script (or program) that runs on the BSMConnector server and discovers
configuration items (CIs) and CI relations. This discovery script must write details of each
discovered CI in XML to a file on the BSMConnector system. For details on the XML syntax,
see "Topology Discovery Syntax" on page 335

The script must meet additional requirements, if the topology-XML policy runs the discovery
script. For details, see "Configuring Settings in Topology-XML Policies" on page 342.
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Tip: You can also create a script that runs on a remote system. BSM Connector can save
the output of the script on the remote system to a file that can be consumed by the
topology-XML policy.

3. Create the synchronization package.
a. In a temporary location, create a directory with a name that matches the synchronization

package name (for example, /temp/mysyncpkg).

b. Create the package descriptor file and save it in the synchronization package directory (for
example, /temp/mysyncpkg/package.xml).

For details on the package descriptor file, see "Package Descriptor File: package.xml" on
page 331.

c. Configure the context mapping file to tag which elements included in discovered data you
want to include in the topology synchronization for mapping. Themapping rules contained
in the XML mapping files are applied to the tagged elements.

Save the context mapping file in the synchronization package directory (for example,
/temp/mysyncpkg/contextmapping.xml).

For details on the context mapping file, see "Context Mapping (Filtering):
contextmapping.xml" on page 332.

d. Configure the typemapping file to define themapping between the discovered CIs to the
type of a CI in the RTSM.

Save the typemapping file in the synchronization package directory (for example,
/temp/mysyncpkg/typemapping.xml).

For details on the typemapping file, see "TypeMapping File: typemapping.xml" on page
332.

e. Configure the attributemapping file to map the attributes of a discovered CI to the
attributes of a CI in the RTSM.

Save the attributemapping file in the synchronization package directory (for example,
/temp/mysyncpkg/attributemapping.xml).

For details on the attributemapping file, see "AttributeMapping File: attributemapping.xml"
on page 333.

f. Configure the relationmapping file to define the CI relationships created in the RTSM
between specified discovered CIs.

Save the relationmapping file in the synchronization package directory (for example,
/temp/mysyncpkg/relationmapping.xml).
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For details on the relationmapping file, see "RelationMapping File: relationmapping.xml"
on page 333.

g. Optional: Use the supplied XML schema definitions to validate the correctness of the XML
mapping files:

<BSM Connector root directory>/conf/topology/xml/schemas

h. Copy the directory that contains the XMLmapping files from the temporary location to the
following directory on the BSMConnector system:

<BSM Connector root directory>/conf/topology/xml/sync-packages/

4. Create a topology-XML policy.
The topology-XML policy contains the settings required to run topology synchronization. The
settings include:

n Frequency: how often themapping rules are applied.

n Path and name of the XML file that contains the discovered data.

n Name of the subdirectory that contains the topology synchronization files.

n Details of the script that BSM Connector runs to gather topology data in an XML file.

n Settings that determine how BSMConnector transfers the resulting topology data to BSM.

For details on topology-XML policies, see "Configuring Settings in Topology-XML Policies" on
the next page.

Topology-XML Policy User Interface
This section includes:

l "Configuring Topology-XML Policy Properties" below

l "Configuring Settings in Topology-XML Policies" on the next page

Configuring Topology-XML Policy Properties

Every policy has a set of properties that identify and describe the policy. Properties include, for
example, the policy name and a description of what the policy does.

To access
In the BSMConnector user interface, click in the toolbar. Then click Topology > Topology-
XML.

Alternatively, double-click an existing policy to edit it.

BSM Connector User Guide
Chapter 15: Topology Policies

HP Business ServiceManagement (9.23) Page 341 of 521



Tasks

How to configure policy properties
In the Properties page, type a name for the policy. You can use spaces in the name. The equal sign
(=) is not allowed.

Related tasks

l "How to Configure Local Topology Synchronization" on page 339

UI Descriptions

For a description of the Properties page, see "Properties Page" on page 494.

Configuring Settings in Topology-XML Policies

The topology page enables you to configure settings for topology synchronization. The settings
determine the topology synchronization rules, the script that BSM Connector runs to gather
topology data in an XML file, and how BSMConnector transfers the resulting topology data to BSM.

To access
In the BSMConnector user interface, click in the toolbar. Then click Topology > Topology-
XML.

Alternatively, double-click an existing policy to edit it.

Learn More

This section includes:

l "Supported Platforms" below

l "Script Requirements" below

Supported Platforms

BSM Connector Platform Remote Server Platform

Windows Windows (SSH only)

UNIX (SSH only)

Linux UNIX (SSH, rlogin, or Telnet)

Script Requirements

l Echo script results and exit codes. The remote scripts must include an echo construct to
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echo script results and exit codes back to BSM Connector. The policy may fail if the required
exit code is not echoed back to BSM Connector.

Windows batch file exit codes are not passed out of the command interpreter, and remote UNIX
script exit codes are not passed back through the remote connection. To solve this problem, we
recommend including an echo to standard out of a return value. In the case of Windows-to-
Windows remote scripts (using Secure Shell), the remote script must echo end script when the
script has terminated.

n Windows scripts:

When running a script on a remoteWindows server using SSH, youmust include an "end
script" string at the end of the script to avoid a timeout error. For example:

@echo off
time
echo end script

n UNIX scripts:

In the script that runs on a remote server, include echo commands that represent the different
logical paths that might be followed. The following is an example script outline based on a
UNIX shell script:

#!/bin/sh
...(script commands and logic here)...
echo "Return Code: 1" (indicating the script failed to complete execution)
...(more script commands and logic here)...
echo "Return Code: 0" (the end of the script, indicating the script completed successfully)

l Exit command. Do not include any carriage returns or any command that would normally
discontinue script processing (for example, do not use the exit command).

l Script interpreters. You can run script interpreters with script extensions by specifying the _
scriptInterpreters property in themaster.config file as follows:

_scriptInterpreters=pl=c:/perl/perl.exe;
py=c:/python/python.exe;php=c:/php/php.exe

Note: This is only supported for running local scripts on a BSMConnector onWindows
server.

Tasks

How to configure settings in topology-XML policies

1. Use the Frequency field to specify how often the policy applies the topology synchronization
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rules. Use the drop-down list to specify increments of seconds, minutes, hours, or days.

Each time the policy runs, themapping rules are applied to the whole discovery XML file, not
only to appended entries.

2. Specify the path and name of the XML file that contains the discovered data.

If you select Save Script Output to File, the policy creates the topology input file and saves
the discovered data in this file.

3. Specify the subdirectory on the BSM Connector server that contains the topology
synchronization files (for example, mysyncpkg).

The policy editor assumes that the synchronization packages are stored in subdirectories of
the <BSM Connector root directory>/conf/topology/xml/sync-packages/ directory (for
example, <BSM Connector root directory>/conf/topology/xml/sync-
packages/mysyncpkg).

4. Optional: Configure the topology-XML policy to run the discovery script.

a. Make sureRun Script is selected.

b. Select a server from the server list (only those remote servers that have been configured in
BSM Connector are displayed). The BSMConnector server is the default server.

Alternatively, click Remote Servers to add a new server.

c. Place the script or script file in one of the following directories, depending on where you
want to run the script or command:

o BSM Connector server.When running scripts on the local BSM Connector server,
place the script into the <BSM Connector root directory>/scripts directory.

When running a command on a remote UNIX server, place the script file containing the
command in the <BSM Connector root directory>/scripts.remote directory on
the BSMConnector server. (The commandmay be used to run a remote script file that
performs multiple functions.)

o Windows remote servers.When running scripts on a remoteWindows server, place
the script into the scripts subdirectory in the home directory of the account BSM
Connector uses to access the remote server.

The path to the user home directory depends on the particular SSH server. For example
if you install a Cygwin SSH server in C:\Cygwin, the default path to the home directory
for the Administrator user will be C:\Cygwin\home\Administrator. For additional
information, see "How to Configure RemoteWindows Servers for SSH Access" on
page 103 and particularly "Install BSM Connector RemoteWindows SSH Files" on
page 111.
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o UNIX remote servers.When running scripts on a remote UNIX server, place the script
into the scripts subdirectory in the home directory of the account BSM Connector uses
to access the remote server. For example, /home/BSMConnector/scripts. For
additional information, see "How to Configure Remote UNIX Servers for SSH Access"
on page 112.

Tip: Remember to grant execute permissions for the connecting user to the remote
scripts.

d. Select the script from theScript drop-down list. If you want to run a command on a remote
UNIX server, chooseUSE COMMAND.

e. If you want to run a command on a remote UNIX server, select the script file containing the
command from theRemote Script Command File drop-down list.

f. Make sureSave Script Output to File is selected if the discovery script writes the XML to
the standard output stream (STOUT) (for example, if the script runs on a remote server)
and you want the policy to create and populate the topology input file.

g. BSMConnector onWindows only: Specify how long the policy waits for the script to run
successfully before timing out.

5. Optional: Customize the advanced settings of the policy. The advanced settings determine
how BSMConnector transfers themapped topology data to BSM.

Related tasks

l "How to Configure BSM Connector to Access RemoteWindows Servers " on page 86

l "How to Configure BSM Connector to Access Remote UNIX Servers " on page 88

l "How to Configure Local Topology Synchronization" on page 339

UI Descriptions

For a description of the Topology Synchronization Settings page, see "Topology Page - Topology-
XML Policies" on page 515.

Mapping Syntax
Mapping is themechanism used tomapCIs, CI attributes, and CI relationships within the topology
model of a third-party system to CIs and CI relationships in the RTSM. The file format, mapping
syntax, and XPath query language used to navigate through the CI data structure is described in the
following sections:
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l "CommonMapping File Format" below

l "Mapping File Syntax" below

l "XPath Navigation" on page 364

Common Mapping File Format

Note: The rule namemust be unique for all rules in the current file.

This example illustrates the common parts of themapping file:

<?xml version="1.0" encoding="utf-8"?>
<Mapping>

<Rules Context="web server SPI">
<Rule name="Apache Server">

<Condition>
<!-- ... Boolean operators ... -->

</Condition>
<MapTo>

<!-- ... Target Mappings ... -->
</MapTo>

</Rule>
<!-- ... More Rules ... -->

</Rules>
<!-- ... More Rule sets with different contexts ... -->

</Mapping>

The components of themapping files are described in "Mapping File Syntax" below.

Mapping File Syntax

The following sections describe the valid syntax used in topology synchronizationmapping files.

l "Rules" on the next page

l "Rule Conditions" on the next page

l "Operator Elements" on page 348

l "Operand Elements" on page 351

l "Mapping Elements" on page 358

l "Filtering" on page 358
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l "TypeMapping" on page 359

l "AttributeMapping" on page 360

l "RelationMapping" on page 362

Rules

The <Rules> tag contains a set of rules. By using the optional Context attribute you can restrict
these rules to a certain context. See "Filtering" on page 358 for more information.

Rule Conditions

The <Condition> element of a rule contains a Boolean operator that specifies how the individual
conditions relate to each other, and, for example, is similar to the <condition> task in Ant.

Each operator can implement an operation against operands. For example, attribute hosted_on has
a value ending with .europe.example.com (attribute hosted_on and .europe.example.com are
operands) or an operation against one or a set of other nested operators like <And>, <Or> or <Not>.

Condition Examples
Check if the type of the current discovered object is testtype.

Example:

<Condition>
<Equals>

<OMType/>
<Value>testtype</Value>

</Equals>
</Condition>

Check if the CI is related to a node that is located in the europe.example.com domain.

Example:

<Condition>
<EndsWith>

<XPathResult>//.[node='true']/attributes/
            host_dnsName<XPathResult>

<Value>.europe.example.com</Value>
</EndsWith>

</Condition>
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Operator Elements

True
<True/>

This operator always returns true when all nested operators return true. It is useful for declaring
default (fall-back) rules. In amapping engine that is using the early-out mode, make sure that this
operator is only used at the end of the synchronization package with the lowest priority.

False
<False/>

Always returns false. You can use the False element to temporarily disable rules.

And
<And>

<!-- Operator -->
<!-- Operator -->
[... more operators ...]

</And>

Returns true when all nested operators return true.

The <And> operator is exclusive. This means that if the result of the first operator is false, the next
operator is not evaluated. Use this operator to implement rules with higher performance by placing
the simplest condition first and themost complex condition at the end.

Or
<Or>

<!-- Operator -->
<!-- Operator -->
[... more operators ...]

</Or>

Returns true if at least one of the operators returns true.

Not
<Not>

<!-- Operator -->
</Not>

Returns true if the operator does not return true.

The <Not> operator is exclusive. This means that evaluation stops as soon as a child operator
returns true.

Exists
<Exists>

<!-- Operand -->
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<Exists>

The value of the operandmust not be null.

Is Node
<IsNode/>

True if the CI is imported as a node, which is the case if the CI type is listed in the nodetypes.xml
file.

True if the element is amanaged node in HPOM.

Is Root CI
<IsRootCI/>

True if the CI is a root CI (a root CI has no parent).

Equals
<Equals>

<!-- Operand -->
<!-- Operand -->
<!-- ... -->

</Equals>

<Equals ignoreCase="[true|false]">
<!-- Operand -->
<!-- Operand -->
<!-- ... -->

</Equals>

The values of the operands must be equal. If there aremore than two operands, all operands must
be equal to each other. Using the optional attribute ignoreCase, you can also compare the string
values of the operands independent of capitalization. By default the equals operator does not ignore
case.

Starts With
<StartsWith>

<!-- Operand -->
<!-- Operand -->

</StartsWith>

The string value of the first operandmust start with the value of the second operand.

Ends With
<EndsWith>

<!-- Operand -->
<!-- Operand -->

</EndsWith>

The string value of the first operandmust end with the value of the second operand.
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Matches
<Matches>

<!-- Operand -->
<!-- Operand -->

</Matches>

The string value of the first operandmust match the regular expression of the second operand.

Example:

<Matches>
<Attribute>host_dnsname</Attribute>
<Value>.*\.example\.com</Value>

</Matches>

Formore information on applicable regular expressions, see:

http://docs.oracle.com/javase/7/docs/api/java/util/regex/Pattern.html

Contains
<Contains>

<!-- Operand -->
<!-- Operand -->

<Contains>

The value returned by the first operandmust contain the value of the second operand. If the
operand’s return type is a list, the list must contain at least one element that is equal to the second
operand. If the operand’s return type is a string, the value of the second operandmust be a
substring of the first operand.

Is Deletion CI
<IsDeletionCI/>

True if the CI is used to delete CIs.
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Operand Elements

HPOM Service ID
<OMId/>

Return type: String

Returns the HPOM ID string of the CI as stored in Operations Management. The HPOM ID returns
different values as follows:

Services: HPOM ID is the service ID

Nodes: HPOM ID is the unique ID

NodeGroups: HPOM ID is the node group ID

HPOM Type
<OMType/>

Return type: String

Returns the HPOM Type stored in Operations Management. For HPOM services, the HPOM Type
is the service type definition. For nodes, the HPOM Type is set to the constant value “node”.

CMDB Type
<CMDBType/>

Return type: String

Returns the CMDB CI Type ID string of the CI as it is stored in the RTSM. Initially this is returned
as null because the CMDB typemust initially be set in the TypeMapping. After this is set, the
CMDB CI Type ID string should be available.

Caption
<Caption/>

Return type: String

Returns the caption string of the CI in the RTSM or BSM.

HPOM Attribute

<OMAttribute>[Name]</OMAttribute>

Return type: String

Returns the value of the HPOM attribute with the given name.

CMDB Attribute
<CMDBAttribute>[Name]</CMDBAttribute>

Return type: String
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Returns the value of the CMDB attribute with the given name as it will be written to the RTSM.
There are no attributes available until the attributemapping has been performed.

Replace
<Replace [regExp="true|false"]>
    <In>
        <!-- 1st. Operand -->
    </In>
    <For>
        <!-- 2nd. Operand -->
    </For>
    <By>
        <!-- 3rd. Operand -->
    </By>
</Replace>

Return type: String

Replaces the strings in the return value of the first operand for all occurrences of the return value of
the second operator by the return value of the third operand. For example, to replace all occurrences
of a backslash in the CI caption by an underscore, youmust declare the following:

<Replace>
    <In>
        <CiCaption/>
    </In>
    <For>
        <Value>\</Value>
    </For>
    <By>
        <Value>_</Value>
    </By>
</Replace>

Optionally, you can use regular expressions for the second operand. You can also use back
references in the third operand.

For more information on applicable regular expressions, see:

http://docs.oracle.com/javase/7/docs/api/java/util/regex/Pattern.html

This example uses regular expressions to extract part of a domain name:

<Replace regExp="true">
    <In>
        <Attribute>host_dnsname</Attribute>
    </In>
    <For>
        <Value>^[^.]*\.([^.]*).*</Value>
    </For>
    <By>
        <Value>$1</Value>
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    </By>
</Replace>

If the attribute host_dnsname contains the value server.rio.example.com, the result of the
Replace operand is rio.

XPath Result
<XPathResult>[XPath]</XPathResult>

Return type: String

Returns the value of the XPath expression, which enables you to access data of any CI that is
contained in the same hierarchy. The XPath expressionmust select a string value, if there are
multiple matches an arbitrary element is returned.

For more information on XPath, see "XPath Navigation" on page 364.

XPath Result List
<XPathResultList>[XPath]</XPathResultList>

Return type: List

Returns a list of all matched values.

For more information on XPath, see "XPath Navigation" on page 364.

Value
<Value>[String]</Value>

Return type: String

Return the constant value.

List
<List>

<!--Operand-->
<!--Operand-->
<!--...-->

</List>

Return type: List

The list operand is designed for use with operators that accept lists as input parameters, such as
the contains operator. The list operand contains a list of other operands, the values of which are to
be added to the returned list.

Parent CI
<ParentCI/>

Return type: CI

Returns the parent CI of the current CI. If the current CI is the root CI, null is returned.

BSM Connector User Guide
Chapter 15: Topology Policies

HP Business ServiceManagement (9.23) Page 353 of 521



Tip: To check for the root CI, use the IsRoot operator.

Child CI
<ChildCI>

[Operator]
</ChildCI>

<ChildCI relationType="[relationType]">
[Operator]

</ChildCI>

Return type: CI

Description: Returns the first child CI of the current CI that matches the enclosed operator.

Optional elements:

relationType: Only follow relations with the specified relation type.

Child CI List
<ChildCIList>

[Operator (Optional)]
</ChildCIList>

<ChildCIList relationType="[relationType]">
[Operator (Optional)]

</ChildCIList>

Return type: List of CIs

Returns all CI children of the current CI.

Optional elements:

Operator: Only CIs that match the operator will be returned.

relationType: Only follow relations with the specified relation type.

Ancestor CI
<AncestorCI>

[Operator]
</AncestorCI>

<AncestorCI relationType="[relationType]">
[Operator]

</AncestorCI>

Return type: CI

Returns the first ancestor CI of the current CI that matches the enclosed operator. An ancestor CI
is the parent or parent of the parent (and so on) of the current CI.

Optional elements:
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relationType: The dependency must have the specified relation type.

Descendant CI
<DescendantCI>

[Operator]
</DescendantCI>

<DescendantCI relationType="[relationType]">
[Operator]

</DescendantCI>

Return type: CI

Returns the first descendant CI of the current CI that matches the enclosed operator. A descendant
CI is the child or child of the child (and so on) of the current CI.

Optional elements:

relationType: Only follow relations with the specified relation type.

Descendant CI List
<DescendantCIList>

[Operator (Optional)]
</DescendantCIList>

<DescendantCIList relationType="[relationType]">
[Operator (Optional)]

</DescendantCIList>

Return type: List of CIs

Returns the all descendant CIs of the current CI. A descendant CI is the child or child of the child
(and so on) of the current CI.

Optional elements:

Operator: Only CIs that match the operator will be returned.

relationType: Only follow relations with the specified relation type.

Dependency CI
<DependencyCI>

[Operator]
</DependencyCI>

<DependencyCI relationType="[relationType]">
[Operator]

</DependencyCI>

Return type: CI

Returns the first dependency CI that matched the included operator.

Optional elements:

relationType: Only follow relations with the specified relation type.
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Dependency CI List
<DependencyCIList>

[Operator (Optional)]
</DependencyCIList>

<DependencyCIList relationType="[relationType]">
[Operator (Optional)]

</DependencyCIList>

Return type: CI

Returns the list of dependencies.

Optional elements:

Operator: Only CIs that match the operator will be returned.

relationType: The dependency must have the specified relation type.

Dependent CI
<DependentCI>

[Operator]
</DependentCI>

<DependentCI relationType="[relationType]">
[Operator]

</DependentCI>

Return type: CI

Returns the first dependent CI that matched the included operator.

Example for a dependent CI:

ServiceA > hosted_on > HostB

In this case ServiceA is a dependent CI of HostB. That means if you have HostB and want to have
all services that depend on this host, you have to use the <DependentCI> operand. If you have
ServiceA and want to have HostB, you have to use the <DependencyCI> operand instead.

Optional elements:

relationType: Only follow relations with the specified relation type.

Dependent CI List
<DependentCIList>

[Operator (Optional)]
</DependentCIList>

<DependentCIList relationType="[relationType]">
[Operator (Optional)]

</DependentCIList>

Return type: CI

Returns the list of dependent CI.
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Example for a dependent CI:

ServiceA > hosted_on > HostB

In this case ServiceA is a dependent CI of HostB. That means if you have HostB and want to have
all services that depend on this host, you have to use the <DependentCI> operand. If you have
ServiceA and want to have HostB, you have to use the <DependencyCI> operand instead.

Optional elements:

Operator: Only CIs that match the operator will be returned.

relationType: The dependency must have the specified relation type.

From CI Get
<From>

<CI>
[CI Operand]

</CI>
<Get>

[Operand]
</Get>

</From>

Return type: Return type of the second operand.

Using this operand you can get values from another CI. The first operand [CI Operand] must return
a CI instance. The second operand operates on that CI instance and the value of this second
operand will be returned by this From operand.

Example:

<From>
<CI>

<ParentCI>
</CI>
<Get>

<Caption/>
</Get>

</From>

Returns the caption from the parent CI of the current CI.

Origin Server
<OriginServer/>

Return type: String

This operand returns the hostname of the server that originally received the discovery data before
forwarding it to other servers.
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Mapping Elements

<MapTo> defines themappings. Each concrete implementation of an engine adds its own XML
elements for its individual mappings here.

Mapping Examples
Map the attribute Caption to the CI attribute display_label in the RTSM.

Example:

<MapTo>
   <CMDBAttribute>
      <Name>display_label</Name>
      <SetValue>
         <Caption />
      </SetValue>
   </CMDBAttribute>
</MapTo>

Map the OMID to the CI attribute data_name in the RTSM.

Example:

<MapTo>
   <CMDBAttribute>
      <Name>data_name</Name>
      <SetValue>
         <OMId />
      </SetValue>
   </CMDBAttribute>
</MapTo>

Filtering

Filtering allows to select interesting parts of topology data by assigning a context to these CIs. This
context allows to selectively apply mapping rules to CIs of the same context. All CIs that have no
context attached will not be synchronized.

Note: The <Rules> tag for filter mapping rules must not contain the Context attribute.

Context Mapping
<Context>[Context Name]</Context>

In the following example, all CIs that are assigned to the type exch_spi_std_server_role and
that are below aCI with a type exch_spi_std_server are assigned to the exchange context.

BSM Connector User Guide
Chapter 15: Topology Policies

HP Business ServiceManagement (9.23) Page 358 of 521



Example:

<Mapping xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation="../mapping.xsd">
<Rules>

<Rule name="Exchange Server Role Filter">
<Condition>
<And>
<Exists>
<XPathResult>ancestor::ci[omType='exch_spi_std_server']

         </XPathResult>
</Exists>
<Equals>

<OMType/>
<Value>exch_spi_std_server_role</Value>

</Equals>
</And>

</Condition>
<MapTo>
<Context>exchange</Context>

</MapTo>
</Rule>

</Rules>
</Mapping>

Type Mapping

The typemappingmaps the third-party CI type definitions to their CMDB types in the RTSM.

Mapping
Maps the CI to the specified CMDB type that is the concatenated string of the results of the
operators. Theremust not bemore than one <CMDBType> element in the <MapTo> section.

<CMDBType>
[Operand]
...

</CMDBType>

In the following example, all CIs that have anOM Type Exch2k7_ByServer and that have the
context exchange assigned aremapped to the CMDB Type exchangeserver.

Example:

<?xml version="1.0" encoding="utf-8"?>
<Mapping>

<Rules context="exchange">
</Rule>
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<Rule name="Map Exchange Server">
<Condition>

<Equals>
<OMType/>
<Value>Exch2k7_ByServer</Value>

</Equals>
</Condition>
<MapTo>

<CMDBType>
<Value>exchangeserver</Value>

</CMDBType>
</MapTo>

</Rule>
</Rules>

</Mapping>

In the following example, all nodes that have an attribute OSType that starts with the string Windows
aremapped to the CMDB type nt.

Example:

<Mapping>
<Rules>
<Rule name="Map Windows Host Type">

<Condition>
<And>

<IsNode/>
<StartsWith>

<OMAttribute>OSType</OMAttribute>
<Value>Windows</Value>

</StartsWith>
</And>

</Condition>
<MapTo>

<CMDBType>
<Value>nt</Value>

</CMDBType>
</MapTo>

</Rule>
</Rules>

</Mapping>

Attribute Mapping

The attributemapping file attributemapping.xml defines themapping between the attributes of a
discovered object and the attributes of a CI in the RTSM.
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Set the value of the attribute of the given name to the returned value of the given operand. If more
than one operand is given, the values will be concatenated.

Mapping to String Values
<CMDBOMAttribute>

<Name>[Attribute Name]</Name>
<SetValue>

[Operands]
</SetValue>

</CMDBCMDBOMAttribute>

Mapping to String Values of a Maximum Length
<CMDBOMAttribute>

<Name>[Attribute Name]</Name>
<SetValue Length="[IntegerValue]">

[Operands]
</SetValue>

</CMDBOMAttribute>

Mapping to Integer Values
<CMDBOMAttribute>

<Name>[Attribute Name]</Name>
<SetIntValue>

[Operands]
</SetIntValue>

</CMDBOMAttribute>

Mapping to Boolean Values
<CMDBOMAttribute>

<Name>[Attribute Name]</Name>
<SetBoolValue>

[Operands]
</SetBoolValue>

</CMDBOMAttribute>

Mapping to Long Values
<CMDBOMAttribute>

<Name>[Attribute Name]</Name>
<SetLongValue>

[Operands]
</SetLongValue>

</CMDBOMAttribute>

Mapping to Date Values
<CMDBOMAttribute>

<Name>[Attribute Name]</Name>
<SetdateValue>
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[Operands]
</SetdateValue>

</CMDBOMAttribute>

Mapping to Float Values
<CMDBOMAttribute>

<Name>[Attribute Name]</Name>
<SetFloatValue>

[Operands]
</SetFloatValue>

</CMDBOMAttribute>

Mapping to Byte Values
<CMDBOMAttribute>

<Name>[Attribute Name]</Name>
<SetByteValue>

[Operands]
</SetByteValue>

</CMDBOMAttribute>

Mapping to Double Values
<CMDBOMAttribute>

<Name>[Attribute Name]</Name>
<SetDoubleValue>

[Operands]
</SetDoubleValue>

</CMDBOMAttribute>

Mapping to StringList Values
<CMDBAttribute>

<Name>[Attribute Name]</Name>
<SetStringListValue>

[Operands] (comma-separated)
</SetStringListValue>

</CMDBAttribute>

Mapping to IntList Values
<CMDBAttribute>

<Name>[Attribute Name]</Name>
<SetIntListValue>

[Operands] (comma-separated)
</SetIntListValue>

</CMDBAttribute>

Relation Mapping

Using the relationmapping you can create relations between CIs.
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<RelationTo>
<To>

[Operand]
</To>
<Type>[RelationType]</Type>

</RelationTo>

Define a relation from the current CI to the CI that is returned by the operand. The operandmay
either return a string, an instance of a CI, a list of CIs or a list of strings. String values must match
the OM ID of the CI to which the relation is created. In the case of a list, a relation is created for
each item (that is in turn either a string or a CI) contained in the list.

The relation has the type specified by [RelationType]. This type is the name of the relation, not the
label.

<RelationFrom>
<From>

[Operand]
</From>
<Type>[RelationType]</Type>

</RelationFrom>

Works just as the previous mapping, but in the opposite direction.

Root Container Mapping
The CMDB model defines certain root container CIs that have to be created before the actual CI
can be created. Topology synchronizationmust know such relations to be able to create the CIs in
the correct order.

<RootContainer>
[Operand]

</RootContainer>

The root container of the current CI is set to the CI specified by the return value of the operand. The
return valuemay either be a String or a CI.

Message Alias Mapping for CI Resolution
<RedirectMessagesOf>

[Operand]
</RedirectMessagesOf>

The aliases of the current CI is set to the OMId(s) specified by the return value of the operand. The
return valuemay either be a String or a CI or a list of CIs or Strings.

In the following example, the CI with the type Exch2k7_ByServer gets a relation of the type is_
impacted_from to the node on which it is hosted and a relation of the type deployed to all
descendant CIs with a type that starts with Exch2k7_Role_.

The same node is also the root container CI.

Example:
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<Mapping>
<Rules Context="exchange">

<Rule name="Create relation server to node">
<Condition>

<Equals>
<OMType/>
<Value>Exch2k7_ByServer</Value>

</Equals>
</Condition>
<MapTo>

<RelationTo>
<To>

<DependencyCI relationType="hosted_on">
<True/>

</DependencyCI>
</To>
<Type>is_impacted_from</Type>

</RelationTo>
<RelationTo>

<To>
<DescendantCIList>

<StartsWith>
<OMType>
<Value>Exch2k7_Role_</Value>

</StartsWith>
</DependencyCI>

</To>
<Type>deployed</Type>

</RelationTo>
<RootContainer>

<DependencyCI relationType="hosted_on">
<True/>

</DependencyCI>
</RootContainer>
<RedirectMessagesOf>

<ChildCIList/>
</RedirectMessagesOf>

</MapTo>
</Rule>

</Rules>
</Mapping>

XPath Navigation

XPath is a syntax for defining parts of an XML document. XPath uses path expressions to navigate
in XML documents.

XPath is used in themapping engines to navigate through the CI data structure.
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If you are not familiar with the XPath query language, an XPath tutorial can be found at the following
Web site:

http://www.w3schools.com/xpath/

Data Structure

The data structure that is exposed to the XPath expressionmatching used inmapping rules is
shown in "Example of an XPath-Navigated Data Structure" on page 367.

CI Data Structure

l OMAttributes
Contains amap of all original RTSM CI attributes. The key of this map is the name of the RTSM
CI attribute that references the RTSM value of the RTSMCI attribute.

l Caption
Represents the name of the CI to be displayed in Service Navigator. Caption has the same
value as the RTSMCI attribute display_label.

l Children
References a list of relations to CIs that have a containment relationship from the current CI to
other CIs. Using this field, you can create complex XPath queries to retrieve values of children
as well as parents using the “..” XPath selector.

l Dependencies
References a list of relations to dependent CIs. Similar to Children. However, referenced
objects are contained in a different hierarchy.

l OMid
Unique ID of a CI.

l Node
Boolean value that indicates whether this is a node in HPOM.

l Type
Contains the service type of an HPOM service.

This is not the display label of the CI Type.

l Service
Boolean value that indicates whether this element is a service in HPOM.

Node groups have Node and Service set to FALSE.
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Relationship Data Structure

l CI
Contains the reference to the CI to which the current CI is related.

l RelationType
Relationship type as stored in the RTSM.

This is not the display label of the CI Type.

For services:
Contains container_f if it is a containment relation in HPOM.
Contains dependency if it is a dependency relation in HPOM.
Contains hosted_on if it is a hosted on relation in HPOM.

For nodes:
Contains container_node or dependency_node.
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The following figure illustrates the data structure exposed to the navigation.

Example of an XPath-Navigated Data Structure

An example of an XPath-navigated data structure is shown in the figure below. The host is a UNIX
system that has anOracle application running on the HP-UX operating system. The starting point or
context for the navigation is the CI that represents the Oracle application (orange background).
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The following figure illustrates some XPath examples.

XPath Expressions and Example Values

The following table lists typical XPath expressions and provides an example for each expression.

Xpath Expression Meaning Example

Caption Caption from CI PRD server 01

./Caption Caption from CI PRD server 01

/Caption Caption of the root (database) CIs PRD

../../Caption Selects the caption from the parent of the
parent CI

PRD

../RelationType Selects the parent relation type container_f

../../OMType Selects the parent of the parent type ACME_System

/OMType Selects type of the root CI ACME_System

//.[type=’WINOSSPI:
Infrastructure’]/Caption

Selects the caption of all CIs of type
WINOSSPI: Infrastructure

BLANTONS:
Infrastructure

//Dependencies
[type=’hosted_on’]
/CI/Caption

Selects the caption of all CIs with a
hosted_on dependency

BLANTONS

//Dependencies/CI/Caption Selects the caption of all CIs that have
dependencies

BLANTONS

Note: If the Xpath expression selects a node below the starting database node, the “..” reads
back one step. The following expression reads down to the node db and then links back to the
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starting database node.

//dependencies[type='hosted_on']/CI/../..

However, if the node db is the starting node, the expression ../.. follows the containment
links of the node db, which is not the dependency relation that is shown in this example. The
result depends on the parent container of the node, which is a different hierarchy.

Topology Synchronization Troubleshooting
This section describes how to troubleshoot BSM Connector local topology synchronization.

This section includes:

l "Troubleshooting local topology synchronization" below

l "Validating XMLMapping Files" below

l "Mapping Log Files" on the next page

l "Writing Rules" on the next page

Troubleshooting local topology synchronization
Make sure the input XML file is written and updated correctly. Each time the topology-XML policy
runs, themapping rules are applied to the whole discovery XML file, not only to appended entries.

For general topology troubleshooting information, see "Topology Troubleshooting and Limitations"
on page 193.

For troubleshooting themapping engine, see "Mapping Log Files" on the next page.

Validating XML Mapping Files
You can use the supplied XML schema definitions to validate the correctness of XML configuration
files. You can also use the supplied XML schema definition files to make writing new configuration
files easier when using a suitable XML editor (for example Eclipse).

XSD XMLSchemaDefinition is a standard fromWorldWideWebConsortium (W3C) for describing
and validating the contents of XML files. XSD files are provided for all XML configuration files. For
more information, see the XMLSchema documentation by W3C available from the followingWeb
site: http://www.w3.org/XML/Schema.

Eachmapping file is automatically validated against the associated XSD file whenever it is read. If
a file cannot be validated, an error message is written to the error log that describes the location of
the error in the validated file.

The schema files are stored in the following directory:

<BSM Connector root directory>/conf/topology/xml/schemas

The files are:

package.xsd
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Validates the package.xml file in each synchronization package.

mapping.xsd

Validates the followingmapping files contained in the synchronization packages:

l Context mapping - contextmapping.xml

l Typemapping - typemapping.xml

l Attributemapping - attributemapping.xml

l Relationmapping - relationmapping.xml

Mapping Log Files
To change the log level of themapping engine, follow these steps:

1. Open the following file in a text editor:

<BSM Connector root
directory>/conf/core/Tools/log4j/PlainJava/toposyncsa.log4j.properties

2. Locate the line starting with loglevel=

3. Set the log level to any of the following values (for example, loglevel=INFO):

DEBUG designates fine-grained informational events that aremost useful to debug an
application.

INFO designates informational messages that highlight the progress of the application at
coarse-grained level.

WARN designates potentially harmful situations.

ERROR designates error events that might still allow the application to continue running.

FATAL designates very severe error events that will presumably lead the application to abort.

Themapping engine generates the following log file:

<BSM Connector root directory>/logs/opr-ts.log

Writing Rules
Use following guidelines when writing rules:

l Simplify Rule Development. You can ease the writing of rules by selecting an XML editor that
can validate and suggest elements according to an XML schema.

l Avoid Complex XPath Queries. Avoid complex XPath queries, especially in general
conditions, where such queries must be applied to every CI. If you cannot avoid a complex
XPath query, try to narrow the condition using operators such as OMType, combined using the
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And operator. Make sure that the simpler, non-XPath conditions are checked first (hint: And is an
exclusive operator).

l Match Against Existing Attributes Only. Accessing attributes that do not exist for all CIs is
very performance intensive in combination with a relative expression depending on the
complexity of the CI hierarchy.

l Avoid Broad XPath Expressions. Certain complex XPath expressions can result in
excessive processing loads. For example, XPath expressions that include the following
characteristics:

n Apply to multiple nodes, such as expressions that contain // or descendants:*/

n Do not match nodes or match only on nodes that are very distant from the current node

The same applies to the XPathResultList operator that returns all matched values. The time
required for such operations grows approximately quadratically with the size of a hierarchy.
Avoid such expressions where possible.

When using the descendants operator, do not use the star symbol (*) as node test, but specify
the name of the node of interest. For example, do not use descendants:*/caption but use
descendants:ci/caption.

If you cannot avoid such an XPath expression within a condition, try to limit its execution by
using the exclusive And operator and perform simple tests before the XPathResult operand is
being used. For example, you could first check for the CI type.

Legacy Discovery
Legacy discovery in BSM Connector uses the discovery functionality of HP Operations Agent. The
discovery agent runs discovery policies that execute discovery scripts on the BSMConnector
server. These policies automatically populate the BSM Run-time ServiceModel (RTSM) with
discovered configuration items (CIs) and CI relationships. Discovered attributes may be hardware
resources, operating system attributes, applications, and other information that can be retrieved
from an object andmapped to CI attributes in the (RTSM). The discovery scripts run according to a
schedule that you specify for each policy.

Note: BSMConnector supports agent-based discovery only for discovery policies that have
beenmigrated from BSM Integration Adapter or imported from HP Operations Manager
(HPOM). You can edit migrated discovery policies. HPOM service auto-discovery policies
cannot be edited because they are incompatible with the BSM Connector legacy discovery
policy editor.

How to Discover Topology Data
This task describes how to configure discovery policies.
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1. Prerequisite:Make sure your BSM Connector is set up as a BSMConnector integration server
in BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see the BSM online
help or the BSM Application Administration Guide.

2. In the BSMConnector user interface, select a discovery policy and click in the toolbar, or
double-click a discovery policy. The discovery policy editor opens. 

3. Complete the information in the following tabs:

n Properties include information that is related to the policy itself (for example, the name and
description of the policy).

n Command defines the script or program that the HP Operations agent runs to discover
configuration items.

n Schedule defines the time, date, and frequency of discovery.

4. Click OK to save the policy and close the editor.

Discovery Policy User Interface
This section includes:

l "Configuring Discovery Policy Properties" below

l "Configuring the Command in Discovery Policies" on the next page

l "Configuring Schedules in Discovery Policies" on page 380

Configuring Discovery Policy Properties

Every policy has a set of properties that identify and describe the policy. Properties include, for
example, the policy name and a description of what the policy does.

To access
In the BSMConnector user interface, select a discovery policy and click in the toolbar, or
double-click a discovery policy. The discovery policy editor opens. 

Tasks

How to configure policy properties
In the Properties page, type a name for the policy. You can use spaces in the name. The equal sign
(=) is not allowed.
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Related tasks

l "How to Discover Topology Data" on page 371

UI Descriptions

For a description of the Properties page, see "Properties Page" on page 494.

Configuring the Command in Discovery Policies

Configuring a discovery policy includes creating a script (or program) that the HP Operations agent
can run on the BSMConnector system to discover configuration items (CIs) and CI relations. This
discovery script must write details of each discovered CI in XML to the standard output stream
(STDOUT). The agent stores these details in the agent repository, which is a local data store of CIs
that exist in the BSMConnector environment. The agent publishes details of new, changed, and
removed CIs to the BSMRTSM, but does not resend details of unchanged CIs.

To access
In the BSMConnector user interface, select a discovery policy and click in the toolbar, or
double-click a discovery policy. The discovery policy editor opens. 

Click Command to open the policy Command page.

Learn More

Configuration Item XML Schema Definition (XSD)
Your discovery script must output XML that conforms to the following schema:

<?xml version="1.0" encoding="utf-8"?>
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema">
   <xs:element name="Service">
      <xs:complexType>
         <xs:choice maxOccurs="unbounded">
            <xs:element ref="NewInstance" />
            <xs:element ref="DeleteInstance" />
            <xs:element ref="NewRelationship" />
            <xs:element ref="DeleteRelationship" />
         </xs:choice>
      </xs:complexType>
      <xs:key name="InstanceKey">
         <xs:selector xpath="NewInstance|DeleteInstance">
         </xs:selector>
         <xs:field xpath="Key"></xs:field>
      </xs:key>
      <xs:keyref refer="InstanceKey" name="InstanceKeyRef">
         <xs:selector xpath="NewInstance|DeleteInstance">
         </xs:selector>
         <xs:field xpath="@ref"></xs:field>
      </xs:keyref>
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      <xs:keyref refer="InstanceKey" name="InstanceRef">
         <xs:selector
xpath="NewRelationship/*/Instance|DeleteRelationship/*/Instance">
         </xs:selector>
         <xs:field xpath="@ref"></xs:field>
      </xs:keyref>
   </xs:element>
   <xs:element name="NewInstance" type="InstanceType" />
   <xs:element name="DeleteInstance" type="InstanceType" />
   <xs:complexType name="InstanceType">
      <xs:sequence>
         <xs:element ref="Std" />
         <xs:element ref="Virtual" minOccurs="0" />
         <xs:element ref="Key" />
         <xs:element ref="Attributes" />
      </xs:sequence>
      <xs:attribute name="ref" type="xs:string" use="required" />
   </xs:complexType>
   <xs:element name="NewRelationship" type="RelationType" />
   <xs:element name="DeleteRelationship" type="RelationType" />
   <xs:complexType name="RelationType">
      <xs:sequence>
         <xs:element ref="Parent" />
         <xs:element ref="GenericRelations" minOccurs="0" />
      </xs:sequence>
   </xs:complexType>
   <xs:element name="Std">
      <xs:simpleType>
         <xs:restriction base="xs:string">
            <xs:enumeration value="DiscoveredElement" />
         </xs:restriction>
      </xs:simpleType>
   </xs:element>
   <xs:element name="Virtual">
      <xs:complexType />
   </xs:element>
   <xs:element name="Key" type="xs:string" />
   <xs:element name="Attributes">
      <xs:complexType>
         <xs:sequence>
            <xs:element ref="Attribute" maxOccurs="unbounded" />
         </xs:sequence>
      </xs:complexType>
   </xs:element>
   <xs:element name="Attribute">
      <xs:complexType>
         <xs:attribute name="value" type="xs:string" use="required" />
         <xs:attribute name="name" type="xs:string" use="required" />
      </xs:complexType>
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   </xs:element>
   <xs:element name="Parent">
      <xs:complexType>
         <xs:sequence>
            <xs:element ref="Instance" />
         </xs:sequence>
      </xs:complexType>
   </xs:element>
   <xs:element name="GenericRelations" type="RelationsList" />
   <xs:complexType name="RelationsList">
      <xs:sequence>
         <xs:element name="Relations" maxOccurs="unbounded">
            <xs:complexType>
               <xs:attribute name="type" type="xs:string" use="required" />
               <xs:sequence>
                  <xs:element ref="Instance" maxOccurs="unbounded" />
               </xs:sequence>
            </xs:complexType>
         </xs:element>
      </xs:sequence>
   </xs:complexType>
   <xs:element name="Instance">
      <xs:complexType>
         <xs:attribute name="ref" type="xs:string" use="required" />
      </xs:complexType>
   </xs:element>
</xs:schema>

Configuration Item XML Element Description
The following table describes the elements that the XML document can contain.

Element Description

NewInstance Represents a discovered CI. Youmust add a ref attribute, whichmust
match the unique CI ID that you specify in theKey element. You can then
use this reference in Instance elements in the current XML document if you
want to create or delete relationships.
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Element Description

DeleteInstance Represents a CI that you want to delete immediately.

The agent automatically deletes previously discovered CIs from the agent
repository if your discovery script runs five times (by default) without
including the CI as aNewInstance in the XML document.

Note: You can control how often the discovery script must run before a
missing CI is automatically deleted by changing the agent parameter
INSTANCE_DELETION_THRESHOLD in the agtrep namespace. However,
if you specify this element, the agent deletes the CI immediately and
publishes the change to the RTSM (Run-time ServiceModel).

NewRelationship Defines a new relationship between CIs. This element must contain
exactly oneParent element and can contain one or moreGenericRelations
elements.

DeleteRelationship Defines relationships that you want to delete. This element must contain
exactly oneParent element and can contain one or moreGenericRelations
elements.

Std Must contain the string DiscoveredElement.

Virtual Include this element if the CI is virtual. A virtual CI is abstract and does not
exist on any node CI. Omit this element if the CI is hosted on a node CI.

Key Contains the full CI ID for this CI, whichmust be unique. Youmust include
this element in all NewInstanceandDeleteInstanceelements. Youmust not
specify aNewInstanceandDeleteInstancewith the same key in the same
XML document.

Attributes Contains Attribute elements.
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Element Description

Attribute Has a name attribute and a value attribute.

Attributes with the following names have a special meaning:

l hpom_citype specifies the CI type as stored in the RTSM (for example,
nt).

The default synchronization package on the BSM server assigns the
context IntegrationAdapter to all CIs that have a hpom_citype
attribute so that they are included for topology synchronization. CIs that
do not have this attribute are filtered out and excluded from topology
synchronization.

l hpom_rootcontainer specifies the full ID of the CI that contains or
hosts this CI. Maps to the CI attribute Container. Creates a
composition relationship.

l Attribute names with the prefix ucmdb_map directly to CI attributes (for
example, ucmdb_primary_dns_namemaps to the CI attribute Primary
DNS Name).

Parent Contains an Instance element, which defines the CI that is the parent of
this relationship.

The parent instance that you specify must exist in the RTSM and in the
agent repository on the BSMConnector server. Therefore, youmay need to
include aNewInstance element to add the parent to the agent repository,
even if the parent already exists in the RTSM.

Instance Has a ref attribute that refers to aNewInstance element in the current XML
document.

GenericRelations Contains one or moreRelations elements.

Relations Has a type attribute that refers to the type of relation as stored in the RTSM
(for example, usage). Contains one or more Instance elements, which refer
to the CIs that are related to the specifiedParent element.

Example Discovery XML
The following example XML creates a node instance with related IP address andMAC address
instances. The IP address instance has a containment relationship and theMAC address has a
composition relationship to the node instance:
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<Service>
   <NewInstance>
      <Std>DiscoveredElement</Std>
      <Key>CBA3A4AC-2EC5-11E0-8071-4876DFD72085</Key>
      <Virtual />
      <Attributes>
         <!-- use nt as CI type attribute -->
         <Attribute name="hpom_citype" value="nt" />
         <!-- use node01 as name attribute -->
         <Attribute name="ucmdb_name" value="node01" />
         <!-- use node01.example.com as primary_dns_name attribute -->
         <Attribute name="ucmdb_primary_dns_name" value="node01.example.com" />
         <!-- use node01.example.com as user_label attribute -->
         <Attribute name="ucmdb_user_label" value="node01.example.com" />
         <!-- use "Windows 2003 R2 64 Bit" as discovered_os_name attribute -->
         <Attribute name="ucmdb_discovered_os_name" value="Windows 2003 R2 64
Bit" />
      </Attributes>
   </NewInstance>
   <NewInstance>
      <Std>DiscoveredElement</Std>
      <Key>E0AD966E-2EC5-11E0-B5C8-4E76DFD72085</Key>
      <Virtual />
      <Attributes>
         <Attribute name="hpom_citype" value="ip_address" />
         <!-- use 192.168.1.3 as name attribute -->
         <Attribute name="ucmdb_name" value="192.168.1.3" />
         <Attribute name="ucmdb_routing_domain" value="DefaultDomain" />
      </Attributes>
   </NewInstance>
   <NewInstance>
      <Std>DiscoveredElement</Std>
      <Key>157C8328-2EC6-11E0-931A-C176DFD72085</Key>
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      <Virtual />
      <Attributes>
         <!-- relation to the MAC address is composition -->
         <!-- this is handled by the attribute hpom_rootcontainer -->
         <Attribute name="hpom_rootcontainer" value="CBA3A4AC-2EC5-11E0-8071-
4876DFD72085" />
         <Attribute name="hpom_citype" value="interface" />
         <Attribute name="ucmdb_name" value="Intel(R) PRO/1000 MT Network
Connection" />
         <Attribute name="ucmdb_mac_address" value="01-23-45-67-89-ab" />
         <Attribute name="ucmdb_interface_description" value="Intel(R) PRO/1000
MT Network Connection" />
         <Attribute name="ucmdb_description" value="Intel(R) PRO/1000 MT Network
Connection" />
      </Attributes>
   </NewInstance>
   <NewRelationship>
   <!-- create relationship of type containment between node (node01) -->
   <!-- and IP address (192.168.1.3) -->
      <Parent>
         <Instance>
               <Key>CBA3A4AC-2EC5-11E0-8071-4876DFD72085</Key>
               <Virtual/>
               <Std>DiscoveredElement</Std>
         </Instance>
      </Parent>
      <GenericRelations>
         <Relations type="containment">
            <Instance>
               <Key>E0AD966E-2EC5-11E0-B5C8-4E76DFD72085</Key>
               <Virtual/>
               <Std>DiscoveredElement</Std>
            </Instance>
         </Relations>
      </GenericRelations>
   </NewRelationship>
</Service>

Tasks

How to configure the command in discovery policies

1. Type the name of your discovery script in theCommand box. For example, you could specify
the command "$ACTION_DIR/custom_discovery.cmd".

$ACTION_DIR represents the folder that contains instrumentation on the BSMConnector
system:

Windows: %OvDataDir%\bin\instrumentation
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Linux: /var/opt/OV/bin/instrumentation

Escape any backslashes (\) with a second backslash (\\).

Tip: Click in the Command box to open the edit assistant. The edit assistant enables
you to insert and remove quotationmarks, and to insert the variables $ACTION_DIR and
$DATA_DIRmore easily.

2. Optional. By default, the HP Operations Agent starts the discovery script under the same
account as the agent is running under, which is Local System or root by default. You can
specify a different user and password if you want the script to run under a different account.

Tip: Themaximum frequency that you can schedule for a discovery policy is hourly. This
frequency may not be convenient when you are developing and testing your policy. However,
after you deploy your policy to a node, you can run the policy on demand using the command
ovagtrep -run <policy name> on the node.

Related tasks

l "How to Discover Topology Data" on page 371

UI Descriptions

For a description of the Command page, see "Command Page (Legacy Discovery Policies)" on
page 459.

Configuring Schedules in Discovery Policies

Use the Schedule tab of the discovery policy editor to specify a discovery schedule for the current
policy. By default, a discovery policy runs the discovery script every Sunday at 00:00.

Tip: You can associate a single schedule only with a discovery policy. To run the same
discovery script according to different schedules, create a policy for each schedule. This
enables you to, for example, run a discovery script Monday to Friday at 15:00, and Saturday
and Sunday at 16:00.

To access
In the BSMConnector user interface, select a discovery policy and click in the toolbar, or
double-click a discovery policy. The discovery policy editor opens. 

Click Schedule.
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Tasks

How to configure the schedule in discovery policies

Indicate when the discovery script should run:

l Days of Week. Specify the day or multiple days of the week that the discovery script should
run.

To specify the day of the week, click the day in theDays of Week display. To select multiple
days, click a day, press Ctrl orShift, and select additional days. A dark-gray bar indicates your
choice.

l Hours of Day. Specify the specific hour or multiple hours of day that the discovery script should
run.

To specify the hour of the day, click the hour in theHours of Day display. To select multiple
hours, click an hour, press Ctrl orShift, and select additional hours. A dark-gray bar indicates
your choice.

l Minute of Hour. Specify theminute or multiple minutes within the hour that the discovery script
should run. Themaximum frequency is once in fiveminutes.

To specify theminute of the hour, click one of the five-minute intervals in theMinute of Day
display. To select multiple intervals, click an interval, press Ctrl orShift, and select additional
intervals. A dark-gray bar indicates your choice.

Tip:

To select multiple times, click the time, press Ctrl orShift, and select additional times.

To select the entire time range, click . To delete a selected time, click .

Your choices are summarized in theSchedule Summary at the bottom of the page.

Related tasks

l "How to Discover Topology Data" on page 371

UI Descriptions

For a description of the Schedule page, see "Schedule Page - Legacy Discovery Policies" on page
501.
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Chapter 16: Web Service Listener Policies
Web service policies enable you to collect data from third-party systems through the BSM
ConnectorWeb service listener. Event, metrics, and topology entry points into BSM are published
for external systems to use.

BSM Connector supplies aWSDL file that can be used to create the client code. The client code
reports the event, metrics, and topology data to BSM Connector. The client has several ways to
report data to BSM Connector:

l report onemetric or an array of metrics

l report data - an array of key value pairs (representing an event, for example)

What Data Is Collected
Web service policies collect data that is extracted from any message received by the BSM
ConnectorWeb service listener. The policies process the data by applying policy defaults and
rules, and then send the data to BSM.

Data can also bemapped to a topology to forward data to the correct CI hierarchy in BSM. You can
configure topology settings for the policy by selecting one of the out-of-the-box scripts, or
configuring your own custom topology script during policy creation.

How to Collect Event Data Through the Web Service
Listener

This task describes how to collect event data and optionally topology data through the BSM
ConnectorWeb service listener.

1. Prerequisite:Make sure your BSM Connector is set up as a BSMConnector integration server
in BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see the BSM online
help or the BSM Application Administration Guide.

2. In the BSMConnector user interface, click in the toolbar. Then click Event > Web
Service Listener.

Alternatively, double-click an existing policy to edit it.

3. In theProperties page, define information that is related to the policy itself (for example, the
name and description of the policy).

For details, see "ConfiguringWeb Service Listener Policy Properties" on page 386.
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4. In theSource page, define the system ID that connects themessages from theWeb service
client with theWeb service listener policy.

For details, see "Configuring the Data Source inWeb Service Listener Policies" on page 387.

5. In theMappings page, configure the default mappings of Web service <key> elements to
custom variables.

For details, see "ConfiguringMappings inWeb Service Listener Policies " on page 396.

6. Optional. In theDefaults page, configure the default settings for all events generated by the
policy (for example, default event correlation settings).

For details, see "Configuring Event Defaults inWeb Service Listener Policies" on page 398.

7. In theRules page, define what the policy should do in response to a specific Web service
message.

For details, see "Configuring Event Rules inWeb Service Listener Policies" on page 403.

8. In theOptions page, configure several policy behaviors (for example, patternmatching
options).

For details, see "Configuring Options inWeb Service Listener Policies" on page 411.

9. In the Topology page, select or create a script that creates a topology in BSM's RTSM that
represents your third-party system.

For details, see "Configuring Topology Scripts inWeb Service Listener Policies" on page 413.

Note: For detailed information on topology scripts, see "Working with Jython-Based
Topology Scripts " on page 180.

10. Click OK to save the policy and close the editor.

11. Optional. If the list of policies does not refresh automatically in the BSMConnector user
interface, click in the toolbar.

How to Collect Metrics Data Through the Web Service
Listener

This task describes how to collect metrics and optionally topology data through the BSMConnector
Web service listener.

Note: For examples and end-to-end workflow information on collectingmetrics data with or
without topology, see "Collecting and ViewingMetrics Data" on page 139. See "Tips and
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Tricks" on page 176 for information on what to do and what to avoid when collectingmetrics.

1. Prerequisite:Make sure your BSM Connector is set up as a BSMConnector integration server
in BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see the BSM online
help or the BSM Application Administration Guide.

2. In the BSMConnector user interface, click in the toolbar. Then click Metrics > Web
Service Listener.

Alternatively, double-click an existing policy to edit it.

3. In theProperties page, define information that is related to the policy itself (for example, the
name and description of the policy).

For details, see "ConfiguringWeb Service Listener Policy Properties" on page 386.

4. In theSource page, define the system ID that connects themessages from theWeb service
client with theWeb service listener policy.

For details, see "Configuring the Data Source inWeb Service Listener Policies" on page 387.

5. Optional. In theDefaults page,assign default values to themetric attributes.

For details, see "ConfiguringMetrics Defaults inWeb Service Listener Policies" on page 400.

6. In theRules page, define what the policy should do in response to a specific metric.

For details, see "ConfiguringMetrics Rules inWeb Service Listener Policies" on page 407.

7. In the Topology page, select or create a script that creates a topology in BSM's RTSM that
represents your third-party system.

For details, see "Configuring Topology Scripts inWeb Service Listener Policies" on page 413.

Note: For detailed information on topology scripts, see "Working with Jython-Based
Topology Scripts " on page 180.

8. Click OK to save the policy and close the editor.

9. Optional. If the list of policies does not refresh automatically in the BSMConnector user
interface, click in the toolbar.
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How to Collect Topology Data Through the Web Service
Listener

You can have BSMConnector report only the topology sent to the BSMConnectorWeb service
listener.

This task describes how to collect topology data through theWeb service listener.

Note: For detailed information on topology scripts, see "Working with Jython-Based Topology
Scripts " on page 180.

1. Prerequisite:Make sure your BSM Connector is set up as a BSMConnector integration server
in BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see the BSM online
help or the BSM Application Administration Guide.

2. In the BSMConnector user interface, click in the toolbar. Then click Topology > Web
Service Listener.

Alternatively, double-click an existing policy to edit it.

3. In theProperties page, define information that is related to the policy itself (for example, the
name and description of the policy).

For details, see "ConfiguringWeb Service Listener Policy Properties" on the next page.

4. In theSource page, define the system ID that connects themessages from theWeb service
client with theWeb service listener policy.

For details, see "Configuring the Data Source inWeb Service Listener Policies" on page 387.

5. In the Topology page, select or create a script that creates a topology in BSM's RTSM that
represents your third-party system.

For details, see "Configuring Topology Scripts inWeb Service Listener Policies" on page 413.

6. Click OK to save the policy and close the editor.

7. Optional. If the list of policies does not refresh automatically in the BSMConnector user
interface, click in the toolbar.
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Web Service Listener Policy User Interface
Web service listener policies display different pages depending on the type of data they are
integrating and on the policy origin.

Choose the type of data you want to integrate and then complete the following tasks:

Event data (optionally with topology data)

l "ConfiguringWeb Service Listener Policy Properties" below

l "Configuring the Data Source inWeb Service Listener Policies" on the next page

l "ConfiguringMappings inWeb Service Listener Policies " on page 396

l "Configuring Event Defaults inWeb Service Listener Policies" on page 398

l "Configuring Event Rules inWeb Service Listener Policies" on page 403

l "Configuring Options inWeb Service Listener Policies" on page 411

l "Configuring Topology Scripts inWeb Service Listener Policies" on page 413

Metrics data (optionally with topology data)

l "ConfiguringWeb Service Listener Policy Properties" below

l "Configuring the Data Source inWeb Service Listener Policies" on the next page

l "ConfiguringMetrics Defaults inWeb Service Listener Policies" on page 400

l "ConfiguringMetrics Rules inWeb Service Listener Policies" on page 407

l "Configuring Topology Scripts inWeb Service Listener Policies" on page 413

Migrated SiteScope technology integrationmonitors (common and legacy events)

l "ConfiguringWeb Service Listener Policy Properties" below

l "Configuring the Data Source inWeb Service Listener Policies" on the next page

l "Configuring Field Mapping inWeb Service Listener Policies" on page 412

l "Configuring Topology Scripts inWeb Service Listener Policies" on page 413

Configuring Web Service Listener Policy Properties
Every policy has a set of properties that identify and describe the policy. Properties include, for
example, the policy name and a description of what the policy does.
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To access

l In the BSMConnector user interface, click in the toolbar. Then click Event > Web
Service Listener.

l In the BSMConnector user interface, click in the toolbar. Then click Metrics > Web
Service Listener.

l In the BSMConnector user interface, click in the toolbar. Then click Topology > Web
Service Listener.

Alternatively, double-click an existing policy to edit it.

Tasks

How to configure policy properties
In the Properties page, type a name for the policy. You can use spaces in the name. The equal sign
(=) is not allowed.

For more information about the other fields, see "ConfiguringWeb Service Listener Policy
Properties" on the previous page.

Related tasks

l "How to Collect Event Data Through theWeb Service Listener" on page 382

l "How to Collect Metrics Data Through theWeb Service Listener" on page 383

l "How to Collect Topology Data Through theWeb Service Listener" on page 385

UI Descriptions

For a description of the Properties page, see "Properties Page" on page 494.

Configuring the Data Source in Web Service Listener
Policies

The source page of theWeb service listener policy editor enables you to set up the system ID.

To access

l In the BSMConnector user interface, click in the toolbar. Then click Event > Web
Service Listener.

l In the BSMConnector user interface, click in the toolbar. Then click Metrics > Web
Service Listener.
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l In the BSMConnector user interface, click in the toolbar. Then click Topology > Web
Service Listener.

Alternatively, double-click an existing policy to edit it.

Click Source to open the policy Source page.

Learn More

Reporting methods
Choose one of the following reportingmethods depending on the type of data you want to send:

l For events, metrics, or topology: configure the reportData method

Tip: For sendingmetrics data, it is recommended that you use the reportMetricObject and
reportMetricsArraymethods. The reportMetricsArray method enables you to submit
metrics in bulk instead of one by one. This is amore efficient method than the
reportMetricObject method because it involves less network traffic.

You can configure the reportDatamethod while creating your SOAP message to send to BSM
Connector.This method contains a data structure that gets an array of key-value objects (see
DataMessage object below).

Enter the following service request:

<wsdl:message name="reportDataRequest">
<wsdl:part name="systemId" type="xsd:string" />
<wsdl:part name="data" type="impl:ArrayOf_tns1_DataMessage" />

</wsdl:message>

where:

"systemId" is the unique text ID for theWeb service listener policy.

"data" is an array of any data type named DataMessage that contains key and value strings:

<complexType name="DataMessage">
<complexContent>

<extension base="tns1:AbstractMessage">
<sequence>

<element name="key" nillable="true" type="soapenc:string" />
<element name="value" nillable="true" type="soapenc:string" />

</sequence>
</extension>

</complexContent>
</complexType>

The service success response is:
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<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"
      xmlns:xsd="http://www.w3.org/2001/XMLSchema"
      xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
   <soapenv:Body>
      <ns1:reportMetricObjectResponse
      soapenv:encodingStyle="http://schemas.xmlsoap.org/soap/encoding/"
      xmlns:ns1="http://webservice.soa.monitors.sitescope.mercury.com">
         <reportMetricObjectReturn xsi:type="xsd:int">1</reportMetricObjectReturn>
      </ns1:reportMetricObjectResponse>
   </soapenv:Body>
</soapenv:Envelope>

Example - Sending a common event using the reportData request
The questionmarks in the following example represent string values.

Example:

<soapenv:Envelope xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:xsd="http://www.w3.org/2001/XMLSchema"
xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"
xmlns:web="http://webservice.soa.monitors.sitescope.mercury.com"
xmlns:soapenc="http://schemas.xmlsoap.org/soap/encoding/">

<soapenv:Header/>
<soapenv:Body>

<web:reportData soapenv:encodingStyle="http://schemas.xmlsoap.org/soap/encoding/">
<systemId xsi:type="xsd:string">1234</systemId>
<data xsi:type="rep:ArrayOf_tns1_DataMessage" soapenc:arrayType="mes:DataMessage[]"

xmlns:rep="http://localhost:8080/SiteScope/services/reportMonitorData"
xmlns:mes="messages.client.webservice.soa.monitors.sitescope.mercury.com">

<data xsi:type="mes:DataMessage">
<key xsi:type="soapenc:string">Title</key>
<value xsi:type="soapenc:string">?</value>

</data>
<data xsi:type="mes:DataMessage">

<key xsi:type="soapenc:string">Severity</key>
<value xsi:type="soapenc:string">?</value>

</data>
<data xsi:type="mes:DataMessage">

<key xsi:type="soapenc:string">SourceHint</key>
<value xsi:type="soapenc:string">?</value>

</data>
<data xsi:type="mes:DataMessage">

<key xsi:type="soapenc:string">CiHint</key>
<value xsi:type="soapenc:string">?</value>

</data>
<data xsi:type="mes:DataMessage">

<key xsi:type="soapenc:string">EtiHint</key>
<value xsi:type="soapenc:string">?</value>

</data>
<data xsi:type="mes:DataMessage">

<key xsi:type="soapenc:string">ComponentCi</key>
<value xsi:type="soapenc:string">?</value>

</data>
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<data xsi:type="mes:DataMessage">
<key xsi:type="soapenc:string">HostHint</key>
<value xsi:type="soapenc:string">?</value>

</data>
<data xsi:type="mes:DataMessage">

<key xsi:type="soapenc:string">Description</key>
<value xsi:type="soapenc:string">?</value>

</data>
<data xsi:type="mes:DataMessage">

<key xsi:type="soapenc:string">Category</key>
<value xsi:type="soapenc:string">?</value>

</data>
<data xsi:type="mes:DataMessage">

<key xsi:type="soapenc:string">SubCategory</key>
<value xsi:type="soapenc:string">?</value>

</data>
<data xsi:type="mes:DataMessage">

<key xsi:type="soapenc:string">Key</key>
<value xsi:type="soapenc:string">?</value>

</data>
<data xsi:type="mes:DataMessage">

<key xsi:type="soapenc:string">CloseKey</key>
<value xsi:type="soapenc:string">?</value>

</data>
<data xsi:type="mes:DataMessage">

<key xsi:type="soapenc:string">LogOnly</key>
<value xsi:type="soapenc:string">?</value>

</data>
</data>

</web:reportData>
</soapenv:Body>

</soapenv:Envelope>

l For metrics: configure the reportMetricObject method
Use the reportMetricObjectmethod to submit a single metric. If you want to submit metrics in
bulk, use the reportMetricsArraymethod.

Enter the following service request:

<wsdl:message name="reportMetricObjectRequest">
<wsdl:part name="metric" type="tns1:MetricMessage" />

</wsdl:message>

where:

"metric" is ametric of the type MetricMessage, which contains various value strings:

<complexType name="MetricMessage">
<complexContent>

<extension base="tns1:AbstractMessage">
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<sequence>
<element name="measurementName" nillable="true" type="soapenc:string" />
<element name="measurementValue" nillable="true" type="soapenc:double" />
<element name="monitorName" nillable="true" type="soapenc:string" />
<element name="monitorState" nillable="true" type="soapenc:string" />
<element name="monitorType" nillable="true" type="soapenc:string" />
<element name="quality" nillable="true" type="soapenc:int" />
<element name="measurementETI" nillable="true" type="soapenc:string" />
<element name="measurementCIHint" nillable="true" type="soapenc:string" />

</sequence>
</extension>

</complexContent>
</complexType>

The service success response is:

<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"
      xmlns:xsd="http://www.w3.org/2001/XMLSchema"
      xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
   <soapenv:Body>
      <ns1:reportMetricObjectResponse

 soapenv:encodingStyle="http://schemas.xmlsoap.org/soap/encoding/"
xmlns:ns1="http://webservice.soa.monitors.sitescope.mercury.com">

         <reportMetricObjectReturn xsi:type="xsd:int">1</reportMetricObjectReturn>
      </ns1:reportMetricObjectResponse>
   </soapenv:Body>
</soapenv:Envelope>

Example - Sending a metric using the reportMetricObject request
The questionmarks in the following example represent string values as follows:

n xsd:double is a double value

n xsd:int is an integer value

n xsd:string is a string value

Example:

<soapenv:Envelope xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
       xmlns:xsd="http://www.w3.org/2001/XMLSchema"
       xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"
       xmlns:web="http://webservice.soa.monitors.sitescope.mercury.com">
<soapenv:Header/>
<soapenv:Body>
  <web:reportMetricObject
soapenv:encodingStyle="http://schemas.xmlsoap.org/soap/encoding/">
    <metric xsi:type="mes:MetricMessage"
    xmlns:mes="messages.client.webservice.soa.monitors.sitescope.mercury.com">
      <sourceTimeStamp xsi:type="xsd:double">?</sourceTimeStamp>
      <targetName xsi:type="xsd:string">?</targetName>
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      <timeStamp xsi:type="xsd:double">?</timeStamp>
      <uniqueSystemId xsi:type="xsd:string">1234</uniqueSystemId>
      <measurementCIHint xsi:type="xsd:string">/</measurementCIHint>
      <measurementETI xsi:type="xsd:string">?</measurementETI>
      <measurementName xsi:type="xsd:string">/</measurementName>
      <measurementValue xsi:type="xsd:double">?</measurementValue>
      <monitorName xsi:type="xsd:string">?</monitorName>
      <monitorState xsi:type="xsd:string">?</monitorState>
      <monitorType xsi:type="xsd:string">?</monitorType>
      <quality xsi:type="xsd:int">?</quality>
    </metric>
  </web:reportMetricObject>
</soapenv:Body>
</soapenv:Envelope>

l For metrics arrays: configure the reportMetricsArray method
The reportMetricsArraymethod enables you to submit metrics in bulk instead of one by one.
This is amore efficient method than the reportMetricObjectmethod because it involves less
network traffic.

However, although you can submit multiple metrics in oneWeb service request, the policy rules
evaluate themetrics individually and not as a whole. For example, if you submit an array of three
metrics, the policy rules will be applied three times, not just once.

Enter the following service request:

<wsdl:message name="reportMetricsArrayRequest">
  <wsdl:part name="metrics" type="impl:ArrayOf_xsd_anyType"/>
</wsdl:message>

where:

"metrics" is an array of metrics of the type ArrayOf_xsd_anyType, which contains various value
strings:

<complexType name="ArrayOf_xsd_anyType">
  <complexContent>
    <restriction base="soapenc:Array">
      <attribute ref="soapenc:arrayType" wsdl:arrayType="xsd:anyType[]"/>
    </restriction>
   </complexContent>
</complexType>

The element <sourceTimeStamp>must have the same value for eachmetric in the array. The
source timestamp is a time number (the number of seconds that have elapsed since January 1,
1970 at 00:00:00 GMT (1970-01-01 00:00:00 GMT)), and represents the time at which themetric
sample is sent. When BSMConnector receives the service request, it compares themetric
sample time with its local time and adjusts the sample time accordingly; that is, BSM Connector
calculates the time difference to the third-party system and increases or decreases the sample
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time accordingly. If you do not want BSM Connector to adjust the sample time, set the element
<sourceTimeStamp> to zero (0) for all metrics in the array.

The service success response is:

<soapenv:Envelope
     xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"
     xmlns:xsd="http://www.w3.org/2001/XMLSchema"
     xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
   <soapenv:Body>
      <ns1:reportMetricsArrayResponse

soapenv:encodingStyle="http://schemas.xmlsoap.org/soap/encoding/"
xmlns:ns1="http://webservice.soa.monitors.sitescope.mercury.com">

         <reportMetricsArrayReturn xsi:type="xsd:int">1</reportMetricsArrayReturn>
      </ns1:reportMetricsArrayResponse>
   </soapenv:Body>
</soapenv:Envelope>

Example - Sending an array of metrics using the reportMetricsArray
request
The questionmarks in the following example represent string values as follows:

n xsd:double is a double value

n xsd:int is an integer value

n xsd:string is a string value

Example:

<soapenv:Envelope xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
       xmlns:xsd="http://www.w3.org/2001/XMLSchema"
       xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"
       xmlns:web="http://webservice.soa.monitors.sitescope.mercury.com"
       xmlns:soapenc="http://schemas.xmlsoap.org/soap/encoding/">
<soapenv:Header/>
<soapenv:Body>
  <web:reportMetricsArray
soapenv:encodingStyle="http://schemas.xmlsoap.org/soap/encoding/">
    <metrics xsi:type="rep:ArrayOf_xsd_MetricMessage"
    soapenc:arrayType="mes:MetricMessage[]">
      <metric xsi:type="mes:MetricMessage"
      xmlns:mes="messages.client.webservice.soa.monitors.sitescope.mercury.com">
        <sourceTimeStamp xsi:type="xsd:double">?</sourceTimeStamp>
        <targetName xsi:type="xsd:string">?</targetName>
        <timeStamp xsi:type="xsd:double">?</timeStamp>
        <uniqueSystemId xsi:type="xsd:string">1234</uniqueSystemId>
        <measurementCIHint xsi:type="xsd:string">/</measurementCIHint>
        <measurementETI xsi:type="xsd:string">?</measurementETI>
        <measurementName xsi:type="xsd:string">/</measurementName>
        <measurementValue xsi:type="xsd:double">?</measurementValue>
        <monitorName xsi:type="xsd:string">?</monitorName>
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        <monitorState xsi:type="xsd:string">?</monitorState>
        <monitorType xsi:type="xsd:string">?</monitorType>
        <quality xsi:type="xsd:int">?</quality>
      </metric>
      <metric xsi:type="mes:MetricMessage"
      xmlns:mes="messages.client.webservice.soa.monitors.sitescope.mercury.com">
        <sourceTimeStamp xsi:type="xsd:double">?</sourceTimeStamp>
        <targetName xsi:type="xsd:string">?</targetName>
        <timeStamp xsi:type="xsd:double">?</timeStamp>
        <uniqueSystemId xsi:type="xsd:string">1234</uniqueSystemId>
        <measurementCIHint xsi:type="xsd:string">/</measurementCIHint>
        <measurementETI xsi:type="xsd:string">?</measurementETI>
        <measurementName xsi:type="xsd:string">/</measurementName>
        <measurementValue xsi:type="xsd:double">?</measurementValue>
        <monitorName xsi:type="xsd:string">?</monitorName>
        <monitorState xsi:type="xsd:string">?</monitorState>
        <monitorType xsi:type="xsd:string">?</monitorType>
        <quality xsi:type="xsd:int">?</quality>
      </metric>
    </metrics>
  </web:reportMetricsArray>
</soapenv:Body>
</soapenv:Envelope>

Tasks

This section includes:

l "How to configure the connection to theWeb service listener" below

l "Event integration only: How to load sample data into the policy" on the next page

How to configure the connection to the Web service listener
This task describes how configure the connection between the policy and theWeb service listener.

1. Enable the connection to the BSM Connector reportMonitorData Web
service listener
To enable the connection to the BSMConnector reportMonitorDataWeb service listener,
youmust create a client code (in any language) that makes the connection and handles the
reporting of the data to BSM Connector through theWeb service listener.

a. Open aWeb browser and go to BSM Connector (https://<BSM Connector
host>:30000/bsmconnector/services).

Take theWSDL file of the service reportMonitorData. TheWSDL is an interface file
which represents the API of the reportMonitorDataWeb service listener in BSM
Connector. The reportMonitorData service is the service that listens to incoming
messages and forwards them to BSM. This file is used to create the client stubs that
connect to the service and report the data.
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b. Generate the stubs using theWSDL file. The generation of the stubs can be to any
language. The way to create the files depends on the language that you want to use.

For example, if you want to use Java as the client code, youmust use theWSDL2JAVA
task in AXIS package that can be downloaded from theirWeb site. Run Java
org.apache.axis.wsdl.WSDL2Java <name of saved WSDL file>. After running this,
you get two packages. One package is com, which holds the needed objects for sending
the data, and the second is localhost, which holds the stubs that makes the connection to
BSM ConnectorWeb service listener.

c. Write the actual client code which uses the generated classes to send the data to BSM
Connector. In the code, call the setreportMonitorDataEndpointAddress(<BSM
Connector targetHost>), which is found inMonitorDataAcceptorServiceLocator (one of
the generated stubs) to set the BSMConnector address to where you want the data
reported.

2. Configure the reportingmethod. Depending on the type of data you want to send (events,
metrics, or topology), choose the appropriate reportingmethod. For more information on
reportingmethods, see "Reportingmethods" on page 388.

3. Type the system ID in the Source page.

Event integration only: How to load sample data into the policy

1. Complete the Source page in theWeb service listener policy, and save it.

Then activate the policy by selecting it in the BSMConnector user interface and clicking in
the toolbar.

2. Run yourWeb service client and send SOAP messages for the policy to theWeb service
listener.

3. Edit the policy by selecting it and clicking in the toolbar. Navigate to the Source page.

4. Click to retrieve the key-value pairs from the SOAP messages. The results are displayed in
the Sample Data tabs of the policy.

Related tasks

l "How to Collect Event Data Through theWeb Service Listener" on page 382

l "How to Collect Metrics Data Through theWeb Service Listener" on page 383

l "How to Collect Topology Data Through theWeb Service Listener" on page 385

UI Descriptions

For a description of the Source page, see "Source Page -Web Service Listener Policies" on page
508.
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Configuring Mappings in Web Service Listener Policies
TheMappings page enables you tomap key and value strings contained inWeb service requests to
custom variables.

To access
In the BSMConnector user interface, click in the toolbar. Then click Event > Web Service
Listener.

Alternatively, double-click an existing policy to edit it.

Click Mappings to open the policy Mappings page.

Learn More

Mappings overview
A custom variable consists of amap name, an optional <key> element from the reportData request
(that is, the SOAP message sent to theWeb service listener), and one or more source and target
value pairs. For example, you can assign the <key> value
<$DATA:/BSMConnectorEvent/Severity> to themap name mapSeverity, and add a source value
of Serious. You can then assign the target value critical to the variable so that BSM Connector
inserts the value critical into the event in all places where the variable is used and the source
value is Serious in the SOAP message.

<key> elements use the following syntax: <$DATA:/BSMConnectorEvent/<key>>

<key> is the string assigned to the <key> element in the SOAP message (for example, <key
xsi:type="soapenc:string">Severity</key>)

For example, the custom variable mapSeverity has the SOAP message key Severity assigned.

Assigning a SOAP message key to amap name is optional. If you do not assign a SOAP message
key to a variable, youmust add the source value directly to the variable when you insert the variable
in an event attribute.

The Sample Data tab is empty if no sample data has been loaded into the policy or if no SOAP
messages have been received for the policy.

The Key tab shows the following information, if sample data is available:

l Keys

If sample data is available, then the Key section shows all SOAP message keys received by the
Web service listener for the specified system ID.
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You can sort the information that appears in the Keys section so that data appears in either
ascending or descending order, indicated by either an up or down arrow at the top of the list. The
items in the Keys section are by default sorted alphabetically in ascending order. To change the
sort order, click the arrow at the top of the list.

l Values

The Values section displays the values of a key selected in the Keys section. If a value appears
more than once, click to show or hide duplicate values. To find values that belong tomore
than one key, select the value and click . The Key Sample Data window opens and shows all
keys that have the selected value.

When you drag a key from the keys list and drop it on the Default ValueMapping List, BSM
Connector automatically adds the default prefix map to themap name and inserts the key. You can
then drag one or moreWeb service source values from the values list and drop them on the Source
Value list. You then finally only have to type the target values.

Tasks

How to configure mappings for Web service request <key> elements
This task describes how tomap <key> elements to custom variables.

1. Create one or more custom variables.

Click above theMapName column and type the variable name in themap name field. Keys
are optional. If you do not assign a key to a variable, youmust add the source value directly to
the variable when you insert the variable in an event attribute.

2. Add one or more source and target value pairs to each custom variable.

n If you are working with sample data, drag the value from the Values list to the Source Value
column, and type the target value in the corresponding field.

Alternatively, click above the Source Value column and type the source and target values
in the corresponding fields.

n Optionally, use the Indicators tab to add indicators to the source or target value fields. After
loading the indicators from the connected BSM server, the Indicators tab shows a hierarchy
of configuration item types with the associated health indicators (HIs) and event type
indicators (ETIs).

To insert an indicator in a source or target value field, drag and drop the indicator name (for
example, Normal) or the indicator name and state (for example, HTTPServer:Normal) from
the Indicators tab to the policy. Use theSelect target drop format panel to toggle between
inserting indicator names only and inserting indicator names and states.
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Related tasks

l "How to Collect Event Data Through theWeb Service Listener" on page 382

UI Descriptions

For a description of theMappings page, see the following sections:

l "Mappings Page (Events Only)" on page 482

l "Sample Data Tab -Web Service Listener Policies" on page 499

l "Indicators Tab" on page 481

Configuring Event Defaults in Web Service Listener
Policies

The Events page enables you to indicate default settings for all events generated by the policy.

These defaults affect all new and existing rules. You can override the defaults in individual rules if
needed. If a rule contains empty event attributes, the agent will use the defaults for the new event.

To access
In the BSMConnector user interface, click in the toolbar. Then click Event > Web Service
Listener.

Alternatively, double-click an existing policy to edit it.

Click Defaults to open the policy Default Event Attributes page.

Tasks

How to configure event defaults for Web service listener policies
This task describes how to configure default settings for all events generated by the policy.

1. Click Event Attributes to define default event attributes, such as severity and category.

Tip: After loading the indicators from the connected BSM server, the Indicators tab shows
a hierarchy of configuration item types with the associated health indicators (HIs) and
event type indicators (ETIs).

To insert an indicator, drag and drop the indicator, indicator state, or both from the
Indicators tab to the policy. Use theSelect target drop format panel to toggle between
inserting indicator names only and inserting indicator names and states.

2. Click Event Correlation to set the type of duplicate event suppression and define themethod
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used to suppress duplicate events.

3. Click Custom Attributesto add additional information to all events generated by this policy.
For example, youmight add a company name, contact information, or a city location to an
event.

4. Click Advanced to define default advanced attributes such as legacy HPOM attributes and
agent MSI (Message Stream Interface) settings.

5. Optionally, use theSample Data tab to drag keys and values to the policy fields. Alternatively,
you can type the path to the key directly into the attribute box.

<key> elements use the following syntax: <$DATA:/BSMConnectorEvent/<key>>

<key> is the string assigned to the <key> element in the SOAP message (for example, <key
xsi:type="soapenc:string">Severity</key>)

BSM Connector replaces the key at runtime with the value of the specified key. If you insert a
key value, the value will be used.

Note:

n The sample data includes a key-value pair that represents the default routing domain
configured for the BSMConnector server in BSM underAdmin > Integrations > BSM
Connector Integrations. The default routing domain name is DefaultDomain.

Youmay insert the default routing domain name in CI-related fields of the policy to help
BSM distinguish different routing domains.

n The Sample Data tab is empty if no sample data has been loaded into the policy or if no
SOAP messages have been received for the policy. For information about loading
sample data into aWeb service listener policy, see "Event integration only: How to load
sample data into the policy" on page 395.

6. Optionally, use theMappings tab to addmapping definitions to the attribute boxes.

Mappings are custom variables that you define in theMappings page (see also "Configuring
Mappings inWeb Service Listener Policies " on page 396). To insert a custom variable, you
can drag it from theMappings list and drop it on the event attribute.

Alternatively, type the custom variable into the attribute box using the following syntax:

<$MAP(<custom_variable>)> where <custom_variable> is themap name of the variable (for
example, <$MAP(Severity)>).

If the custom variable does not have a SOAP message key assigned, use the following
syntax:
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<$MAP(<custom_variable>,<<source_value>>) where <source_value> can be one of the
following:

n Name of the SOAP message key, for example <$MAP(Severity)>,
<$DATA:/BSMConnectorEvent/Severity>

n The source value itself, for example <$MAP(Severity)>,critical)>

7. Optionally, use thePolicy Variables tab to add policy variables to event attributes. BSM
Connector replaces the variables with the appropriate values in the generated event.

It is often useful to surround the variable with quotationmarks, especially if it may return a
value that contains spaces, for example "<$MSG_NODE>".

Related tasks

l "How to Collect Event Data Through theWeb Service Listener" on page 382

UI Descriptions

For a description of the Defaults page, see the following sections:

l "Event Attributes Tab" on page 459

l "Event Correlation Tab" on page 465

l "Custom Attributes Tab" on page 469

l "Advanced Tab" on page 470

l "Sample Data Tab -Web Service Listener Policies" on page 499

l "Mappings Tab (Events Only)" on page 483

l "Indicators Tab" on page 481

l "Policy Variables Tab (Events Only)" on page 491

Configuring Metrics Defaults in Web Service Listener
Policies

The Default Monitor Attributes page enables you to assign default values to themetric attributes.
The values can be used when defining the policy rules on the Rules tab, and can also be overridden
there.

Note: For examples and end-to-end workflow information on collectingmetrics data with or
without topology, see "Collecting and ViewingMetrics Data" on page 139. See "Tips and
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Tricks" on page 176 for information on what to do and what to avoid when collectingmetrics.

To access
In the BSMConnector user interface, click in the toolbar. Then click Metrics > Web Service
Listener.

Alternatively, double-click an existing policy to edit it.

Click Defaults to open the policy Default Monitor Attributes page.

Learn More

This section includes:

l "Metrics attributes" below

l "Parameters for metrics policies" on the next page

Metrics attributes
Each time ametrics policy runs, it extracts raw data from its defined data source and builds a
metric structure, which it then forwards to BSM.

A metric structure consists of these attributes:

l Attributes related to themetrics source, category, or status:

n Monitor name

n Monitor type

n Target

n Time stamp

n Quality

n Monitor state

l Attributes related to a specific metric in the source:

n Name

n Value

n CI hint

n Indicator name
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Parameters for metrics policies
The reportMetricObject and reportMetricsArraymethods send the following keys, which you can
reference in ametrics integration policy as $key. For example, if you insert $MonitorName in the
Monitor Name field, the policy replaces $MonitorNamewith themonitor name from the SOAP
message before sending themetric to BSM.

Key from SOAP Message Policy Parameter

monitorName $MonitorName

monitorType $MonitorType

targetName $TargetName

timeStamp $TimeStamp

quality $Quality

monitorState $MonitorState

measurementName $MeasurementName

measurementValue $Value

measurementCIHint $MeasurementCIHint

measurementETI $MeasurementETI

Tasks

How to configure metrics defaults for Web service listener policies
This task describes how to configuremetric attribute defaults for all metrics collected by this policy.

1. Define the default metric attributes common to all metrics collected by this policy, such as
monitor name, type, and state.

Tip: The Policy Constants tab lists the available constants representingmetrics quality
(status) that are available in BSM Connector. Use drag and drop to add them to the
Quality attribute.

2. InMetrics, click to add attributes specific to a single metric.

Alternatively, expand an existingmetric group to edit it.

Tip: After loading the indicators from the connected BSM server, the Indicators tab shows
a hierarchy of configuration item types with the associated health indicators (HIs) and
event type indicators (ETIs).
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To insert an indicator, drag and drop the indicator from the Indicators tab to the policy.
BSM Connector inserts the indicator name.

3. Optionally, use theOperations tab to apply operations to themetric attribute values.

Tip:

You can insert keys directly into the boxes using the $<key> syntax.

<key> is the string assigned to the <key> element in the SOAP message (for example, <key
xsi:type="soapenc:string">Severity</key>)

BSM Connector replaces the key at runtime with the value of the specified key. If you insert a
key value, the value will be used.

Related tasks

l "How to Collect Metrics Data Through theWeb Service Listener" on page 383

l "How to Collect Metrics with Computer - Monitor Topology" on page 142

l "How to Collect Metrics with Custom, Computer, or Computer - Running Software Topology
Data" on page 147

l "How to Collect Metrics Without Reporting Topology" on page 160

UI Descriptions

For a description of the Defaults page, see the following sections:

l "Default Monitor Attributes and Attributes Tabs" on page 478

l "Indicators Tab" on page 481

l "Operations Tab (Metrics Only)" on page 483

l "Policy Constants Tab (Metrics Only)" on page 491

Configuring Event Rules in Web Service Listener Policies
Rules define what a policy should do in response to a specific type of event. Each rule consists of a
condition and of settings for the event generated by the policy. The condition is the part of a policy
that describes the source. The settings enable you to configure the event that BSM Connector
sends to BSM.

A policy must contain at least one rule. If the policy contains multiple rules, it is important to
remember that the rules are evaluated in a specific order, and that when one condition is matched,
no additional rules will be evaluated.
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To access

l In the BSMConnector user interface, click in the toolbar. Then click Event > Web
Service Listener.

l In the BSMConnector user interface, click in the toolbar. Then click Metrics > Web
Service Listener.

Alternatively, double-click an existing policy to edit it.

Click Rules to open the policy Rules page.

Learn More

Rule types
The rule types are:

l Event on matched rule. If matched, BSM Connector sends an event to BSM. The event uses
the settings defined for the rule. If you do not configure these settings, the default settings are
used.

l Suppress on matched rule. If matched, BSM Connector stops processing and does not send
an event to BSM.

l Suppress on unmatched rule. If not matched, BSM Connector stops processing and does not
send an event to BSM.

Tasks

How to configure rules in Web service listener policies
This task describes how configure policy rules.

1. In thePolicy Rules section, click and select the type of rule to define what the policy
should do in response to a specific Web servicemessage. Each policy must have at least one
rule.

2. In theRule Content section, use theCondition tab to specify the keys and values that the
policy searches for in the SOAP message that the policy evaluates. If the policy finds amatch,
it may or may not generate an event, depending on the rule type.

a. Click to create a new condition. New conditions by default use the equals operator.

b. Click to expand the new condition.

c. In theProperty field, specify the <key> that the policy searches for. Youmust prefix the
<key> with /BSMConnectorEvent/ (for example, /BSMConnectorEvent/Severity).

d. Select the pattern operator.
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If you select thematches operator, you can type a pattern in the Operand field. For a list of
available operators, see "Configuring Event Rules inWeb Service Listener Policies" on
page 403.

e. In theOperand field, type the value or pattern that you want the policy to compare with the
<key>.

Tip: You can use standard BSM Connector pattern-matching rules whenmatching
values. Select thematches operator and click in the Operand field to open the
patternmatching expression toolbox. The toolbox displays the following:

o Pattern Matching Expressions. Click an expression to insert it in the Operand
field.

o Variable Bindings Options. Variable bindings options include case sensitivity
and field separators for the rule. If you do not specify patternmatching options for
the rule, either the defaults (case sensitive; a blank and the tab character as
separators) or the default options set for the policy will be used. See also
"Configuring Options inWeb Service Listener Policies" on page 411.

3. Use theEvent Attributes tab to define event attributes (for example, event title and
description) for all events generated by this rule.

Tip: After loading the indicators from the connected BSM server, the Indicators tab shows
a hierarchy of configuration item types with the associated health indicators (HIs) and
event type indicators (ETIs).

To insert an indicator, drag and drop the indicator, indicator state, or both from the
Indicators tab to the policy. Use theSelect target drop format panel to toggle between
inserting indicator names only and inserting indicator names and states.

4. Use theEvent Correlation tab to set the type of duplicate event suppression and define the
method used to suppress duplicate events.

5. Use theCustom Attributes tab to add additional information to all events generated by this
rule. For example, youmight add a company name, contact information, or a city location to an
event.

6. Use theAdvanced tab to define an event drill-downURL, legacy HPOM attributes, and agent
MSI (Message Stream Interface) settings.

7. Optionally, use theSample Data tab to drag keys and values to the policy fields. Alternatively,
you can type the path to the key directly into the attribute box.

<key> elements use the following syntax: <$DATA:/BSMConnectorEvent/<key>>
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<key> is the string assigned to the <key> element in the SOAP message (for example, <key
xsi:type="soapenc:string">Severity</key>)

BSM Connector replaces the key at runtime with the value of the specified key. If you insert a
key value, the value will be used.

Note:

n The sample data includes a key-value pair that represents the default routing domain
configured for the BSMConnector server in BSM underAdmin > Integrations > BSM
Connector Integrations. The default routing domain name is DefaultDomain.

Youmay insert the default routing domain name in CI-related fields of the policy to help
BSM distinguish different routing domains.

n The Sample Data tab is empty if no sample data has been loaded into the policy or if no
SOAP messages have been received for the policy. For information about loading
sample data into aWeb service listener policy, see "Event integration only: How to load
sample data into the policy" on page 395.

8. Optionally, use theMappings tab to addmapping definitions to the attribute boxes.

Mappings are custom variables that you define in theMappings page (see also "Configuring
Mappings inWeb Service Listener Policies " on page 396). To insert a custom variable, you
can drag it from theMappings list and drop it on the event attribute.

Alternatively, type the custom variable into the attribute box using the following syntax:

<$MAP(<custom_variable>)> where <custom_variable> is themap name of the variable (for
example, <$MAP(Severity)>).

If the custom variable does not have a SOAP message key assigned, use the following
syntax:

<$MAP(<custom_variable>,<<source_value>>) where <source_value> can be one of the
following:

n Name of the SOAP message key, for example <$MAP(Severity)>,
<$DATA:/BSMConnectorEvent/Severity>

n The source value itself, for example <$MAP(Severity)>,critical)>

9. Optionally, use thePattern Matching Variables tab to add variables created through pattern
matching.

Patternmatching variables insert matched strings that have previously been assigned to
variables. To insert a patternmatching variable, type the variable name enclosed in angle

BSM Connector User Guide
Chapter 16: Web Service Listener Policies

HP Business ServiceManagement (9.23) Page 406 of 521



brackets (for example, <variablename>) or drag and drop it from the PatternMatching
Variables list to the event attribute.

10. Optionally, use thePolicy Variables tab to add policy variables to event attributes. BSM
Connector replaces the variables with the appropriate values in the generated event.

It is often useful to surround the variable with quotationmarks, especially if it may return a
value that contains spaces, for example "<$MSG_NODE>".

Related tasks

l "How to Collect Event Data Through theWeb Service Listener" on page 382

l "How to Collect Metrics Data Through theWeb Service Listener" on page 383

UI Descriptions

For a description of the Rules page, see the following sections:

l "Rules Page - Policy Rules" on page 495

l "Condition Tab - Rules Only" on page 472

l "Event Attributes Tab" on page 459

l "Event Correlation Tab" on page 465

l "Custom Attributes Tab" on page 469

l "Advanced Tab" on page 470

l "Sample Data Tab -Web Service Listener Policies" on page 499

l "Mappings Tab (Events Only)" on page 483

l "PatternMatching Variables Tab (Event Rules Only)" on page 491

l "Indicators Tab" on page 481

l "Policy Variables Tab (Events Only)" on page 491

Configuring Metrics Rules in Web Service Listener
Policies

Rules define what a policy should do in response to a specific type of metric. Each rule consists of
a condition and of settings for themetrics generated by the policy. The condition contains the string
or pattern that must bematched for the rule to apply. The settings enable you to configure the
metrics that BSM Connector sends to BSM.
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If the policy contains multiple rules, it is important to remember that the rules are evaluated in a
specific order, and that when one condition is matched, no additional rules will be evaluated.

Note: For examples and end-to-end workflow information on collectingmetrics data with or
without topology, see "Collecting and ViewingMetrics Data" on page 139. See "Tips and
Tricks" on page 176 for information on what to do and what to avoid when collectingmetrics.

To access
In the BSMConnector user interface, click in the toolbar. Then click Metrics > Web Service
Listener.

Alternatively, double-click an existing policy to edit it.

Click Rules to open the policy Rules page.

Learn More

This section includes:

l "Rule types" below

l "Metrics attributes" below

l "Parameters for metrics policies" on the next page

Rule types
The rule types are:

l Process on matched rule. If matched, BSM Connector sends metrics to BSM. Themetrics
use the settings defined for the rule. If you do not configure these settings, the default settings
are used.

l Suppress on matched rule. If matched, BSM Connector stops processing and does not send
metrics to BSM.

l Suppress on unmatched rule. If not matched, BSM Connector stops processing and does not
sendmetrics to BSM.

Metrics attributes
Each time ametrics policy runs, it extracts raw data from its defined data source and builds a
metric structure, which it then forwards to BSM.

A metric structure consists of these attributes:
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l Attributes related to themetrics source, category, or status:

n Monitor name

n Monitor type

n Target

n Time stamp

n Quality

n Monitor state

l Attributes related to a specific metric in the source:

n Name

n Value

n CI hint

n Indicator name

Parameters for metrics policies
The reportMetricObject and reportMetricsArraymethods send the following keys, which you can
reference in ametrics integration policy as $key. For example, if you insert $MonitorName in the
Monitor Name field, the policy replaces $MonitorNamewith themonitor name from the SOAP
message before sending themetric to BSM.

Key from SOAP Message Policy Parameter

monitorName $MonitorName

monitorType $MonitorType

targetName $TargetName

timeStamp $TimeStamp

quality $Quality

monitorState $MonitorState

measurementName $MeasurementName

measurementValue $Value

measurementCIHint $MeasurementCIHint

measurementETI $MeasurementETI
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Tasks

How to configure rules for metrics in Web service listener policies

1. In thePolicy Rules section, click and select the type of rule to define what the policy
should do in response to a specific string in the table column.

2. In theRule Content section, use theCondition tab to define thematch condition.

Thematch conditionmust be a valid boolean expression. The expression can contain one or
more operations from theOperations tab. The expression can access the contents of the data
that is being processed using the dollar sign ($) notation.

3. Optional. If you are creating a rule of the type 'process onmatched rule', set Attributes for
metrics that you want the policy to send. If default attributes are specified in the Defaults tab,
you use the defaults or you can override them as described below.

The attributes are in two groups: common attributes at the top that apply to all metrics defined
this policy, and attributes specific to eachmetric.

a. Define themetric attributes common to all metrics collected by this policy, such as monitor
name, type, and state.

Tip: The Policy Constants tab lists the available constants representingmetrics
quality (status) that are available in BSM Connector. Use drag and drop to add them to
theQuality attribute.

b. InMetrics, click to add attributes specific to a single metric.

Alternatively, expand an existingmetric group to edit it.

Tip: After loading the indicators from the connected BSM server, the Indicators tab
shows a hierarchy of configuration item types with the associated health indicators
(HIs) and event type indicators (ETIs).

To insert an indicator, drag and drop the indicator from the Indicators tab to the policy.
BSM Connector inserts the indicator name.

You can createmultiple metrics.

Click to expand ametric attribute group

4. Optionally, use theOperations tab to apply operations to themetric attribute values.

Tip:
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You can insert keys directly into the boxes using the $<key> syntax.

<key> is the string assigned to the <key> element in the SOAP message (for example, <key
xsi:type="soapenc:string">Severity</key>)

BSM Connector replaces the key at runtime with the value of the specified key. If you insert a
key value, the value will be used.

Related tasks

l "How to Collect Metrics Data from Log Files" on page 238

l "How to Collect Metrics with Computer - Monitor Topology" on page 142

l "How to Collect Metrics with Custom, Computer, or Computer - Running Software Topology
Data" on page 147

l "How to Collect Metrics Without Reporting Topology" on page 160

UI Descriptions

For a description of the Rules page, see the following sections:

l "Rules Page - Policy Rules" on page 495

l "Condition Tab (Rules Only)" on page 481

l "Default Monitor Attributes and Attributes Tabs" on page 478

l "Indicators Tab" on page 481

l "Operations Tab (Metrics Only)" on page 483

l "Policy Constants Tab (Metrics Only)" on page 491

Configuring Options in Web Service Listener Policies
The options tab enables you to configure several policy behaviors, for example which events are
logged locally, how the policy handles unmatched events, and defaults for patternmatching in
policy rules.

To access
In the BSMConnector user interface, click in the toolbar. Then click Event > Web Service
Listener.

Alternatively, double-click an existing policy to edit it.

Click Options to open the policy Options page.
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Tasks

How to configure options for log file policies
In the Options page, configure which events are logged locally, how the policy handles unmatched
events, and defaults for patternmatching in policy rules.

For more information about the other fields, see "Configuring Options inWeb Service Listener
Policies" on the previous page.

Related tasks

l "How to Collect Event Data Through theWeb Service Listener" on page 382

UI Descriptions

For a description of the Options page, see "Options Page (Events Only)" on page 489.

Configuring Field Mapping in Web Service Listener
Policies

The field mapping page is only available in policies that have beenmigrated from SiteScope
technology integrationmonitors of the data typeCommon Events or Legacy Events. The field
mapping defines the conversion rules from third-party data to the BSM event format.

You can use the field mapping page tomodify andmaintain the event field mapping inmigrated
integrationmonitor policies.

For more information on field mapping, see the SiteScope Help or the the Using SiteScopeGuide.

To access
In the BSMConnector user interface, select amigrated integrationmonitor policy and click in
the toolbar, or double-click an integrationmonitor policy. The integrationmonitor policy editor
opens. 

Click Field Mapping to open the policy Field Mapping page.

Learn More
Legacy and Common Events Data Type
In SiteScope, you can choose the Common Events or Legacy Events data type to integrate events
collected from third-party systems to BSM:

l Common Events Integration. The SiteScope Common Events integration typemakes events
available for use in the following BSM applications:
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n Operations Management

n Service Health

n Service Level Management

l Legacy Events Integration (deprecated). The SiteScope Legacy Events integrationmakes
events available for use in:

n System Availability Management Event Log

n BSM's Service Health

n Trend reports

For more information on common and legacy event integrations, see the SiteScope Help or the the
Using SiteScopeGuide.

Tasks
Related tasks

l "How toMigrate SiteScope Technology IntegrationMonitors" on page 40

UI Descriptions
For a description of the Field Mapping page, see "Field Mapping Page" on page 481.

Configuring Topology Scripts in Web Service Listener
Policies

The topology page enables you to create a topology in BSM's RTSM by selecting an out-of-the-box
script or creating your own custom script.

Note: For detailed information on topology scripts, see "Working with Jython-Based Topology
Scripts " on page 180.

To access

l In the BSMConnector user interface, click in the toolbar. Then click Event > Web
Service Listener.

l In the BSMConnector user interface, click in the toolbar. Then click Metrics > Web
Service Listener.
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l In the BSMConnector user interface, click in the toolbar. Then click Topology > Web
Service Listener.

Alternatively, double-click an existing policy to edit it.

Click Topology to open the policy Topology page.

Learn More
This section includes:

l "Selecting a Topology" below

l "Custom Topology Scripts" on page 416

l "Mandatory Values WhenReporting Topology Only" on page 417

Selecting a Topology
The following topology scripts are available for integrating events, metrics, and topology:

Topology Script
Events
Integration

Metrics
Integration

Topology
Integration

No Topology

Select if you do not want to send any topology
(althoughmetrics and event data is still sent).

yes yes not
available

Computer - Monitor (deprecated)

Creates a topology with a Computer CI connected to a
SiteScope CI with aMonitored By link.

Note:

The Computer - Monitor topology script has been
deprecated. For new metrics integrations, use the
Computer, Computer - Running Software, or a
custom topology script.

The Computer - Monitor topology integration
requires that the names or IP addresses of the
nodes that it adds to the RTSM are accessible
through DNS resolution. To successfully add a
Node CI specified in a policy's Target field to the
RTSM, BSMConnector must be able to resolve
the node's fully qualified domain name and IP
address through a DNS service.

not
available

yes not
available
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Topology Script
Events
Integration

Metrics
Integration

Topology
Integration

Computer

Creates a topology with a Computer CI.

The Computer topology script is not available in
migrated SiteScope technology integrationmonitors.

yes yes yes

Computer - Running Software

Creates a topology with a Computer CI and a Running
Software CI connected to it with aComposition
relationship. The following illustrates the topology
created for the Computer - Running Software
integration type which retrieves data from a third-party
system:

The Computer - Running Software topology script is
not available in migrated SiteScope technology
integrationmonitors.

yes yes yes

Custom

You create your own topology if you want the retrieved
data to be forwarded to specific CIs and not one of the
out-of-the-box topology scripts.

Note: You should only select Custom if you are
familiar with the Jython language, since youmust
create the topology script in Jython yourself.
Depending on the data type you want to collect,
we recommend that you select and edit one of the
out-of-the-box scripts.

yes yes yes

BSMConnector User Guide
Chapter 16: Web Service Listener Policies

HP Business ServiceManagement (9.23) Page 415 of 521



Note: BSMConnector automatically populates theMonitored by attribute of the reported CIs
with the following values when using one of the out-of-the-box topology scripts:

l BSM Connector

l <policy name>where <policy name> is the name of the policy as set in the policy's
Properties page

Custom Topology Scripts
You can choose one of the out-of-the-box topologies which are already configured with the
necessary information, or you can create your own custom topology script.

To create a custom script, use the script editor provided in the Topology page, or use any other
script editor. Following are the guidelines for creating your own topology script:

l For general information on topology scripts, see "Working with Jython-Based Topology Scripts "
on page 180.

l Youmay use the following code to set theMonitored by attribute on the CIs reported by a
custom script:

ems_lib.addMonitoredByForThirdPartySoftware(Framework, <computer>)

l Use the following code to get the routing domain for a Node CI:

domainName = system_lib.getDiscoveryDomainByIP(Framework, <IP or node DNS
name>)

Web service listener policies that integrate events only:

The sample data includes a key-value pair that represents the default routing domain configured
for the BSMConnector server in BSM underAdmin > Integrations > BSM Connector
Integrations. The default routing domain name is DefaultDomain.

Youmay insert the default routing domain name in CI-related fields of the policy to help BSM
distinguish different routing domains.

For more information on the routing domain attribute in RTSM, see the Data Flow Management
Guide.

l You can access values received through theWeb service fromWeb service listener policies.
For example, you can access the value of the key in the SOAP request <key>Host</key in the
following way:

value1 = Framework.getDestinationAttribute(“Host")

BSMConnector User Guide
Chapter 16: Web Service Listener Policies

HP Business ServiceManagement (9.23) Page 416 of 521



Mandatory Values When Reporting Topology Only
The following values aremandatory when reporting only the topology discovered by the BSM
Connector policies, without reporting events or metrics data:

For
Topology
Script

Field
Name Description

l Computer

l Computer -
Running
Software

target_
name

Name of the host or machine that generated the event. This can be
addedmanually or taken from:
Framework.getDestinationAttribute("<someAttribute>")

Examples:

Log file policies: Framework.getDestinationAttribute("group0") where
group0 is the value of the first patternmatching group.

Database policies: Framework.getDestinationAttribute("NAME")
where NAME is the name of a database column.

Web service listener policies: Framework.getDestinationAttribute
(“Host") where HOST is the key in the SOAP request
<key>Host</key>.

l Computer

l Computer -
Running
Software

target_
ip

IP of the host or machine. This can be addedmanually, or calculated
using:
HostIPCachingManager.getIPByHostName(target_name)

where target_name represents a valid host or machine, or you can
use:
HostIPCachingManager.getIPByHostName("<someAttribute>")

Computer -
Running
Software

name Name of Running Software. This can be addedmanually, or taken
from:
Framework.getDestinationAttribute("<someAttribute>")

Tasks
This section includes:

l "How to report topology with event data" below

l "How to report topology with metrics data" on the next page

l "How to report topology without event or metrics data" on page 419

How to report topology with event data

1. In the BSMConnector user interface, click in the toolbar. Then click Event > Web
Service Listener.
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Click Topology to open the policy Topology page.

2. Select a script template and if necessary, click Load Template.

The out-of-the-box topology scripts do not require any changes.

To create a custom script, see "Working with Jython-Based Topology Scripts " on page 180 for
more information.

3. Optionally, use theSample Data tab to drag keys and values to the topology script.
Alternatively, type the key directly into the topology script, for example Severity. In this
example, Severity is the string assigned to the <key> element in the SOAP request: <key
xsi:type="soapenc:string">Severity</key>.

BSM Connector replaces the key at runtime with the value of the specified key. If you insert a
key value, the value will be used.

Note:

n The sample data includes a key-value pair that represents the default routing domain
configured for the BSMConnector server in BSM underAdmin > Integrations > BSM
Connector Integrations. The default routing domain name is DefaultDomain.

Youmay insert the default routing domain name in CI-related fields of the policy to help
BSM distinguish different routing domains.

n The Sample Data tab is empty if no sample data has been loaded into the policy or if no
SOAP messages have been received for the policy. For information about loading
sample data into aWeb service listener policy, see "Event integration only: How to load
sample data into the policy" on page 395.

How to report topology with metrics data

Tip:

You can insert keys directly into the topology script, for example Severity. In this example,
Severity is the string assigned to the <key> element in the SOAP request: <key
xsi:type="soapenc:string">Severity</key>.

BSM Connector replaces the key at runtime with the value of the specified key. If you insert a
key value, the value will be used.

1. In the BSMConnector user interface, click in the toolbar. Then click Metrics > Web
Service Listener.

Click Topology to open the policy Topology page.

2. Select a script template and if necessary, click Load Template.
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The out-of-the-box topology scripts do not require any changes.

To create a custom script, see "Working with Jython-Based Topology Scripts " on page 180 for
more information.

How to report topology without event or metrics data

Tip:

You can insert keys directly into the topology script, for example Severity. In this example,
Severity is the string assigned to the <key> element in the SOAP request: <key
xsi:type="soapenc:string">Severity</key>.

BSM Connector replaces the key at runtime with the value of the specified key. If you insert a
key value, the value will be used.

1. In the BSMConnector user interface, click in the toolbar. Then click Topology > Web
Service Listener.

Click Topology to open the policy Topology page.

2. Select a script template and if necessary, click Load Template.

3. Select a script template and if necessary, click Load Template.

The out-of-the-box topology scripts do not require any changes.

To create a custom script, see "Working with Jython-Based Topology Scripts " on page 180 for
more information.

4. Map the data discovered by the policy to the relevant attributes in the topology script.

For a list of mandatory values, see "Mandatory Values WhenReporting Topology Only" on
page 417.

Note: BSM removes CIs from the RTSM if no topology data has been received for them over a
period of time. To prevent BSM from deleting the CIs that BSM Connector has sent to BSM,
BSMConnector regularly sends a list of active CIs to BSM in addition to the topology data.
Inactive CIs are not sent to the RTSM and aremarked for deletion in the RTSM.

You can configure BSM Connector to always send CIs regardless of whether topology data
has been received for them. This guarantees that CIs reported by BSMConnector are never
deleted automatically from the RTSM. This configuration option is known as always touch
mode and is recommended for BSM Connector topology-only policies that collect data from
incremental data sources such as log files or databases. The first time the policies run, they
collect all CIs from the data source. The next time the policies run, they collect new and
changed CIs only and then forward only the additions and changes to BSM. The always touch
mode ensures that the already existing, unchanged CIs are also reported and are thus not
deleted.
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Formore information, see "Touching of CIs in BSM Connector" on page 192.

Related tasks

l "How to Collect Event Data Through theWeb Service Listener" on page 382

l "How to Collect Metrics Data Through theWeb Service Listener" on page 383

l "How to Collect Topology Data Through theWeb Service Listener" on page 385

UI Descriptions

For a description of the Topology page, see the following sections:

l "Topology Page - Database, Log File, Web Service Listener, and Custom Topology Policies" on
page 514

l "Sample Data Tab -Web Service Listener Policies" on page 499

Troubleshooting Web Service Listener Policies
This section describes troubleshooting and limitations when working withWeb service listener
policies.

This section includes:

l "Debugging errors" below

l "Web service listener policy file rolling" on page 422

l "Checking receivedWeb service requests" on page 423

l "Client test tools" on page 423

l "Metrics troubleshooting" on page 425

l "Topology troubleshooting" on page 426

Debugging errors

l Check for errors in the following files:

<BSM Connector root directory>\logs\error.log

<BSM Connector root directory>\logs\RunMonitor.log

<BSM Connector root directory>\logs\bac_integration\bac_integration.log.
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l You canmodify the level and type of information reported to the log files by changing the log file
settings in the <BSM Connector root
directory>\conf\core\Tools\log4j\PlainJava\log4j.properties file. You can instruct the
loggingmechanism to:

n Report logged information in less or greater detail than is reported by default.

n Log all metrics sent by metrics integration policies to BSM.

n Log all received data from third-party systems.

To modify log settings:

a. Open the log4j.properties file in a text editor.

b. To specify that metrics sent by metrics integration policies to BSM be logged:

i. Locate the following lines in the file:

log4j.category.EmsSamplePrinter=${loglevel}, integration.appender
log4j.additivity.EmsSamplePrinter=false

ii. Change the argument of log4j.category.EmsSamplePrinterfrom ${loglevel} to
DEBUG, as follows:

log4j.category.EmsSamplePrinter=DEBUG, integration.appender

iii. Save the file. It may take a few seconds for the changes to take effect.

The results are logged to the bac_integration.log file.

c. To specify that all received data from third-party systems be logged:

i. Locate the following lines in the file:

log4j.category.EmsEventPrinter=${loglevel}, monitors.appender
log4j.additivity.EmsEventPrinter=false

ii. Change the argument of log4j.category.EmsEventPrinter from ${loglevel} to
DEBUG, as follows:

log4j.category.EmsEventPrinter=DEBUG, monitors.appender

iii. Save the file. It may take a few seconds for the changes to take effect.

The results are logged to theRunMonitor.log file.

Tip: After you have determined the cause of the problem, we recommend that you set log

BSM Connector User Guide
Chapter 16: Web Service Listener Policies

HP Business ServiceManagement (9.23) Page 421 of 521



levels to their default settings so as not to overload the system.

l If metrics are created and sent from BSMConnector, but the data is not seen in BSM Service
Health, Event Log, or SiteScope reports, look in
<BSM root directory>\log\wde\wdeIgnoredSamples.log to make sure themetrics were not
dropped due tomissing fields or values.

l Change the logging level for Service Health to verify that Service Health received the samples.
Open the following file on the Gateway Server machine:
<BSM root directory>\conf\core\tools\log4j\wde\wde.properties

Change the log level parameter to DEBUG in the following lines:

n log4j.category.com.mercury.am.platform.wde.decode.IgnoredSamples
Logger=${loglevel}, IgnoredSamples.appender

n log4j.category.com.mercury.am.platform.wde.publish_SamplePublisher
Samples=${loglevel}, PublishedSamples.appender

Look at the corresponding log files:

n <BSM root directory>\log\wde\wdeIgnoredSamples.log

n <BSM root directory>\log\wde\wdePublishedSamples.log

Web service listener policy file rolling
AWeb service listener event integration policy reads the following XML file:

Windows: %OvDataDir%\tmp\<policyID>.xml

Linux: /var/opt/OV/tmp/<policyID>.xml

The file contains the received SOAP messages in an XML file format that Web service listener
policies can evaluate. The file exists only for policies that integrate events.

To prevent the file from becoming too large, a new version of the file is created when its size
reaches 100000 KB. The original file is renamed and stored as a backup file. By default, up to three
backup files can be created.

Caution:When the XML file rolls, that is, a new version is created, but the policy has not
completed reading all entries, the unread entries are lost and no events are created.

The following defaults are set:

l Maximum file size: 100000 KB

Tip: If not all expected events arrive in BSM, increase themaximum file size to 1000000
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KB.

l Maximum number of backup files: 3

To change the defaults:

1. Open the following file:

<BSM Connector root directory>/groups/master.config

2. Change the following values as required:

_eventRollingMaxFileSizeInKB=100000

_eventRollingMaxBackup=3

3. Restart the BSM Connector server:

Windows: Restart theHP BSM Connector service in theAdministrative Tools > Services.

Linux: Restart the BSM Connector main process, type /opt/HP/BSMConnector/stop followed
by /opt/HP/BSMConnector/start.

Checking received Web service requests
Check the followingWeb service listener XML file for any Web service requests:

Windows: %OvDataDir%\tmp\<policyID>.xml

Linux: /var/opt/OV/tmp/<policyID>.xml

The file contains the received SOAP messages in an XML file format that Web service listener
policies can evaluate. The file exists only for policies that integrate events.

Client test tools
After creating aWeb service listener policy in BSM Connector, you can check connectivity to the
Web service listener by using the client check tools. This tools sendmessages to the BSM
Connector reportMonitorDataWeb service. Themessages can bemetrics or event messages.

The client test tools are located on the BSMConnector server in:

<BSM Connector root directory>/conf/ems/webservice/test_client

After running the tools, access BSM and see if the data that you sent is displayed.

l test_data_client
Use the test_data_client tool to send events or metrics:

Usage: test_data_client.bat|sh sysId=<The Web Server system id>
[host=<BSM Connector host>] [port=<BSM Connector port>]
[isSSL=<false/true>] key1=value1 key2=value2 ...

BSMConnector User Guide
Chapter 16: Web Service Listener Policies

HP Business ServiceManagement (9.23) Page 423 of 521



where:

sysId Required. System ID of the policy that
receives themessages.

Default value: none

host Address of the BSMConnector host that
receives themessages.

Default value: localhost

port Port at which BSMConnector receives the
messages.

Default value: 8080

isSSL Is BSM Connector configured for SSL.

Possible values: true, false

Default value: false

key[n] Required. Key-value pair, for example
key1=value1.

Default value: none

l test_metrics_client
Use the test_metrics_client tool to sendmetrics:

Usage: sysId=<The Web Server system id> [host=<BSM Connector host>]
[port=<BSM Connector port>] [isSSL=<false/true>] metric1..N=Quality=
<QUALITY_GOOD/QUALITY_WARNING/QUALITY_ERROR>||MeasurementCIHint=
<?>||MeasurementETI=<?>||MeasurementName=<?>||MeasurementValue=
<double value>||MonitorName=<?>||MonitorState=<?>||MonitorType=
<?>||TargetName=<?>||SourceTimeStamp=<double value>||TimeStamp=
<double value>)

where:

sysId Required. System ID of the policy that
receives themessages.

Default value: none
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host Address of the BSMConnector host that
receives themessages.

Default value: localhost

port Port at which BSMConnector receives the
messages.

Default value: 8080

isSSL Is BSM Connector configured for SSL.

Possible values: true, false

Default value: false

metricn

Quality Quality in BSM Connector terms. Possible
values are: QUALITY_ERROR, QUALITY_
WARNING, QUALITY_GOOD.

MeasurementCIHint CI resolution hint that is used to identify
monitored CIs and relate metrics to them.

MeasurementETI The display name of the ETI.

MeasurementName Name themetric.

MeasurementValue Value of metric. Must be a double-precision
number.

MonitorName Logical monitor name.

MonitorState Themonitor status.

MonitorType Themonitor type.

TargetName The target of this monitor (such as the name
of host machine).

SourceTimeStamp Source stamp in the seconds since Jan 1st
1970 format. Must be a double-precision
number.

TimeStamp Time stamp in the seconds since Jan 1st
1970 format. Must be a double-precision
number.

Metrics troubleshooting
See "Metrics Troubleshooting" on page 178 for more information on troubleshooting and limitations
when BSMConnector sends metrics to BSM.
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Topology troubleshooting
See "Topology Troubleshooting and Limitations" on page 193 for more information on
troubleshooting and limitations when BSMConnector is enabled to report CIs and CIs relationships
topology to BSM.
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Chapter 17: XML File Policies
XML file policies read values in XML files and respond when the value that you choose appears in
the file. XML file policies are especially suited for integrating events from third-party systems that
can store their event information in XML format.

XML file policies process XML files and send events to BSM when certain conditions apply. You
can define the attributes of the BSM event based on information in the XML file. This enables you to
process events generated by other applications and to convert them to BSM events.

XML file policies process exactly the XML elements and attributes that you define. The XML syntax
is not important to the policy, as long as the event information is embedded in XML elements and
attributes.

Tip: If the application does not store its events in XML files, youmay write a program or script
that extracts the events from wherever they are stored, formats the data using XML syntax,
and generates an XML file with the events. If you have control over the XML elements that are
used in the XML file, choose XML elements and attributes that map to event attributes and
values. This will simplify the policy.

How to Collect Event Data from XML Files
This task describes how to collect event data from XML files.

1. Prerequisite:Make sure your BSM Connector is set up as a BSMConnector integration server
in BSM:

Admin > Integrations > BSM Connector Integrations

For details on configuring a BSMConnector integration server in BSM, see the BSM online
help or the BSM Application Administration Guide.

2. In the BSMConnector user interface, click in the toolbar, then click Event > XML. The
XML file policy editor opens. 

Alternatively, double-click an existing XML file policy to edit it.

3. In theProperties page, define information that is related to the policy itself (for example, the
name and description of the policy).

For details, see "Configuring XML File Policy Properties" on the next page.

4. In theSource page, define the XML file that the policy reads (for example, the path and name
of the XML file).

For details, see "Configuring the Data Source in XML File Policies" on page 429.
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5. In theMappings page, configure the default mappings of XML elements and attributes to
custom variables.

For details, see "ConfiguringMappings in XML File Policies" on page 431.

6. Optional. In theDefaults page, configure the default settings for all events generated by the
policy (for example, default event correlation settings).

For details, see "Configuring Event Defaults in XML File Policies" on page 434.

7. In theRules page, define what the policy should do in response to a specific type of event.

For details, see "Configuring Rules in XML File Policies" on page 436.

8. In theOptions page, configure several policy behaviors (for example, patternmatching
options).

For details, see "Configuring Options in XML File Policies" on page 440.

9. Click OK to save the policy and close the editor.

10. Optional. If the list of policies does not refresh automatically in the BSMConnector user
interface, click in the toolbar.

XML File Policy User Interface
This section includes:

l "Configuring XML File Policy Properties" below

l "Configuring the Data Source in XML File Policies" on the next page

l "ConfiguringMappings in XML File Policies" on page 431

l "Configuring Event Defaults in XML File Policies" on page 434

l "Configuring Rules in XML File Policies" on page 436

l "Configuring Options in XML File Policies" on page 440

Configuring XML File Policy Properties
Every policy has a set of properties that identify and describe the policy. Properties include, for
example, the policy name and a description of what the policy does.

To access
In the BSMConnector user interface, click in the toolbar, then click Event > XML. The XML
file policy editor opens. 

Alternatively, double-click an existing XML file policy to edit it.
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Tasks

How to configure policy properties
In the Properties page, type a name for the policy. You can use spaces in the name. The equal sign
(=) is not allowed.

For more information about the other fields, see "Configuring XML File Policy Properties" on the
previous page.

Related tasks

l "How to Collect Event Data from XML Files" on page 427

UI Descriptions

For a description of the Properties page, see "Properties Page" on page 494.

Configuring the Data Source in XML File Policies
The source page of the XML file policy editor enables you to specify which XML file the policy
reads. You can also set options that configure how the policy reads the file.

To access
In the BSMConnector user interface, click in the toolbar, then click Event > XML. The XML
file policy editor opens. 

Alternatively, double-click an existing XML file policy to edit it.

Click Source to open the policy Source page.

Learn More

Requirements for XML source files
XML files must meet the following criteria so that they can be processed correctly by XML file
policies:

l XML file requirements:

n Use file rolling to create at least two or more XML input files. BSM Connector first reads the
older file before starting to process the younger file. Each file should not be larger than 2GB.

You can use wildcards in the Log File Path / Name field to matchmultiple file names. For
example, to match the XML source file names events.1.xml and events.2.xml, use the
pattern <path>/events<*>.xml in the Log File Path / Name field. For more information on
patternmatching, see "Pattern-Matching Details" on page 443.
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Make sure theClose after reading check box is cleared when using file rolling.

n Make sure the polling interval is shorter than the frequency in which data is written to the file.

l XML format requirements:

n The root element is optional.

n If a root element exists, it must not be closed by an end tag.

n All other XML elements must be complete.

The following example XML begins with the root tag <AllAlerts> and contains two types of
events: performance alerts and availability alerts. If you define the XML elements
<PerformanceAlert> and <AvailabilityAlert> as event tags in the Source tab of XML file
policies, only those events are processed by XML file policies.

Example:

<AllAlerts>
<AvailabilityAlert>

<Title>Host Unreachable</Title>
<Severity>Critical</Severity>
<TimeOccured>02/11/10 03:52:18AM</TimeOccured>
<Object>Host:fish.example.com</Object>

</AvailabilityAlert>
<PerformanceAlert>

<Title>Disk IO rate high</Title>
<Severity>Warning</Severity>
<TimeOccured>02/11/10 04:08:31AM</TimeOccured>
<Object>Disk:disk0:dog.example.com</Object>

</PerformanceAlert>
<AvailabilityAlert>

<Title>Web Application unresponsive</Title>
<Severity>Critical</Severity>
<TimeOccured>02/11/10 05:01:26AM</TimeOccured>
<Object>WebApp:http://employeeportal.intra.example.com</Object>

</AvailabilityAlert>
<PerformanceAlert>

<Title>Phyiscal Read Rate high for Bufferpool BP1</Title>
<Severity>Warning</Severity>
<TimeOccured>02/11/10 08:37:09AM</TimeOccured>
<Object>DB:USRDB:cat.example.com</Object>

</PerformanceAlert>
<PerformanceAlert>

<Title>Phyiscal Read Rate high for Bufferpool BP1</Title>
<Severity>Warning</Severity>
<TimeOccured>02/11/10 08:37:09AM</TimeOccured>
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<Object>DB:USRDB:cat.example.com</Object>
</PerformanceAlert>

Tasks

How to configure the XML source
This task describes how configure the XML source file and how the policy reads it.

1. Type the full path to the XML file on the BSMConnector system.

2. Click to load a sample XML file. You can load a sample file from the BSMConnector
system or from the system where theWeb browser runs.

When you load sample data, BSM Connector replaces already loaded data with the new data.
This does not affect any mappings that are defined based on previously available sample data.

3. Click to create one or more XML event tags. You can create a tagmanually by typing the
XML element. If you are working with sample data, you can create a tag by double-clicking the
XML element in the list.

The XML event tag creates a shortcut to the XML element that you want the policy to process.
An event tag typically identifies an event record in an XML log file. You can definemore than
one event tag. For example, an XML file may contain two types of events:
<PerformanceAlert> and <AvailabilityAlert>. To process both types, define both
elements as event tags.

Related tasks

l "How to Collect Event Data from XML Files" on page 427

UI Descriptions

For a description of the Source page, see "Source Page - XML File Policies" on page 509.

Configuring Mappings in XML File Policies
TheMappings page enables you tomap XML elements and attributes to custom variables.

To access
In the BSMConnector user interface, click in the toolbar, then click Event > XML. The XML
file policy editor opens. 

Alternatively, double-click an existing XML file policy to edit it.

Click Mappings to open the policy Mappings page.
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Learn More

Mappings overview
A custom variable consists of amap name, an optional XML property (XML elements or attributes),
and one or more source and target value pairs. For example, you can assign the XML element
Severity to themap name mapSeverity, and add a source value of Warning. You can then assign
the target value Major to the variable so that BSM Connector inserts the value Major into the event
in all places where the variable is used and the source value is Warning in the XML log file.

XML properties use the following syntax: <$DATA:/<XML_property>>

<XML_property> is the XML path, separated by slashmarks (/), from the XML event tag to the XML
element or attribute.

For example, the custom variable mapSeverity has the following XML property:
<$DATA:/Performance_Alert/Severity>where Severity is a child element of Performance_
Alert.

XML properties are optional. If you do not assign an XML property to a variable, youmust add the
source value directly to the variable when you insert the variable in an event attribute.

Note: The Sample Data tab is empty if no sample data has been loaded into the policy or if the
sample data does not match any specified XML event tags.

The Sample Data tab shows the following information if sample data is available:

l XMLProperties section

If sample data is available, then the XMLProperties section of the Sample Data tab shows all
XML elements and attributes that match an XML event tag. (You can identify attributes based on
the preceding at sign (@).)

The XMLProperties section by default shows the short path to the XML property or value. To
view the full path, click . The full path begins with the XML event tag specified in the Source
tab.

To search for an XML property or value, type the search string in the Search Properties box. The
list changes as you type; only matching items appear.

l The Values section displays the values of an XML property selected in the XMLProperties
section. If a value appears more than once, click to show or hide duplicate values. To find
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values that belong tomore than one XML property, select the value and click . The XML
Sample Data window opens and shows all XML properties that have the selected value.

When you drag an XML element or attribute from the XML properties list and drop it on the Default
ValueMapping List, BSM Connector automatically adds the default prefix map to themap name and
inserts the correct path to the XML property. You can then drag one or more XML source values
from the XML values list and drop them on the Source Value list. You then finally only have to type
the target values.

Tasks

How to configure XML mappings
This task describes how tomap XML elements and attributes to custom variables.

1. Create one or more custom variables.

If you are working with sample data, drag the XML elements or attributes from the XML
Properties list to theMapName column. BSM Connector automatically adds the default prefix
map to themap name and inserts the correct path to the XML property.

Alternatively, click above theMapName column and type the variable name in themap
name field. XML properties are optional. If you do not assign an XML property to a variable, you
must add the source value directly to the variable when you insert the variable in an event
attribute.

2. Add one or more source and target value pairs to each custom variable.

n If you are working with sample data, drag the value from the Values list to the Source Value
column, and type the target value in the corresponding field.

Alternatively, click above the Source Value column and type the source and target values
in the corresponding fields.

n Optionally, use the Indicators tab to add indicators to the source or target value fields. After
loading the indicators from the connected BSM server, the Indicators tab shows a hierarchy
of configuration item types with the associated health indicators (HIs) and event type
indicators (ETIs).

To insert an indicator in a source or target value field, drag and drop the indicator name (for
example, Normal) or the indicator name and state (for example, HTTPServer:Normal) from
the Indicators tab to the policy. Use theSelect target drop format panel to toggle between
inserting indicator names only and inserting indicator names and states.

Related tasks

l "How to Collect Event Data from XML Files" on page 427
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UI Descriptions

For a description of theMappings page, see the following sections:

l "Mappings Page (Events Only)" on page 482

l "Sample Data Tab - XML File Policies" on page 500

l "Indicators Tab" on page 481

Configuring Event Defaults in XML File Policies
The Events page enables you to indicate default settings for all events generated by the policy.

These defaults affect all new and existing rules. You can override the defaults in individual rules if
needed. If a rule contains empty event attributes, the agent will use the defaults for the new event.

To access
In the BSMConnector user interface, click in the toolbar, then click Event > XML. The XML
file policy editor opens. 

Alternatively, double-click an existing XML file policy to edit it.

Click Defaults to open the Default Event Attributes page.

Tasks

How to configure events for XML file policies
This task describes how to configure default settings for all events generated by the policy.

1. Click Event Attributes to define default event attributes, such as severity and category.

Tip: After loading the indicators from the connected BSM server, the Indicators tab shows
a hierarchy of configuration item types with the associated health indicators (HIs) and
event type indicators (ETIs).

To insert an indicator, drag and drop the indicator, indicator state, or both from the
Indicators tab to the policy. Use theSelect target drop format panel to toggle between
inserting indicator names only and inserting indicator names and states.

2. Click Event Correlation to set the type of duplicate event suppression and define themethod
used to suppress duplicate events.

3. Click Custom Attributesto add additional information to all events generated by this policy.
For example, youmight add a company name, contact information, or a city location to an
event.
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4. Click Advanced to define default advanced attributes such as legacy HPOM attributes and
agent MSI (Message Stream Interface) settings.

5. Use theSample Data tab to drag XML properties (XML elements and attributes) and values to
the attribute boxes. Alternatively, you can type the path to the XML property or value directly
into the attribute box.

XML properties use the following syntax: <$DATA:/<XML_property>>

<XML_property> is the XML path, separated by slashmarks (/), from the XML event tag to the
XML element or attribute.

BSM Connector replaces the XML property at runtime with the value of the specified XML
element or attribute. If you insert an XML value, the value will be used.

6. Use theMappings tab to addmapping definitions to the attribute boxes.

Mappings are custom variables that you define in themappings tab (see also "Configuring
Event Defaults in XML File Policies" on the previous page). To insert a custom variable, you
can drag it from theMappings list and drop it on the event attribute.

Alternatively, type the custom variable into the attribute box using the following syntax:

<$MAP(<custom_variable>)> where <custom_variable> is themap name of the variable (for
example, <$MAP(map@Severity)>).

If the custom variable does not have an XML property assigned, use the following syntax:

<$MAP(<custom_variable>,<<source_value>>) where <source_value> can be one of the
following:

n XML path to the source value, for example <$MAP(map@Severity, <$DATA/Performance_
Alert/Severity>)>

n The source value itself, for example <$MAP(map@Severity, Warning)>

7. Optionally, use thePolicy Variables tab to add policy variables to event attributes. BSM
Connector replaces the variables with the appropriate values in the generated event.

It is often useful to surround the variable with quotationmarks, especially if it may return a
value that contains spaces, for example "<$MSG_NODE>".

Related tasks

l "How to Collect Event Data from XML Files" on page 427

UI Descriptions

For a description of the Defaults page, see the following sections:
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l "Event Attributes Tab" on page 459

l "Event Correlation Tab" on page 465

l "Custom Attributes Tab" on page 469

l "Advanced Tab" on page 470

l "Sample Data Tab - XML File Policies" on page 500

l "Mappings Tab (Events Only)" on page 483

l "Indicators Tab" on page 481

l "Policy Variables Tab (Events Only)" on page 491

Configuring Rules in XML File Policies
Rules define what a policy should do in response to a specific type of event. Each rule consists of a
condition and of settings for the event generated by the policy. The condition is the part of a policy
that describes the source. The settings enable you to configure the event that BSM Connector
sends to BSM.

A policy must contain at least one rule. If the policy contains multiple rules, it is important to
remember that the rules are evaluated in a specific order, and that when one condition is matched,
no additional rules will be evaluated.

To access
In the BSMConnector user interface, click in the toolbar, then click Event > XML. The XML
file policy editor opens. 

Alternatively, double-click an existing XML file policy to edit it.

Click Rules to open the policy Rules page.

Learn More

Rule types
The rule types are:

l Event on matched rule. If matched, BSM Connector sends an event to BSM. The event uses
the settings defined for the rule. If you do not configure these settings, the default settings are
used.

l Suppress on matched rule. If matched, BSM Connector stops processing and does not send
an event to BSM.

l Suppress on unmatched rule. If not matched, BSM Connector stops processing and does not
send an event to BSM.
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Tasks

How to configure rules in XML policies
This task describes how configure policy rules.

1. In thePolicy Rules section, click and select the type of rule to define what the policy
should do in response to a specific string in the XML file. Each policy must have at least one
rule.

2. In theRule Content section, use theCondition tab to specify the XML properties and values
that the policy searches for in the XML file that the policy reads. If the policy finds amatch, it
may or may not generate an event, depending on the rule type.

a. Click to create a new condition. New conditions by default use the equals operator.

b. Click to expand the new condition.

c. In theProperty field, specify the XML element or attribute that the policy searches for. You
must specify the XML path from the XML event tag to the property, separated by slash
marks (/) (for example, /PerformanceAlert/Severity).

If you are working with sample data, you can drag and drop the XML element or attribute
from the XML Properties list to the Properties field.

d. Select the pattern operator.

If you select thematches operator, you can type a pattern in the Operand field. For a list of
available operators, see "Configuring Rules in XML File Policies" on the previous page.

e. In theOperand field, type the value or pattern that you want the policy to compare with the
XML property. If you are working with sample data, you can drag the value from the Values
list and drop it in the Operand field.

Tip: You can use standard BSM Connector pattern-matching rules whenmatching
values. Select thematches operator and click in the Operand field to open the
patternmatching expression toolbox. The toolbox displays the following:

o Pattern Matching Expressions. Click an expression to insert it in the Operand
field.

o Variable Bindings Options. Variable bindings options include case sensitivity
and field separators for the rule. If you do not specify patternmatching options for
the rule, either the defaults (case sensitive; a blank and the tab character as
separators) or the default options set for the policy will be used. See also
"Configuring Options in XML File Policies" on page 440.
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3. Use theEvent Attributes tab to define event attributes (for example, event title and
description) for all events generated by this rule.

Tip: After loading the indicators from the connected BSM server, the Indicators tab shows
a hierarchy of configuration item types with the associated health indicators (HIs) and
event type indicators (ETIs).

To insert an indicator, drag and drop the indicator, indicator state, or both from the
Indicators tab to the policy. Use theSelect target drop format panel to toggle between
inserting indicator names only and inserting indicator names and states.

4. Use theEvent Correlation tab to set the type of duplicate event suppression and define the
method used to suppress duplicate events.

5. Use theCustom Attributes tab to add additional information to all events generated by this
rule. For example, youmight add a company name, contact information, or a city location to an
event.

6. Use theAdvanced tab to define an event drill-downURL, legacy HPOM attributes, and agent
MSI (Message Stream Interface) settings.

7. Use theSample Data tab to drag XML properties (XML elements and attributes) and values to
the attribute boxes. Alternatively, you can type the path to the XML property or value directly
into the attribute box.

XML properties use the following syntax: <$DATA:/<XML_property>>

<XML_property> is the XML path, separated by slashmarks (/), from the XML event tag to the
XML element or attribute.

BSM Connector replaces the XML property at runtime with the value of the specified XML
element or attribute. If you insert an XML value, the value will be used.

8. Use theMappings tab to addmapping definitions to the attribute boxes.

Mappings are custom variables that you define in themappings tab (see also "Configuring
Rules in XML File Policies" on page 436). To insert a custom variable, you can drag it from the
Mappings list and drop it on the event attribute.

Alternatively, type the custom variable into the attribute box using the following syntax:

<$MAP(<custom_variable>)> where <custom_variable> is themap name of the variable (for
example, <$MAP(map@Severity)>).

If the custom variable does not have an XML property assigned, use the following syntax:

<$MAP(<custom_variable>,<<source_value>>) where <source_value> can be one of the
following:
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n XML path to the source value, for example <$MAP(map@Severity, <$DATA/Performance_
Alert/Severity>)>

n The source value itself, for example <$MAP(map@Severity, Warning)>

9. Optionally, use thePattern Matching Variables tab to add variables created through pattern
matching.

Patternmatching variables insert matched strings that have previously been assigned to
variables. To insert a patternmatching variable, type the variable name enclosed in angle
brackets (for example, <variablename>) or drag and drop it from the PatternMatching
Variables list to the event attribute.

10. Optionally, use thePolicy Variables tab to add policy variables to event attributes. BSM
Connector replaces the variables with the appropriate values in the generated event.

It is often useful to surround the variable with quotationmarks, especially if it may return a
value that contains spaces, for example "<$MSG_NODE>".

Related tasks

l "How to Collect Event Data from XML Files" on page 427

UI Descriptions

For a description of the Rules page, see the following sections:

l "Rules Page - Policy Rules" on page 495

l "Condition Tab - Rules Only" on page 472

l "Event Attributes Tab" on page 459

l "Event Correlation Tab" on page 465

l "Custom Attributes Tab" on page 469

l "Advanced Tab" on page 470

l "Sample Data Tab - XML File Policies" on page 500

l "Mappings Tab (Events Only)" on page 483

l "PatternMatching Variables Tab (Event Rules Only)" on page 491

l "Indicators Tab" on page 481

l "Policy Variables Tab (Events Only)" on page 491
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Configuring Options in XML File Policies
The options tab enables you to configure several policy behaviors, for example which events are
logged locally, how the policy handles unmatched events, and defaults for patternmatching in
policy rules.

To access
In the BSMConnector user interface, click in the toolbar, then click Event > XML. The XML
file policy editor opens. 

Alternatively, double-click an existing XML file policy to edit it.

Click Options to open the policy Options page.

Tasks

How to configure options for XML policies
In the Options page, configure which events are logged locally, how the policy handles unmatched
events, and defaults for patternmatching in policy rules.

For more information about the other fields, see "Configuring Options in XML File Policies" above.

Related tasks

l "How to Collect Event Data from XML Files" on page 427

UI Descriptions

For a description of the Options page, see "Options Page (Events Only)" on page 489.
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Appendix A: Pattern Matching in Policy Rules
BSMConnector uses patternmatching in the following ways:

l To extract data from log files andmake this data available as patternmatching groups.

A patternmatching group represents a unit of data that matches a specified pattern and that is
then retained for use in event attributes, mappings, and rules.

Example: The log file pattern (.*) (.*) (.*) (.*)matches the log file lines

Info: user1 logged on
Info: user1 logged off

In this example, the parentheses surround thematch pattern, and instruct the policy to
retain thematched values as patternmatching groups. The patttern .*matches all
characters, and the space is the delimiter in the log file.

The pattern assigns the string Info: to the patternmatching group "group0", user1 to
"group1", logged to "group2", and the strings on and off to "group3". You can then insert
the generated patternmatching groups "group0" to "groupn" in event attributes, mappings,
and rules.

For more information about the patternmatching syntax used to create patternmatching groups
in log file policies, see "Regular Expressions" on page 269.

l To determine if an event should be sent to BSM or should be suppressed.

BSM Connector compares the pattern that you specify with the data contained in XML elements
or attributes, in patternmatching groups, in database columns, or in variable bindings. When the
pattern is matched, the policy sends or suppresses an event, depending on the rule type.

Example:A log file policy contains a rule of the type "event onmatched rule". A condition
compares the pattern <![administrator]>with the value of "group3".

If the value of "group3" is administrator, the pattern does not match and the next
condition is evaluated. If the value is user1, the patternmatches and an event is sent to
BSM.
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Formore information about the patternmatching syntax used to in rule conditions, see
"Pattern-Matching Details" below.

Pattern-Matching Details
HP Operations Agent provides a powerful pattern-matching language that reduces the number of
conditions youmust use. Selected, dynamic parts of text-based events can be extracted, assigned
to variables, and used as parameters to build the event description or to set other attributes.

The pattern-matching language enables you to very accurately specify the character string that you
want a rule to match.

Note: In text boxes where pattern-matching expressions are allowed you can click for a
shortcut menu with pattern-matching expressions that can be selected and inserted into the
text box.

Matching special characters
Ordinary characters are expressions which represent themselves. Any character of the supported
character set may be used. However, if any of the following special characters are used they must
be prefaced with a backslash (\) that masks their usual function.

\ [ ] < > | ^ $

If ^ and $ are not used as anchoring characters, that is, not as first or last characters, they are
considered ordinary characters and do not need to bemasked.

Matching characters at the beginning or end of a line
If the caret (^) is used as the first character of the pattern, only expressions discovered at the
beginning of lines arematched. For example, "^ab" matches the string "ab" in the line "abcde", but
not in the line "xabcde".

If the dollar sign is used as the last character of a pattern, only expressions at the end of lines are
matched. For example, "de$" matches "de" in the line "abcde", but not in the line "abcdex".

Matching multiple characters
Patterns used tomatch strings consisting of an arbitrary number of characters require one or more
of the following expressions:

l <*> matches any string of zero or more arbitrary characters (including separators)

l <n*> matches a string of n arbitrary characters (including separators)

l <#> matches a sequence of one or more digits

l <n#> matches a number composed of n digits

l <_> matches a sequence of one or more field separators
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l <n_> matches a string of n separators

l <@> matches any string that contains no separator characters, in other words, a sequence of
one or more non-separators; this can be used for matching words

l </> matches one or more line breaks

l <n/> matches exactly n line breaks

l <S> matches one or more white space characters: space, tab and new line characters (" ", \t, \n,
\r)

l <nS> matches exactly nwhite space characters

Note: OnWindows operating systems, a new line consists of two white space characters
(\n\r).

Separator characters are configurable for each pattern. By default, separators are the space and the
tab characters.

Matching two or more different expressions
Two expressions separated by the special character vertical bar (|) matches a string that is
matched by either expression. For example, the pattern:

[ab|c]d

matches the string "abd" and the string "cd".

Matching text that does not contain an expression
The NOT operator ( ! ) must be used with delimiting square brackets, for example:

<![WARNING]>

The pattern abovematches all text which does not contain the string "WARNING".

TheNOT operatormay also be used with complex subpatterns:

SU <*> + <@.tty> <![root|[user[1|2]]].from>-<*.ot>

The above patternmakes it possible to generate a "switch user" event for anyone who is not user1,
user2 or root. Therefore the following would bematched:

SU 03/25 08:14 + ttyp2 user11-root

However, this line would not bematched, because it contains an entry concerning "user2":

SU 03/25 08:14 + ttyp2 user2-root

Notice that if the subpattern including the not operator does not find amatch, the not
operatorbehaves like a <*>: it matches zero or more arbitrary characters. For this reason, the
pattern-matching expression: <![1|2|3]> matches any character or any number of characters,
except 1, 2, or 3.
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Mask ( \ ) Operator
The backslash ( \ ) is used tomask the special meaning of the characters:

[ ] < > | ^ $

A special character preceded by \ results in an expression that matches the special character itself.

Notice that because ^ and $ only have special meaning when placed at the beginning and end of a
pattern respectively, you do not need tomask them when they are used within the pattern (in other
words, not at beginning or end).

The only exception to this rule is the tab character, which is specified by entering "\t" into the
pattern string.

Bracket ([ and ]) Expressions
The brackets ([ and ]) are used as delimiters to group expressions. To increase performance,
brackets should be avoided wherever they are unnecessary. In the pattern:

ab[cd[ef]gh]

all brackets are unnecessary--"abcdefgh" is equivalent.

Bracketed expressions are used frequently with theOR operator, theNOT operator and when
using subpatterns to assign strings to variables.

Numeric range operators
HP Operations Agent provides six numeric range operators that can be used in patternmatching.
The operators are used in this way:

Operator
name Syntax

Example/Explanation

Less than <[pattern This is a match
pattern you provide that
returns the number to be
compared] -lt n This is the
value against which you want
to test the number returned by
the match pattern>

<[<#>] -lt 5>
matches every number
less than 5

Less than
or equal to

<[pattern] -le n > <[<#>] -le 5>
matches 5 and every
number less than 5

Greater
than

<[pattern] -gt n > <[<#>] -gt 5>
matches every number
greater than 5
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Greater
than or
equal to

<[pattern] -ge n > <[<#>] -ge 5>
matches 5 and every
number greater than 5

Equal to <[pattern] -eq n > <[<#>] -eq 5>
matches 5 or 5.0

Not equal
to

<[pattern] -ne n > <[<#>] -ne 5>
matches every number
but 5 and 5.0

The operators can also be combined to producematches according to
ranges of numbers:

Matches
numbers
that
belong to
the
interval,
excluding
the limits

< n -lt [pattern] -lt n > <5 -lt [<#>] -lt
10>
matches every number
between 5 and 10 ( but
not 5 or 10)

Matches
numbers
that
belong to
the
interval,
including
the limits

< n -le [pattern] -le n > <5 -le [<#>] -le
10>
matches every number
between 5 and 10
(including 5 and 10)

Matches
numbers
that do not
belong to
the
interval,
excluding
the limits

< n -gt [pattern] -gt n > <10 -gt [<#>] -gt
5>
matches every number
between 5 and 10 ( but
not 5 or 10)

Matches
numbers
that do not
belong to
the
interval,
including
the limits

< n -ge [pattern] -ge n > <10 -ge [<#>] -ge
5>
matches every number
between 5 and 10
(including 5 and 10)
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User-Defined Variables in Patterns
Any matched string can be assigned to a variable, which can be used to compose events. To define
a parameter, add ". parametername " before the closing bracket. The pattern:

^errno: <#.number> - <*.error_text>

matches an event such as:

errno: 125 - device does not exist

and assigns "125" to number and "device does not exist" to error_text.

When using these variables, the syntax is <variable_name> (for example, <number>).

Rules by which HP Operations Agent assigns strings to variables
In matching the pattern <*.var1><*.var2> against the string "abcdef", it is not immediately clear
which substring of the input string will be assigned to each variable. For example, it is possible to
assign an empty string to var1 and the whole input string to var2, as well as assigning "a" to var1
and "bcdef" to var2, and so forth.

The patternmatching algorithm always scans both the input line and the pattern definition (including
alternative expressions) from left to right. <*> expressions are assigned as few characters as
possible. <#>, <@>, <S> expressions are assigned as many characters as possible. Therefore,
var1will be assigned an empty string in the example above.

Tomatch an input string such as:

this is error 100: big bug

use a pattern such as:

error<#.errnumber>:<*.errtext>

In which:

l "100" is assigned to errnumber

l "big bug" is assigned to errtext

For performance and pattern readability purposes, you can specify a delimiting substring between
two expressions. In the above example, ":" is used to delimit <#> and <*>.

Matching <@.word><#.num> against "abc123" assigns "abc12" toword and "3" to num, as digits
are permitted for both <#> and <@>, and the left expression takes as many characters as possible.

Patterns without expression anchoring canmatch any substring within the input line. Therefore,
patterns such as:

this is number<#.num>

are treated in the sameway as:

<*>this is number<#.num><*>
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Using subpatterns to assign strings to variables
In addition to being able to use a single operator, such as * or #, to assign a string to a variable, you
can also build up a complex subpattern composed of a number of operators, according to the
following pattern: <[ subpattern ].var>

For instance: <[<@>file.tmp].fname>

In the example above, the period ( . ) between "file" and "tmp" matches a similar dot character,
while the dot between "]" and "fname" is necessary syntax. This pattern wouldmatch a string such
as "Logfile.tmp" and assigns the complete string to fname.

Other examples of subpatterns are:

l <[Error|Warning].sev>

l <[Error[<#.n><*.msg>]].complete>$ 

In the first example above, any line with either the word "Error" or the word "Warning" is assigned to
the variable, sev. In the second example, any line containing the word "Error" has the error number
assigned to the variable, n, and any further text assigned tomsg. Finally, the word "Error", the error
number, and the text are assigned to complete.

The second example requires the dollar sign ($) at the end to anchor the expression. As mentioned
above, patterns without expression anchoring canmatch any substring within the input line.
Therefore, the pattern:

<[Error[<#.n><*.msg>]].complete>

would be treated as:

<*><[Error[<#.n><*.msg>]].complete><*>

Patterns are evaluated from left to right, and <*> expressions are assigned as few characters as
possible. Therefore, without a dollar sign ($) to anchor the end of the expression, the <*.msg>
expression always matches zero characters, and the remainder of the line is matched with the
implicit <*> expression at the end.

Pattern Matching for Variables
You can test a string or variable against a pattern, and define an output string that is conditional on
the result. You can do this using $MATCH, which has the following syntax:

$MATCH(string, pattern, true, [false])

Specify the parameters as follows:

string
Specify a literal string (for example, TEST STRING) or a policy variable (for example
<$LOGPATH>).

pattern
Specify a pattern, using HP Operations Agent patternmatching syntax. You can create user-
defined variables in the pattern to use in the parameters true and false. The pattern is case
sensitive.
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true
Specify a string to return if the string and patternmatch. You can specify a literal string, or a
user-defined variable, or a policy variable.

false
Optional. Specify a string to return if the string and pattern do not match. You can specify a
literal string, or a user-defined variable, or a policy variable.

Separate each parameter with a comma (,). To specify a commawithin a parameter, youmust
precede it with two backslashes (\\).

You can use $MATCH within your policies in the following event attributes:

l Service ID

l Message type

l Category

l Application

l Object

l Title

Note: You can use $MATCH only once in eachmessage attribute. You cannot use $MATCH
recursively.

Example

A policy can read a number of log files. The name of the path of the log file is available in the policy
variable <$LOGPATH>. If part of the log file path corresponds to an application name, you can use
$MATCH to set the application event attribute as follows:

$MATCH(<$LOGPATH>,<@.application>.log, <application>, Unknown)

Examples of Pattern Matching in Rule Conditions
The following examples show some of themany ways in which the pattern-matching language can
be used.

l Error

Recognizes any event containing the keyword Error at any place in the event. (It is case
sensitive by default.)

l panic

Matches all events containing panic, Panic, PANIC anywhere in the text of the event, when
case sensitivemode is switched off.

BSM Connector User Guide
Appendix A: PatternMatching in Policy Rules

HP Business ServiceManagement (9.23) Page 449 of 521



l logon|logoff

Uses theOR operator to recognize any event containing the keyword logon or logoff.

l ^getty:<*.msg> errno<*><#.errnum>$

Recognizes any event such as: getty: cannot open ttyxx errno : 6 or getty: can't
open ttyop3; errno 16

In the example getty: cannot open ttyxx errno : 6, the string "cannot open ttyxx" is
assigned to the variablemsg. The digit 6 is assigned to the variable errnum. Note that the dollar
sign ($) is used as an anchoring symbol to specify that the digit 6 will only bematched if it is at
the end of the line.

l ^errno[ |=]<#.errnum> <*.errtext>

Matches events such as: errno 6 - no such device or address or errno=12 not enough
core.

Note the space before theOR operator. The expression in square brackets matches either this
blank space, or the "equals" sign. The space between <#.errnum> and <*.errtext> is used as a
delimiter. Although not strictly required for assignments to the variables shown here, this space
serves to increase performance.

l ^hugo:<*>:<*.uid>:

Matches any /etc/passwd entry for user hugo and returns the user ID to variable uid. Notice that
":" in themiddle of the pattern is used to delimit the string passed to uid from the preceding
string. The colon ":" at the end of the pattern is used to delimit the string passed to uid from the
succeeding group ID in the input pattern. Here, the colon is necessary not only as a speed
enhancement, but also as ameans of logical separation between strings.

l ^Warning:<*.text>on node<@.node>$

Matches any event such as: Warning: too many users on node hpbbx and assigns too
many users to text, and hpbbx to node.

l ^<*.line1><1/><*.line2><1/><*.line3><1/><*.line4>$

Matches four lines of text, for example:

Security ID: S-1-5-21-3358208617-1210941181-189752109-500
Account Name: Administrator
Account Domain: EXAMPLE
Logon ID: 0x228a2

There is one line break between each line. The pattern assigns each line of text to a variable.

l <<#> -le 45>
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This patternmatches all strings containing a number which is less than or equal to 45. For
example, the event: ATTENTION: Error 40 has occurredwould bematched.

Note that the number 45 in the pattern is a true numeric value and not a string. Numbers higher
than 45, for instance, "4545" will not bematched even if they contain the combination, "45".

l <15 -lt <2#> -le 87>

This patternmatches any event in which the first two digits of a number are within the range 16-
87. For instance, the event: Error Message 3299would bematched. The string: Error Message
9932would not bematched.

l ^ERROR_<[<#.err>] -le 57>

This patternmatches any text starting with the string "ERROR_" immediately followed by a
number less than, or equal to, 57.

For example, the event: ERROR_34: processing stoppedwould bematched and the string 34
would be assigned to the variable, err.

l <120 -gt [<#>1] -gt 20>

Matches all numbers between 21 and 119 which have 1 as their last digit. For instance, events
containing the following numbers would bematched: 21, 31, 41... 101... 111 and so on.

l Temperature <*> <@.plant>: <<#> -gt 100> F$

This patternmatches strings such as: "Actual Temperature in Building A: 128 F". The letter "A"
would be assigned to the variable, plant.

l Error <<#> -eq 1004>

This patternmatches any event containing the string "Error" followed by a space and the
sequence of digits, "1004".

For example,Warning: Error 1004 has occurredwould bematched by this pattern. However,
Error 10041would not bematched by this pattern.

l WARNING <<#> -ne 107>

This patternmatches any event containing the string "WARNING" followed by a space and any
sequence of one or more digits, except "107". For example, the event: Application Enterprise
(94/12/45 14:03): WARNING 3877would bematched.
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Appendix B: Command-Line Tools
You can use the following command-line tools to configure BSM Connector:

l "BSM Connector Configuration Tool" below

l "Local User Configuration Tool" on page 455

Tool location
The BSMConnector command-line tools are located on the BSMConnector server in:

Windows: %OvDataDir%\installation\HPOprIA\

Linux: /var/opt/OV/installation/HPOprIA/

Log files
All BSM Connector command-line tools write information to the following log file on the BSM
Connector server:

<BSM Connector root dir>/logs/opr-pm-cli.log

The tools append log information to the file when you run them again.

BSM Connector Configuration Tool
You can reconfigure BSM Connector by running the configuration program bsmc-conf.

The bsmc-conf tool is located on the BSMConnector server at the following location:

Windows: %OvDataDir%\installation\HPOprIA\bsmc-conf.bat

Linux: /var/opt/OV/installation/HPOprIA/bsmc-conf.sh

bsmc-conf accepts the following options:

bsmc-conf.[bat|sh] -srv <hostname> [ -cert_srv <hostname> ] [ -f ] [ -flexmgmt
[ -omc_srv <hostname> ] ] | -help | -version

This section includes:

l "Command options" on the next page

l "To reconnect BSM Connector to another BSM server" on page 454

l "To install and configure BSM Connector on an HPOM managed node" on page 454

l "Log files" on page 455

l "Using ovconfchg" on page 455
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Command options
-s,-srv <hostname>

Specifies the BSM server.

<hostname> is the FQDN or IP address of the BSM gateway server, load balancer, or reverse
proxy (depending on your BSM deployment) to which you want to connect the BSMConnector.

You can look up the hostname in theDefault Virtual Gateway Server for Data Collectors
URL infrastructure setting:

Admin > Platform > Setup and Maintenance > Infrastructure Settings > Foundations >
Platform Administration > Host Configuration

-cs,-cert_srv <hostname>

Specifies the certificate server.

<hostname> is the FQDN or IP address of the certificate server for your BSM environment.

Use this option if you want to issue certificates from a certificate server other than the BSM
server specified using the -srv option (for example from anHP Operations Manager server or a
BSM server from another BSM deployment).

If you omit this option, bsmc-conf uses the BSM server specified using the -srv option.

Note:When accessing BSM through an IIS secure reverse proxy (SRP), enter the FQDN
of the BSM gateway server. For more information on configuring an IIS reverse proxy for
BSM, see the BSMHardening Guide.

-f,-force>

Forcemode (for example to reconfigure BSM Connector to connect to a different BSM server).

-fm,-flexmgmt

Creates the flexible management policy BSM Connector FlexMgmt Policy.The policy
configures the agent to send the following data to the BSM server:

l Events generated by BSMConnector policies. These events automatically have the Type
attribute set toBSMC_Message.

The HPOM management server specified using the -omc_svr option receives all events that
do not have the Type attribute set toBSMC_Message.

l Metrics data.

l Topology data (both legacy and DDM-discovered data).

-omc,-omc_srv <hostname>

FQDN of the HPOMmanagement server.

If you omit this option, bsmc-conf takes the value of MANAGER from the internal configuration
settings file and inserts it as target server in the flexible management policy BSM Connector
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FlexMgmt Policy. All events that do not have the Type attribute set toBSMC_Message are
sent to this server.

Tip: Use the following command to find the current value of MANAGER:

ovconfget sec.core.auth MANAGER

-h,-help

Shows tool usage and description.

-v,-version

Displays the BSMConnector version number.

When you run bsmc-conf, the program does the following:

l Replaces all existing values with new or default values.

l Creates a backup of the flexible management policy:

Windows: %OvDataDir%\conf\HPOprIA\<policy_ID>_data.bak

%OvDataDir%\conf\HPOprIA\<policy_ID>_header.xml.bak

Linux: /var/opt/OV/conf/HPOprIA/<policy_ID>_data.bak

/var/opt/OV/conf/HPOprIA/<policy_ID>_header.xml.bak

To reconnect BSM Connector to another BSM server

1. On the BSMConnector server, type the following command to reconnect the system to
another BSM server:

bsmc-conf -srv <new BSM server> -force

2. Add the BSMConnector server to the BSMConnector Integrations page in BSM (Admin >
Integrations > BSM Connector Integrations).

Do not select theConfigure policy management checkbox.

3. In Operations Management, grant the certificate generated by bsmc-conf.

4. Delete the BSMConnector integration from the old BSM server.

5. Results.BSMConnector sends all collected data to the new BSM server.

To install and configure BSM Connector on an HPOM managed node

1. On the BSMConnector server, type the following command to configure the BSMConnector
on an HPOMmanaged node:
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bsmc-conf -srv <new BSM server> -force -flexmgmt -omc_srv <HPOM management
server>

2. Add the BSMConnector server to the BSMConnector Integrations page in BSM (Admin >
Integrations > BSM Connector Integrations).

Do not select theConfigure policy management checkbox.

3. In Operations Management, grant the certificate generated by bsmc-conf.

4. Results. The new BSM server becomes the primary manager of the HP Operations Agent. The
flexible management policy BSM Connector FlexMgmt Policy configures the agent to send
the following data to the BSM server:

n Events generated by BSMConnector policies. These events automatically have the Type
attribute set toBSMC_Message.

The HPOM management server receives only events that do not have the Type attribute set
toBSMC_Message.

n Metrics data.

n Topology data (both legacy and DDM-discovered data).

Log files
bsmc-confwrites information to the following log file:

<BSM Connector root dir>/logs/opr-pm-cli.log

The tool appends log information to the file when you run the program again.

Using ovconfchg
The command-line tool ovconfchg enables you to change one or more configuration parameters in
the internal configuration settings file. ovconfchg is an expert tool and should be used by
experienced administrators only.

To run ovconfchg:

Windows: ovconfchg -edit

Linux: /opt/OV/bin/ovconfchg -edit

The -edit option starts a text editor to edit the settings file. After you have saved your changes,
youmust restart the application.

Local User Configuration Tool
Each BSMConnector instancemaintains a local users store. These users can access the local
BSM Connector instance only and cannot not gain access to other BSM Connector applications.
When BSMConnector users launch the BSMConnector user interface, they have to provide the
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credentials of a local BSM Connector user, or, if smart card authentication is configured, the smart
card PIN.

To add additional users to the user store, run the BSMConnector local user configuration tool user.

Note: Users added the local user store cannot be specified as BSMConnector user in the
Main Settings of the BSMConnector Integrations page in BSM (Admin > Integrations >
BSM Connector Integrations). Youmust enter the BSMConnector administration user that
you configured in the configuration wizard during installation.

The user tool is located on the BSMConnector server in:

Windows: %OvDataDir%\installation\HPOprIA\user.bat

Linux: /var/opt/OV/installation/HPOprIA/user.sh

user accepts the following options:

user -help | -list | -add <username> <password> | -delete <username> | -version

Command options
-h,-help

Shows tool usage and description.

-l,-list

Lists the users stored in the local user store.

-a,-add <username> <password>

Adds a user to the local users store. If the user already exists, the password is overwritten.

The username and passwordmust contain ASCII characters only. The user namemust contain
at least three characters. Valid characters in user names are alphanumeric characters (a-z, A-
Z, and 0-9), hyphens (-), underscores (_), periods (.), and the at sign (@).

When configuring BSM Connector for smart card authentication, use the value of the User
Principal Name (UPN) in the certificate as user name.

-d,-delete <username>

Deletes the specified user from the local user store.

-v,-version

Displays the BSMConnector version number.

Local user store
The local user store is located in the following file on the BSMConnector system:

Windows: %OvDataDir%\conf\HPOprIA\users.properties

Linux: /var/opt/OV/conf/HPOprIA/users.properties
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To add local users

1. Windows. Run the local user configuration tool:

a. Open a command prompt and type:

cd %OvDataDir%\installation\HPOprIA

b. Run the BSMConnector local user configuration tool, type:

user.bat -add <username> <password>

Linux. Start the BSM Connector local user configuration tool, type:

/var/opt/OV/installation/HPOprIA/user.sh -add <username> <password>

2. Optional. Review the log file at:

<BSM Connector root dir>/logs/opr-pm-cli.log

The program appends log information to the file when you run the program again.
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Command Page (Legacy Discovery Policies)

UI
Element Description

Command Name of the discovery script.

Use the variable $ACTION_DIR to represent the folder that contains instrumentation
onmanaged nodes. For example, you could specify the command "$ACTION_
DIR/custom_discovery.cmd".

$ACTION_DIR represents the folder that contains instrumentation on the BSM
Connector system:

Windows: %OvDataDir%\bin\instrumentation

Linux: /var/opt/OV/bin/instrumentation

Escape any backslashes (\) with a second backslash (\\).

Tip: Click in the Command box to open the edit assistant. The edit assistant
enables you to insert and remove quotationmarks, and to insert the variables
$ACTION_DIR and $DATA_DIRmore easily.

Username User name of the account under which the discovery script is started.

By default, the agent starts the service discovery script under the same account as
the agent is running under, which is Local System by default.

Password Password of the account under which the discovery script is started.

Defaults and Rules Pages (Events)

Note: In the default event attributes of openmessage interface policies, you can set only the
Category attribute.

In the default event attributes of SNMP trap policies, you can set only the Severity and
Category attributes.

You can set the other event attributes within individual rules.

Event Attributes Tab

UI Element Description

Title Brief description of the nature of the event.

Description Detailed description of the event.
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Severity Severity assigned to the event.

Time
Created

Database, log file, Web service listener, and XML file policies only:

Date and time when the event was created.

Use the following conventions when specifying the date and time attribute:

l Integers.BSMConnector interprets integers in the policy source as seconds
since 00:00:00 UTC on 1 January 1970 (Unix time). For example,
1276600333 is 15 June 2010, at 11:12:13.

l Default time formats.BSMConnector by default interprets the following time
formats:

yyyy-mm-ddTHH:MM:SS (for example, 2010-06-15T11:12:13)

mm/dd/yyyy HH:MM:SS (for example, 06/15/2010 11:12:13)

l Pattern matching. You can use the function <$DATETIME(FORMAT,VALUE)>
to specify a pattern (FORMAT) that matches the time string in the policy source
(VALUE). You can use standard pattern-matching rules whenmatching values.
By default, patternmatching for the time format is case sensitive. The default
field separators are the space and the tab characters.

FORMATmust be enclosed in quotationmarks ("FORMAT") and accepts the
following variables:

H (hours), M (minutes), S (seconds). If H, M, or S is not set, the hour, minute,
or second displays as zero.

d (day), m (month), y (year). If d or m is not set, the day or month display as
one. If y is not set, the current year is assumed. If y is less than 100, the
current millennium is assumed; for example, if y matches 10, the year
displays as 2010. It is not possible to match a year earlier than 1970.

p (P.M.) If p is set, BSM Connector adds 12 hours to the hours that precede
the variable.

VALUE is one of the following:

n Database policies.VALUE is the table column or value tomatch.

Table columns use the following syntax:
<$DATA:/BSMConnectorEvent/<table_column>>

<table_column> is the name of the table column in the third-party
database.
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Examples:

Tomatch the time format 06/15/2010 11:12:13 in the table column
<$DATA:/BSMConnectorEvent/TIMERECEIVED>, type
<$DATETIME("^<#.m>/<#.d>/<#.y> <#.H>:<#.M>:<#.S>$",
<$DATA:/BSMConnectorEvent/TIMERECEIVED>)>

Tomatch the time format 11:12 15.06.2010 in the table column
<$DATA:/BSMConnectorEvent/TIMERECEIVED>, type
<$DATETIME("^<#.H>:<#.M> <#.d>.<#.m>.<#.y>$",
<$DATA:/BSMConnectorEvent/TIMERECEIVED>)>

Tomatch the time format 06/15/2010 1:35 PM in the table column
<$DATA:/BSMConnectorEvent/TIMERECEIVED>, type
<$DATETIME("^<#.m>/<#.d>/<#.y> <#.H>:<#.M> <2*.p>$",
<$DATA:/BSMConnectorEvent/TIMERECEIVED>)>

n Log file policies.VALUE is the patternmatching group or value tomatch.

Patternmatching groups use the following syntax:
<$DATA:/BSMConnectorEvent/<pattern_matching_group>

<pattern_matching_group> is the name of the group assigned to a
particular content match.

Examples:

Tomatch the time format 06/15/2010 11:12:13 in the patternmatching
group <$DATA:/BSMConnectorEvent/group3>, type
<$DATETIME("^<#.m>/<#.d>/<#.y> <#.H>:<#.M>:<#.S>$",
<$DATA:/BSMConnectorEvent/group3>)>

Tomatch the time format 11:12 15.06.2010 in the patternmatching group
<$DATA:/BSMConnectorEvent/group3>, type
<$DATETIME("^<#.H>:<#.M> <#.d>.<#.m>.<#.y>$",
<$DATA:/BSMConnectorEvent/group3>)>

Tomatch the time format 06/15/2010 1:35 PM in the patternmatching
group <$DATA:/BSMConnectorEvent/group3>, type
<$DATETIME("^<#.m>/<#.d>/<#.y> <#.H>:<#.M> <2*.p>$",
<$DATA:/BSMConnectorEvent/group3>)>

n Web service listener policies.VALUE is the <key> element or value to
match.

<key> elements use the following syntax:
<$DATA:/BSMConnectorEvent/<key>>
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<key> is the string assigned to the <key> element in the SOAP message
(for example, <key xsi:type="soapenc:string">Severity</key>)

Examples:

Tomatch the time format 06/15/2010 11:12:13 in the <key> element
<$DATA:/BSMConnectorEvent/TIMERECEIVED>, type
<$DATETIME("^<#.m>/<#.d>/<#.y> <#.H>:<#.M>:<#.S>$",
<$DATA:/BSMConnectorEvent/TIMERECEIVED>)>

Tomatch the time format 11:12 15.06.2010 in the <key> element
<$DATA:/BSMConnectorEvent/TIMERECEIVED>, type
<$DATETIME("^<#.H>:<#.M> <#.d>.<#.m>.<#.y>$",
<$DATA:/BSMConnectorEvent/TIMERECEIVED>)>

Tomatch the time format 06/15/2010 1:35 PM in the <key> element
<$DATA:/BSMConnectorEvent/TIMERECEIVED>, type
<$DATETIME("^<#.m>/<#.d>/<#.y> <#.H>:<#.M> <2*.p>$",
<$DATA:/BSMConnectorEvent/TIMERECEIVED>)>

n XML file policies.VALUE is the XML property or value tomatch.

XML properties use the following syntax: <$DATA:/<XML_property>>

<XML_property> is the XML path, separated by slashmarks (/), from the
XML event tag to the XML element or attribute.

Examples:

Tomatch the time format 06/15/2010 11:12:13 in the XML property
<$DATA:/SCOM_Alert/TimeRaised>, type
<$DATETIME("^<#.m>/<#.d>/<#.y> <#.H>:<#.M>:<#.S>$",
<$DATA:/SCOM_Alert/TimeRaised>)>

Tomatch the time format 11:12 15.06.2010 in the XML property
<$DATA:/SCOM_Alert/TimeRaised>, type
<$DATETIME("^<#.H>:<#.M> <#.d>.<#.m>.<#.y>$",<$DATA:/SCOM_
Alert/TimeRaised>)>

Tomatch the time format 06/15/2010 1:35 PM in the XML property
<$DATA:/SCOM_Alert/TimeRaised>, type
<$DATETIME("^<#.m>/<#.d>/<#.y> <#.H>:<#.M> <2*.p>$",
<$DATA:/SCOM_Alert/TimeRaised>)>

If you leave the attribute empty or if none of the time formats above can be
matched, then the date and time when the agent created the event appears in
BSM. This time always appears using the time zone of the agent at creation time
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(for example, 11:30 (CET/winter). This means that this time always appears in
this fixed time zone.

Category Name of the logical group to which the event belongs (for example, Database,
Security, or Network). The event category is similar in concept to the HP
Operations Manager message group.

Subcategory Name of the logical subgroup (category) to which the event belongs (for example,
Oracle (database), Accounts (security), or Routers (network)).

ETI Contains the event type indicator (ETI) resolution hint, which BSM uses to
associate the event with an ETI and for event correlation.

Use the format <ETI name>:<ETI state>:<metric value>. Specify the name
of the indicator (for example, CPULoad), the indicator state (for example, High),
and optionally themetric value (for example, 80). When BSM receives an event
with an ETI resolution hint of CPULoad:High, and the ETI and state exist, the
Event Type Indicator attribute is set to CPULoad:High in the event. Themetric
value is optional and serves informational purposes only.

Node Name of the system where the event occurred (for example,
node.example.com).

Related CI Contains the related CI hint, which BSM uses to identify the CI related to the
event (for example, oraclesid01@@node.example.com or
C:@@server.example.com). Use the format <hint 1>:<hint 2>:...:<hint
n>@@<hostname>.

Contains the CI hint, which BSM uses to identify the CI related to themetric (for
example, oraclesid01@@node.example.com or C:@@server.example.com).
Use the format <hint 1>:<hint 2>:...:<hint n>@@<hostname>.

Best practices for CI hints
The related CI hint should have sufficient hints to find the corresponding CI.

It is necessary to differentiate between CIs that have a Composition relationship
to a node, and those that do not have such a relationship:

l For “hosted on” CIs

<key attribute 1>:<key attribute 2>:<key attribute
n>@@<hostname>

Typically, a “hosted on” CI is a sub-type of “Running Software”. For example,
a CI of type websphereas has a Composition relationship to a node.

l For virtual CIs

<key attribute 1>:<key attribute 2>:<key attribute n>
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A virtual CI does not have a strong containment relationship (Composition
relationship) to node.

An example of a typical virtual CI type is cluster. This CI type does not have a
strong containment relationship to a node.

Tip: If you have problems resolving non-hosted CIs, provide the RTSM
ID of the desired CI as a hint using the format UCMDB:<ci_uuid>.

For more information about CI resolution in BSM, see theUsingOperations
Management PDF or online help.

Sub
Component

Information used to identify a subcomponent of a CI. This CI subcomponent is
used to calculate an aggregated status within BSM's Service Health for selected
CIs.

If an HI is populated by events frommultiple components, you can specify a
component name in this field in order to ensure the correct calculation of the HI
state.

For example, if you have a Computer CI with two CPUs, cpu #1 and cpu #2,
events from both CPUs will be sent to the same CPU LoadHI. By default, the
events will override each other and create an incorrect HI state. To prevent this,
you can populate Sub Component with values "cpu #1" and "cpu #2"which
will cause the HI state to be calculated as an aggregated state between the two
events.

Source CI Contains the source CI hint. For example, type the name and instance of the
third-party system that provides events (for example,
NNMi@@mgmt1.example.com or SCOM@@mgmt2.example.com).

If you enter a source CI hint, BSM tries to find the corresponding CI in the RTSM.

Source
Event ID

ID of the event in the third-party system. This ID is required for synchronization
of event changes with the source event. It also enables drilldown into the third-
party system in the Event Browser in Operations Management.

Tip: The file that the policy reads usually contains the source event ID. If
you are working with sample data, you can drag the source event ID from
the Sample Data tab and add it to the source event ID field.

Send with
closed
status

Sets the event's lifecycle status to Closed before sending it to BSM.
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Send with
closed
status

Sets the event's lifecycle status to Closed before sending it to BSM. Possible
values:

yes = Sets lifecycle status to Closed.

no = Does not set the lifecycle status to Closed.

Default value: empty (= no)

Tip: Click and select yes or no from themenu.

Event Correlation Tab

Note: You cannot set the following attributes in the event defaults of openmessage interface
and SNMP trap policies:

l Close Events with Key

l Suppress Deduplication on Server

You can set these event attributes within individual rules.

In scheduled task policies, you can set only the following event correlation attributes:

l Event Key

l Suppress Deduplication on Server

UI Element Description

Event Key An identifier used to identify duplicates and for Close Events with Key.

BSM Connector User Guide
Appendix C: UI Descriptions

HP Business ServiceManagement (9.23) Page 465 of 521



UI Element Description

Close Events
with Key

If events with the event key that you type here exist in the Operations
Management event database when this event is received, these events are
automatically closed. You can use patternmatching and variables tomatch
multiple event keys. For example, consider the following pattern:

<$MSG_SEV>:<$MSG_NODE_NAME>:<5*>

This pattern is evaluated by first replacing the variables with the values that
they resolve to, for example:

critical:cabbage.example.com:<5*>

This pattern is then compared using patternmatching rule against the event
keys for all events in the Operations Management event database. The pattern
above wouldmatch the following event keys:

critical:cabbage.example.com:12345
critical:cabbage.example.com:TEST1

Note: AnHP Operations Manager i Event Management Foundation
License is required to enable the Close Events with Key feature in BSM.

Suppress
Dedu-
plication on
Server

Stops automatic discarding of new events that are duplicates of existing
events.

Event Suppression

Suppress
events which
are

l Generated by the same input event. Select this option to suppress events
that were sent in response to two separate input events that are identical
except for the date and time that the event was generated (for example,
identical entries in a log file).

l Generated by the same rule. Select this option to suppress events that
match the pattern specified for the selected rule. This is amore general
setting for the suppression of duplicate events. For example, a policy might
contain a rule with this match pattern: Error Message<#> The log file lines
Error Message10 and Error Message20 are not identical, but would both
match this rule.

l Identical relative to their attributes. Select this option to suppress either
events that have the same event key or (if no event key is present) events
that have identical event attributes (except for the date and time that the
event was generated).

Suppression
Method

For event correlation, you can define one of three correlationmethods:
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l Time Interval. This correlationmethod lets you define an interval during
which duplicate events will be ignored. For more information, read this
detailed example.

Time interval correlation example

In the illustration below, the interval is set to 30 seconds, but the
suppression is limited to 60 seconds.

The  represents events that are identical. 

a. The first input event (E1) matches a rule in the policy.  The policy sends
an event and starts timing. 

b. A secondmatching event (E2) occurs 25 seconds later. This event
occurred less than 30 seconds after the first event, and is therefore
suppressed. 

c. A third matching event (E3 ) occurs less than 30 seconds after the
second event, and so is also suppressed. 

d. The next matching event (E4) occurs less than thirty seconds after the
third event, but is alsomore than 60 seconds after the first event, and
therefore the policy sends an event.
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l Counter. This correlationmethod counts the number of matching input
events and sends an event only after the number of matching input events
equals the counter threshold. The counter can also be reset to zero after a
time period that you specify. For more information, read this detailed
example.

Counter correlation example

 The  represent events that are identical. 

a. The first input event (E1) matches a rule in the policy, and the counter
increments to one.  No event is sent. 

b. A secondmatching event (E2 ) occurs, the counter increments to two,
an event is sent, and the counter resets.   

c. A third matching event (E3 ), and the counter increments to one. No
event is sent. 

d. The next matching event (E4) occurs more than thirty seconds after the
third event.  Since at thirty seconds the counter was reset to zero, the
counter now increments to one. No event is sent.

l Time Interval/Counter. If you use the Time interval and Counter together,
events are evaluated first by the timer. If an event passes the timer, it is then
evaluated by the counter, which either suppresses it or sends an event to

BSM Connector User Guide
Appendix C: UI Descriptions

HP Business ServiceManagement (9.23) Page 468 of 521



UI Element Description

BSM.

Note: If you specify just time interval correlation or just counter-based
correlation in an individual event, any event defaults for the other
correlationmethod also apply. For example, if you specify time interval
correlation for an event, and the event defaults specify counter-based
correlation, the combined time interval and counter-based correlation
applies to both new rules and existing rules.

Note: You can change this default behavior, so that only the correlation
method that you specify in the individual event applies. To change the
default behavior, set the parameter OPC_IGNORE_DEFAULT_MSG_
CORRELATION=TRUE in the eaagt namespace on the node. You can
configure this parameter using ovconfchg at a command prompt.

Time Interval Time interval during which duplicate events are ignored.

Suppress for
no longer
than

Time interval after which duplicate events are no longer ignored.

Counter
threshold

Value that triggers an event if met or crossed.

Reset counter
threshold
after

Time interval after which the counter is reset to 0.

Custom Attributes Tab

Note: You cannot set custom attributes in the event defaults of the following policy types:

l Openmessage interface policies

l SNMP trap policies

You can set custom attributes within individual rules for these policy types.

UI
Element Description

Create New Custom Attribute:Creates a new custom attribute.

Delete Custom Attribute:Deletes an existing custom attribute.
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Name The name of the custom attribute. The name is case-insensitive.

Custom attributes are additional attributes that contain any information that is
meaningful to you. For example, youmight add a company name, contact
information, or a city location to an event. You can havemore than one custom
attribute attached to a single event.

The following custom attribute names cannot be used because they are reserved for
internal use:

Description

EtiHint

HP_OPR_SAAS_CUSTOMER_ID

NoDuplicateSuppression

RelatedCiHint

SourceCiHint

SourcedFromExternalId

SourcedFromExternalUrl

SubCategory

SubCiHint

Value Value of the custom attribute.

Advanced Tab

Note: You cannot set the following attributes in the event defaults of openmessage interface
and SNMP trap policies:

l Event Drilldown URL

l Type

You can set these event attributes within individual rules.
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Event
Drilldown
URL

Rules only: URL of the event in the third-party system. This is the complete path
of the URL, and includes the FQDN (Fully Qualified Domain Name) of the
computer that hosts the third-party system, the communication port, and the root
URL path (for example,
http://nnmi.example.com:8004/nnm/launch?cmd=showForm&objtype
=Incident&objuuid=$OPC_CUSTOM[nnm.incident.uuid]&menus=true).

Event drilldown information enables BSM users to launch the user interface of the
third-party system in the context of an event.

Tip: To drill down to a specific event in the third-party system, add the source
event ID to the URL. If you are working with sample data, you can drag the
source event ID from the Sample Data tab and add it to the Event Drilldown
URL field.

Note: This event attribute can also be set by BSM based on a BSM
Connector integration server configuration. If a policy and an integration
server configuration both set this attribute, the information in the policy takes
precedence.

Application Application that caused the event to occur. Unlike the Related CI attribute, which
is a direct relationship to a CI in the RTSM, the application attribute is a simple
string-type attribute (for example, Oracle andOS).

Object Device such as a computer, printer, or modem. Unlike the Related CI attribute,
which is a direct relationship to a CI in the RTSM, the object attribute is a simple
string-type attribute (for example, C:, and /dev/spool).

Type Rules only: String used to organize different types of events within an event
category or subcategory (for example, users or applications, accounts and
security).

The attribute is automatically set to BSMC_Message. You can delete the value but it
will be inserted when you save the policy.

HPOM
Service ID

ID of the service associated with the event. A service ID is a unique identifier for a
service and can be used in BSM to identify the node and CI associated with the
event.

Use event
default

Rules only: Indicates the agent MSI settings configured in the event defaults:

Agent MSI not set. Output to the agent MSI is not configured in the event
defaults.

Divert events. The Divert events setting is configured in the event defaults.

Copy events. The Copy events setting is configured in the event defaults.
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Agent MSI Themessage stream interface (MSI) allows external applications to interact with
the internal event flow of HP Operations Agent. The external application can be a
read-write application, for example, an event processing program that can read
events, modify attributes, and generate new events for retransmission to the
server. The application could also read events, or send its own events.

Divert
events

Divert an event to theMSI instead of to the server when an event is requested by
an external application.

Copy
events

Send the event to the server, and a copy of the event to theMSI.

Condition Tab - Rules Only
The following policy types use this condition tab:

l Database policies

l Log file policies

l Web service listener policies

l XML file policies

UI
Element Description

New Item. Creates a new condition with the default operator equals.

Delete Item. Deletes the selected condition.

Move Up.Moves the selected condition higher in the condition order.

Move Down.Moves the selected condition lower in the condition order.

Expand. Expands the list of conditions to display all details.

Collapse. Collapses the list of conditions to display only the names and hide the
details.

Click to expand the details of a condition.

Click to hide the details of a condition.

BSM Connector User Guide
Appendix C: UI Descriptions

HP Business ServiceManagement (9.23) Page 472 of 521



UI
Element Description

Property Database policies: Table column that the policy searches for. Youmust prefix the
column namewith /BSMConnectorEvent/ (for example,
/BSMConnectorEvent/Severity).

Log file policies: Patternmatching group that the policy searches for. Youmust prefix
the group namewith /BSMConnectorEvent/ (for example,
/BSMConnectorEvent/group0).

Web service listener policies: <key> element that the policy searches for. Youmust
prefix the <key> element with /BSMConnectorEvent/ (for example,
/BSMConnectorEvent/Severity).

XML file policies: XML property that the policy searches for. Youmust specify the
XML path from the XML event tag to the property, separated by slashmarks (/) (for
example, /PerformanceAlert/Severity).

Operator The following operators are available:

l equals

l not equals

l less than

l greater than

l less or equal

l greater or equal

l matches (Enables you to enter a pattern in the Operand field.)
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Operand Database policies: Value or pattern that you want the policy to compare with the table
column. If you are working with sample data, you can drag the value from the Table
Column Values list and drop it in the Operand field.

Log file policies: Value or pattern that you want the policy to compare with the pattern
matching group. If you are working with sample data, you can drag the value from the
PatternMatching Group Values list and drop it in the Operand field.

Web service listener policies: Value or pattern that you want the policy to compare
with the <key>.

XML file policies: Value or pattern that you want the policy to compare with the XML
property. If you are working with sample data, you can drag the value from the XML
Values list and drop it in the Operand field.

Tip: You can use standard BSM Connector pattern-matching rules when
matching values. Select thematches operator and click in the Operand field to
open the patternmatching expression toolbox. The toolbox displays the
following:

l Pattern Matching Expressions. Click an expression to insert it in the
Operand field.

l Variable Bindings Options. Variable bindings options include case
sensitivity and field separators for the rule. If you do not specify pattern
matching options for the rule, either the defaults (case sensitive; a blank and
the tab character as separators) or the default options set for the policy will be
used. See also "Configuring Options in Log File Policies" on page
260"Configuring Options in XML File Policies" on page 440"Configuring
Options in Database Policies" on page 224"Configuring Options inWeb
Service Listener Policies" on page 411"Configuring Options in Open
Message Interface Policies" on page 297.

Condition Tab - Open Message Interface Policy Rules Only

UI Element Description

Node Fully qualified domain name, node name, or IP address that the policy compares
with the node in the sourcemessage.

Separatemultiple entries with the OR operator (|) or leave blank tomatch all
nodes.

This field corresponds to the node option of the opcmsg command.
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Message
Group

Message group that the policy compares with themessage group in the source
message.

Separatemultiple entries with the OR operator (|) or leave blank tomatch all
message groups.

This field corresponds to the msg_grp option of the opcmsg command.

Application Application that the policy compares with the application in the sourcemessage.

Separatemultiple entries with the OR operator (|) or leave blank tomatch all
applications.

This field corresponds to the application option of the opcmsg command.

Object Object that the policy compares with the object in the sourcemessage.

Separatemultiple entries with the OR operator (|) or leave blank tomatch all
objects.

This field corresponds to the object option of the opcmsg command.

Note: Although the term application generally refers to a general program
name and object generally refers to a process or sub-program, you should use
these values to assist your own organizational scheme.

Severity Severity that the policy compares with the severity in the sourcemessage. At
least one severity must be selected.

This field corresponds to the severity option of the opcmsg command.
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Message
Text

Message text or pattern that the policy compares with themessage text in the
sourcemessage.

Tip: You can use standard BSM Connector pattern-matching rules when
matching values. Select thematches operator and click in the Operand
field to open the patternmatching expression toolbox. The toolbox displays
the following:

l Pattern Matching Expressions. Click an expression to insert it in the
Operand field.

l Variable Bindings Options. Variable bindings options include case
sensitivity and field separators for the rule. If you do not specify pattern
matching options for the rule, either the defaults (case sensitive; a blank
and the tab character as separators) or the default options set for the
policy will be used. See also "Configuring Options in Log File Policies" on
page 260"Configuring Options in XML File Policies" on page
440"Configuring Options in Database Policies" on page 224"Configuring
Options inWeb Service Listener Policies" on page 411"Configuring
Options in OpenMessage Interface Policies" on page 297.

Condition Definition Tab - SNMP Trap Policy Rules Only

UI
Element Description

Node FQDN (Fully Qualified Domain Name), the primary node name, or the IP address of
the configuration item for which you want to forward events.

If you only want to match SNMP events from a specific configuration item, type the
FQDN (Fully Qualified Domain Name), the primary node name, or the IP address.
Givemultiple entries with theOR operator (for example,
celery.example.com|broccoli.example.com), or leave blank for all configuration
items.

Event
Object ID

Complete Event Object Identifier for the SNMP trap that you want to match.

For example: .1.3.6.1.4.1.11.2.17.1.0.40000001

SNMPv1
notation

If selected, you can specify only part of the identifier rather than the complete event
object ID.

For example, by specifying only the Enterprise ID, you canmatch all events with a
specific Enterprise ID.
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Enterprise
ID

Enterprise ID for incoming SNMP traps to be compared with this condition. The
enterprise ID is a vendor-specific identifier for the trap. Standard BSM Connector
pattern-matching syntax may not be used in this field; however, it is possible to
match a range of objects by entering only a prefix. For instance, the pattern:

.1.3.6.1.4.1.11.2.17

wouldmatch:

.1.3.6.1.4.1.11.2.17.1

.1.3.6.1.4.1.11.2.17.2

and so on.

Generic
ID

Generic Trap ID. Possible values are:

l (0)ColdStart

l (1)WarmStart

l (2) LinkDown

l (3) LinkUp

l (4)Authentification

l (5)EgpNeighborLoss

l (6)EnterpriseSpecific

l (7) don't care

If you select (6) EnterpriseSpecific, you can type in the specific trap ID. Select
don't care to intercept any kind of trap.

Specific
ID

Type in the specific trap ID if you have selected (6) EnterpriseSpecific in Generic
Trap. Enterprise-specific SNMP traps can be implemented by vendors on their
specific network devices. The specific trap ID is used to identify the source of the
trap.

Note: The SNMP syntax used by the editor requires that the trap string begins with a point.

Condition Variable Bindings Tab - SNMP Trap Policy Rules Only

UI
Element Description

Creates a new variable binding.
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UI
Element Description

Deletes the selected variable binding.

Opens the Variable Bindings Options page.

Variable Variable binding you want the policy to read. 1 represents the first variable binding in
the event, 2 the second variable, and so on. You do not need to prefix the variable with
a dollar sign ($); BSM Connector does this automatically.

Pattern Match pattern for the binding.

Tip: You can click the button to open the patternmatching expression toolbox.

Defaults and Rules Pages (Metrics)
Default Monitor Attributes and Attributes Tabs
Most metrics attributes are represented by string values andmust be enclosed in quotationmarks
(""). You can optionally use the plus sign (+) to add group values (for example, "Disk Usage on " +
$group0). For details, see "UI Descriptions" on page 458.

The following attributes are represented by numeric values andmust not be enclosed in quotation
marks:

l Time stamp

l Measurement value

Tip: Use the parseDouble() function to convert a quoted string value to a numeric value (for
example, parseDouble(“123123”). Alternatively, use parseDouble($group0) if the value in the
log file is numeric and without quotationmarks. (Youmay use patternmatching to remove
quotationmarks from a log file while it is parsed by the policy.)

l Quality

Tip: The Policy Constants tab lists the available constants representingmetrics quality
(status) that are available in BSM Connector. Use drag and drop to add them to theQuality
attribute.
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UI
Element Description

Monitor
Name

Name of amonitor representing a group of metrics that have something in common.

Example: "Windows CPU Monitor on"+group0

Monitor
Type

Themonitor type/category.

Example: "My Integration CPU Monitor "

Target The target of this monitor (such as the name of a node).

Example: "mynode.mycompany.com"

Time
Stamp

Time stamp in the seconds since Jan 1st 1970 format. Must be a double-precision
number.

Example: parseDouble(“123123”)

Quality Metrics quality (status) in BSM Connector terms. Possible values are: QUALITY_
ERROR, QUALITY_WARNING, QUALITY_GOOD.

Example: $group4.equals("error") ? QUALITY_ERROR :$group4.equals("warning")
? QUALITY_WARNING : QUALITY_GOOD

Monitor
State

Themonitor status.

Example: "Running..."

Metrics

New Item:Creates new metrics.

Delete Item:Deletes the selectedmetrics.

Move Up:Moves the selectedmetrics higher in themetrics order.

Move Down:Moves the selectedmetrics lower in themetrics order.

Expand:Expands the list of metrics to display all details.

Collapse:Collapses the list of metrics to display only the names and hide the
details.

Name Name the Nthmetric.

Example: "CPU Utilization"

Value Value of Nthmetric. Must be a double-precision number.

Example: 80
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UI
Element Description

CI Hint Contains the related CI hint, which BSM uses to identify the CI related to the event
(for example, oraclesid01@@node.example.com or C:@@server.example.com).
Use the format <hint 1>:<hint 2>:...:<hint n>@@<hostname>.

Contains the CI hint, which BSM uses to identify the CI related to themetric (for
example, oraclesid01@@node.example.com or C:@@server.example.com). Use
the format <hint 1>:<hint 2>:...:<hint n>@@<hostname>.

Best practices for CI hints
The related CI hint should have sufficient hints to find the corresponding CI.

It is necessary to differentiate between CIs that have a Composition relationship to a
node, and those that do not have such a relationship:

l For “hosted on” CIs

<key attribute 1>:<key attribute 2>:<key attribute n>@@<hostname>

Typically, a “hosted on” CI is a sub-type of “Running Software”. For example, a CI
of type websphereas has a Composition relationship to a node.

l For virtual CIs

<key attribute 1>:<key attribute 2>:<key attribute n>

A virtual CI does not have a strong containment relationship (Composition
relationship) to node.

An example of a typical virtual CI type is cluster. This CI type does not have a
strong containment relationship to a node.

Tip: If you have problems resolving non-hosted CIs, provide the RTSM ID of
the desired CI as a hint using the format UCMDB:<ci_uuid>.

For more information about CI resolution in BSM, see theUsingOperations
Management PDF or online help.

Note: CI hints are not required when using the Computer - Monitor topology
script because the script sets them automatically. However, it is recommended
to specify CI hints for custom, Computer, and Computer - Running Software
topology scripts.

Indicator
Name

Indicator name. Must be enclosed in quotationmarks ("").

Example: "CPULoad"
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Condition Tab (Rules Only)

UI Element Description

Match Match condition.

Field Mapping Page

UI Element Description

Field Mapping
Script

Defines the conversion rules from third-party data to the BSM event format.

For more information on field mapping, see the SiteScope Help or the the
Using SiteScopeGuide.

Indicators Tab

UI Element Description

Refresh. Loads the configured indicators from the connected BSM server.

Note:

l Loading indicators from the BSM server may take a few seconds.

l The BSMConnector server must be configured as a BSMConnector
integration server in BSM for the indicators to load successfully. See also
"Indicator definitions could not be loaded" on page 135

Event integration policies only: Shows or hides theSelect drop target format
drop-down panel:

l Use Indicator States. Click to change the drop target format to indicator
states only.

l Use Indicator Names and States. Click to change the drop target format to
indicator names and states.

<Search …> Entered search string is used to search the indicators and highlight only the
indicators containing the specified string.

To search for indicators with specific text strings in the name, type the string in
the <Search…> field and click the button. The first matching indicator is
selected in the list of rules. Click the and buttons tomove to the previous
and next matching indicator.

<Indicators> Hierarchy of configuration item types with associated health indicators (HIs) and
event type indicators (ETIs). To insert an indicator in a policy, drag and drop the
indicator from the Indicators tab to the relevant field in the policy.
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Mappings Page (Events Only)

UI
Element Description

Create new mapping definition. Adds a new mapping definition to the list of
mappings.

Delete mapping definition. Deletes the selectedmapping definition.

Copy Mapping Definition. Creates a copy of the selectedmapping definition.

Move Up.Moves the selectedmapping definition up to a higher position.

Move Down.Moves the selectedmapping definition down to a lower position.

Map
Name

Name of the custom variable. BSM Connector automatically adds the default prefix
map to themap name if the variable has been created from sample data.

Data
Input
Property

Database policies: Table column assigned to the custom variable.

BSM Connector replaces the table column at runtime with the value of the specified
column. If you insert a value, the value will be used.

Log file policies: Patternmatching group assigned to the custom variable.

BSM Connector replaces the patternmatching group at runtime with the value of the
specified group. If you insert a value, the value will be used.

Web service listener policies: Key assigned to the custom variable.

BSM Connector replaces the key at runtime with the value of the specified key. If
you insert a value, the value will be used.

XML file policies: XML element or attribute assigned to the custom variable.

XML properties use the following syntax: <$DATA:/<XML_property>>

<XML_property> is the XML path, separated by slashmarks (/), from the XML event
tag to the XML element or attribute.

BSM Connector replaces the XML property at runtime with the value of the specified
XML element or attribute. If you insert an XML value, the value will be used.

Create new mapping. Adds a new pair of source and target values to themapping
definition.

Delete mapping. Deletes the selected source and target value pair.

Copy Value Mapping. Creates a copy of the selected valuemapping.

Move Up.Moves the selected valuemapping up to a higher position.
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Move Down.Moves the selected valuemapping down to a lower position.

Source
Value

Database policies:Original value of the table column.

Log file policies:Original value of the patternmatching group.

Web service listener policies:Original value associated with the <key> element in
the SOAP message.

XML file policies:Original value of the XML element or attribute.

Target
Value

Database policies:New value of the table column.

Log file policies:New value of the patternmatching group.

Web service listener policies:New value associated with <key>.

XML file policies:New value of the XML element or attribute.

Mappings Tab (Events Only)

UI Element Description

<Mappings> Displays themapping definitions configured for the policy. For details, see
"ConfiguringMappings in XML File Policies" on page 431"ConfiguringMappings
in Log File Policies " on page 245"ConfiguringMappings in Database Policies" on
page 210"ConfiguringMappings inWeb Service Listener Policies " on page 396.

Operations Tab (Metrics Only)

Expressions and
Functions Description

? : Conditional operator. Allows usage of conditions and branching logic:
"someCondition ? value1 : value2" means "If someCondition is true, assign
the value of value1 to result. Otherwise, assign the value of value2 to
result."

Example: $group1.equals("error") ? true : false

+ String concatenation.

Example: "trap type is " + $trap

 <, <=, > , >=,
==, !=

Checks the numerical correctness of the expression.  Can be used with
numeric values.

Example:Match: $numberOfLines == 100
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Expressions and
Functions Description

&&, || To be used to combine any of the above boolean expressions.

Example:Match: $status.equals("ERROR") || ($numberOfLines == 100)

true, false Constant Boolean values.

Example:Match: true

( ) Allows grouping of operators in order to change the order of their execution.

Example:Monitor Name: ($group1.equals("CPU") ? "CPU Utilization" :
$group1.equals("Memory") ? "Memory Usage" : "Unknown") + " " + $group2

boolean contains
(String)

Returns true if and only if this string contains the specified sequence of char
values.

For more details, see http://download.oracle.com/javase/7/docs/api/
java/lang/String.html#contains(java.lang.CharSequence).

Example:Monitor Name: $group0.contains("monitor")? $group0 : $group0 +
"monitor"

boolean endsWith
(String)

Tests if this string ends with the specified suffix.

For more details, see http://download.oracle.com/javase/7/docs/
api/java/lang/String.html#endsWith(java.lang.String).

Example:Monitor Name: $group1.endsWith("Operations")? $group1 :
$group1 + "Operations"

boolean equals
(String)

Compares this string to another string.

For more details, see
http://download.oracle.com/javase/7/docs/api/java/lang/
String.html#equals(java.lang.Object).

Examples:

Match: "ERROR".equals($status)

or

Match: $status.equals("ERROR")
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Expressions and
Functions Description

boolean
equalsIgnoreCase
(String)

Compares this String to another String, ignoring case considerations.

For more details, see
http://download.oracle.com/javase/7/docs/api/java/lang/
String.html#equalsIgnoreCase%28java.lang.String%29.

Examples:

Match: "ERROR".equalsIgnoreCase($status)

or

Match: $status.equalsIgnoreCase("ERROR")

boolean exists
(String)

Checks for an existence of a property in the processed event andmake sure
that it is not an empty value.

Example:Match: exist($status)

String getToken
(String, String
,int)

Splits input string according to a supplied delimiter (in regular expression
format), and returns one of the result strings according to a specified zero-
based index.

Example: getToken($var, "/", 1) will produce "y" if $var equals "x/y/z"

int indexOf
(String)

Returns the index within this string of the first occurrence of the specified
substring.

For more details, see http://download.oracle.com/javase/7/docs/
api/java/lang/String.html#indexOf(int).

Example:Severity: $group0.lastIndexOf("Critical")>-1? "Critical" :
"Normal"

int indexOf
(String, int)

Returns the index within this string of the first occurrence of the specified
substring, starting at the specified index.

For more details, see http://download.oracle.com/javase/7/docs/
api/java/lang/String.html#indexOf(java.lang.String,%20int).

Example:Severity: $group0.indexOf("Critical",3)>-1? "Critical" : "Normal"

boolean isDouble
(String)

Checks if the input string can be interpreted as a double number.

Example:Match: isDouble($size)

boolean isEmpty() Tests for an empty string (length() == 0).

For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#isEmpty().

Example:Description: $group1.isEmpty()?$group0 :$group1
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Expressions and
Functions Description

boolean isInt
(String)

Checks if the input string can be interpreted as an integer number.

Example:Match: isInt($size)

int lastIndexOf
(String, int)

Returns the index within this string of the last occurrence of the specified
substring, searching backward starting at the specified index.

For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#lastIndexOf(java.lang.String,%20int).

Example:Severity: $group0.lastIndexOf("Critical",2)>-1? "Critical" :
"Normal"

int lastIndexOf
(String)

Returns the index within this string of the rightmost occurrence of the
specified substring.

For more details, see http://download.oracle.com/javase/7/docs/
api/java/lang/String.html#lastIndexOf(java.lang.String).

Example:Severity: $group0.lastIndexOf("Critical")>-1? "Critical" :
"Normal"

int length() Returns the length of this string.

For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#length().

Example:Description: $group1.length() <10 ? $group0+$group1 :$group1

booleanmatches
(String)

Tells whether or not the stringmatches the given regular expression.

For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#matches(java.lang.String).

Example:Severity: $group0.matches("(.*)Critical(.*)")? "Critical" : "Normal"

double
parseDouble
(String)

Use to convert strings to numeric values. The input string should be a valid
representation of an integer or a floating point number.

Note:Calling this function on a string that cannot be interpreted as a number
causes an error and the incoming data is dropped.

Example:Match: parseDouble($size) > 10

int parseInt
(String)

Use to convert strings to numeric values. The input string should be a valid
representation of an integer or a floating point number.

Note:Calling this function on a string that cannot be interpreted as a number
causes an error and the incoming data is dropped.

Example:Match: parseInt($size) > 10
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Expressions and
Functions Description

String
resolveHostIP
(String)

Performs DNS resolution from a server to its IP address.
If the DNS resolution fails, the function returns the value unknown host.

Example: Target: resolveHostIP($host)

String
resolveHostName
(String)

Performs DNS resolution from an IP address to a fully qualified domain
name.
If the DNS resolution fails,
the function returns the original input host name.

Example: Target: resolveHostName($host)

boolean
startsWith
(String)

Tests if this string starts with the specified prefix.

For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#startsWith(java.lang.String).

Example:Monitor Name: $group1.startsWith("Operations")? $group1 :
"Operations"+$group1

boolean
startsWith
(String, int)

Tests if the substring of this string beginning at the specified index starts
with the specified prefix.

For more details, see http://download.oracle.com/javase/7/docs/
api/java/lang/String.html#startsWith(java.lang.String,%20int).

Example:Monitor Name: $group1.startsWith("Operations",2)? $group1 :
"Operations" + $group1

long str_to_
seconds
(String, String)

Calculates the timestamp (in seconds, since January 1, 1970 format) held in
the first String using the format in the second string.

True if the date specified in $time in yyyy-MM-dd HH:mm:ss.SSS format is
later than the current time.

For more details, see http://download.oracle.com/javase/7/docs/
api/java/text/SimpleDateFormat.html.

Example:Match: str_to_seconds ($time,"yyyy-MM-dd HH:mm:ss.SSS") >
time()

Note:Use the following symbols to represent time:

Year - `y'; Month - `M"; Day of month - `d'; Hour - `H'; Minute - `m'; Second -
`s'
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Expressions and
Functions Description

String substring
(int)

Returns a new string that is a substring of this string. The substring begins
with the character at the specified index and extends to the end of this
string.

For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#substring(int).

Example: Title: $group0.substring(2)

String substring
(int, int)

Returns a new string that is a substring of this string.

For more details, see http://download.oracle.com/javase/7/docs/api/
java/lang/String.html#substring(int).

Example: Title: $group0.substring(2,9)

int time() Returns the current time, in seconds, since January 1, 1970 format.

Example:Match: $timeStampField > (time()-600)

True if the value of the $timeStampField is newer than tenminutes ago (in
seconds, since January 1, 1970 format).

String
toLowerCase()

Converts all of the characters in this to lower case using the rules of the
default locale.

Example: Title: $group0.toLowerCase()

String
toUpperCase()

Converts all of the characters in this to upper case using the rules of the
default locale.

For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#toUpperCase().

Example: Title: $group0.toUpperCase()

String trim() Returns a copy of the string, with leading and trailing whitespace omitted.

For more details, see http://download.oracle.com/javase/7/
docs/api/java/lang/String.html#trim().

Example:Category: $group3.trim()
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Options Page (Events Only)

UI Element Description

Log Local
Events

Defines which incoming events are logged. These events are logged on the BSM
Connector system in the log file:

Windows: %OvDataDir%\log\OpC\opcmsglg

Linux: /var/opt/OV/log/OpC/opcmsglg

that match
a rule and
trigger an
event

Logs any events in the event source that match the policy rules.

that match
a rule and
are ignored

Logs any events in the event source that are suppressed. (Suppressed events are
not sent to BSM.)

that do not
match any
rule

Logs any events that do not match any of the rules in the policy.

Unmatched
Events

Send an event to BSM when the input event does not match any rule in the policy
because none of the conditions apply or because the policy does not contain any
rules. This ensures that unexpected events that might be important do not go
unreported. By default, unmatched events are ignored.

Each policy that sends unmatched events to BSM creates an event with the
default values of the policy.

Tip: If you want a policy to send events only with the default values, omit all
rules from the policy.

Note:

Openmessage interface and SNMP trap policies: The agent creates an event
for an unmatched event only if the input event is unmatched in all policies on
the BSMConnector system. The agent sends only one event for each
unmatched input event.

Database, log file, Web service listener, and XML file policies: If several
event policies forward unmatched events to BSM, you could receivemultiple
events about a single input event.
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are
forwarded
to BSM
Server

Sends unmatched events to BSM.

are
forwarded
to BSM
Server with
state
'closed'

Sets the unmatched event's lifecycle status to Closed before sending it to BSM.

are ignored Ignores unmatched events.

Pattern
Matching
Options

Defines case sensitivity and field separators for all rules.

Case
sensitive
check

Defines whether the case (uppercase or lowercase) of a text string is considered
when the pattern of a rule is compared with the source data. When switched on, a
match only occurs if the use of uppercase and lowercase letters is exactly the
same in both the source data and the pattern. This is the default setting.

Field
Separators

Defines which characters should be considered to be field separators. Field
separators are used in the pattern as separator characters for the rule condition.
You can define up to seven separators, including these special characters:

l \n New line (NL)

l \t Horizontal tab (HT)

l \v Vertical tab (VT)

l \b Backspace (BS)

l \r Carriage return (CR)

l \f Form feed (FF)

l \a Alert (BEL)

l \\ Backslash (\)

For example, if you wanted a backslash, an asterisk, and the letter A to define the
fields in the event, you would type \\*A (with no spaces separating the characters).

If you leave this box empty, the default separators (a blank and the tab character)
are used by default.

You can set case sensitivity and separator characters for individual rules in a
policy by clicking the button in rule's match condition.

Apply to
All

Applies the patternmatching options to all existing rules in a policy. This
overwrites any modifications made to the patternmatching options in individual
rules.

If you change the patternmatching options and do not click Apply to all, they only
apply to all new rules in a policy.
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Pattern Matching Variables Tab (Event Rules Only)

UI Element Description

<variables> Displays the user-defined variables configured in the Condition tab. For more
information about assigning strings to variables, see "User-Defined Variables in
Patterns" on page 447.

Policy Constants Tab (Metrics Only)

UI Element Description

QUALITY_
ERROR

Maps themetrics quality to the critical HI state (that is, the state that corresponds
to the critical severity; if critical does not exist on the CI, major, minor, or warning).

QUALITY_
WARNING

Maps themetrics quality to the warning HI state (that is, the state that corresponds
to the warning severity; if warning does not exist on the HI, the closest state to it
except for states representing normal severity).

QUALITY_
GOOD

Maps themetrics quality to the normal HI state (that is, the state that corresponds
to the normal severity).

Policy Variables Tab (Events Only)

Variable Description

<$#> Returns the number of variables in an enterprise-specific SNMP event (generic
event 6 Enterprise specific ID). Sample output: 2

<$*> Returns all variables assigned to the event up to the possible fifteen. Sample
output: [1] .1.1 (OctetString): arg1 [2] .1.2 (OctetString):
turnip.example.com

<$@> Returns the time the event was received as the number of seconds since Jan 1,
1970 using the time_t representation. Sample output: 859479898

<$1> Returns one or more of the fifteen possible event parameters that are part of an
SNMP event. (<$1> returns the first variable, <$2> returns the second variable,
and so on.)

<$\>1> Returns all attributes greater than n as value strings, useful for printing a variable
number of arguments. <$\>0> is equivalent to $*without sequence numbers,
names, or types. Sample output: bokchoy.example.com

<$\>+1> Returns all attributes greater than n as name:value string. Sample output: .1.2:
asparagus.example.com
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<$+2> Returns the nth variable binding as name:value. Sample output: .1.2:
artichoke.example.com

<$\>-n > Returns all attributes greater than n as [seq] name (type): value strings. Sample
output: [2] .1.2 (OctetString): cauliflower.example.com

<$-2> Returns the nth variable binding as [seq] name-type:value. Sample output: [2]
.1.2 (OctetString): brusselsprouts.example.com

<$A> Returns the node that produced the event. Sample output:
eggplant.example.com

<$C> Returns the community of the event. Sample output: public

<$E> Returns the enterprise ID of the event. Sample output:
.1.3.6.1.4.1.11.2.17.1

<$e> Returns the enterprise object ID. Sample output: .1.3.6.1.4.1.11.2.17.1

<$DATABASE_
SERVER>

Returns the name of the database server as specified in theServer name field in
theSource page. Sample output: dbserver.example.com

<$DATABASE_
TABLES>

Returns the names of the queried tables as specified in the FROM field in the
Source page. Sample output: ALL_EVENTS

<$F> Returns the textual name of the remote postmaster daemon's computer if the
event was forwarded. Sample output: cress.example.com

<$G> Returns the generic event ID. Sample output: 6

<$LOGFILE> Returns the name of the log file that contains the input event. Sample output:
program_log.txt

<$LOGPATH> Returns the name and path of the log file that contains the input event. Sample
output: C:\temp\mylogfile\program_log.txt

<$MSG_APPL> Returns the name of the application associated with the input event that caused
themessage. Sample output: /usr/bin/su(1) Switch User

<$MSG_GEN_
NODE>

Returns the IP address of the node that sends the event. Sample output:
192.168.1.123.

<$MSG_GEN_
NODE_NAME>

Returns the host name of the node that sends the event. Sample output:
node123.example.com.

<$MSG_GRP> Returns the default category of the event. Sample output: Security

<$MSG_ID> Returns the unique identity number of the event, as generated by the HP
Operations Agent. Note that identity numbers are not generated for suppressed
messages. Sample output: 6e998f80-a06b-71d0-012e-0f887a7c0000
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<$MSG_NODE> Returns the IP address of the node on which the original event took place.
Sample output: 192.168.1.123

<$MSG_NODE_
NAME>

Returns the name of the node on which the original event took place. This is the
hostname that the agent resolves for the node. This variable is not fixed,
however, and can be changed by a policy on a per-event basis. For example, if
the policy is receiving SNMP traps that originate from other devices, youmight
want to set this variable to the name of the device where the trap originated.

<$MSG_
SERVICE>

Returns the service name associated with the event.

<$MSG_
OBJECT>

Delivers the name of the object associated with the event.

<$MSG_
OBJECT>

Returns the name of the object associated with the event. This is set in the Event
Defaults section of the policy editor.

<$MSG_SEV> Returns the default value for the severity of the event. Sample output: Normal

<$MSG_TEXT> Returns the full text of the event. For openmessage interface policies, this value
is themsg_text parameter submitted by the opcmsg command. Sample output:
SU 03/19 16:13 + ttyp7 bill-root

<$MSG_TIME_
CREATED>

Returns the time themessage was created on themanaged node in seconds
elapsed sincemidnight (00:00:00), January 1, 1970, coordinated universal time.
Sample output: 950008585

<$MSG_TYPE> Delivers the name set for message type.

<$N> Returns the event name (textual alias) of the event format specification used to
format the event, as defined in the Event Configurator. Sample output: OV_Node_
Down

<$NAME> Returns the name of the policy that sent the event. Sample output: cpu_util

<$O> Returns the name (object identifier) of the event. Sample output:
.1.3.6.1.4.1.11.2.17.1.0.58916865

<$o> Returns the numeric object identifier of the event. Sample output:
.1.3.6.1.4.1.11.2.17.1.0.58916865

<$OPTION(N)
>

Returns the value of an optional variable that is set by opcmsg (for example,
<$OPTION(A)>, < $OPTION(B)>, and so on.).

<$PROG> Returns the name of the program executed by the scheduled task policy Sample
output: check_for_upgrade.bat

<$R> Returns the true source of the event. This value is inferred through the transport
mechanism which delivered the event. Sample output: carrot.example.com
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<$r> Returns the implied source of the event. This may not be the true source of the
event if the true source is proxying for another source, such as when an
application running locally is reporting information about a remote node. Sample
output: rutabaga.example.com

<$S> Returns the specific event ID. Sample output: 5891686

<$s> Returns the event's severity. Sample output: Normal

<$T> Returns the event time stamp. Sample output: 0

<$USER> Returns the name of the user under which the scheduled task was executed.
Sample output: administrator

<$V> Returns the event type, based on the transport from which the event was
received. Currently supported types are SNMPv1, SNMPv2, CMIP, GENERIC,
and SNMPv2INFORM. Sample output: SNMPv1

<$X> Returns the time the event was received using the local time representation.
Sample output: 17:24:58

<$x> Returns the date the event was received using the local date representation.
Sample output: 03/27/10

Properties Page

UI Element Description

Name Name of the policy. You can use spaces in the name. The equal sign (=) is not
allowed.

Tip: Include the name of the integrated software in the policy name.

Description Description of what the policy does. Youmight also add other notes (for example,
data sources that are used).

Category Name of the logical group to which the policy belongs. Categories may help you
to better group your policies. Separatemultiple categories with commas.

Policy ID GUID (globally unique identifier) assigned to the policy when it is first created.
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Last
Modification

The date and time that the policy was saved.

The date and time displays using the current time zone of the computer on which
theWeb browser runs. The language setting of theWeb browser determines the
date and time format (for example, 09/14/2010 8:16:38 AM for English (United
States)). If theWeb browser and the computer on which the server run have
different language settings, the language setting of theWeb browser takes
precedence. However, English is the default language if theWeb browser is
configured to use a language that is not available on the server.

Last
Modified by

The name of the user active when the policy was saved.

Sample
Type

Metrics integration policies only. The type of metrics sample collected: ss_t
(System). Other sample types are currently not supported.

Rules Page - Policy Rules
Policy Rules List

UI Element Description

Event policies: Create New Rule:Provides the following options:

l Event on matched rule. If matched, BSM Connector sends an event to BSM.
The event uses the settings defined for the rule. If you do not configure these
settings, the default settings are used.

l Suppress on matched rule. If matched, BSM Connector stops processing
and does not send an event to BSM.

l Suppress on unmatched rule. If not matched, BSM Connector stops
processing and does not send an event to BSM.

Metrics policies: Create New Rule:Provides the following options:

l Process on matched rule. If matched, BSM Connector sends metrics to
BSM. Themetrics use the settings defined for the rule. If you do not configure
these settings, the default settings are used.

l Suppress on matched rule. If matched, BSM Connector stops processing
and does not sendmetrics to BSM.

l Suppress on unmatched rule. If not matched, BSM Connector stops
processing and does not sendmetrics to BSM.
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Copy Rule. Copies the selected rule. You can then rewrite the description of the
copied rule and edit the rule.

Delete Rule. Deletes the selected rule.

Move Up.Moves the selected rule higher in the rule order.

Move Down.Moves the selected rule lower in the rule order.

<Move to> Entered number is used to select the rule with that sequence number in the list of
rules.

To select a specific rule in the rule list, type the rule's sequence number in the
<Move to> field and click the button.

<Search
rules>

Entered search string is used to search the rule descriptions and highlight only the
rules containing the specified string.

To search for rules with specific text strings in the rule description, type the string
in the <Search rules> field and click the button. The first matching rule is
selected in the list of rules. Click the and buttons tomove the previous and
next matching rule.

Activate/Deactivate Rule Filter. Activates and deactivates the rule filter.

Seq. Sequence number of the rules. Rules are evaluated in a specific order. When one
condition is matched, no additional rules are evaluated.

Rule
Description

Description of the rule. It is good practice to use a description that helps you
remember what the rule does

BSMConnector User Guide
Appendix C: UI Descriptions

HP Business ServiceManagement (9.23) Page 496 of 521



UI Element Description

Rule Type The three rule types of event policies are:

l Event on matched rule. If matched, BSM Connector sends an event to
BSM. The event uses the settings defined for the rule. If you do not configure
these settings, the default settings are used.

l Suppress on matched rule. If matched, BSM Connector stops processing
and does not send an event to BSM.

l Suppress on unmatched rule. If not matched, BSM Connector stops
processing and does not send an event to BSM.

The three rule types of metrics policies are:

l Process on matched rule. If matched, BSM Connector sends metrics to
BSM. Themetrics use the settings defined for the rule. If you do not configure
these settings, the default settings are used.

l Suppress on matched rule. If matched, BSM Connector stops processing
and does not sendmetrics to BSM.

l Suppress on unmatched rule. If not matched, BSM Connector stops
processing and does not sendmetrics to BSM.

You can change the rule type by clicking the current rule type in the list of rules
and selecting another rule type from the drop-down list.

Sample Data Tab
Sample Data Tab- Database Policies

UI Element Description

<Search
Properties>

Entered search string is used to find a table column. The list changes as you type;
only matching items appear.

To clear the search results, click .

Toggle Short/Full Path Notation. Shows or hides the full path to the table
column. The full path starts with /BSMConnectorEvents/BSMConnectorEvent.
The Table Column section by default shows the short path to the table column.

Find Matching Events. To find values that belong tomore than one table row,
select the value and click . The Database Sample Data window opens and
shows all rows that have the selected value.
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Toggle Deduplication. Shows or hides duplicate values.

Table
Column

Shows all columns that are returned by the database query.

Note: The Sample Data tab is empty if no sample data has been loaded into
the policy or if the database query did not succeed. See also "Configuring the
Data Source in Database Policies" on page 204.

Values for
<...>

Displays the values of the column selected in the Table Column section.

Sample Data Tab - Log File Policies

UI Element Description

<Search
Properties>

Entered search string is used to find a patternmatching group.
The list changes as you type; only matching items appear.

To clear the search results, click .

Toggle Short/Full Path Notation. Shows or hides the full path
to the patternmatching group. The full path starts with
/BSMConnectorEvents/BSMConnectorEvent. The Pattern
Matching Group section by default shows the short path to the
patternmatching group.

Find Matching Events. To find values that belong tomore than
one patternmatching group, select the value and click . The
Log File Sample Data window opens and shows all pattern
matching groups that have the selected value.

Toggle Deduplication. Shows or hides duplicate values.
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Pattern
Matching
Group

Shows the patternmatching groups that match a string in the log
file.

Note:

l The default patternmatching group host_name contains
the fully qualified domain name of the BSM Connector
server.

l The Sample Data tab is empty if no sample data has
been loaded into the policy or if the sample data does not
match the log file pattern specified in the source page.
See also "Configuring the Data Source in Log File
Policies" on page 242.

Values for
<...>

Displays the values of the patternmatching group selected in the
PatternMatching Group section.

Note: Only thematches found in the first 100 lines of the log
file are displayed.

Sample Data Tab - Web Service Listener Policies

UI Element Description

<Search
Properties>

Entered search string is used to find a key. The list changes as you type; only
matching items appear.

To clear the search results, click .

Toggle Short/Full Path Notation. Shows or hides the full path to the key. The
full path starts with /BSMConnectorEvents/BSMConnectorEvent. The Key
section by default shows the short path to the key.

Find Matching Events. To find values that belong tomore than one key, select
the value and click . TheWeb Service Sample Data window opens and shows
all keys that have the selected value.

Toggle Deduplication. Shows or hides duplicate values.
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Key Shows all keys that have been received by theWeb service listener for this
policy.

Note:

l The sample data includes a key-value pair that represents the default
routing domain configured for the BSMConnector server in BSM under
Admin > Integrations > BSM Connector Integrations. The default
routing domain name is DefaultDomain.

Youmay insert the default routing domain name in CI-related fields of the
policy to help BSM distinguish different routing domains.

l The Sample Data tab is empty if no sample data has been loaded into the
policy or if no SOAP messages have been received for the policy. For
information about loading sample data into aWeb service listener policy,
see "Event integration only: How to load sample data into the policy" on
page 395.

Values for
<...>

Displays the values of the key selected in the Keys section.

Sample Data Tab - XML File Policies

UI Element Description

<Search
Properties>

Entered search string is used to find an XML property or value. The list changes
as you type; only matching items appear.

To clear the search results, click .

Toggle Short/Full Path Notation. Shows or hides the full path to the XML
property or value. The full path begins with the XML event tag specified in the
Source tab. The XMLProperties section by default shows the short path to the
XML property or value.

Find Matching Events. To find values that belong tomore than one XML
property, select the value and click . The XMLSample Data window opens and
shows all XML properties that have the selected value.

Toggle Deduplication. Shows or hides duplicate values.
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XML
Properties

Shows all XML elements and attributes that match an XML event tag. (You can
identify attributes based on the preceding at sign (@).)

Note: The XML properties list is empty if no sample data has been loaded
into the policy or if the sample data does not match any specified XML event
tags.

Values for
<...>

Displays the values of the XML property selected in the XMLProperties section.

Schedule Page
Schedule Page - Legacy Discovery Policies

UI Element Description

Clears the selection.

Selects all days, hours, or minutes.

Days of Week Days of the week from Sunday to Saturday.

Hours of Day 1 to 12 AM and 1 to 12 PM.

Minute of Hour 0 to 59minutes.

Schedule Summary Summary of the specified schedule

Schedule Page - Scheduled Task Policies

UI Element Description

Select All. Selects all units of time.
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Scheduling
Options

The following options are available:

l Once.WhenOnce is selected, the command runs on one specific day at the
time you indicate.

Note: If the selected date or time occurs in the past, the command is not
executed, and the Schedule tab shows a warning.

l Once per interval.WhenOnce per interval is selected, the command runs
once each time the interval that you indicate passes.

l Advanced.WhenAdvanced is selected, you can indicate specific days and
times when the command should be run. You select specific days of the week,
specific days of themonth, and specific months. This allows you to specify
odd schedules such as, "OnMonday when it falls on the 2nd of themonth."
You can also indicate that the command should only be run during a specific
year.

Note: If you select Advanced but then do not specify a schedule, the
command by default runs every minute.

Once

Set to
current
time

Selects the current time in the schedule.

Minute of
Hour

0 to 59minutes.

Hours of
Day

1 to 12 AM and 1 to 12 PM.

Date: <> Date when the command should run. Click the calendar icon to open a calendar
view for the current month.

Once per interval

Interval:
<> h <> m
<> s

Interval in hours, minutes, and seconds.

Advanced (daily execution)
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Minute of
Hour

0 to 59minutes.

Hours of
Day

1 to 12 AM and 1 to 12 PM.

Days of
Month

1 to 31 days of themonth.

Months of
Year

Months from January to December.

Days of
Week

Days of the week from Sunday to Saturday.

Restrict
schedule
to the year

Select to schedule the task for the specified year only.

Source Page
Source Page - Database Policies - Basic and Query Settings

UI Element Description

Basic Settings

Database
Connection
URL

URL to a database connection (sometimes referred to as an Authentication
string).

One way to create a database connection is to useODBC to create a named
connection to a database. For example, first use the ODBC control panel to
create a Data Source Name (DSN) called test under the system DSN tab.
Then, enter jdbc:odbc:test as the connection URL. Alternatively, use the
suppliedMicrosoft SQL or Oracle driver to connect to the database.

Database
Driver

Driver used to connect to the database. Use the fully qualified class name of the
JDBC driver you are using.

Database
User Name

User name used to log on to the database.

Database
Password

Password used to log on to the database.
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Server Name Name of the database server. The value entered here is returned by the policy
variable <$DATABASE_SERVER>, which can be used in the Source CI attribute to
identify the source of the database data.

Frequency How often the policy queries the database (in seconds, minutes, hours, days, or
weeks).

Default value: 10minutes

Minimum value: 3 seconds

Timeout Amount of time, in seconds, that BSM Connector waits before the policy query
times out.

Default value: 60 seconds

Note: The timeout periodmust be shorter than the frequency.

Query Settings

SELECT SELECT clause to be used in the SQL query. Enter * for all fields or a comma
separated list of column names to be retrieved from the database.

When specifying the SELECT clause, the column used as the enumerating field
must appear in the clause.

FROM FROM clause to be used in the SQL query. Enter a table name or a comma
separated list of tables from which the selected columns should be extracted.

WHERE WHERE clause to be used in the SQL query. This is an optional field which
enables you to define the select criteria.

Leaving it empty results in retrieving all the rows from the table defined in the
FROM option.

Enumerating
field

Name for a database field that can be used to order the data that is returned from
the database query.

For details on how data from the enumerating field is processed, see "UI
Descriptions" on page 458 above.

Note: The column used as enumerating field must be included in the SELECT
clause.
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Enumerating
field type

The type of field used to order the result set. This can be a DATE field, an
INTEGER field, a DOUBLE floating point numeral field, or a LONG field.

The following table maps SQL types to the required enumerating field type.

SQL Type

SMALLINT

INTEGER

BIGINT

NUMERIC

DOUBLE

DECIMAL

FLOAT

TIMESTAMP

DATE

Enumerating Field Type

INTEGER

INTEGER / LONG

LONG

LONG

DOUBLE

DOUBLE

DOUBLE

TIMESTAMP

TIMESTAMP

Initial
Enumerating
Value

Initial value to be used as a condition for the initial run of this policy instance. For
example, if you specify theEnumerating field type as a field type DATE and you
enter a value of 2000-01-31 12:00:00 in the Initial Enumerating Value field,
only records that were added to the database after the specified date are
forwarded.

Max rows to
fetch

Maximum number of rows the policy retrieves from the database for each cycle.

Default value: 5000 rows

If the number of result rows exceeds the set maximum, the policy retrieves the
remaining rows (those that exceeded themaximum) on future cycles, until all
result rows are retrieved.

The value should be sufficient to keep up with database table growth, yet small
enough to avoid java.lang.OutOfMemoryException errors. Further, policy run
frequency should also be considered. Make sure that the rate at which data is
collected by the policy—which is dependent on both policy run frequency and
network/system speed—is greater than, or equal to, the rate of data insertion on
the third-party system.

Source Page - Database Policies - Sample Data

UI
Element Description
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Retrieves the specified table columns from the database.

Note: BSMConnector can only load amaximum of 50MB of sample data.

Opens the Database Sample Data dialog box. This dialog box displays the table
columns and values returned by the database query.

<> Displays themessage Sample data loaded from databasewhen the database
query was successful.

Source Page - Log File Policies
This requires that the user account under which BSMConnector is running has permission to
access the remote directory using the UNC path.

UI
Element Description

Server Server on which this policy reads the log file. The drop-down list displays on those
remote servers that have been configured in BSM Connector.

Default value:BSMConnector server (the server on which BSMConnector is
installed)

Remote
Servers

Opens the Remote Servers dialog box. For details, see "Configuring Remote
Servers " on page 89.
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Log File
Name

Path and name of the log file from which you want to extract data.

l Remote UNIX. For reading log files on remote UNIX machines, the pathmust
be relative to the home directory of UNIX user account being used to log on to
the remotemachine. Click Remote Servers and select the UNIX remote server
for information about which UNIX user account is being used.

l Remote Windows through NetBIOS. You can also access log files by
including the UNC path to the remote log file. For example,
\\remoteserver\sharedfolder\filename.log.

This requires that the user account under which BSMConnector is running has
permission to access the remote directory using the UNC path.

If a direct connection using the operating system is unsuccessful, BSM
Connector tries to match the \\remoteserverwith servers currently defined as
remoteWindows connection profiles (displayed in the remote server list).

If an exact match is found for \\remoteserver in the remoteWindows
connection profiles, BSM Connector tries to use this connection profile to
access the remote log file. If nomatching server name is found, the policy
reports that the remote log file cannot be found.

It is not necessary to select a remoteWindows server if you are using NetBIOS
to connect to remoteWindows servers.

l Remote Windows through SSH. Select a remote server from the drop-down
list. The path of the log file depends on the type of SSH server installed on the
remoteWindows server:

n SSH servers that provide a UNIX-like interface (for example, Cygwin
OpenSSH):

/cygdrive/<drive_letter>/<directory>/filename.log

n SSH servers that provide aWindows command prompt (for example,
OpenSSH forWindows):

<drive_letter>:\<folder>\filename.log

Optionally, you can use a regular expression to insert date and time variables. For
example, you can use a syntax of s/ex$shortYear$$0month$$0day$.log/ to
match date-coded IIS log file names. For details, see "Special Substitution for File
Path" on page 277.

Log File
Encoding

Log file encoding that is used if you are reading a log file whose encoding is
different than the BSMConnector machine's default encoding.

Default value:Cp1252
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Frequency How often the policy reads the log file (in seconds, minutes, hours, days, or
weeks).

Default value: 10minutes

Minimum value: 15 seconds

Timeout Maximum number of seconds that the policy attempts to access the log file.

Default value: 60 seconds

Note: The timeout periodmust be shorter than the frequency.

Log File Pattern

Log File
Pattern

Text to look for in the log entries. You can also use a regular expression in this entry
to match text patterns. Surround values you wish to extract with parenthesis, for
example (.*) (.*) (.*)(.*). Escape special characters with a backslash (\).
Examples of special characters are the plus sign (+), the asterisk (*), the question
mark (?), the at sign (@), the exclamation point (!), the caret (^), brackets ([]), and
braces ({}).

For more information about regular expressions, see "Regular Expressions" on
page 269.

Sample Data

Loads the first 100 lines of the log file and applies the log file pattern.

Note: BSMConnector can only load amaximum of 50MB of sample data.

<> Displays themessage Sample data loaded from file '<file>' if the log file
could be loaded successfully.

Source Page - Web Service Listener Policies

UI
Element Description

System
ID

Text system ID for theWeb service listener policy instance.

Each receivedmessage from the third-party system holds a system ID. EachWeb
service listener policy receives messages only with a system ID that matches the
system ID defined in the policy. The system ID must be unique for all policies. Enter
the system ID that represents themessages that you want this policy to receive.

Sample Data (for event integration only)
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UI
Element Description

Retrieves the specified key-value pairs from the SOAP messages.

Note: BSMConnector can only load amaximum of 50MB of sample data.

Opens theWeb Service Sample Data dialog box. This dialog box displays the keys
and values of the received SOAP messages.

<> Displays themessage Sample data loadedwhen the policy receives messages
through theWeb service listener that match the system ID defined in the policy.

Source Page - XML File Policies

UI
Element Description

Log File
Path /
Name

Path and name of the XML file that the policy reads. Type the drive letter and the full
path for the location of this file on the BSM Connector system.

You can use the following configurations tomake your policy more flexible:

l Windows environment variables (for example, winnt or clusterlog). The
syntax for these variables is <$variablename>, for example <$winnt>.

l Script or command that returns the path and name of the log file you want to
access. For example, type <`command`>where command is the name of a script
that returns the path and name of the log file you want the policy to read.

The command can also returnmore than one log file path separated by spaces.
The HP Operations Agent processes each of the files using the same options
and conditions as configured for this policy. This is very useful when you want to
dynamically determine the log file path or process multiple instances of a log file.

l Patternmatching. The pattern-matching language enables you to very accurately
specify the file names that you want the policy to match. For example, you can
use the pattern <path>/events<*>.xml to match XML source file names such
as events.1.xml and events.2.xml.

For more information on patternmatching, see "Pattern-Matching Details" on
page 443.

Note: BSMConnector cannot process log files that are larger than 2GB.
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Polling
Interval

Determines how often the policy reads the XML file. This period of time is the polling
interval. The polling interval should be as large as possible, although this depends
on the amount of new data written to the file and the readmode that you choose. Set
the interval to no less than 30 seconds; usually 5minutes is appropriate. Note,
however, that a policy begins to evaluate data after the first polling interval passes.
A shorter polling interval is better when you are testing a policy.

Default value: 5minutes

Logfile
Character
Set

Name of the character set used by the XML file that the policy reads.

Note: It is important to choose the correct character set. If the character set
that the policy is expecting does not match the character set in the XML file,
patternmatchingmay not work, and the event details can have incorrect
characters or be truncated in BSM. If you are unsure of which character set is
used by the XML file that the policy reads, consult the documentation of the
program that writes the file.

Default value: UTF-8

Send
event if
log file
does not
exist

BSMConnector sends an event if the specified XML file does not exist.

Default value: not selected

Close
after
reading

The policy keeps the XML file open (and retains its file handle) after reading it. Do
not use a polling interval of less than oneminute when this option is selected.

If you do not select this option and the name of the XML file changes, the policy
continues to read the original XML file instead of processing any new XML file with
the specified name. Consider the following example: a policy reads the log file
syslog.log. Mondays at 23:59, the file is renamed to syslog.monday, and a new
version of syslog.log is created for the Tuesday log. Without Close after reading
being selected, the policy continues to read syslog.monday because the file handle
refers to the original, renamed file.

Default value: not selected
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Read
Mode

The readmode of an XML file policy indicates whether the policy processes the
entire file or only new entries.

Read from last position. The policy reads only new—
appended—entries written in the XML file while the policy
is activated. If the file decreases in size between
readings, then the entire file is read. Entries that are added
to the file when the policy is disabled are not processed by
the policy.

Choose this option if you are concerned only with entries
that occur when the policy is enabled.

Advantage:No
chance of reading
the same entry
twice. (Unless the
file decreases in size
because some
entries were
deleted.)

Disadvantage:
Entries written to file
while the policy is
disabled or the agent
is not running are not
processed by the
policy.

Read from beginning (first time). The policy reads the
complete XML file each time the policy is activated or the
agent restarts. This ensures that all entries in the file are
compared with the rules in the policy. Each successive
time that the policy reads the file, only new (appended)
entries in the file are processed.

Choose this option if you want to ensure that every
existing and future entry in the file is processed by the
policy while it is activated.

Advantage:Every
existing and future
entry in the file will
be processed by the
policy.

Disadvantage:
Duplicate entries can
occur if an activated
policy is deactivated
and reactivated, or if
the agent stops and
restarts.

Read from beginning (always). The policy reads the
complete XML file every time it detects that the file has
changed. The policy scans the file at the specified polling
interval. If no change is detected, the file is not
processed. Any entries overwritten while the agent is not
running or the policy is deactivated will not be evaluated
by the policy.

Choose this option if the policy reads a file that is
overwritten, rather than appended.

Advantage:Ensures
that files that are
overwritten are
correctly processed.

Disadvantage:Only
valid for files that are
overwritten, rather
than appended.

Note: Every policy reads the same XML files independently from any other
policies. This means, for example, that if "Policy 1" with readmodeRead from
beginning (first time) is activated and "Policy 2" with the same readmode
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already exists, "Policy 1" still reads the entire file after it has been activated.

Default value: Read from last position

Sample
Data

Enables you to upload an XML sample file. BSM Connector makes the XML
elements and values of the sample file available to you in the Event and Rules
pages so that you can insert them by dragging and dropping.

Load sample data from server. Loads an XML sample file from the BSM
Connector system.

Load sample data from local file system. Loads an XML sample file from the
system where theWeb browser runs.

Note: BSMConnector can only load amaximum of 50MB of sample data.

Opens the XMLSample Data dialog box. This dialog box displays the contents of
the uploaded XML sample file.

XML
Event
Tag

Enables you to specify one or more XML event tags. The XML event tag creates a
shortcut to the XML element that you want to process. An event tag typically
identifies an event record in an XML file. You can definemore than one event tag.

Create new XML event tag manually. Enables you to type an XML element in the
provided box.

Create new XML event tag from XML sample data. Opens the XMLSample
Data Outline dialog box. This dialog box displays the XML elements and attributes
contained in the uploaded XML sample data.

Deletes the selected XML event tag.

Caution: Deleting an event tag that is referenced in a policy corrupts the policy
and renders it unusable.

Start, Success, Failure Event Pages (Scheduled Task
Policies)

UI Element Description

Send Start Event Click to send an event when the command begins to run.

Send Success
Event

Click to send an event when the command completes successfully.

Send Failure
Event

Click to send an event when the command fails to run or fails to complete
successfully.
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Task Page (Scheduled Task Policies)

UI
Element Description

Load. Opens a file selection dialog box for you to select the VB or Perl script to
load into the policy.

Task Type Type of task:

l Command

l VB Script

l Perl Script

Command Complete path and extension of the command that you want to run (for example,
%OvDataDir%\bin\instrumentation\cleanup.exe). The file that you specify
should exist on the system.

By default, the command runs under the same account as the agent is running,
which is Local System or root by default.

Username User name under which the command should be run. The user must exist and have
permission to run the command on the system. If you specify a non-existent user,
the command fails to run.

Password Password for the user. If the password changes, the policy must be updated and
reactivated.

VB Script Code that defines the VB script. Instead of typing the script into the field, you can
upload an existing script.

Tip: Use the policy method Rule.Status to specify whether the task is
successful. For example, to specify that the task has failed (and trigger a
failure event), use Rule.Status=False. (See "Rule Object" on page 307 .)

Note: HP Operations Agent uses a generic Microsoft scripting engine to run
VBScript scripts.You can therefore use standard VBScript objects (for
example, the FileSystemObject object) in your scripts. Objects that are
specific to wscript or cscript (for example, theWScript object) are not
supported.
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UI
Element Description

Perl
Script

Code that defines the Perl script. Instead of typing the script into the field, you can
upload an existing script.

Tip: Use the policy method $Rule->Status to specify whether the task is
successful. For example, to specify that the task has failed (and trigger a
failuremessage), use $Rule->Status(False). (See "Rule Object" on page
307 .)

Note: The agent runs as a service that has no standard input, standard output,
or standard error. Therefore, the predefined file handles STDIN, STDOUT, and
STDERR are not available for Perl scripts in scheduled task policies. It is also
not possible to open file handles that use command pipes or capture the
standard output from commands within backticks (`).

Topology Page
Topology Page - Database, Log File, Web Service Listener, and Custom Topology Policies

UI
Element Description

Frequency Custom topology discovery only: How often the policy runs the topology script.
Use the drop-down list to specify increments of seconds, minutes, hours, days or
weeks.

Default value: 10minutes

Minimum value: 15 seconds

<script> Custom topology discovery only: The contents of the script are visible in this box.
You can edit the script contents in this field using the script editor provided by BSM
Connector, or you can copy it into your preferred text editor, edit it, and then copy it
back into this box.

Note: The topology script is sensitive to spaces and tabs.
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UI
Element Description

Script
Template

Database, log file, andWeb service listener topology discovery only: Script to
create the topology in BSM for the data retrieved from the connected third-party
system. The script is based on the Jython scripting language (Python enabled by
Java).

l Metrics and event integration only: No Topology. No script is selected and no
topology is sent (although data is still sent).

l Metrics integration only: Computer - Monitor. BSMConnector reports this
data to the Computer CI, a descendant of the Node CI.

l Computer. Creates a topology with a Computer CI.

l Computer - Running Software. Creates a topology with a Computer CI and a
Running Software CI connected to it with a Composition relationship.

l Custom. You create your own topology if you want the retrieved data to be
forwarded to specific CIs and not the standard Computer or Running Software
CIs.

Note: You should only select Custom if you are familiar with the Jython
language, since youmust create the topology script in Jython yourself.
Depending on the data type you want to collect, we recommend that you
select and edit one of the out-of-the-box scripts.

Load
Template

Database, log file, andWeb service listener topology discovery only: Loads the
required script for the topology you selected in theScript template option. If you
select Computer - Monitor, Custom, or No Topology, there is no script to load and
the Load template button is not available.

Caution:When you load a script, the currently loaded script is overwritten and
all of you changes are lost.

Topology Page - Topology-XML Policies

UI Element Description

Basic Settings
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UI Element Description

Frequency How often the policy applies themapping rule files. Each time the policy runs, the
mapping rules are applied to the whole discovery XML file, not only to appended
entries. Use the drop-down list to specify increments of seconds, minutes, hours,
days or weeks.

Default value: 1 hour

Minimum value: 15 seconds

Topology
Input File

Path and name of the discovery XML file that the discovery script or the policy
creates.

If the script writes the XML output to the standard output stream (STOUT) (for
example, on a remote server), select theSave Script Output to File checkbox to
create and populate the topology input file.

For details on the required XML syntax, see "Topology Discovery Syntax" on page
335.

Sync-
Packages

Subdirectory containing themapping rule files on the BSMConnector system. The
policy editor assumes that the synchronization packages are stored in
subdirectories of the <BSM Connector root
directory>/conf/topology/xml/sync-packages/ directory. To specify more
than one synchronization package, separate individual subdirectories with semi-
colons.

For details onmapping rules, see "Topology Synchronization Rules" on page 330.

Example:mysyncpkg;yoursyncpkg

Collection Script Settings

Run Script Enables the policy to run the discovery script on the local or a remote server. The
script runs before themapping rules are applied.

Default value: not selected

Remote
Server

Name of the server where you want to run the discovery script. Select a server
from the server list.

Only thoseWindows and UNIX remote servers configured in BSM Connector
using SSH, telnet or rlogin are displayed. For a list of supported network protocols,
see "Supported Platforms" on page 342.

Default value:BSMConnector server (the server on which BSMConnector is
installed)

Remote
Servers

Opens the Remote Servers dialog box. For details, see "Remote Servers
Overview" on page 85.

Script The discovery script to run. Only executable script files are displayed.
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UI Element Description

Select a script from the drop-down list.

l BSM Connector server.When running scripts on the local BSM Connector
server, scripts placed into the <BSM Connector root directory>/scripts
directory may be used.

l Windows remote servers.BSMConnector gets scripts from the home
directory of the account BSM Connector uses to access the remote server.

The path to the user home directory depends on the particular SSH server. For
example if you install a Cygwin SSH server in C:\Cygwin, the default path to
the home directory for the Administrator user will be
C:\Cygwin\home\Administrator. For additional information, see "How to
Configure RemoteWindows Servers for SSH Access" on page 103 and
particularly "Install BSM Connector RemoteWindows SSH Files" on page 111.

l UNIX remote servers.BSMConnector gets scripts from a scripts subdirectory
in the home directory of the account BSM Connector uses to access the
remote server. For example, /home/BSMConnector/scripts. For additional
information, see "How to Configure Remote UNIX Servers for SSH Access"
on page 112.

Tip: Remember to grant execute permissions for the connecting user to
the remote scripts.

Symbolic links are supported when executing scripts on remote UNIX servers.
This support is enabled by setting the property
_scriptMonitorAllowSymbolicLink to true (false by default) in the
<BSM Connector root directory>/groups/master.config file. When
enabled, symbolic link scripts appears in the list of available scripts.

l USE COMMAND (remote UNIX servers only). If you choose USE
COMMAND, youmust also specify a USE COMMAND script file name in the
Remote script command file field. BSM Connector sends the command or
commands found in the USE COMMAND script file to be run as a command
line on the remote UNIX system. Script files for the USE COMMAND option
must be created in the <BSM Connector root directory>/scripts.remote
directory.

Syntax exception:Do not include any command that would normally discontinue
script processing (for example, do not use the exit command).

Parameters Specifies any additional parameters to pass to the discovery script. You can use a
regular expression or use the policy date attributes to insert variables into the
parameters box.
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l Regular expressions. For details on inserting date variables, see "BSM
Connector Date Variables" on page 275.

Example: The regular expression s/$month$ $day$ $year$/ passes the
current month, day, and year to the script (for example, “3 13 2013”).

l Date attributes.

<time> Passes the time that the policy completed the last
run to the script.

“4:10”

<time-date> Passes the date portion of the time that the policy
completed to the script.

“3/13/13”

<time-time> Passes the time portion of the time that the policy
completed to the script.

“4:11”

Syntax exceptions:BSMConnector cannot pass the following characters to
scripts: ` ; & |

Output
Encoding

Select the code page or encoding to use for the command output if the command
output uses an encoding that is different from the encoding used on the server
where BSMConnector is running.

Default value:Cp1252 (windows-1252)

Remote
Script
Command
File

The script file that contains the commands that BSM Connector should send to
the remote UNIX server if USE COMMAND is selected as the Script option and a
remote UNIX server as the Server. You can save one or more commands in the
text script file and save the file in the <BSM Connector root
directory>/scripts.remote directory. BSM Connector opens this file and runs the
command at the command prompt of the remote UNIX server chosen in the
Server option.

The USE COMMAND script canmake use of positional parameters such as $1,
$2 (or alternatively %1, %2), and so on, inside the script. Enter the parameters you
want BSM Connector to pass to the script in the Parameters field provided above.

You can use one or more commands per USE COMMAND script file.

Default value: none

Syntax exception:Do not include any carriage returns or any command that
would normally discontinue script processing (for example, do not use the exit
command).
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Save
Script
Output to
File

Configures the policy to save the output of the discovery script to the XML file
specified in the Topology Input File field. Select this option if the discovery
script writes the XML to the standard output stream (STOUT) (for example, if the
script runs on a remote server) and you want the policy to create and populate the
topology input file.

Default value: selected

Timeout Amount of time to wait for the script to run successfully before timing out.

The timeout value is the total time that BSM Connector waits for a successful run
of the script. You can use this option to have BSMConnector run the policy but kill
the script execution if a script exit code is not detected within the timeout period.

The following limitations exist:

l It is only available with BSM Connector running on theWindows platform.

l It can only be used with scripts stored and run on the local BSM Connector
server.

l It only applies to running scripts, not commands.

Default value: 10minutes

Minimum value: 15 seconds

Advanced Settings

Bulking
Strategy

Determines how BSMConnector chunks the CIs and CI relations it sends to
BSM.

l Standard. Topology synchronization transmits a bulk of CIs and CI relations
when all members of a composition relation are gathered in the bulk or when the
bulk threshold is crossed. The standardmode is recommended for small
topologies resulting in a single bulk to transmit. Use structural mode for larger
topologies so that all CIs required by BSM to identify a node are gathered in the
same bulk.

l Structural.When topology synchronization encounters BSM CIs of the type
Node or derived CI types, it creates a chunk of CIs required for identification in
BSM and transmits the bulk to BSM.

Default value:Structural

Maximum
Bulk Size

Sets themaximum number of CIs and CI relations inside a single bulk generated
by topology synchronization.

Default value: 500
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Bulk-Full
Threshold

Sets the near limit tolerance for topology synchronization to recognize a bulk is
full.

Example: If themaximum bulk size is 500 and the threshold is 30, topology
synchronization considers the bulk to be full when it contains 470 or more
elements. The current bulk is then transferred using the result
ObjectStateHolderVector.

Default value: 30
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We appreciate your feedback!
If you have comments about this document, you can contact the documentation team by email. If
an email client is configured on this system, click the link above and an email window opens with
the following information in the subject line:

Feedback on BSM Connector User Guide (Business Service Management9.23)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client,
and send your feedback to ovdoc-asm@hp.com.
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